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What is new in 10.04.100?
You will find the release notes for IGEL Linux 10.04.100 as a text file next to the installation programs on our 
download server1 and in this knowledge base: release notes.

Moble device access is implemented as accessory; see Mobile Device Access (see page 497).
During first setup, the user must accept the EULA; see Using the Setup Assistant Function (see page 
9).
For the on-screen keyboard, a reduced alternative layout is available; see Appearance (see page 467).
The smartcard middlewares Coolkey, Gemalto Safenet and OpenSC are integrated; see 
Middleware (see page 660), Encryption (see page 344) and Smartcard (see page 175).
The VoIP client Ekiga is integrated; see VoIP Client (see page 394).
The OpenConnect VPN Client is integrated; see OpenConnect VPN (see page 594).
The XDMCP Client is integrated; see XDMCP for this Display (see page 203).
For the Parallels Client, USB Redirection is now available; see USB Redirection (see page 257).
For the Horizon Client, Fabulatech USB Redirection is now available; see Fabulatech USB 
Redirection (see page 170) .
For the Horizon Client, the virtualization pack for Skype for Business is now available; see Skype 
for Business (see page 177).

https://www.igel.com/software-downloads/igel-universal-management-suite/
https://www.igel.com/software-downloads/igel-universal-management-suite/
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IGEL Universal Desktop Firmware
IGEL thin clients comprise the latest hardware and an embedded operating system. Depending on the product, this 
operating system may be based on IGEL Linux or Microsoft Windows Embedded Standard.

The firmware included with every IGEL Universal Desktop product is multifunctional and contains a wide range of 
protocols allowing access to server-based services.

Management software: Universal Management Suite

For optimum management of your IGEL thin clients, the IGEL Universal Management Suite (UMS) is available on our 
download page2.

_____

Supported Formats and Codecs (see page 5)
IGEL Devices Supported by IGEL OS 10 (see page 6)

With the IGEL Universal Management Suite, you can configure thin clients in the same way as in the devices' 
local setup.



https://www.igel.com/software-downloads/igel-universal-management-suite/
https://www.igel.com/software-downloads/igel-universal-management-suite/
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Supported Formats and Codecs
As supplied, IGEL Linux supports the following multimedia formats and codecs:

Ogg/Vorbis
Ogg/Theora
WAV
FLAC

The following codecs can be added with the optional Multimedia Codec Pack3:

Supported formats: Supported codecs:

AVI

MPEG

ASF (restricted under Linux)

WMA

WMV (restricted under Linux)

MP3

OGG

MP3

AAC

WMA stereo

WMV 7/8/9

MPEG 1/2

MPEG4

H.264

AC3 is not licensed.

IGEL zero clients in the IZ range feature the Multimedia Codec Pack as standard.

https://www.igel.com/multimedia-codec-pack/
https://www.igel.com/multimedia-codec-pack/
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IGEL Devices Supported by IGEL OS 10

Core Requirements for IGEL OS 10
CPU with 64-bit support
Memory (RAM): 2 GB
Storage: 2 GB

IGEL Devices Supported by IGEL OS 10

IGEL UD (Universal Desktop)

Product 
Line

Device 
Type

Hardware 
ID

64 Bit Memor
y
(RAM)

Storage UEFI Secure 
Boot Support

HW Video 
Acceleration

UD2 D220 40 Yes 2 GB 4 GB Yes Yes

UD3 M340C 50 Yes 2 GB 4 GB Yes Yes

UD3 M340C 51 Yes 2 GB 4 GB Yes Yes

UD5 H830C 50 Yes 2 GB 4 GB Yes (BIOS/UEFI 
update may be 
necessary)

Yes

UD6 H830C 51 Yes 2 GB 4 GB Yes (BIOS/UEFI 
update may be 
necessary)

Yes

UD7 H850C 10 Yes 4 GB 4 GB Yes Yes

UD9 TC215B 40 / 41 
(Touch)

Yes 2 GB 4 GB Yes Yes

IGEL Zero

Product 
Line

Device 
Type

Hardware 
ID

64 Bit Memory
(RAM)

Storage UEFI Secure 
Boot Support

HW Video 
Acceleration

IZ2 D220 40 Yes 2 GB 4 GB Yes Yes

IZ3 M340C 50 Yes 2 GB 4 GB Yes Yes

IZ3 M340C 51 Yes 2 GB 4 GB Yes Yes
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Partial Support

Product 
Line

Device 
Type

Hardware 
ID

64 Bit Memory
(RAM)

Storage UEFI Secure 
Boot Support

HW Video 
Acceleration

UD3 M320C 40 Yes 2 GB (after 
upgrade)

2 GB No No

UD3 M330C 41 / 42 Yes 2 GB (after 
upgrade)

2 GB No No

UD5 H820C 40 Yes 2 GB (after 
upgrade)

2 GB No Yes

UD10 TC236 10 / 10 
(Touch)

Yes 2 GB (after 
upgrade)

2 GB No No

The following devices were supplied with 1 GB RAM; a RAM upgrade is therefore necessary.
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Setup Assistant
When you start an unconfigured thin client, you will be welcomed by the Setup Assistant application. This takes 
you through the most important initial configuration steps.

_____

Using the Setup Assistant Function (see page 9)
Language (see page 12)
Accept EULA (see page 13)
Keyboard Layout (see page 14)
Time Zone Continent/Area (see page 15)
Time and Date (see page 16)
Mobile Broadband (see page 17)
Wireless (see page 18)
Connectivity (see page 19)
ICG Agent Setup (see page 20)
Finish (see page 21)

•
•

•

The Setup Assistant starts automatically after booting IGEL OS if all of the following requirements are met:
The device is not yet configured.
No IP address for the Universal Management Suite (UMS) was transferred using the DHCP 
option 224.
No UMS can be accessed under the DNS name igelrmserver .
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Using the Setup Assistant Function
Setup assistant buttons:

Next: Go to the next configuration step

Back: Go back to the previous step
Cancel: Exit the setup sssistant without saving changes to the configuration. Changes to the time 
and date will however remain effective.

Language
Language: Select the language for the user interface.

Accept EULA

You must accept the EULA to continue with setting up and using your thin client.

 Click I agree to continue with the setup.

Keyboard Layout
Keyboard layout: Select the keyboard layout. The selected layout applies for all parts of the 
system including emulations, window sessions and X11 applications.

Time Zone Continent/Area
Timezone continent/area: Select the continent/area for your location.
Possible values:

General: Under Location, you can select a GMT time zone.

From IGEL Linux Version 10.03.100 the button is labeled Skip if the configuration step can 
be omitted; if you click on Skip, nothing will change during the current configuration step. 
If the configuration is edited, the button will switch to Next.



If the Activate your UD Pocket (UD Pocket Demo) or ICG Agent Setup configuration steps 
fail, change the network settings of your device:

 If you require a system-wide proxy, start the setup and configure the proxy settings under
Network > Proxy. You will find a description in the Proxy (Proxy (see page 617)) chapter of the 
manual.If you require WLAN/WiFi, set up Café Wireless (Wi-Fi) on your device. From IGEL Linux 
Version 10.03.100, WLAN setup is integrated into the Setup Assistant.



This step is part of the setup assistant from IGEL Linux 10.04.100 onwards.
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Africa ... Pacific: Under Location, you can select a city for the selected continent/area.
Location: Select your location or time zone.

Time and Date
Date: Select the current date.
Time: Set the current local time.
Apply: Sets the system clock according to what is entered above.

WLAN

This configuration step is available if a WLAN adapter was found when starting the device. The device will search for 
available WLAN access points as soon as the configuration step is opened. The WLAN access points found will be 
listed. You can then connect to your desired WLAN access point.

Wireless regulatory domain: In the first selection menu, select the world region (example: 
Europe) in which you are situated and in the second one the country (example: United Kingdom).

: Searches again for WLAN access points.
: Opens a dialog which allows you to enter the WLAN name (SSID) of a hidden WLAN access 

point.
(Name of a WLAN access point in the list): Click on your desired WLAN access point and enter your 
access data in the dialog.
Once the connection is established, the  symbol will be shown in the Connected column.

Activate Your UD Pocket

Location: Summer time adjustment is taken into account here. Example: If you select 
"Berlin", the device will switch between summer time and normal time in accordance with 
the German adjustment rules. Time zone: The GMT time zones specify by how many hours 
the time zone for a particular location differs from the Greenwich time zone. The 
preceding symbol is used in accordance with the POSIX format. Examples: For New York 
City, select "GMT+5" which means "5 hours west of Greenwich". For Moscow, select 
"GMT-3” which means "3 hours east of Greenwich".



This step is part of the setup assistant from IGEL Linux 10.03.100 onwards.

If you carry out the WLAN configuration and exit the Setup Assistant by selecting Finish, the connection 
will be saved and WLAN will be permanently enabled. If you skip this configuration step or cancel the 
configuration, WLAN will not be permanently enabled.



This step is part of the setup assistant from IGEL OS 10.03.500 onwards.



Setup Assistant

IGEL OS Reference Manual   11 / 710

1.
2.

•

When you start a UD Pocket Demo, you can obtain an evaluation license. With this evaluation license, all features of 
the UD Pocket are available for a period

Fill out all fields.
Activate the checkbox near I agree to the terms + conditions and privacy policy.

ICG Agent Setup
If your system administrator has given you access data for IGEL Cloud Gateway, you can connect the thin client to 
the gateway here.

You will find instructions for this under Using ICG Agent Setup (see page 515).

Otherwise, do not touch this page and click on Skip or Next.

Finish
Finish: Saves all settings and closes the Setup Assistant. If you have changed the language, the X11 
graphics system will restart; the screen will go black for a short time. If you have a UD Pocket 
Demo, a restart is required to finish the activation.
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Language
Language: Select the language for the user interface.
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Accept EULA
You must accept the EULA to continue with setting up and using your device.

 Click I agree to continue with the setup.
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Keyboard Layout
Keyboard layout: Select the keyboard layout. The selected layout applies for all parts of the system including 
emulations, window sessions and X11 applications.
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Time Zone Continent/Area
Timezone continent/area: Select the continent/area for your location.
Possible values:

General: Under Location, you can select a GMT time zone.
Africa ... Pacific: Under Location, you can select a city for the selected continent/area.

Location: Select your location or time zone.

Location: Summer time adjustment is taken into account here. Example: If you select "Berlin", the device 
will switch between summer time and normal time in accordance with the German adjustment rules. Time 
zone: The GMT time zones specify by how many hours the time zone for a particular location differs from 
the Greenwich time zone. The preceding symbol is used in accordance with the POSIX format. Examples: 
For New York City, select "GMT+5" which means "5 hours west of Greenwich". For Moscow, select "GMT-3” 
which means "3 hours east of Greenwich".





Setup Assistant

IGEL OS Reference Manual   16 / 710

Time and Date
Date: Select the current date.

Time: Set the current local time.

Apply: Sets the system clock according to what is entered above.
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Mobile Broadband
In the basic mode (default), you can make the following settings:

Country: The country of your provider.

Provider: Provider (the possible options depend on what you choose for Country)

APN/Plan: APN/Plan (the possible options depend on what you choose for Provider)

For more configuration options, click the Expert Mode button.

In the expert mode, you can make the following settings:

Enabled: Determines if the settings made in the expert mode are used. (Default: Enabled)
APN: APN (Access Point Name) for your network connection. If you do not know the APN, ask your 
mobile communications operator for it.
Network ID: Network ID for your network connection. If you do not know the network ID, ask your 
mobile communications operator for it.
Number: Access number for your network connection. If you do not know the access number, ask 
your mobile communications operator for it.
User name: User name for your network connection. If you do not know the user name, ask your 
mobile communications operator for it.
Password: Password for your network connection. If you do not know the password, ask your 
mobile communications operator for it.
PIN: PIN for the SIM card used.
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Wireless
This configuration step is available if a WLAN adapter was found when starting the device. The device will search for 
available WLAN access points as soon as the configuration step is opened. The WLAN access points found will be 
listed. You can then connect to your desired WLAN access point.

Wireless regulatory domain: In the first selection menu, select the world region (example: Europe) in which you 
are situated and in the second one the country (example: United Kingdom).

: Searches again for WLAN access points.

: Opens a dialog which allows you to enter the WLAN name (SSID) of a hidden WLAN access point.

(Name of a WLAN access point in the list): Click on your desired WLAN access point and enter your access data in the 
dialog.

Once the connection is established, the   symbol will be shown in the Connected column.

If you carry out the WLAN configuration and exit the Setup Assistant by selecting Finish, the connection 
will be saved and WLAN will be permanently enabled. If you skip this configuration step or cancel the 
configuration, WLAN will not be permanently enabled.
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Connectivity
This page is shown if for any reason no network connectivity is available.

Follow the instructions on the screen.
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ICG Agent Setup
If your system administrator has given you access data for IGEL Cloud Gateway, you can connect the device to the 
gateway here.

You will find instructions for this under Using ICG Agent Setup (see page 515).

Otherwise, do not touch this page and click on Skip or Next.
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Finish
Finish: Saves all settings and closes the Setup Assistant. If you have changed the language, the X11 graphics system 
will restart; the screen will go black for a short time. If you have a UD Pocket Demo, a restart is required to finish the 
activation.
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Boot Procedure
The quick installation procedure is complete.

 Restart the system in order to start the boot procedure.

Boot Menu (see page 23)
Network Integration (see page 30)
X-Server (see page 31)
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Boot Menu
During the boot procedure, a boot menu is available on request. Via this menu, you can access system parameters 
or reset the thin client to the factory defaults if the thin client is configured incorrectly or you experience problems 
when booting.

 During the boot procedure, press the [Esc] key repeatedly in rapid succession in the Secondstage Loader when 
the Loading Kernel message is shown on the screen.
A menu with four boot options as well as an option for resetting the thin client to the default factory settings will 
appear:

Quiet boot: Normal start (default)
Verbose boot: Start with system messages and an interactive root shell
Emergency boot (setup only): Setup only
Failsafe boot with CRC check: Start with an integrity check of the operating system
Reset to factory defaults: Reset the client to factory defaults
Custom boot command: Boot with configurable command line options
VESA only Boot: Basic boot (not manufacutrer specific) 
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Quiet Boot
Quiet boot is the default boot mode. In this mode, all kernel messages are disabled and the graphical user interface 
is started.
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1.
2.
3.
4.
5.
6.

Verbose Boot
Unlike in Quiet boot mode, the boot messages are shown in Verbose boot mode. The boot procedure also pauses 
before the graphics system and the user session start.

This gives you an opportunity to open a root shell and interactively execute debugging commands (such as 
ifconfig etc.).

Proceed as follows:

Select Verbose boot from the boot menu.
Wait until the boot messages stop at Reached target IGEL Network Online .
Open a virtual console with the key combination [Ctrl ]+ [Alt ]+ [F11 ]or [Ctrl ]+ [Alt ]+ [F12].
Log in by pressing [Return ]and enter the root password if necessary.
Go through the desired individual commands.
Now enter the following command to continue the normal boot procedure:
systemctl default  

The graphical user session will start.

Use the root shell only if you have adequate knowledge of Linux or if you are instructed to do so by the 
IGEL Helpdesk and are given appropriate guidance. Incorrect use can destroy the operating system.
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Emergency Boot
During an Emergency Boot, the thin client is started without network drivers and with a resolution of 640 x 480 - 60 
Hz. The setup is then opened directly.

This option is useful if, for example, you have selected an excessively high screen resolution or a wrong mouse type 
and these settings can no longer be changed in the normal setup.

 Close the setup window to shut down the system or restart it.
Unlike with a reset, the setup will open with the actual settings.
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Failsafe Boot - CRC Check
During a Failsafe boot, a check of the file system is carried out first. The thin client then starts in Verbose mode.

This option is helpful if you no longer have a bootable system after a firmware update. The Failsafe boot checks 
where the problem is. If need be, an old version will be booted and you will need to repeat the firmware update.



Boot Procedure
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1.
2.

1.
2.
3.

4.
5.

Reset to Factory Defaults

Do you know the password?

Confirm the warning message.
Enter the password. You have three attempts.

Do you not know the password?

Confirm the warning message.
When you are prompted to enter the password, press the Enter key three times.
Press [c].
The Terminal Key will appear.
Contact us using license@igel.com4.
Enter the Terminal Key shown, the firmware version, and your contact details.
IGEL will send you a so-called Reset to Factory Defaults Key specially for your device. To ensure 
that the process is as straightforward and yet as secure as possible, each key is valid for just one 
device.
See also Resetting a Device with Unknown Administrator Password.

If you select Reset to factory defaults, all personal settings on the thin client (including your password 
and the sessions you have configured) will be lost.



A warning message will appear on the screen before the procedure is carried out. If the device is protected 
by an administrator password, you will be prompted to enter this password.



You can also reset your device to factory defaults in the UMS Console under Devices > Other commands 
> Reset to Factory Defaults, see Devices. 



mailto:license@igel.com
mailto:license@igel.com
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1.
2.

3.

4.

Custom Boot Command
If you select Custom boot command, preconfigured options will be placed on the kernel command line. This allows 
you for example to investigate and rectify problems with specific hardware components.

To configure the options for the Custom boot command, proceed as follows:

Open a local terminal and log in as root .
Enter the following command to bring up the current options:
bootreg get /dev/igfdisk boot_cmd

Save your desired options with the following command:
bootreg set /dev/igfdisk boot_cmd "<Your Options>"

Check the options that you have entered:
bootreg get /dev/igfdisk boot_cmd

The Custom boot command is merely a temporary solution – it is not an everyday booting method. It must 
therefore be selected manually in the boot menu.



If you would like to delete options for the Custom boot command, leave an empty string of 
characters in their place: bootreg set /dev/igfdisk boot_cmd ""
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Network Integration
Once the kernel has been loaded, the network can be configured.

There are three possible ways of integrating the terminal into the network environment.

Depending on the terminal settings, choose between

DHCP,
BOOTP,
manually configured IP address.

The network interface can be stopped and restarted on the Linux Console (accessible via 
[Ctrl]+[Alt]+[F11]) with this command:  /etc/init.d/network stop   /etc/

init.d/network start
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X-Server
The final step in the boot procedure involves starting the X-Server and the local windowmanager.
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The IGEL Linux Desktop
You can operate the thin client via the taskbar and the IGEL menu.

The following items can be found in the taskbar at the bottom of the screen:

Opens the IGEL menu.

Quick Start Panel

Application Launcher: Opens a dialog window with 
start symbols for sessions.

Setup: Opens the IGEL setup.

 
Symbol for sessions: Launches a session.

Window bar

Window buttons Allows you to switch between open windows.

System tray
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•

CPU power plan: Changes the power saving 
settings.

Volume control

Allows you to remove a USB stick safely

Local network connection

Time / date

Show Desktop

The IGEL menu offers the following areas and functions:

Sessions: Allows you to launch sessions
System: Allows you to launch system programs
About: Shows all relevant system information
Search window: Allows you to find sessions and functions in the start menu

 Allows you to shut down the thin client

 Allows you to restart the thin client
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Application Launcher
To launch the Application Launcher, proceed as follows:

 Click on  in the Quick Start Panel or in the start menu.

The sub-areas of the Launcher provide access to:

Listing of the sessions (see page 36) that have been set up
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Listing of the most important tools (see page 37)

License declarations (see page 38) for the components used

The About Window (see page 39) with information about the system

Restart

Shut down

Search field for fast access to the components

You will find information regarding the configuration here Application Launcher (see page 437).
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Sessions
All sessions created are shown in a list of applications if they are enabled for the main session page.

 To open an application, double-click on it or click on  Run. 
Alternatively, you can launch sessions via icons on the desktop, in the quick launch bar or from the Start menu and 
context menu. 
Applications can also be launched automatically and a key combination (hotkey) can be defined. 
It is also possible, to build a file structure for the sessions in the application launcher. Therefor, in the setup page 
Desktop Integration of the relevant application you have to define a folder in the application launcher.

The available options for launching a session can be defined under Desktop Integration in the session 
configuration.
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•

System

Under System , you can execute various tools including the firmware updating tool with the pre-set update 
information.

The following tools are available:

Identify Monitors: Shows the screen's number and manufacturer details.
Screenshot Tool: Takes photos of the screen content.
Bluetooth Tool: Starts the Bluetooth tool.
Firmware Update: Carries out the update with the settings made during the setup.
Savely Remove Hardware: Removes external storage devices without a risk of losing data.
Disk Utility: Shows information regarding connected USB drives.
Network Tools: Provides detailed information on the network connection and offers a number of 
problem analysis tools such as Ping or Traceroute.
Setup: Launches the IGEL Setup.
System Information: Shows information regarding hardware, the network and connected 
devices.
System Log Viewer: Shows system log files "live" and allows you to add your own logs.
Task Manager: Manages all processes.
Touchscreen Calibration: Allows a connected touchscreen monitor to be calibrated.
UMS Registration: Logs the thin client on to a UMS server (access data for the server are required).
Webcam Information: Shows data relating to a connected webcam and allows the camera to be 
tested.
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•

License

Under License  you will find the following:

The licenses for the components used in the UD system
Information on the provision of source code, e.g. under GPL
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•
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•

About Window
In the About window, accessible via the  icon, you will find the following data:

Product: Information regarding the installed firmware
Copyright
Firmware Version
Product ID
Product Name
Website

Network: Computer name, hardware address and IP address of the thin client
Local Name
Standard Gateway (only with valid network connection)
DNS Server (only with valid network connection)
Universal Management Suite

Interface [number name]:
Description
Hardware Address
IP Address

Hardware:
Boot Mode
CPU Model
Device Type
Flash Size
Graphic Chipset
Memory Size
Total Operating Time
Unid ID (equal to MAC address (UD, UDC) or serial number (UD Pocket))

Licensed Features: List with all firmware features for which a license is available

If the network status changes, the details will automatically be updated. To force an 

update, click on .


You can copy individual entries via the context menu (right mouse button).
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Restart and Shutdown

Within the Application Launcher you will find two buttons for  rebooting or  shutting down the 
device. Both actions can be disabled for the user and will then be available to the administrator only.

You can change the default action when shutting down the device using the button on the screen or the on/off 
button on the device itself in the setup under System > Power Options > Shutdown.
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Setup
With the help of the setup, you can change the system configuration and session settings.

_____

Starting the Setup (see page 42)
End the Setup (see page 43)
Setup Areas (see page 44)
Quick Setup (see page 45)
Setup Search (see page 46)

Any changes you have made in the UMS take precedence and may no longer be able to be changed. A lock 
symbol before a setting indicates that it cannot be changed.





Setup

IGEL OS Reference Manual   42 / 710

•
•

•

•

•

•
•

Starting the Setup
You can open the setup in the following ways:

Double-click  in the Application Launcher
or click on Run.

Double-click  on the desktop (if available based on the settings).

Select  Setup in the desktop context menu (if available based on the settings).

Select System >  Setup in the start menu.

Click on  in the Quick Start Panel.
Launch the setup using the keyboard command [Ctrl]+[Alt]+[s], or 
in the Appliance Mode using [Ctrl]+[Alt]+[F2].

You can configure how the setup can be launched under Accessories. The options 
described above as well as combinations thereof are available.
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End the Setup
In order to end the setup again, you have the following options:

 Click on Apply if you have finished configuring a setup area and would like to save your settings without closing 
the setup program.

 Click on Cancel if you have not made any changes and would like to abort the setup.

 Click on OK to save your changes and exit the setup.
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Setup Areas
The setup application comprises the following main areas:

Sessions: Allows you to configure application sessions such as ICA, RDP, PowerTerm, browser and 
others
Accessories: Allows you to configure various local tools - setup pages for the local shell (Terminal), 
sound mixer, screen keyboard (for touchscreen monitors), options for the Application Launcher
and the setup application itself.
User Interface: Allows you to configure display settings, entry devices, hotkey commands etc.
Network: Allows you to configure all network settings for LAN/WLAN interfaces and the dial-up 
connections
Devices: Allows you to configure various devices
Security: Allows you to set the administrator/user passwords and user authorizations etc.
System: Allows you to set various basic system parameters including the date and time, 
information regarding the firmware update, remote management etc.

 Click on one of the areas to open up the relevant sub-structure.

The tree structure allows you to switch between the setup options.

Three navigation buttons are available. The buttons allow you to move back and forth between the setup pages you 
have visited or reach the next level up within the structure.

You will find a more detailed description of the individual setup options elsewhere. This is merely a brief overview.
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1.

2.

3.

Quick Setup
As administrator, you prepare the setup for the user. If you want to give the user the option of defining their own 
settings in certain areas of the setup, you can prepare a quick setup. A quick setup is a slimmed down version of the 
setup. It only displays areas the user is allowed to change.

To create a quick setup session, proceed as follows:

Enable the password for the administrator in IGEL Setup under Security > Password. (see page 644)

Under Accessories > Quick Setup (see page 424), define the name and options for calling up the quick 
setup.
Under Accessories > Quick Setup > Setup User Permissions (see page 426) enable those areas to 
which the user is to have access.

If users are to be allowed to edit parts of the setup only with a password, enable the 
password for the setup user too.



You can set up a hotkey to start quick setup in appliance mode. Instructions for setting up 
the hotkey can be found under Quick setup (see page 424).
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1.
2.
3.
4.

Setup Search
The Search function enables you to find parameter fields or parameter values within the setup.

To start a search, click on the button below the tree structure.
Enter the text to be searched for and the search details.
Select one of the hits.
Click on Show result and you will be taken to the relevant setup page. 
The parameter or value found will be highlighted as shown below.
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Sessions
Menu path: Sessions > Sessions Summary

In this area, you will find an overview of all available sessions.

Add: Adds a session from the selection of available session types.

Filter: Filters sessions shown in the list according to the string of characters entered.

Copy Session (see page 48)
Global Session Options (see page 49)
Citrix XenDesktop/XenApp (see page 50)
RDP Global (see page 108)
RDP Session (see page 134)
Remote Desktop Web Access (see page 149)
Horizon Client Global (see page 163)
Horizon Client Session (see page 178)
Appliance Mode (see page 192)
Caradigm (see page 204)
Leostream (see page 210)
AppliDis (see page 217)
Evidian AuthMgr (see page 223)
NoMachine NX Client (see page 233)
Parallels Client Global (see page 255)
Parallels Client Session (see page 261)
PowerTerm Selection (see page 275)
PowerTerm Session (see page 276)
IBM iAccess Client (see page 279)
ThinLinc Global (see page 293)
ThinLinc Session (see page 300)
SSH Session (see page 312)
VNC Viewer Sessions (see page 320)
Browser Global (see page 330)
Browser Session (see page 349)
Media Player Global (see page 375)
Media Player Session (see page 382)
Java Session (see page 390)
VoIP Client (see page 394)
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2.
3.

Copy Session
You can copy a session in the setup. The copy of the session has all the properties of the original session and is 
located in the same folder as the original session.

To copy a session, proceed as follows:
In the setup, open the menu path Sessions > [Session Type] > [Session Type] Sessions.
Example: Sessions > RDP > RDP Sessions 
The existing sessions are shown.
Highlight the session that you want to copy.
In the [Session Type] Sessions area, click . Alternative: Open the context menu of the session 
by right-click and select Copy.
A copy of the session will be created.



Sessions

IGEL OS Reference Manual   49 / 710

•

•

•
•

•

•

Global Session Options
Menu path: Setup > Sessions > Global Session Options

Network notification on session start: If when launching sessions no network is available, a 
notification will be shown.
☑ Network notification is enabled (default)
☐ Network notification is disabled
Notification delay: Time in seconds after which the notification is shown. (default: 15)
Possible values:

1 ... 120 seconds
Delay session start at boot time to apply new UMS settings: If new settings were made in the 
UMS, the thin client may receive them during the boot procedure.
☑ The session start will be delayed until the settings have been transferred or the time limit has 
been exceeded.
Timeout: Delay in seconds. (default: 10)
Possible values:

1 ... 120 seconds
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Citrix XenDesktop/XenApp
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp

Citrix Receiver Selection (see page 51)
HDX / ICA Global (see page 52)
Legacy ICA Sessions (see page 78)
Citrix StoreFront/Web Interface (see page 88)
Citrix Self-Service (see page 102)
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Citrix Receiver Selection
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Receiver Selection

Select which of the installed Citrix Receiver versions is to be used for Citrix sessions.

Citrix Receiver version

Default (13.8.0)
13.3.2
13.4.2
13.7.0
13.8.0
The Citrix Receiver 12/13 Feature Matrix FAQ provides an overview of the features offered by the 
various versions.

•
•

After changing the Citrix Receiver version, check the settings under:
Citrix > Citrix StoreFront / Web Interface > Server
Citrix > Citrix StoreFront / Web Interface > Logon
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HDX / ICA Global
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global

This section describes global Citrix settings which apply for all Citrix sessions. Most of these settings can be either 
carried over or overwritten in the individual sessions.

Users can only change an expired password if this option is enabled on the Citrix server too. See Citrix: Changing 
Password Issue.

Server Location (see page 53)
Local Logon (see page 54)
Window (see page 55)
Keyboard (see page 56)
Mapping (see page 57)
Firewall (see page 65)
Options (see page 66)
Native USB Redirection (see page 68)
Fabulatech USB Redirection (see page 70)
HDX Multimedia (see page 73)
Codec (see page 74)
Unified Communications (see page 76)

Please note that a number of configuration options depend on the version of the Citrix Receiver selected. A 
comparison of functions can be found in the FAQs: Citrix Receiver 12/13 Feature Matrix .
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Server Location
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Server Location

Here, you can specify one or more HTTP Master Browsers. These provide a list of all Citrix servers and all published 
applications which are accessible via the network and use the selected browsing protocol.

To manage the list of master browser, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

You can specify a separate address list for each network protocol. This can be TCP/IP, TCP/IP + HTTP or SSL/TLS + 
HTTPS.

TCP/IP: If your network configuration uses routers or gateways, or if additional network traffic 
owing to transmissions is to be avoided, you can specify special server addresses for the Citrix
servers from which the list of available servers and/or published applications is to be requested.

TCP/IP + HTTP - You can also call up information from the available Citrix servers and published 
applications via a firewall. To do this, you use the protocol TCP/IP + HTTP as the server location.

SSL/TLS + HTTPS: Secure Sockets Layer (SSL) and Transport Layer Security (TLS) offer server 
authentication and data stream encryption. They also allow you to check the integrity of 
messages.

You can add a number of addresses to the address list so that the clients can establish a 
connection and function even if one or more servers are not available.



The "TCP/IP + HTTP" server location supports the auto-locate function.

If you try to establish a non-SSL/TLS connection to an SSL/TLS server, you will not be 
connected. A Connection Failed message will be shown.
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Local Logon
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Local Logon

In this area, you can specify settings for logging on to the ICA client.

Use Kerberos passthrough authentication in all ICA sessions (default: disabled)
☑ Single sign-on for all ICA sessions if Log on to the thin client with AD/Kerberos is configured.

Use local login window:
☑ The user must enter the password again when logging on.
☐ The local logon window will not be used. (default)
Relaunch mode:
☑ The logon module is automatically restarted after being closed.
☐ The logon module will not automatically restart. (default)
Type:

Carry over user/domain from last logon
Carry over user/domain from session setup

Preset login information:
☑ The logon window is prepopulated with the user name and domain. (default)
Show domain:
☑ Shows the domain entry in the logon window. (default)
Set client name to user name
☑ Sets the name of the client of the ICA connection as the user name. (default)

Enable smartcard logon
☑ Logging on with a smartcard is allowed. (default)

Domains: One or more domains which are to be available. If you enter a number of domains, these 
will be shown in the Domains drop-down area in the login module.
Click  to create a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.
Click  to copy the selected entry.

The server too must be configured for passthrough authentication. When launching ICA 
sessions, it is then no longer necessary to enter a user name and password again as the 
local logon data (domain logon) are transferred for session logon purposes.



This setting may help to resolve reconnection problems during load balancing.

Only specific smartcard types are supported. You will find a list of compatible types in the 
Smartcard sub-section of the setup.
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Window
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Window

Under Window, you can configure the following settings:

Only for Legacy ICA sessions

Default Number of Colors: Specifies the default color depth.
Possible values:

16
256
32 Thousand
16 million
Automatic

Approximate Colors: Given the differences between the color palettes used by the ICA client and 
the thin client desktop, the screen may flash annoyingly if you switch between windows on a 
pseudo-color screen. The ICA client's color adaptation scheme prevents this flashing as it uses the 
colors from the local desktop palette in order to display the ICA window session.
☑ Flashing when switching between windows is avoided.
☐ Disabled (Default)
Default window width: Specifies the window width in pixels (default: 640).
Default window height: Specifies the window height in pixels (default: 480)
Font smoothing: Enables font smoothing - in the event of performance problems, font smoothing 
should be switched off as it requires additional computing power.

Off
Default
ClearType

For all Citrix sessions

Multi-monitor full-screen mode:
Restrict full-screen session to one monitor
Extend full-screen session to all monitors

XenApp/StoreFront start monitor: Select the monitor on which the session is to start.
1st Monitor
2nd Monitor

Embed systray icons in taskbar: Inserts an application icon into the local taskbar.
On
Off

Control bar for Citrix sessions:
☑ Shows a control bar for minimizing and closing a Citrix full-screen session.
☐ Disabled (default)
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Keyboard
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Keyboard

On the Keyboard page, you can define alternative key combinations for hotkeys commonly used during ICA 
sessions. In Windows for example, the key combination [Alt]+[F4] closes the current window. This key combination 
works in ICA sessions too. All key combinations with [Alt] which are not used by the X Window Manager function in 
the familiar way during an ICA session.

The following settings can be configured:

Keyboard Layout
Default: The local keyboard setting will be used in ICA too.
Other Countries

Input language:
Default: The local keyboard setting will be used in ICA too.
Other Countries

Mapping Ctrl+Alt+End to Ctrl+Alt+Del for Citrix sessions
☑ The user can use the combination [Ctrl]+[Alt]+[End ]to change the password instead of [Ctrl]+
[Alt]+[Del ]when the corresponding prompt message appears.
☐ No mapping (default)
Keyboard Mapping File: You can choose between two alternatives.

Generic: Sends language-independent scancodes from the keyboard to the computer.
Linux: Sends language-specific scancodes.

The key alternatives are restricted to [Ctrl]+[Shift]+[Key] by default. However, you can change the 
settings by clicking on the Hotkey Modifier drop-down field and/or hotkey symbol for the relevant 
key combination.

Possible keys: [F1] – [F12] , [Plus], [Minus], [Tab]
Possible modifiers: [Shift], [Ctrl], [Alt], [Alt]+[Ctrl], [Alt]+[Shift], [Ctrl]+[Shift]
Toggle SpeedScreen: Key combination for switching SpeedScreen (client reacts 
immediately to keyboard inputs or mouse clicks) on and off alternately.



Sessions

IGEL OS Reference Manual   57 / 710

•
•
•
•

Mapping
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping

Locally connected devices such as printers or USB storage devices can be made available in ICA sessions.

__________

Drive Mapping (Citrix) (see page 58)
COM Ports (see page 60)
Printer for ICA (see page 62)
Device Support (see page 63)
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Drive Mapping (Citrix)

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Drive Mapping

Through drive mapping, each directory mounted on the thin client (including CD-ROMs and disk drives) is made 
available to you during ICA sessions on Citrix servers.

In this area, you can specify which drives and paths are mapped during the logon. This applies for all ICA sessions.

Activate drive mapping:
☑ Citrix servers can access the thin client's local drives. (default)

To manage the Drive Mapping list, proceed as follows:

 Click on  to create a new entry.

 Click on  to remove the selected entry.

 Click on  to edit the selected entry.

 Click on  to copy the selected entry.

Add Drive Mapping

Enable:
☑ The drive will be made available in the session.
Drive to map: DOS-style drive letters on the Citrix Server.

Local (USB) devices which are to be used for drive mapping purposes must first be set up as storage 
devices (see page 636).



•
•

•

Before you unplug a hotplug storage device from the thin client, you must safely remove it. Otherwise, 
data on the hotplug storage device can be damaged. Depending on the configuration, there is one or 
several possibilities to safely remove a hotplug storage device:

Click on  in the task bar. The taskbar is not available in a fullscreen session.
Click on in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a fullscreen session. For further information, see In-session 
Control Bar (see page 538).
Function Accessories > Disk Removal (see page 494) with further starting possibilities; 
amongst other things, a hotkey can be defined here.
If the following warning is displayed: Volume(s) still in use. Dont' remove the device., 
then the hotplug storage device must not be removed. First, exit the program concerned 
or close all files or directories that reside on the hotplug storage device.
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Local Drive Path: Unix path name of the local directory to which the mapping is to refer.

Read Access
Possible options:

yes
no
ask user: The read access right is queried when each ICA session is accessed for the first 
time.

Write Access
Possible options:

yes
no
ask user: The write access right is queried when each ICA session is accessed for the first 
time.

If the drive letter you have selected is no longer available on the Citrix server, the specified 
directory or local drive will be given the next free letter during the logon.



If you map a locally connected device, use the pre-defined path names available in the 
drop-down field.
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COM Ports

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > COM Ports

Enable COM port mapping
☑ Enables the mapping of serial devices connected to the thin client to the serial interfaces of the 
Citrix server. (Default)

To manage the list of COM Port Devices, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

Add

COM Port Device: Allows you to select from all serial and USB interfaces on the thin client.
Possible values:

COM 1
COM 2
COM 3
COM 4
USB COM 1
USB COM 2
USB COM 3
USB COM 4

Detect devices...: Opens a dialog allowing you to select the device file. 3 device files are available 
for each device; the Description column shows the type of device file:

(GENERIC) [device designation]: Generic type. The name of the device file ends in a 
consecutive number which depends on the boot procedure or the order of insertion. 
Example: /dev/ttyUSB0

(BY PORT) [device designation]: According to USB port. The device file is in the /dev/

usbserial/  directory. The name of the device file ends in the number of the USB port 

that the device is plugged into. Example: /dev/usbserial/ttyUSB_P12

(BY USBID) [device designation]: According to USB ID. The device file is in the /dev/

usbserial/  directory. The name of the device file ends as follows: _V[Vendor 

ID]_P[Product ID] . Example: /dev/usbserial/ttyUSB_V067b_P2303

If you would like to use signature pads, you must enable them beforehand under User 
Interface > Input > Signature Pad (see page 556).
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• (Virtual) [device designation]: Virtual device; used for signature pads for example. Example: 
/dev/ttyVST0

If your device has an additional multiport PCI card, more than 2 connections may be 
available.
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Printer for ICA

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Printers

You can set up a printer for ICA sessions here.

Enable Client Printer Mapping: With this function, the locally connected thin client printer is 
made available for your ICA sessions, provided that it was not disabled on the server side.
Set another default printer:
☑ Allows you to specify a default printer for the client which differs from the one defined in the 
printer setup.
☐ Do not set another default printer. (default)
Default Printer: Print queues used on the thin client to specify the default printer for the session. 
lp  is the locally configured default printer.

Default Printer Driver: Windows driver name for the printer which is automatically set up. Enter 
one of the universal drivers or your own driver name here. 
Possible values:

Metaframe XP PS universal driver
Metaframe XP PCL5c universal driver
Metaframe XP PCL4 universal driver
Citrix PCL4 universal driver (old)
User entry

Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the server.

The printers must be set up on the Devices > Printers > CUPS > Printers page and must 
be enabled there for mapping in ICA sessions, see ICA sessions.
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Device Support

Menu path: Setup > Sessions > Citrix XenDesktop / XenApp > HDX/ICA Global > Mapping > Device Support

In this area, you can enable virtual ICA channels for communicating with various devices connected to the thin 
client.

The devices supported are listed in the IGEL Third Party Hardware Database5.

DriveLock channel: The virtual DriveLock channel is implemented on the thin client. The channel 
must also be installed on the Citrix XenApp server.
DriveLock can read hardware data from local USB devices and transfer these data to the XenApp 
server with the help of the Virtual ICA Channel Extension. From IGEL Linux Version 10.03.500 this is 
also possible with SATA devices. When using whitelists, rules based on the hardware properties of 
the connected drive (e.g. manufacturer details, model and serial number) are taken into account.
Important information regarding DriveLock can be found in the FAQ Using DriveLock with IGEL 
Thin Clients.
☑ A virtual channel for DriveLock is enabled.
☐ No virtual channel for DriveLock is enabled. (Default)
deviceTRUST channel
☑ A virtual channel for deviceTRUST is enabled.
☐ No virtual channel for deviceTRUST is enabled. (Default)
Diktamen Channel for Dictation
☑ A virtual channel for Diktamen is enabled.
☐ No virtual channel for Diktamen is enabled. (Default)
Grundig MMC-Kanal for dictation with Grundig devices
☑ A virtual channel for communication with Grundig devices is enabled.
☐ No virtual channel for communication with Grundig devices is enabled. (Default)
Nuance channel for dictation: Virtual audio channel for dictation devices. Dictation microphones 
from Grundig, Philips and Olympus are supported.

☑ The Nuance audio channel is enabled.
☐ The Nuance audio channel is not enabled. (Default)
Olycom Channel for Dictation with Olympus Devices
☑ A virtual channel for communication with Olympus devices is enabled.
☐ No virtual channel for communication with Olympus devices is enabled. (Default)
signotec signature pad channel
☑ A virtual channel for communication with signotec signature pads is enabled.
☐ No virtual channel for communication with signotec signature pads is enabled. (Default)
StepOver signature pad channel
☑ A virtual channel for communication with StepOver signature pads is enabled.
☐ No virtual channel for communication with StepOver signature pads is enabled. (Default)
Philips speech channel for dictation

This channel is only responsible for audio transmission. The channel for dictation device 
operating elements is manufacturer-specific and must be enabled separately.



https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
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☑ A virtual channel for communication with Philips dictation devices is enabled.
☐ No virtual channel for communication with Philips dictation devices is enabled. (Default)
DPM server drive: Via this drive, the Philips PocketMemo dictation device makes the voice 
recordings available to the server. (Default: P)

SpeechAir server drive: Via this drive, the Philips SpeechAir dictation device makes the voice 
recordings available to the server. (Default: S)

The dictation device is automatically assigned to the selected drive letter. Ensure that no 
other Hotplug storage device is assigned to this drive letter. Further information can be 
found under Hotplug storage device (see page 636) and Drive mapping (see page 58).



The dictation device is automatically assigned to the selected drive letter. Ensure that no 
other Hotplug storage device is assigned to this drive letter. Further information can be 
found under Hotplug storage device (see page 636) and Drive mapping (see page 58).
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Firewall
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Firewall

In this area, you can configure the following firewall settings:

Use Alternative Address:
☑ Allows you to use a proxy or Secure Gateway server as an alternative address for connections 
via a firewall.
☐ Do not use an alternative address (default)

SOCKS / Secure Proxy

Proxy Type
None (Direct Connection)
SOCKS: A proxy that uses the SOCKS protocol
Secure (HTTPS): An HTTP proxy with TLS/SSL encryption.

Proxy Server: Name or IP address of the proxy server
Proxy Port: TCP port of the proxy server (default: 1080)

Secure Gateway (relay mode)

Secure Gateway address: If you would like to use a Citrix Secure Gateway in relay mode, you must 
give the full DNS name – the IP address is not sufficient in this case.
Port: TCP port of the gateway (default: 443)

After enabling the alternative address, add the server to the address list under Sessions > 
Citrix XenDesktop/XenApp > HDX/ICA Global > Server Location.
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Options
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Options

In this area, you can set up additional options to optimize the system's general behavior and its performance.

Use Server Redraw:
☑ The Citrix server is responsible for refreshing the screen content.
☐ Do not use server redraw (default)
Disable Windows Alert Sounds
☑ Switches off the Windows warning sounds.
☐ The warning sounds remain enabled. (default)
Allow Backing Store
☑ The X Server temporarily stores hidden window content.
☐ Window content is not stored. (default)
Deferred screen update mode
☑ Enables delayed updates from the local video buffer on the screen. The local video buffer is 
used if the seamless Windows mode or HDX latency reduction is used.
☐ No delayed update (default)
Cache Size in kB: (default: 1024)
Minimum Bitmap Size in Bytes: The minimum size of the bitmap files that are to be stored in the 
cache (default: 1024).
Persistent Cache Path: The directory where the files are to be stored locally. (default: $ICAROOT/
cache)

Scrolling control: Depending on the speed of your network or the response time of your server, 
there may be a delay between you letting go of the mouse button on a scroll bar and the scrolling 
actually stopping (e.g. when using Excel). Changing this value may help (default: 100)
Audio Bandwidth Limit in StoreFront sessions

High
Medium
Low

Enable Auto Reconnect
☑ Automatically attempt to reconnect if connection is terminated (default)
☐ Do not attempt to reconnect.
Maximum Retries: (default: 3)
Delay in seconds before reconnecting: (default: 30)
Allow Kerberos passthrough authentication in StoreFront sessions
☑ Kerberos passthrough authentication is allowed. (default)

Do not make the cache too big otherwise you run the risk of the thin client having too little 
storage space for its own system and other applications. You may have no alternative but 
to equip your thin client with additional RAM.



Higher quality requires more network and computing resources.
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☐ Kerberos passthrough authentication is not allowed.

CGP Address
Use server address
Text input
disabled

Multi-Stream ICA
☑ Support Multi-Stream ICA (Citrix Receiver 13.5 or newer) 
☐ Do not support Multi-Stream ICA. (default)

This point concerns Citrix XenApp in Version 6.5 and older.
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Native USB Redirection
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Native USB Redirection

USB devices can be permitted or prohibited during a Citrix session on the basis of rules. Sub-rules for specific 
devices or device classes are also possible. The use of rules is described under USB Access Control (see page 640).

Enable native USB redirection
☑ Native USB redirection is enabled globally (default: disabled)

Default rule: This rule will apply if no special rule was configured for a class or a device.
Deny
Allow

Class Rules

Class rules apply to USB device classes and sub-classes.

To manage rules, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

Add class rule:

Rule:
Allow
Deny

Class ID: Selection list
Sub-class ID: Selection list
Name: Free text entry

Device Rules

Device rules apply to specific USB devices.

Enable either native USB redirection or Fabulatech USB redirection, but not both 
together.



Disable USB redirection if you use DriveLock. Further information can be found in the 
Using DriveLock with IGEL Devices FAQ.
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Add device rule:

Rule:
Allow
Deny

Vendor ID: Hexadecimal manufacturer number
Product ID: Hexadecimal device number
Name. Text input
Name: Free text entry
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Fabulatech USB Redirection
Menu path: Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Fabulatech USB Redirection

Redirection for USB devices can be allowed or denied during a Citrix session on the basis of rules. Sub-rules for 
specific devices or device classes are also possible. The use of rules is described under USB Access Control (see page 
640).

Fabulatech USB Redirection

☑ Fabulatech USB redirection is enabled for all Citrix sessions.

Default rule: This rule will apply if no special rule was configured for a class or a device.

Deny
Allow

Class Rules

Class rules apply to USB device classes and sub-classes.

Managing rules:

 Create a new entry

 Remove the selected entry

 Edit the selected entry

 Copy the selected entry

Class rule properties:

Rule:

Allow: Devices that have the properties defined here are redirected by the Fabulatech USB 
redirection.
Deny: Devices that have the properties defined here are not redirected.

Class ID: Device class

Subclass ID: Subclass relating to the specified device class

For the Fabulatech USB redirection, a server-side component is required. We recommend the USB for 
Remote Desktop IGEL Edition; see http://www.usb-over-network.com/partners/igel/.



Enable either native or Fabulatech USB redirection – not both together. Disable USB redirection if you use 
DriveLock.



Ensure that no other Hotplug storage device (USB stick) is connected if a session is started with Fabulatech 
USB redirection. Otherwise, the hotplug storage device will not be securely removed when the session 
starts, and this could lead to data loss. With IGEL Linux Version 10.02.x the Hotplug storage device is 
already insecurely removed when the Fabulatech USB redirection is enabled.



http://www.usb-over-network.com/partners/igel/
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Name: Free text entry

Override serial: Serial number that will appear in the session

Override name: Device name that will appear in the session

Postpone

☑ The USB device is only removed from the system (thin client) when the session starts.

☐ The USB device is no longer shown immediately after the system is booted. (Default)

Takeaway

☑ The USB device may be removed from the system (thin client).

☐ The device may not be removed. (Default)

No Reset

☑ The device will not be automatically reset after the connection with the session has been terminated.

☐ The device will be reset after the connection with the session has been terminated. (Default)

Device Rules

A device rule applies to a specific device that is identified by its serial number.

Device rule settings:

Rule:

Allow
Deny

Vendor ID: Hexadecimal manufacturer number

Product ID: Hexadecimal device number

Name: Free text entry

Override serial: Serial number that will appear in the session.

Override name: Device name that will appear in the session.

Postpone

☑ The USB device is only removed from the system (thin client) when the session starts. (Default)

☐ The USB device is no longer shown immediately after the system is booted.

Takeaway

☑ The USB device may be removed from the system (thin client). (Default)

☐ The device may not be removed.

This setting is only effective if the Takeaway parameter is enabled.

This setting is only effective if the Takeaway parameter is enabled.
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No Reset

☑ The device will not be automatically reset after the connection with the session has been terminated. (Default)

☐ The device will be reset after the connection with the session has been terminated.
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HDX Multimedia
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > HDX Multimedia

HDX multimedia redirection improves the playback of audio and video content during a Citrix session.

Hardware acceleration for multimedia playback is available on specific devices. Further information can be found in 
the Hardware Video Acceleration on IGEL OSFAQ.

Enable multimedia redirection
☑ Multimedia data are sent to the thin client and decoded there
☐ Multimedia data are decoded on the server. (default)
HDX Realtime WebCam Redirection
☑ Redirection is enabled
The following webcam parameters can be adjusted (for information on how to determine the 
capabilities of the webcam, see Using Webcam Information): 

HDX WebCam FrameRate (default: 5)
Image quality of the HDX webcam (default: 16)
Image width of the HDX webcam (default: 352)
Image height of the HDX webcam (default: 288)
HDX webcam delay time (default: 2000)
HDX webcam delay type (default: 1)

☐ Redirection is not enabled (default)
Use HDX RealTime Media Engine
☑ The HDX RealTime Media Engine significantly improves the performance of Lync / Skype for 
Business.
☐ The HDX RealTime Media Engine is not used. (default)
Enable content redirection
☑ Specific content types are opened with a local program, e.g. PDF documents with Evince.
☐ Content redirection is disabled. (default)
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Codec
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Codec

Graphical codec: Decoding method for the transferred screen content

Automatic: Automatically selects the appropriate codec according to the performance of the 
hardware.
H.264 Deep Compression Codec:

High image quality is possible, with lower network load
Without available hardware acceleration it is very CPU intensive.

JPEG: 
High image quality possible, with high network load
Moderate CPU load

Additional parameters for H.264 Deep Compression Codec

These parameters are relevant if Automatic or H.264 Deep Compression Codec is selected.

Accelerated H.264 Deep Compression Codec 
☑ Enables hardware-accelerated decoding with H.264, which reduces CPU load.
☐ Uses the software implementation of H.264 and results in a greater CPU load. (default)
For more information, read the Setting up Citrix Sessions with Hardware-Accelerated H.264 Deep 
Compression Codec How-To.

Following options are available in combination with H.264 Deep Compression Codec:

Text tracking:
☑ Loss-free depiction of texts (default)
Text is displayed sharper, especially if "Visual Quality" is set to Low/Medium. Recommended for 
office applications, but requires a higher available bandwidth. With bad connection and EDT over 
UDP it can lead to missing text parts.
Small frames feature:
☑ Pixel-perfect depiction of lines etc. (default)
This feature allows efficient processing when only a small part of the screen changes over time (for 
example, when a cursor flashes on an otherwise stable background).

•
•

•

•

At the Citrix Server following policies must be set:
Use video codec for compression must be enabled.
For the entire screen: Text tracking should be enabled if bandwidth is not a 
problem to increase readability in Office applications
For actively changing regions: Citrix Receiver 13.6+ required, otherwise 
JPEG fallback will be loaded
Use video codec when preferred: If For actively changing regions is 
selected by Citrix, a Citrix receiver 13.6+ must be activated, otherwise JPEG 
fallback is loaded.
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Additional parameters for JPEG

These parameters are relevant if JPEG is selected.

JPEG direct-to-screen decoding
☑ Decodes image tiles directly without using a bitmap cache.
☐ No JPEG direct-to-screen decoding (default)
JPEG batch decoding
☑ Enables batch processing and delayed XSync. (default)
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Unified Communications
Menu path: Sessions > Citrix  XenDesktop/Xen App > HDX / ICA Global > Unified Communications

Skype for Business (see page 77)
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Skype for Business

Menu path: Setup > Sessions > Citrix XenDesktop / XenApp > HDX / ICA Global > Unified Communications > 
Skype for Business

The HDX Realtime Media Engine is required for using Skype for Business in a HDX/ICA session.

HDX Realtime Media Engine

☑ The HDX Realtime Media Engine is active.

☐ The HDX Realtime Media Engine is not active. (Default)
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Legacy ICA Sessions
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions

You can set up your own ICA sessions here.

The global ICA session settings can be changed in the individual sessions.

The primary source of further information relating to Citrix connections should always be the relevant Citrix
documentation. This manual merely gives general configuration tips.

_____

Server (see page 79)
Logon (see page 80)
Window (see page 81)
Firewall (see page 82)
Reconnect (see page 83)
Options (see page 84)
Desktop Integration (see page 86)
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Server
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > [ICA Session] > Server

In this area, you can specify the following server connection details regardless of the default settings:

Browser Protocol: The protocol that is to be used when searching for servers and published 
applications

Default
TCP/IP + HTTP
TCP/IP
SSL + HTTPS

Do not use default server location:
☑ Lifts the default server requirement – for each protocol separately
☐ Default server location is used (default)

HTTP server location

Several names or IP addresses of the server and application browser

Citrix server: By selecting the server, the user is connected to the entire desktop as if logging on at 
the server itself. As a result, all applications, rights and settings contained in the user's profile 
(local server profile) are available. (default: enabled)
Published application: If you select a published application, the session is opened in a window 
which contains just one application. The session is ended when you close this application. 
(default: disabled)
Server: Application name, server or IP address

Click on Browse to send a transmission signal which searches through all available servers 
and published applications.

Application: If you have entered the server manually, you can specify a published application 
here. These fields are automatically filled in if you have found one of the recognized published 
applications as a result of the search.
Work Directory: Complete path of the work directory for the application on the server.

ICA sessions only function with XenApp servers of Version 6.5 or older.
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Logon
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > [ICA Session] > Logon

Use Kerberos passthrough authentication for this session:

☑ Single sign-on will be enabled for this ICA session if Log on to the thin client with AD/Kerberos is configured. The 
server too must be configured for passthrough authentication. When launching the ICA session, there is no need to 
enter a user name and password again.

☐ Kerberos passthrough authentication will not be enabled. (default)

Use passthrough authentication for this session:

☑ Single sign-on will be enabled for this ICA session if Log on to the thin client with AD/Kerberos is configured. The 
fact that the user name and password are temporarily stored when logging on to the thin client means that there is 
no need to enter them again when launching a session.

☐ Passthrough authentication will not be enabled. (default)

User Name: Specifies the user name. These details are automatically forwarded to the server and no longer need to 
be entered on the logon screen.

Password: Specifies the password

Domain: Specifies the domain

Do not show password protection window before logon:

☑ The Windows splash screen is disabled. (default)

☐ The Windows splash screen is not disabled.

This option must be disabled when logging on to Windows using a smartcard.
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Window
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > [ICA Session] > Window

Number of colors: Specifies the default color depth.
Possible values:

16
256
32 thousand
16 million
Automatic
Default: The value set in HDX/ICA Global

Use default settings for color table
☑ Default settings are enabled. (default)
☐ The settings for this setup page are enabled.
Approximate Colors
☑ The color table will be approximated for this session.
☐ The color table will remain preset on a global basis. (default)
Use Full Screen
☑ Use full-screen mode if possible. (default)
☐ Full-screen mode will not be used.
Use Full Screen restricted to Workarea:
☑ In this full-screen mode, the local taskbar can be used at the same time.
☐ The full screen covers the local taskbar (default).
Window Size:

Default
640x480
800x600
1024x768
1280x1024
1600x1200

Start Monitor: Starts the session window on this monitor.
No configuration
1st Monitor
2nd Monitor

Enable Seamless Window Mode:
☑ The seamless mode is enabled. It can only be used with published applications or with a 
specified start program for the server connection.
☐ The seamless mode is disabled. (default)
Font smoothing: Font smoothing is preset on a global basis. You can change it for this session.

Global setting
Off
Default
ClearType
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Firewall
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > [ICA Session] > Firewall

In this area, you can specify the following firewall details regardless of the default settings:

Use default alternate address setting
☑ Default alternate address setting is used (default)
☐ Default alternate address setting is not used
Use alternative address: Define a proxy or Secure Gateway server as an alternative address for 
connections via a firewall. Note the tool tips regarding the individual configuration parameters.
☑ Use alternate address for firewall connections
☐ Disabled (default)

SOCKS / Secure proxy

Use default proxy settings
☑ Default proxy settings are used (default)
☐ Default proxy settings are not used
Proxy Type:

None (Direct Connection)
SOCKS: A proxy that uses the SOCKS protocol
Secure (HTTPS): An HTTP proxy with TLS/SSL encryption.

Proxy Server: Name or IP address of the proxy server
Proxy Port: TCP port of the proxy server (default: 1080)

Secure Gateway (relay mode)

Use default Secure Gateway settings
☑ Default Secure Gateway settings are used (default)
☐ Default Secure Gateway settings are not used
Secure Gateway address: If you would like to use a Citrix Secure Gateway in relay mode, you must 
give the full DNS name – the IP address is not sufficient in this case.
Port: TCP port of the gateway (default: 443)

After enabling the alternative address, add the server to the address list under Setup > 
Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > ICA Session > Server.
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Reconnect
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > [ICA Session] > Reconnect

Use default Auto Reconnect settings
☑ The default settings are used. (default)
Enable Auto Reconnect
☑ Auto Reconnect is enabled. (default)
Maximum retries: Maximum number of repeated attempts (default: 3)
Delay in seconds before reconnecting: (default: 30)
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Options
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > [ICA Session] > Options

Compression: Reduces the quantity of data transmitted via the ICA session. This in turn reduces 
network traffic to the detriment of CPU performance. (default: disabled)

Persistent Cache Enabled: Enables caching in the cache memory (configured in the global ICA 
settings) for each session. (default: disabled)

Encryption Level:
Basic
RC5 (128 bit - logon only)
RC5 (40 bit)
RC5 (56 bit)
RC5 (128 bit)

Client Audio:
☑ Transfer system sounds and audio output from applications to the thin client. (default)
Audio Bandwith Limit:

High
Medium
Low

Speedscreen latency reduction

Mouse click feedback: The mouse pointer immediately turns into an hourglass symbol, thus 
providing visual feedback in response to a mouse click.

Automatic
Off
On

•
•

Enable compression if you connect your server(s) via WAN.
Disable this option if you use a relatively low-performance server and only work in 
one LAN.



Caching image data makes sense if you use a number of ICA sessions but only one or two 
sessions are critical with regards to network bandwidth or are used heavily during the day. 
In this case, you should reserve the cache memory for these sessions.



Encryption increases the security of your ICA connection. Basic encryption is enabled by 
default. You should therefore ensure that the Citrix server supports RC5 encryption before 
you select a higher degree of encryption.



The higher the level of audio quality you select, the more bandwidth is needed for 
transferring audio data.
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Local text echo: Displays the text entered more quickly.
Automatic: If you are not sure how fast the connection is.
Off: For faster connections (connection via a LAN)
On: For slower connections (connection via WAN) in order to reduce the delay between the 
user entering text and the text being displayed on the screen.
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Desktop Integration
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > [ICA Session] > Desktop 
Integration

Session name: Name for the session

Session start options

Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Autostart requires network
☑ If no network is available at system startup, the session is not started. A message is shown. As 
soon as the network is available, the session is started automatically.
☐ The session is started automatically, even when no network is available.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Citrix StoreFront/Web Interface
Menu path: Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface

Most of the settings were already configured under HDX ICA Global and Legacy ICA Sessions.

Server (see page 89)
Logon (see page 91)
Appearance (see page 93)
Reconnect (see page 94)
Refresh (see page 96)
Log Off (see page 98)
Desktop Integration (see page 100)
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Server
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Connections

Citrix server type:
Web Interface / Services Site: For Citrix XenApp Version 6.5 and older
StoreFront: For Citrix XenApp Version 6.5 and 7
StoreFront Legacy Mode: For Citrix XenApp Version 6.5 and 7 in Legacy Mode

Server location: You can set up up to 5 Citrix master browsers per domain. If the first browser is 
not available, the second will be queried and so on. Please note that multiple farms can be 
searched. You can therefore specify addresses for a number of server farms.
To manage the list, proceed as follows:

Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

Add (Web Interface / Services Site)

Protocol:
http://
https://

Citrix Xen App Services Site: Server name or IP address of the server
Port: Network port on which the service is available (default: 80 (http), 443 (https) )
Path to the config.xml file: (default: Citrix/PNAgent/config.xml)
Server Farm Name: Name of the Citrix farm

Add (StoreFront)

Protocol:
https://

Citrix Store Site Address: Server name or IP address of the server
Port: Network port on which the service is available (default: 443)
Path to Store: (default: Citrix/Store)
Store Name: Name of the Citrix store

Add (StoreFront Legacy Mode)

Protocol:
https://

Store address: Server name or IP address of the server
Port: Network port on which the service is available (default: 443)

The selection options depend on the type of Citrix Receiver, see Citrix Receiver 
selection (see page 51).
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Path to Store: (default: Citrix/Store/PNAgent/config.xml)
Store Name: Name of the Citrix store

Domains

To manage the list of domains, proceed as follows:
Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

Handling of the domain in the logon window:
Normal
Unchangeable
Hidden
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Logon
Menu path: Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Logon

In this area, you can define session-specific logon options.

Authentication type: Depending on the Receiver version, the following types are available:

Password authentication:  Suitable for on-premises connections; connections via Citrix NetScaler 
or to a cloud environment may cause problems.
Kerberos passthrough authentication (Web Interface only, not StoreFront): Uses local logon data 
for listing and launching applications. The option enables single sign-on for XenApp if logon with 
AD/Kerberos is configured on the thin client.
Smartcard authentication (StoreFront only, not Web Interface)
Citrix authentication mechanism (instead of IGEL), without smartcard
Citrix authentication mechanism (instead of IGEL), with smartcard

Additional options include the following:

Use passthrough authentication

☑ Cached logon data are used for listing and starting applications.

☐ No passthrough authentication (default)

Auto Logon

☑ Uses the logon data preset on this page when connecting to the server.

☐ Do not log on automatically (default)

User Name: Can only be filled in with password authentication

Password: Can only be filled in with password authentication

Domain: Can only be filled in with password authentication

Remember username and domain:

☑ Saves the user name and domain from the last logon. (default)

☐ The user name and domain will not be saved.

Synchronize Citrix password with screen lock:

☑ Synchronizes the screen lock password with that of the Citrix application.

☐ No synchronization (default)

Relaunch Citrix login after logoff:

☑ Automatically shows the Logon dialog again after logging off.

☐ Does not start the logon procedure again. (default)

If you have set an authentication type with smartcard, select the type of card on the Smartcard (see page 658)
page.
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Launch following applications automatically after server connection is established: A list of applications to be 
started in the session.
To edit the list, proceed as follows:

Click on  to create a new entry. In the Add dialog, give the name of the application.

Click on  to remove the selected entry.
Click on  to move the entry upwards.
Click on  to move the entry downwards.

You can also enter part of the name followed by an asterisk (*).

After a successful logon, the associated desktop icon for each available application will be placed on the 
thin client desktop. All applications whose name matches one of the names given in the Launch following 
applications automatically after server connection is established area will then be launched.
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Appearance
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Appearance

Show applications in the start menu
☑ Applications will appear in the start menu (default)
☐ Applications will not appear in the start menu
Show in the start menu

All: All Citrix applications will be shown in the start menu.
Follow server settings

Resize icons for the start menu
☑ The size of icons for the start menu will automatically be adjusted. (default)

Apply display filter to start menu entries
☑ Only the applications selected in the display filter will be shown in the start menu.
☐ Do not use display filter (default)
Show applications in the Application Launcher
☑ Applications will be shown in the Application Launcher. (default)
Apply display filter to Application Launcher entries
☑ Only the applications selected in the display filter will be shown in the Application Launcher.
☐ Do not use display filter (default)
Show applications on desktop
☑ The applications will be shown on the desktop. (default)
Keep folder structure on desktop
☑ The Citrix sessions are shown in their directory structure on the desktop.
☐ The directory structure is not shown. (default)
Show desktop shortcuts

All: All Citrix applications will be shown in the Desktop Launcher.
Follow server settings

Apply display filter to desktop icons
☑ Desktop icons are created only for the applications selected in the display filter (see below). 
(default)
Display filter: Show only the following applications. In the Add dialog, enter the name of the 
application that is to be shown on the desktop.
To manage the list, proceed as follows:

Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.

Enable following applications in quick start panel: In the Add dialog, enter the name of the 
application that is to be shown in the quick start panel.

Automatic scaling can prolong the logon procedure.
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Reconnect
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Reconnect

Automatic reconnection at logon
☑ Connection will take place when logging on.
☐ Do not reconnect (default)
Connect to
Possible values:

Active and terminated sessions
Terminated sessions only
Ask user

Automatic reconnection from menu/desktop
☑ Reconnect
☐ Do not reconnect (default)
Connect to
Possible values

Active and terminated sessions
Terminated sessions only
Ask user

Reconnect session name: Session name (default: Reconnect)

Starting Methods for Sessions

Start menu: If this option is enabled, the session can be launched from the start menu.
Application Launcher: If this option is enabled, the session can be launched with the Application 
Launcher.
Desktop: If this option is enabled, the session can be launched with a program launcher on the 
desktop.
Quick start panel: If this option is enabled, the session can be launched with the quick start panel.
Start menu's system tab: If this option is enabled, the session can be launched with the start 
menu's system tab.
Application Launcher's system tab: If this option is enabled, the session can be launched with 
the Application Launcher's system tab.
Desktop context menu: If this option is enabled, the session can be launched with the desktop 
context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Refresh
Menu path: Setup > Sessions > Citrix > Citrix StoreFront > Refresh

Refresh Session Name: Name for the session.

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Log Off
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Logoff

Name of the logoff session: Session name (default: Logoff)

Session start options

Session name: Name for the session

Start menu:
☑ The session can be started with the start menu. (Default)
☐ The session cannot be found in the start menu.
Application Launcher:
☑ The session can be started with the Application Launcher. (Default)
☐ The session cannot be found in the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop. (Default)
☐ The session does not have a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
☐ The session cannot be found in the quick start panel. (Default)
Start menu's system tab:
☑ The session can be started with the start menu’s system tab.
☐ The session cannot be found in the start menu’s system tab. (Default)
Application Launcher's system tab:
☑ The session can be started with the Application Launcher’s system tab.
☐ The session cannot be found in the Application Launcher’s system tab. (Default)
Desktop context menu:
☑ The session can be started with the desktop context menu.
☐ The session cannot be found in the desktop context menu. (Default)
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey: A hotkey with which the session can be started is defined. It consists of modifiers and a 
key.
Modifiers: One or two modifiers for the hotkey:

None

 = Shift
[Ctrl ] = Ctrl

 = Super_L

[Alt] = Alt

Modifiers can be combined by using the pipe character |:

[Ctrl ]+  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the character string for 

the Key field. Example: Tab  in (keysym 0xff09, Tab)
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Desktop Integration
Menu path: Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Desktop Integration

Login session name: Session name. 

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Citrix Self-Service
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Self-Service

The Citrix Self-Service interface allows access to Citrix StoreFront or Web Interface services.

_____

Server (see page 103)
Options (see page 105)
Desktop Integration (see page 106)
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Server
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Self-Service > Server

Use IGEL setup for configuring Citrix Self-Service
☑ The IGEL Setup is used for Citrix Self-Service configuration. (Default)

To manage the list, proceed as follows:

 Click on  to create a new entry.

 Click on  to remove the selected entry.

 Click on  to edit the selected entry.

 Click on  to copy the selected entry.

Server Location: XenApp 6.x or older

Add:

Protocol:
http://
https://

Server: Name or IP address of the server
Server port: Port on which the service is available (default: 80 (http), 443 (https))
Path to config.xml file: (default: Citrix/PNAgent/config.xml)
Store name: Name for the store

Server Location: XenApp/XenDesktop 7.x Store

Add:

Protocol:
http://
https://

Server: Name or IP address of the server
Server port: Port on which the service is available (default: 80 (http), 443 (https))
Path to store: (default: Citrix/Store)
Store name: Name for the store

Server Location: XenApp/XenDesktop 7.x Legacy Mode

Add:

Protocol:
http://
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https://
Server: Name or IP address of the server
Server port: Port on which the service is available (default: 80 (http), 443 (https))
Path to config.xml file: (default: Citrix/Store/PNAgent/config.xml)
Store name: Name for the store
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Options
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Self-Service > Server > Options

Display Mode: Display type for the Self-Service user interface
Possible values:

Window
Full screen

Multi User (StoreFront servers only)
☑ The user data on the client will be deleted after logging off or terminating Self-Service. (default)
Reconnect after logon:
☑ The Self-Service user interface reconnects automatically to applications and desktops after 
being launched.
☐ The Self-Service user interface does not reconnect automatically.
Reconnect to apps after starting an application:
☑ The Self-Service user interface will attempt to reconnect to ongoing sessions if an application 
is launched or the store is reloaded.
☐ The Self-Service user interface will not attempt to reconnect. (default)

In full screen mode, the IGEL desktop will not be available.
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Desktop Integration

Self-Service session: Name for the Self-Service session (default: Self-Service)

Session start options

Session name: Name for the session

Session start options

Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )



The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Autostart requires network
☑ If no network is available at system startup, the session is not started. A message is shown. As 
soon as the network is available, the session is started automatically.
☐ The session is started automatically, even when no network is available.
Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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RDP Global
Menu path: Setup > Sessions > RDP > RDP Global

This section describes the procedure for configuring the global RDP settings. This configuration applies for all RDP 
sessions.

_____

Gateway (see page 109)
Local Logon (see page 111)
Window (see page 112)
Keyboard (see page 114)
Mapping (see page 115)
Performance (see page 124)
Options (see page 127)
Native USB Redirection (see page 128)
Fabulatech USB Redirection (see page 131)
Multimedia (see page 133)

The protocol version cannot be configured manually. The version used by the server is automatically 
recognized and used.
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Gateway
Menu path: Setup > Sessions > RDP > RDP Global > Gateway

Via Microsoft Remote Desktop Gateway, you can access remote Windows systems.

The gateway translates between the internal Remote Desktop Protocol (RDP) and the external HTTPS connection.

Access to the Remote Desktop environment is provided via the browser. The browser establishes a secure 
connection to the gateway. From here, the connection query is forwarded to the target system. In the process, pre-
defined Connection Access Policies and Resource Access Policies (CAP and RAP) for access control are evaluated.

Enable gateway support:

☑ Gateway support is enabled and you can configure the following settings:

☐ Gateway support is disabled. (default)

Gateway address

The following Windows Server editions can preferably be used as gateway servers: 
Server 2008R2 Standard (restricted to 250 RD Gateway connections) 
Server 2008R2 Enterprise 
Server 2008R2 Datacenter 
Server 2012 Standard 
Server 2012 Datacenter 
Server 2012 Essential (restricted to the RD Gateway role) 
Server 2012R2 Standard 
Server 2012R2 Essential (restricted to the RD Gateway role)

Use other logon data for RD gateway

RD gateway requires Microsoft Windows Server 2008R2 or Server 2012 with various 
restrictions for each server version.



RD Gateway is not supported in the IGEL RDP Legacy Mode.
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☑ Uses custom data that can be defined below rather than the session access data.
☐ Uses the session access data. (default)

Gateway user name: User name when logging on to the gateway
Gateway password: Password when logging on to the gateway
Gateway domain: Domain in which the gateway is located
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Local Logon
Menu path: Setup > Sessions > RDP > RDP Global > Local Logon

In this area, you can prepopulate user data. As a result, you can avoid users possibly having to log in a number of 
times.

Use local login window
☑ The RDP login window is used on the terminal side to set the user name and domain when a 
connection to the terminal server is established for the first time. (default)

You can configure the following presets:

Preset login information
☑ The login window is prepopulated with the user name and domain. (default)
Type: Here, you can prepopulate the user name and domain in the logon window. 
Possible values:

Set user/domain from last login
Set user/domain from session setup

Show domain
☑ Shows the domain entry in the logon window. (default)
Set client name to user name
☑ The name of the client for the RDP connection will be set to the user name. This setting may 
help to resolve reconnection problems during load balancing. (default)
Relaunch mode
☑ The RDP login window is displayed in restart mode and cannot be closed.
☐ The RDP window will not be displayed in restart mode. (default)
Enable network authentication
☑ Enables network authentication via NTLM. Smartcards are not supported here. (default)
Domains: Allows you to add domains which are to be available. If you enter a number of domains, 
these will be shown in the Domains drop-down area in the login module.

To manage the list of domains, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

You can also use Local logon to freely select the server in the logon window of an RDP session.
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Window
Menu path: Setup > Sessions > RDP > RDP Global > Window

In this area, you can configure the window for RDP sessions.

You can change the following settings:

Number of Colors: Specifies the color depth.
Possible values:

256
Thousands
Millions

Window size: Specifies the width and height of the window.
Fullscreen: The session is shown on the full screen. The thin client's taskbar is not visible.
Work area: The session is shown on the full screen, minus the area needed by the thin 
client's taskbar.
Numeric details: The session is shown in the selected resolution or on the selected 
percentage of the screen area.

Desktop scale factor: Specifies the desktop scaling in percent. Select a value from the selection 
list or enter a percentage value manually.

Possible values:
Automatic: The resolution set under Setup > User Interface > Display > Options > Monitor-
DPI will be used for the RDP session.
Numeric details: The display will be magnified by the factor given here. Value range: 100% - 
500%

Enable Display Control
☑ The window size can be changed during the session. (Default)

Desktop scaling is supported from Windows Server 2012 or higher and from Windows 8.1 
or higher.



Set the Desktop scale factor to a fixed value of 100% to allow server-side desktop scaling to 
take effect. All values other than 100% overwrite the server-side setting.
This only works for single-monitor sessions, multi-monitor sessions are supported as of IGEL 
OS 10.05.130.



If the window size is to be changed during the session, at least Windows 8.1 or Windows 
Server 2012 R2 must be running on the server.



It is not possible to change the window size during the session if Window size is set to 
fullscreen or workarea.
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Control Bar for RDP-Sessions
☑ A control bar for minimizing and closing a full-screen session will be shown.
☐ No control bar will be shown. (Default)

Multi-monitor fullscreen mode - If more than one monitor is connected to the terminal:
Restrict fullscreen session to one monitor.
Display fullscreen session on all monitors.
Expand fullscreen session across all monitors.

If the symbol bar is enabled, a session will be shown on one monitor only, even if Multi-
monitor fullscreen mode is set to Expand full-screen session across all monitors.





Sessions

IGEL OS Reference Manual   114 / 710

•

•

•

Keyboard
Menu path: Setup > Sessions > RDP > RDP Global > Keyboard

Configure how the keyboard reacts within RDP sessions. The following options are available:

Enable clipboard
☑ You can use the clipboard. (default)
Input language: Here, you can determine which language is used for auto-correction in the RDP 
session. This is independent of the keyboard layout. The "Default" setting corresponds to the 
system setting. (default: Default).
Override local window manager keyboard shortcuts
☑ All keyboard entries, including those which would otherwise be processed by the local window 
manager, will be sent straight to the Windows server.
☐ The keyboard shortcuts of the local window manager will not be overridden. (default)
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Mapping
Menu path: Sessions > RDP > RDP Global > Mapping

In this area, you can make available locally connected devices such as printers or USB storage devices in RDP 
sessions.

Drive Mapping (see page 116)
COM Ports (see page 118)
Printers (see page 120)
Device Support (see page 121)
Audio (see page 123)
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Drive Mapping
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Drive Mapping

Through drive mapping, connected mass storage devices can be made available in the session. Specify which 
folders or drives are mapped during the login.

Enable Drive Mapping
☑ Drive mapping is enabled. (default)

Drive Mapping: List of mapped drives.

To set up drive mapping, proceed as follows:

Click  Add to bring up the mapping window.
Click Enabled to enable the drive connection.
Select a Drive to map from the list under which the local device or the folder is to be mapped.

Give the Local Drive Path of the local directory to which the mapping is to refer.

Local (USB) devices which are to be used for drive mapping purposes must first be set up 
as devices. See Hotplug storage device.



•
•

•

Before you unplug a hotplug storage device from the thin client, you must safely remove it. Otherwise, 
data on the hotplug storage device can be damaged. Depending on the configuration, there is one or 
several possibilities to safely remove a hotplug storage device:

Click on  in the task bar. The taskbar is not available in a fullscreen session.
Click on in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a fullscreen session. For further information, see In-session 
Control Bar.
Function Accessories > Safely Remove Hardware with further starting possibilities; 
amongst other things, a hotkey can be defined here.
If the following warning is displayed: Volume(s) still in use. Dont' remove the device., 
then the hotplug storage device must not be removed. First, exit the program concerned 
or close all files or directories that reside on the hotplug storage device.



If the drive letter you have selected is no longer available on the server, the specified 
directory or local drive will be given the next free letter during the login.
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If you map a locally connected device, use the pre-defined path names available in the 
drop-down field. The directories in question are those on which the devices are mounted 
by default during the boot procedure (e.g.  /autofs/floppy  for an integrated floppy 
drive).
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COM Ports
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Serial Connections

As with locally connected mass storage devices, you can also map the thin client's local serial connections (COM 
ports) during an RDP session:

Enable COM port mapping:
☑ COM port mapping is enabled. (default)
Server COM Port starts with: Specifies the lowest device number that is used on the server for 
mapping. Possible values:

COM 1 to COM 6. (default: COM1)
COM Port Devices: List with mapped local serial devices.
Click  to add a serial device.

COM Port Device:
Possible values: 
COM 1 
COM 2 
COM 3 
COM 4 
USB COM 1 
USB COM 2 
USB COM 3 
USB COM 4

Detect Devices... : Opens a dialog allowing you to select the device file. 3 device files are available 
for each device; the Description column shows the type of device file:

(GENERIC) [device designation]: Generic type. The name of the device file ends in a 
consecutive number which depends on the boot procedure or the order of insertion. 
Example: /dev/ttyUSB0

(BY PORT) [device designation]: According to USB port. The device file is in the /dev/

usbserial/  directory. The name of the device file ends in the number of the USB port 

that the device is plugged into. Example: /dev/usbserial/ttyUSB_P12

(BY USBID) [device designation]: According to USB ID. The device file is in the /dev/

usbserial/  directory. The name of the device file ends as follows: _V[Vendor 

ID]_P[Product ID] . Example: /dev/usbserial/ttyUSB_V067b_P2303
(Virtual) [device designation]: Virtual device; used for signature pads for example. Example: 
/dev/ttyVST0

If your device has an additional multiport PCI card, more than 2 connections may be 
available.
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If you would like to use signature pads, you must enable them beforehand under User 
Interface > Input > Signature Pad (see page 556).
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Printers
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Printers

In this area, you can configure printer mapping.

Enable Client Printer Mapping

☑ The locally connected thin client printer is made available for your RDP sessions, provided that it was not 
disabled on the server side. (default)

The printers must be set up on the Devices > Printer > CUPS > Printers (see page 621) page and must be 
enabled there for mapping in RDP sessions.



Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the 
server.
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Device Support
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Device Support

In this area, you can enable virtual RDP channels for communicating with various devices connected to the thin 
client.

The devices supported are listed in the IGEL Third Party Hardware Database6.

Enable plugin support
☑ Communication between connected devices and the relevant server applications is enabled. 
The individual channels must also be enabled.
☐ Communication between connected devices and server applications is not enabled. (Default)

DriveLock channel: The virtual DriveLock channel is implemented on the thin client. The channel 
must also be installed on the RDP server.
DriveLock can read hardware data from local USB devices and transfer these data to the server 
with the help of the virtual RDP channel extension. From IGEL Linux Version 10.03.500 this is also 
possible with SATA devices. When using whitelists, rules based on the hardware properties of the 
connected drive (e.g. manufacturer details, model and serial number) are taken into account.
Important information regarding DriveLock can be found in the Using DriveLock with IGEL Devices
FAQ.
☑ A virtual channel for DriveLock is enabled.
☐ No virtual channel for DriveLock is enabled. (Default)
Diktamen channel for dictation
☑ A virtual channel for Diktamen is enabled.
☐ No virtual channel for Diktamen is enabled. (Default)
deviceTRUST channel
☑ A virtual channel for deviceTRUST is enabled..
☐ No virtual channel for deviceTRUST is enabled. (Default)
Grundig MMC channel for dictation with Grundig devices
☑ A virtual channel for communication with Grundig devices is enabled.
☐ No virtual channel for communication with Grundig devices is enabled. (Default)
Philips speech channel for dictation
☑ A virtual channel for communication with Philips dictation devices is enabled.
☐ No virtual channel for communication with Philips dictation devices is enabled. (Default)
DPM server drive: Via this drive, the Philips PocketMemo dictation device makes the voice 
recordings available to the server. (Default: P)

When using DriveLock, ensure that the use of USB devices is not universally restricted; see 
Devices > USB Access Control (see page 640).



https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
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SpeechAir server drive: Via this drive, the Philips SpeechAir dictation device makes the voice 
recordings available to the server (default: S)

Enable smartcard
☑ The thin client’s smartcard reader will appear within the RDP session. Applications can access 
the reader and the smartcards it contains. (Default)
☐ The thin client’s smartcard reader will not appear within the RDP session.

The dictation device is automatically assigned to the selected drive letter. Ensure that no 
other Hotplug storage device is assigned to this drive letter. Further information can be 
found under Hotplug storage device (see page 636) and Drive mapping (see page 116).



The dictation device is automatically assigned to the selected drive letter. Ensure that no 
other Hotplug storage device is assigned to this drive letter. Further information can be 
found under Hotplug storage device (see page 636) and Drive mapping (see page 116).
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Audio
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Audio

In this area, you can configure the settings for local audio transmission.

Enable client audio
Possible values:

On: Audio will be transmitted.
Off: No audio will be transmitted.

Audio quality mode
Possible values:

Automatic
High: High audio quality is favored.
Medium: Medium audio quality is favored.
Dynamic

Audio compression
Possible values:

Automatic
On: Compressed audio data will be accepted.
Off: Compressed audio data will not be accepted.

Audio recording
☑ The microphone will be diverted to the session.
☐ The microphone will not be diverted to the session. (Default)
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Performance
Menu path: Setup > Sessions > RDP > RDP Global > Performance

In this area, you can configure settings in order to improve the performance of the RDP session.

Enable RemoteFX
☑ Remote FX is enabled (default)
RemoteFX codec mode

Use server setting
Optimized for LAN
Optimized for WAN
Legacy mode

 You can disable graphics functions which are not absolutely necessary.

Graphics settings that you can disable in order to improve performance:

Disable desktop background
☑ Desktop background is disabled
☐ Desktop background is enabled (default)
Don't show contents of window while dragging
☑ Window content will be hidden.
☐ Window content will be shown. (default)
Disable menu and window animation
☑ Menu and window animation is disabled.
☐ Menu and window animation is enabled. (default)
Disable themes
☑ Themes are disabled.
☐ Themes are enabled. (default)
Disable cursor shadow
☑ Cursor shadow is disabled.
☐ Cursor shadow is enabled. (default)
Disable cursor settings
☑ Cursor settings are disabled. No "unnecessary" mouse movements will be sent.
☐ Cursor settings are enabled. (default)
Enable font smoothing
☑ Font smoothing is enabled.
Compression
☑ Data is compressed.
☐ Data flow is not compressed. (default)

In low-bandwidth environments, you should use compression in order to reduce the network traffic. 
Please note that the use of compression reduces the burden on the network but does use CPU power.
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RemoteFX Support
Menu path: Setup > Sessions > RDP > RDP Global > Performance > RemoteFX Support

With the Service Pack 1 for Windows Server 2008 R2, local system functions such as Windows Aero or 3D display can 
be made available in RDP sessions too.

In order to do this, the RemoteFX extension for RDP must be enabled. You can configure the relevant settings under 
RDP Global > Performance or in the corresponding session settings.

Globally enabling Remote FX is not recommended as conventional RDP sessions may also be affected by 
this. With RemoteFX, all graphics effects available under Performance are enabled. This may slow down 
the session as a result. It is better to enable the function only for individual sessions which establish a 
connection to appropriately equipped servers.
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Further information on Remote FX and the server-related requirements is available from Microsoft at https://
technet.microsoft.com/en-us/library/dd736539(ws.10).aspx7.

In the IGEL Registry, you can configure the number of frames sent by the server without confirmation 
under the key rdp.winconnect.remotefx-ack . The default value is 1. A value of 2 or 3 can lead to 
improved performance in networks with high latency.



http://technet.microsoft.com/en-us/library/dd736539(ws.10).aspx
http://technet.microsoft.com/en-us/library/dd736539(ws.10).aspx
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Options
Menu path: Setup > Sessions > RDP > RDP Global > Options

In this area, you can configure the following settings:

Inverted cursor color
Possible values:

Black
White
Dotted

Reset license
☑ The Microsoft llicense will be removed from the device. The device must then be restarted.
☐ The license will not be removed. (default)
Reset confirmed server certificates
☑ All confirmed server certificated will be deleted from the client.
☐ The certificates will not be deleted. (default)
Client name: Client name for terminal service identification. 
Possible values:

Special client name: Specify a special client name in the next field.
MAC address: Use the MAC address of the computer as the client name
Computer name: Use the name of the computer

Custom client name: If you have opted for a special client name, you can enter the name here. If 
the field remains empty, the MAC address of the client will be used automatically.
Verify server certificate
☑ The server certificate will be verified if the connection is TLS-encrypted. (default)

You can also configure your own values custom:, . The colors must be given in the 
ARGB8888 format, e.g. 0xFF000000.
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Native USB Redirection
Menu path: Sessions > RDP > RDP Global > Native USB Redirection

USB devices can be permitted or prohibited during an RDP session on the basis of default rules. Sub-rules for 
specific devices or device classes are also possible. The use of rules is described under USB Access Control (see page 
640).

Enable native USB redirection

☑ Native USB redirection is enabled and you can define default rules below.

☐ Native USB redirection is not enabled. (Default)

Default rule
Possible values:

Deny
Allow

Class Rules
Class rules apply to USB device classes and sub-classes.

To manage rules, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

Add a class rule:

Rule:

Deny
Allow

Class ID: Selection list

Enable either Native or Fabulatech USB Redirection – not both together. For details on Fabulatech USB 
Redirection, see Fabulatech USB Redirection (see page 131).



Disable USB redirection if you use DriveLock. Further information can be found under Using DriveLock 
with IGEL Devices.



Tip

To secure your endpoint, it is generally recommended to set Default rule to Deny and to configure 
Allow rules only for the required USB devices and USB device classes. 
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Subclass ID: Selection list

Name: Free text entry

Device Rules
Device rules apply to specific USB devices.

Add a device rule:

Rule:

Allow
Deny

Vendor ID: Hexadecimal manufacturer number

Product ID: Hexadecimal device number

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
489).
System Information example:
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Name: Free text entry

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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Fabulatech USB Redirection
Menu path: Setup > Sessions > RDP > RDP Global > Fabulatech USB Redirection

Redirection for USB devices can be allowed or denied during an RDP session on the basis of rules. Sub-rules for 
specific devices or device classes are also possible. The use of rules is described under USB Access Control.

Fabulatech USB Redirection

  Fabulatech USB redirection is enabled for all RDP sessions.

Default rule: This rule will apply if no special rule was configured for a class or a device.
Prohibit
Allow

Class rules
Class rules apply to USB device classes and sub-classes.

Managing rules:

 Create a new entry
 Remove the selected entry
 Edit the selected entry
 Copy the selected entry

Class rule properties:

Rule:
Allow: Devices that have the properties defined here are redirected by the Fabulatech USB 
redirection.
Prohibit: Devices that have the properties defined here are not redirected.

Class ID: Device class
Subclass ID: Subclass relating to the specified device class
Name: Free text entry
Override serial: Serial number that will appear in the session

For the Fabulatech USB redirection, a server-side component is required. We recommend the USB for 
Remote Desktop IGEL Edition; see http://www.usb-over-network.com/partners/igel/.



Enable either native or Fabulatech USB redirection – not both together. Disable USB redirection if you use 
DriveLock.



Ensure that no other Hotplug storage device (USB stick) is connected if a session is started with Fabulatech 
USB redirection. Otherwise the Hotplug storage device will not be securely removed when the session 
starts, and this could lead to data loss. With IGEL Linux Version 10.02.x the Hotplug storage device is 
already insecurely removed when the Fabulatech USB redirection is enabled.



http://www.usb-over-network.com/partners/igel/
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Override name: Device name that will appear in the session
Postpone

 The USB device is only removed from the system (thin client) when the session starts.
 The USB device is no longer shown immediately after the system is booted. (Default)

This setting is only effective if the Takeaway parameter is enabled.
Takeaway

 The USB device may be removed from the system (thin client).
 The device may not be removed. (Default)

No Reset
 The device will not be automatically reset after the connection with the session has been 

terminated.
 The device will be reset after the connection with the session has been terminated. (Default)

Device rules
A device rules applies to a specific devices that is identified by its serial number.

Device rule settings:

Rule:
Allow
Prohibit

Vendor ID: Hexadecimal manufacturer number
Product ID: Hexadecimal device number
Name: Free text entry
Override serial: Serial number that will appear in the session.
Overriede name: Device name that will appear in the session.
Postpone

 The USB device is only removed from the system (thin client) when the session starts. (Default)
 The USB device is no longer shown immediately after the system is booted.

This setting is only effective if the Takeaway parameter is enabled.
Takeaway

 The USB device may be removed from the system (thin client). (Default)
 The device may not be removed.

No Reset
 The device will not be automatically reset after the connection with the session has been 

terminated. (Default)
 The device will be reset after the connection with the session has been terminated.
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Multimedia
Menu path: Setup > Sessions > RDP > RDP Global > Multimedia

In this area, you can enable video redirection in order to allow optimized video playback in remote sessions.

Video redirection
☑ Use video redirection. The thin client renders the video data.
☐ Do not use video redirection. (default)
From IGEL Linux 5.06.100, hardware acceleration for multimedia playback is available on certain 
devices. You will find more detailed information in the FAQ Hardware Video Acceleration on IGEL 
OS.
.
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RDP Session
Menu path: Sessions > RDP > RDP Sessions

You can set up your own RDP sessions here.

The following configuration pages offer you detailed setup options for the RDP session:

Server (see page 135)
Gateway (see page 136)
Logon (see page 137)
Window (see page 138)
Keyboard (see page 140)
Mapping (see page 141)
Performance (see page 142)
Options (see page 143)
USB Redirection (see page 144)
Multimedia (see page 145)
Desktop Integration RDP (see page 146)
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Server
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Server

In this area, you can change the information regarding the server connection.

 Choose between Server and RemoteApps mode.

Server

Server: Name or IP address of the server.
RDP port: The RDP TCP/IP port which is used for the connection. (Default: 3389)
Application: Start application for the terminal server session.
Command line parameter for the executed program: Command line parameter with which you 
would like to call up your own application in the RemoteAPP mode
Changeable server URL on local logon
☑ The server can be entered freely when the user logs on locally. Local logon must be enabled in 
order to do this.
☐ The terminal server’s logon window will be shown. When using local logon, the thin client’s 
logon window will be shown. (Default)

Enable RemoteApp mode
Like the published applications of a Citrix server, MS Windows Server 2008 offers the option of passing on 
RemoteApps to the thin client.

Detailed instructions regarding server configuration can also be found on the Microsoft website: TS RemoteApp 
Step-by-Step Guide8.

On the client side, only a few parameters need to be configured after enabling the RemoteApp mode.

If the Passthrough Authentication option is enabled, the session with the local logon 
data for the terminal user, e.g. from the domain logon, is used. However, this setting will 
be overridden by the Local Logon global parameter. You should therefore not use both 
options at the same time.



Please note that the name of the application to be launched must be preceded by two pipe characters (||), 
e.g. ||Excel .



https://technet.microsoft.com/en-us/library/cc730673(v=ws.10).aspx
https://technet.microsoft.com/en-us/library/cc730673(v=ws.10).aspx
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Gateway
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Gateway

Here, you can specify custom gateway details for your RDP session.

Enable gateway support
Global setting: The settings from RDP Global > Gateway will be carried over.
Session setting: Here, you can configure custom settings. The entry options correspond to 
those under RDP Global > Gateway (see page 109).
Off: No gateway support

Gateway address

The following Windows Server editions can preferably be used as gateway servers: 
Server 2012 Standard 
Server 2012 Datacenter 
Server 2012 Essential (restricted to the RD Gateway role) 
Server 2012R2 Standard 
Server 2012R2 Essential (restricted to the RD Gateway role)
Server 2016
Server 2019

Use other credentials for RD Gateway authentication:
☑ Uses custom data that can be defined below rather than the session access data.

Gateway user name
Gateway password
Gateway domain

RD Gateway requires Microsoft Windows Server 2008R2 or Server 2012 with various 
restrictions for each server version.



RD Gateway is not supported in the IGEL RDP Legacy Mode.
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Logon
Menu path: Sessions > RDP > RDP Sessions > [Session Name] > Logon

Here, you can specify session-specific settings for login.

Use passthrough authentication for this session

☑ This option can be used if the local device login takes place via Kerberos or Shared Workspace. The login data 
saved temporarily when logging in to the device will be used for the user name and password.

☐ The login data are not passed on. (Default)

User name: Name of the user

Password: Password of the user

Domain: Windows domain

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 





Sessions

IGEL OS Reference Manual   138 / 710

•

•
•
•
•

•

•
•
•

•

•

•
•

•

•

•
•

•
•
•

•

•

Window
Menu path: Setup > Sessions> RDP > RDP-Sessions > [Session Name] > Fenster

Here, you can specify the settings for the RDP session window.

Number of colours
Possible values:

Global setting
256
Thousands
Millions

Window size
Possible values:

Global setting
Fullscreen: The session is shown on the full screen. The thin client's taskbar is not visible.
Workarea: The session is shown on the full screen, minus the area needed by the thin 
client's taskbar.
Numeric details: The session is shown in the selected resolution or on the selected 
percentage of the screen area.

Desktop scale factor: Specifies the desktop scaling in percent. This function is available from IGEL 
Linux Version 10.02.

Possible values:
Global setting (default)
Automatic: The resolution set under Setup > User Interface > Display > Options > Monitor-
DPI will be used for the RDP session.
Numeric details: The display will be magnified by the factor given here. Value range: 100% - 
500%

Display resolution
Possible values:

Same as window size
Value selection: The session runs on the server side with the screen resolution selected here. 
The session will be shown on the thin client in the screen resolution set with the Window 
size parameter. If the screen resolution on the server side is smaller than the Window size, 
the display will be magnified accordingly and anti-aliasing may be used. Example: 
Applications that only work or work optimally with a specific screen resolution.

Start monitor: Specifies the monitor on which the session is to start.
No configuration
Selects a specific monitor

Multi-monitor fullscreen mode: This setting is relevant if more than one monitor is connected to 
the terminal:

Global setting

Desktop scaling is supported from Windows Server 2012 or higher and from Windows 8.1 
or higher.
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Restrict fullscreen session to one monitor.
Display fullscreen session on all monitors.
Expand fullscreen session across all monitors.
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Keyboard
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Keyboard

Here, you can specify session-specific keyboard settings.

Keyboard map
Possible values:

Automatic
Country name

Override local window manager keyboard shortcuts
Possible values:

Global setting
On
Off
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Mapping
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Mapping

Enable COM port mapping
Global setting:
On
Off

Enable drive mapping
Global setting from RDP Global > Mapping > Drive Mapping
On
Off

Enable printer mapping
Global setting from RDP Global > Mapping > Printers
On
Off

Enable plugin support
Global setting from RDP Global > Mapping > Drive Support
Off

Enable client audio
Global setting from RDP Global > Mapping > Audio
On
Off

Audio quality mode
Global setting from RDP Global > Mapping > Audio
Automatic
High: High audio quality is favored.
Medium: Medium audio quality is favored.
Dynamic

Audio compression
Global setting from RDP Global > Mapping > Audio
Automatic
On
Off

Audio capture
Global setting from RDP Global > Mapping > Audio
On
Off

Enable clipboard
Global setting from RDP Global > Keyboard
On
Off
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Performance
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Performance

Enable RemoteFX
Global setting from RDP Global > Performance
On
Off

Disable wallpaper
Global setting from RDP Global > Performance
On
Off

Do not show contents of window while dragging
Global setting from RDP Global > Performance
On
Off

Disable menu and window animation
Global setting from RDP Global > Performance
On
Off

Disable themes
Global setting from RDP Global > Performance
On
Off

Disable cursor shadow
Global setting from RDP Global > Performance
On
Off

Disable cursor settings
Global setting from RDP Global > Performance
On
Off

Enable font smoothing
Global setting from RDP Global > Performance
On
Off

Compression
Global setting from RDP Global > Performance
On
Off
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Options
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Options

Here, you can specify the name and symbol for the RDP client.

Client name: Specifies the name that is sent to the terminal server for identification purposes.
Possible values:

Global setting: The setting from RDP Global > Options will be carried over.
Custom client name: The name given under Custom client name will be used as the client 
name.
MAC address: The MAC address of the computer will be used as the client name.
Host name: The name of the device specified under Setup > Network > LAN Interfaces > 
Terminal name  will be used as the client name. See LAN Interfaces (see page 563).

Custom client name: Custom client name; if the field is empty, the MAC address will be used.
Load balancing routing token: The character string is needed if Token based load balancing is 
used.
For further information, see What Is the String for Token-Based Load Balancing?.
Icon name: File name of the icon without file extension. (Default: rdp)
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USB Redirection
Menu path: Sessions > RDP > RDP Sessions > [Session Name] > USB Redirection

Native USB redirection

Global setting: The settings from RDP Global > Native USB Redirection will be carried over.
On: Native USB redirection is enabled.
Off: Native USB redirection is disabled.

Further information regarding the global settings can be found under Native USB Redirection (see page 128).
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Multimedia
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Multimedia

Enalbe video redirection
Global setting: The setting from RDP Global > Multimedia will be used.
On: Video redirection is enabled.
Off: Video redirection is disabled.

Further information regarding the global settings can be found under Multimedia (see page 133).
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Desktop Integration RDP
Menu path: Sessions > RDP > RDP Sessions > [Session Name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☐ The session is started automatically, even when no network is available.
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Remote Desktop Web Access
Menu path: Sessions > RDP > Remote Desktop Web Access

With Web Access for Remote Desktop (Web Access for RD), users can access RemoteApp and a Remote Desktop 
connection via the start menu on a computer or via a web browser.

RemoteApps and Remote Desktop connections therefore provide a modified view of RemoteApp programs and 
virtual desktops for users.

More information on Web access for Remote Desktop can be found under Microsoft Technet - Web Access for RDP9.

The settings for launching the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

http://technet.microsoft.com/en-us/library/cc731923.aspx
http://technet.microsoft.com/en-us/library/cc731923.aspx
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Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Server (see page 152)
Authentication (see page 156)
Appearance (see page 157)
Logoff (see page 158)
Desktop Integration (see page 160)
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Server
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Connections

In this area, you can specify the server configuration.

The Web Access page for Windows Server 2012 and Windows Server 2012 R2 can also be used on a Linux thin client in 
the Firefox browser. See About browser (see page 155).

Server configuration
Possible values:

Predefined configuration: You can define several server connections with the same user 
access data. The user must enter their access data and the domain in the logon window. See 
Predefined configuration (see page 153).
Ask user: The connection is preconfigured on the server side. The user only needs to enter 
their corporate e-mail address. See Ask user (see page 154).

Server location: These settings are needed if Server configuration is set to Predefined 
configuration.

Protocol: Possible values:
http:// 
https://
RD Web Access Server: Name of the Web Access server
Path to web portal (default: /rdweb/feed/webfeed.aspx)
Enable gateway support: Possible values:
Global settings 
Session settings 
Off
Gateway address: If you would like to carry over the session settings, you must also specify 
the gateway address.

Domains: Domain of the Web Access server

_____

Predefined Configuration (see page 153)
Ask User (see page 154)
Via Browser (see page 155)
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1.
2.
3.
4.

5.

Predefined Configuration
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Server

To predefine settings, proceed as follows:

Click on Remote Desktop Web Access > Server.
Select Predefined Configuration under Server Configuration.
Create a new session. See the Connections (see page 152) section regarding the session settings.
Select a logon option under Remote Desktop Web Access > Authentication.
If you have selected Predefined Configuration, the Kerberos Passthrough Authentication mode 
will be available for logging on in addition to the normal user authentication process.
Under Desktop Integration (see page 160) and Log Off (see page 158), you can specify how you would like 
to log on and off.

The applications can be provided in the Application Launcher, in the start menu, in the quick start panel or on the 
desktop. Under Appearance (see page 157), you can choose from the list of available applications for display on the 
desktop or in the quick start panel.

You must make a setting for the login icon because this is not preconfigured and you will 
not otherwise have access to the Web Access logon.
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Ask User
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Server

With this logon method, the network connections connected with the user name on the server side must be 
preconfigured and it must be possible to query them via DNS.

To configure access via Ask user, proceed as follows:

 Select Ask user under RD Web Access > Server > Server configuration menu.
The user is given a login window in which they enter their e-mail address consisting of @ :
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Via Browser
The Web Access page for Windows Server 2012 and Windows Server 2012 R2 can also be used on a Linux thin client in 
the Firefox browser.

The user only needs the corresponding URL which is entered in the address bar.
They then log in on the browser page using their user name and password.

If the user clicks one of the applications offered by Web Access, the thin client will open a logon mask and then a 
Remote Desktop session for the application chosen.
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1.

2.

3.

Authentication
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Authentication

You can change logon settings on the server and select applications that are launched automatically after logging 
on.

Authentication mode: Specifies how the user authenticates themselves on the server.
Possible values:

Passthrough authentication: This option can be used if the local thin client logon takes 
place via Kerberos or Shared Workspace. The logon data saved temporarily when logging on 
to the thin client will be used for the user name and password.
Auto logon: The logon data in Username, Password and Domain will be used to log on.
User logon: The user enters their data in a logon window.

Username: User name when logging on to the server
Password: Password when logging on to the server

Domain: Domain in which the user name and password are valid

To select an application for automatic launching, proceed as follows:

Click  in the Start following applications automatically after server connection is 
established area.
In the Add dialog, enter the name of the application. (Example: Word 2013)

Click on Ok.
After a successful logon, the associated desktop icon for each available application will be placed 
on the thin client desktop. All applications whose name matches one of the names given in the 
Start following applications automatically after server connection is established area will 
then be launched.

The logon settings on the server are only effective if the Sessions > RDP > Remote Desktop Web Access > 
Server option under Server configuration is set to Predefined configuration. Further information can be 
found under Connections (see page 152).



Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to 
store the session password on the endpoint device. 



You can also enter part of the name followed by an asterisk ( * ). If for example you enter 

Word* , all available versions of Microsoft Word as well as Microsoft WordPad will be 
opened.
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Appearance
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Appearance

In this area, you can decide where you would like to display Remote Desktop Web Access applications:

Show applications in start menu

☑ The applications are shown in the start menu. (Default)

Apply display filter to start menu entries

☑ Only the applications listed in the display filter will be shown in the start menu.

☐ All applications will be shown in the start menu. (Default)

Show applications in Application Launcher

☑ The applications are shown in Application Launcher. (Default)

Apply display filter to Application Launcher entries

☑ Only the applications listed in the display filter will be shown in the Application Launcher.

☐ All applications will be shown in the Application Launcher. (Default)

Show applications on desktop

☑ The applications will be shown on the desktop. (Default)

Apply display filter to desktop icons

☑ Only the applications listed in the display filter will be shown on the desktop.

☐ All applications will be shown on the desktop. (Default)

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Display filter: Show only the following applications

 Via , you can add applications to the display filter and determine display options for this selected group.

Enable following applications in Quick Start Panel

 Via , you can specify applications which will be added to the quick start panel.
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Logoff
Menu path: Setup > RDP > Remote Desktop Web Access > Logoff

Here, you can specify how you would like to log off from the application.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Desktop Integration
Menu path: RDP > Remote Desktop Web Access > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Horizon Client Global
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global

In this area, you can define the global settings for Horizon Client sessions.

The following settings are carried over from the global settings for RDP sessions:

Drive mapping; see Client drive mapping (see page 116)
Number of colors; see Window (see page 112)
Window size; see Window (see page 112)
Multi-monitor full-screen mode; see Window (see page 112)

_____

Server Options (see page 164)
Local Logon (see page 166)
USB Redirection (see page 167)
Fabulatech USB Redirection (see page 170)
Drive Mapping (see page 172)
Multimedia (see page 173)
Performance (see page 174)
Smartcard (see page 175)
Unified Communications (see page 176)
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Server Options
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Server Options

In this area, you can specify the settings for the connection between the VMware Horizon Client and the server.

Preferred desktop protocol: The selected option is preferred by the client when negotiating the 
connection protocol.

Possible values:
Server setting: The client does not give the server details of a preferred connection protocol. 
The connection protocol preferred by the server is used.
RDP: The client tells the server that it prefers RDP as the connection protocol.
PCoIP: The client tells the server that it prefers PCoIP as the connection protocol.
VMware Blast: The client tells the server that it prefers VMware Blast as the connection 
protocol.

Enable kiosk mode:
☑ Horizon client sessions are held in kiosk mode.
☐ Horizon client sessions are held in normal mode. (default)
Server certificate verification mode: Specifies what will happen if server certificate verification 
fails.
Possible values:

Reject if verification fails
Warn if verification fails
Allow unverifiable connections

Action to take in case there are running applications from previous sessions: Specifies the 
start behavior of an application-type session if applications from a previous session are still 
running.

If the server does not accept the connection protocol preferred by the client, the 
connection protocol preferred by the server will be used.



Hardware video acceleration can be used for VMware Blast. Information regarding 
hardware video acceleration on IGEL thin clients can be found in the Hardware Video 
Acceleration on IGEL OS FAQs. For hardware video acceleration, the Multimedia Codec 
Pack must be installed. If no hardware video acceleration is available, rendering will take 
place via software, without acceleration.



Fabulatech USB redirection and VMWare Blast are not compatible. If you use Fabulatech USB 
redirection, ensure that RDP or PCoIP is used as the protocol for VMWare Horizon sessions.



The session type is defined under Setup > Sessions > Horizon Client > Horizon Client 
Session > [Session Name] > Connection Settings > Session Type.
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Possible values:
Ask to reconnect to open applications: When the session starts, the user is asked whether 
they want to reestablish the connection. If the connection is reestablished, the applications 
running will be available. The applications will have the same status as when the 
connection was terminated.
Reconnect automatically to open applications: The connection will be reestablished 
automatically. The application running will be available. The application will have the same 
status as when the connection was terminated.
Do not ask to reconnect and do not reconnect: The connection will not be reestablished.



Sessions

IGEL OS Reference Manual   166 / 710

•

•

•
•

•

•

•

•

•

•
•
•
•

Local Logon
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Local Logon

In this area, you can prepopulate user data. As a result, you can avoid users possibly having to log in a number of 
times.

You can change the following settings:

Use local login window:
☑ The local login window of the thin client will be used to log in to the server. If you use the local 
login window, you can prepopulate login information.
☐ The local login window will not be used. (default)
Preset logon information:
☑ Login information will appear automatically in the logon window. With Type, you can specify 
the source of the logon information. (default)
Type:

Set user/domain from last login: The login information from the last session will appear 
automatically in the login window.
Set user/domain from session setup: Session-specific login information will appear 
automatically in the login window. The session-specific login information is described under 
Connection Settings (see page 181).
Set user/domain from appliance mode: If this option is enabled, the login information 
specified in the Appliance Mode (see page 192) for VMWare Horizon will appear automatically in 
the logon window.

Show domain:
☑ The domain will be shown in the logon window. (default)
Relaunch mode:
☑ The login window is shown in relaunch mode and cannot be closed.
☐ The login window is not shown in relaunch mode. (default)
Exit on disconnect or when an error occurs:
☑ The session will be ended completely when the connection is terminated.
☐ The connection overview will be shown when the connection is terminated. (default)

Working with the domain list:

Click  to add a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.
Click  to copy the selected entry.
Further settings options can be found under AD/Kerberos Configuration (see page 655) and AD/
Kerberos (see page 650).
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2.

USB Redirection
Menu path: Sessions > Horizon Client > Horizon Client Global > USB Redirection

In this area, you can enable and configure USB redirection for specific devices. A USB composite device can be split 
into its components (interfaces). Example: USB dictation device that is split into the components loudspeaker, 
microphone, storage device/drive and control buttons.

You can change the following settings:

USB Redirection

On
Off

Automatically connect at startup

☑ USB devices that were inserted before the start of the session are available in the session. (default)

Automatically connect when inserted

☑ USB devices that are inserted during the session are available in the session. (default)

Default rule: This rule will apply if no special rule was configured for a class or a device.

Allow
Deny

Automatic splitting of composite USB devices

☑ A USB composite device will automatically be split into its individual components (interfaces). The class rules 
will be applied to these individual devices.

☐ The device will not be split into its components.

Creating a Class Rule

To create a new rule, click  in the Class Rules area.
Choose a Rule. The rule specifies whether use of the device class defined here is allowed or 
prohibited.

Ensure that the power supplied by the USB connection is adequate for the device.

If USB redirection is enabled, drive mapping should be disabled; see Drive Mapping (see page 172). Otherwise, 
USB redirection can cause a storage device to be removed from the drive mapping. This is the case if the 
Automatically connect when inserted option is enabled.



Tip

To secure your endpoint, it is generally recommended to set Default rule to Deny and to configure 
Allow rules only for the required USB devices and USB device classes. 
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4.
5.
6.

1.
2.

•
•
•

•
3.
4.

Under Family, select the class of device for which the rule should apply. Examples: Audio, Printer,
Smartcard, Storage Devices.
Under Name, give a name for the rule.
Click on Ok.
Click on Apply or Ok.
The rule is active.

Creating a Device Rule

To create a new rule, click  in the Device Rules area.
Choose a Rule. The following rules are available:

Deny: The device will not be redirected via USB redirection.
Allow: The device will be redirected via USB redirection.
Split: A USB composite device will automatically be split into its individual components 
(interfaces).
No auto-split: A USB composite device will not be split.

Give the Vendor ID of the device as a hexadecimal value.
Give the Product ID of the device as a hexadecimal value.

When a rule is defined, at least one of the properties Vendor ID or Product ID must be given.

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you 
can use the System Information tool. For further information, see Using “System Information” 
Function (see page 489).
System Information example:
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6.
7.
8.

Only for USB composite devices: Under Interface Exclude List, enter a list of interfaces that are to 
be excluded from USB redirection. The individual interfaces are separated by spaces. Example: "0 
1"
Under Name, give a name for the rule.
Click on Ok.
Click on Apply or Ok.
The rule is active.

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) 
in the terminal.
Example for lsusb :
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Fabulatech USB Redirection
Menu path: Sessions > Horizon Client > Horizon Client Global > Fabulatech USB Redirection

For Fabulatech USB Redirection, a special Fabulatech server component must be installed on the Citrix server (USB 
for Remote Desktop Igel Edition).

More detailed information about the function can be found on the Fabulatech partner site: http://www.usb-over-
network.com/partners/igel/.

Enable Fabulatech USB Redirection

☑ Fabulatech USB Redirection is used.

☐ Fabulatech USB Redirection is not used. (Default)

Default rule: This rule will apply if no special rule was configured for a class or a device.
Possible options:

Deny
Allow

Class Rules
Class rules apply to USB device classes and sub-classes.

Managing rules:

 Create a new entry
 Remove the selected entry
 Edit the selected entry
 Copy the selected entry

Class rule properties:

Rule
Possible options:

Deny: Devices that have the properties defined here are not redirected.
Allow: Devices that have the properties defined here are redirected by the Fabulatech USB 
redirection.

Class ID: Device class
Subclass ID: Subclass relating to the specified device class
Name: Free text entry

Enable either native or Fabulatech USB redirection – not both together. Disable USB redirection if you use 
DriveLock.



Ensure that no other hotplug storage device (USB stick) is connected if a session is started with Fabulatech 
USB redirection. Otherwise, the hotplug storage device will not be securely removed when the session 
starts, and this could lead to data loss. With IGEL Linux Version 10.02.x the hotplug storage device is 
already insecurely removed when the Fabulatech USB redirection is enabled.



http://www.usb-over-network.com/partners/igel/
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Override serial: Serial number that will appear in the session
Override name: Device name that will appear in the session
Postpone
☑ The USB device is only removed from the system (thin client) when the session starts.
☐ The USB device is no longer shown immediately after the system is booted. (Default)

Takeaway
☑ The USB device may be removed from the system (thin client).
☐ The device may not be removed. (Default)
No Reset
☑ The device will not be automatically reset after the connection with the session has been 
terminated.
☐ The device will be reset after the connection with the session has been terminated. (Default)

Device Rules
A device rule applies to a specific device that is identified by its serial number.

Device rule settings:

Rule
Possible options:

Deny: The device will not be redirected via Fabulatech USB Redirection.
Allow: The device will be redirected via Fabulatech USB Redirection.

Vendor ID: Hexadecimal manufacturer number
Product ID: Hexadecimal device number
Name: Free text entry
Override serial: Serial number that will appear in the session.
Override name: Device name that will appear in the session.
Postpone
☑ The USB device is only removed from the system (thin client) when the session starts. (Default)
☐ The USB device is no longer shown immediately after the system is booted.

Takeaway
☑ The USB device may be removed from the system (thin client). (Default)
☐ The device may not be removed.
No Reset
☑ The device will not be automatically reset after the connection with the session has been 
terminated. (Default)
☐ The device will be reset after the connection with the session has been terminated.

This setting is only effective if the Takeaway parameter is enabled.

This setting is only effective if the Takeaway parameter is enabled.
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3.

4.

Drive Mapping
Menüpfad: Setup > Horizon Client > Horizon Client Global > Drive Mapping

Through drive mapping, connected mass storage devices can be made available in the session. Specify which 
folders or drives are mapped during the login.

Enable Drive Mapping
☑ Drive mapping is enabled. (default)

Drive Mapping: List of mapped drives.

To set up drive mapping, proceed as follows:
Click  Add to bring up the mapping window.
Click Enabled to enable the drive connection.
Select a Drive to map from the list under which the local device or the folder is to be mapped.

Give the Local Drive Path of the local directory to which the mapping is to refer.

Local (USB) devices which are to be used for drive mapping purposes must first be set up 
as devices. See Hotplug storage device (see page 636).



•
•

•

Before you unplug a hotplug storage device from the thin client, you must safely remove it. Otherwise, 
data on the hotplug storage device can be damaged. Depending on the configuration, there is one or 
several possibilities to safely remove a hotplug storage device:

Click on  in the task bar. The taskbar is not available in a fullscreen session.
Click on in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a fullscreen session. For further information, see In-session 
Control Bar (see page 538).
Function Accessories > Safely Remove Hardware with further starting possibilities; 
amongst other things, a hotkey can be defined here.
If the following warning is displayed: Volume(s) still in use. Dont' remove the device., 
then the hotplug storage device must not be removed. First, exit the program concerned 
or close all files or directories that reside on the hotplug storage device.



If the drive letter you have selected is no longer available on the server, the specified 
directory or local drive will be given the next free letter during the login.



If you map a locally connected device, use the pre-defined path names available in the 
drop-down field. The directories in question are those on which the devices are mounted 
by default during the boot procedure (e.g.  /autofs/floppy  for an integrated floppy 
drive).
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Multimedia
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Multimedia

You can change the following multimedia settings:

Enable VMware Multimedia Redirection
Possible values:

Off: The server renders the multimedia data and sends the individual images to the client.
On: The client renders the multimedia data supplied by the server.

Real Time Audio Video (RTAV): Specifies the redirection of video data from the client USB 
webcam.
Possible values:

Off: The client does not forward the webcam data as video data.

On: The client forwards the webcam data as video data.

With USB redirection, data from the webcam can be forwarded to the server even if RTAV 
is disabled.
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Performance
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Performance

In this area, you can optimize the performance of Horizon Client sessions.

You can change the following settings:

PCoIP client-side image cache size: Specifies the size of the cache for images. Caching parts of 
the display reduces the amount of data to be transferred.
Possible values:

50 MB
100 MB
150 MB
200 MB
250 MB
300 MB

Larger cache sizes of 250 MB or more should only be used if at least 2 GB RAM or more is 
available.
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Smartcard
Menu path: Sessions > Horizon Client > Horizon Client Global > Smartcard

In this area, you can specify which middleware is used for logon with smartcard.

The following middlewares for logging on to VMware Horizon are available to choose from:

Horizon logon with Gemalto eToken and IDPrime smartcards und token

☑ The middleware for Gemalto/SafeNet eToken, IDPrime smartcards and tokens is used.

☐ The middleware for Gemalto/SafeNet eToken, IDPrime smartcards and tokens is not used. (Default)

Horizon logon with cryptovision sc/interface smartcards

☑ The middleware for cryptovision sc/interface smartcards is used.

☐ The middleware for cryptovision sc/interface smartcards is not used. (Default)

Horizon logon with Gemalto IDPrime smartcards

☑ The middleware for Gemalto IDPrime smartcards is used.

☐ The middleware for Gemalto IDPrime smartcards is not used. (Default)

Horizon logon with Athena IDProtect smartcards

☑ The middleware for Athena IDProtect smartcards is used.

☐ The middleware for Athena IDProtect smartcards is not used. (Default)

Horizon logon with A.E.T. SafeSign smartcards

☑ The middleware for A.E.T. SafeSign Smartcards is used.

☐ The middleware for A.E.T. SafeSign Smartcards is not used. (Default)

Horizon logon with SecMaker Net iD smartcards

☑ The middleware for SecMaker Net iD smartcards is used.

☐ The middleware for SecMaker Net iD smartcards is not used. (Default)

Horizon logon with smartcards supported by Coolkey library

☑ The Coolkey middleware is used.

☐ The Coolkey middleware is not used. (Default)

Horizon logon with smartcards supported by OpenSC

☑ The OpenSC middleware is used.

☐ The OpenSC middleware is not used. (Default)

Activate this Gemalto middleware if you want to use Gemalto common criteria devices in unlinked mode.
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Unified Communications
Menüpfad: Sessions > Horizon Client > Horizon Client Global > Unified Communications

Here, you can change settings relevant to Unified Communications.

Skype for Business (see page 177)
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Skype for Business
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Unified Communications > Skype for 
Business

Virtualization Pack Skype for Business: Defines whether the Virtualization Pack Skype for 
Business is active.
☑ The Virtualization Pack Skype for Business is active. (Default)
☐ The Virtualization Pack Skype for Business is not active.
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Horizon Client Session
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name]

You can configure one or more Horizon Client sessions.

The settings for launching the session are described below.

Session name: Name for the session.

Session start options
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Relaunch

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

__________

Connection Settings (see page 181)
Window Settings (see page 182)
Mouse and Keyboard (see page 183)
Mapping (see page 184)
Performance (see page 185)
Options (see page 186)
Multimedia (see page 187)
Proxy (see page 188)
Desktop Integration (see page 189)
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Connection Settings
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Connection 
Settings

In this area, you can specify the settings for the connection between the Horizon Client and the server.

Server URL: URL of the VMware Horizon server
Use passthrough authentication for this session
☑ The user name and password are temporarily saved and used for authentication purposes in 
this session.
☐ Passthrough authentication is not used. (default)
User name: User name when logging on to the VMware Horizon server
User password: Password when logging on to the VMware Horizon server
Domain: Domain when logging on to the VMware Horizon server
Session type: Specifies whether the session contains a desktop or an individual application.
Possible values:

Desktop: The session contains a desktop.
Application: The session contains an individual application.

Desktop name: Specifies a name for the desktop. This option is available if Session Type is set to 
“Desktop”.
Application: Application that is launched during the session. This option is available if Session 
Type is set to “Application”.
Autoconnect
☑ When the session starts, the connection to the desktop or application will automatically be 
established. For this to be possible, the name of the desktop or application must be defined.
☐ When the session starts, the overview will be shown. (default)
Preferred desktop protocol: The selected option is preferred by the client when negotiating the 
connection protocol.
Possible values:

Global setting
Server setting
RDP
PCoIP
VMWare Blast

Enable kiosk mode
Global setting
On
Off

Further settings options can be found under AD/Kerberos Configuration (see page 655) and AD/
Kerberos (see page 650).
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Window Settings
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Window Settings

In this area, you can change the way in which the session is displayed.

Window size: Specifies the width and height of the window.
Possible values:

Global setting: The window size is carried over from the global settings for RDP sessions, see 
Window (see page 112).
Fullscreen: The session is shown on the full screen.
User selection
Numeric details: The session is shown in the selected resolution or on the selected 
percentage of the screen area.

Number of colors: Specifies the color depth.
Global setting: The color depth is carried over from the global settings for RDP sessions, see 
Window (see page 112).
256
Thousands
Millions

Start monitor: Specifies the monitor on which the session is shown.
Further settings options can be found under Screen (see page 517) and Window (see page 112).
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Mouse and Keyboard
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Mouse and 
Keyboard

In this area, you can define the settings for the mouse and keyboard.

Disable Mouse Motion Events
☑ The mouse pointer will only be shown locally on the thin client. If the user moves the mouse 
over a session item, no reaction of the item will be shown.
Further settings options can be found in the user interface setup area under Language (see page 539)
as well as Keyboard (see page 548) and Additional keyboard layouts (see page 549).



Sessions

IGEL OS Reference Manual   184 / 710

•
•
•
•
•

•
•
•
•

•
•
•
•

•
•
•
•

•
•
•
•

•
•
•

Mapping
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Mapping

In this area, you can specify the data transmission between the thin client and Horizon Client session.

Enable Client Audio
Global setting
On - enhanced
On - secure
Off

Enable Clipboard
Global setting
On
Off

Enable Printer Mapping
Global setting
On
Off

Enabling COM Port Mapping
Global setting
On
Off

Enable Drive Mapping
Global setting
On
Off

Enable USB Redirection
Global setting
Off

Further settings options can be found in the RDP Global setup area under Drive Mapping (see page 
116), COM Ports (see page 118), Printers (see page 120), Audio (see page 123), Keyboard (see page 114) and in 
the Devices area under Printers (see page 619).

These settings only apply to RDP-based sessions.
 Check whether Sessions > Horizon Client Sessions > Horizon Client Session > Connection Settings 

> Preferred Connection Protocol selection is set to "RDP".
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Performance
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Performance

In this area, you can save system resources by disabling certain visual functions of the user interface.

Disable wallpaper:
On: No desktop background image is shown.

Do not show contents of window while dragging:
On: The content of a window will not be shown while the window is being moved.

Disable menu and window animation:
On: Transitions for menus and windows will not be animated.

Disable themes:
On: No optional desktop theme can be used.
Off: An optional desktop theme can be used.

Disable cursor shadow:
On: The mouse pointer will be shown without a shadow.
Off: The mouse pointer will be shown with a shadow.

Disable cursor settings
On: The mouse pointer settings cannot be changed.
Off: The mouse pointer settings can be changed.

Enable font smoothing:
Global setting: The setting under Sessions > Horizon Client > Horizon Client Global will be 
used.
On: Edges will be smoothed when text is displayed.
Off: Edges will not be smoothed when text is displayed.

Further settings options can be found in the Horizon Global setup area under Performance (see page 
174) and in the RDP Global area under Performance (see page 124).
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Options
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Options

In this area, you can change the following settings:

Working directory: Directory that is used after logging on
Compression:

Global setting: The setting from Setup > Sessions > Horizon Client > Horizon Client Global
will be carried over.
On: The data flow between the client and server will be compressed.
Off: The data flow will not be compressed.

Enforce TLS-encrypted connections:
Global setting: The setting from Setup > Sessions > Horizon Client > Horizon Client Global
will be carried over.
On: Encryption of the connection with TLS will be forced.
Off: Encryption will not be forced.

Network level authentication:
On: The user will authenticate themselves on the network level (network layer 
authentication) in order to establish an RDP connection.

Off: Conventional authentication
Further settings options can be found in the RDP Global setup area under Options (see page 127), 
Performance (see page 124) and in the Horizon Global area under Local Logon (see page 166).

If network level authentication is enabled, the local logon window is used. This also 
applies if the Use local logon window option under Setup > Sessions > Horizon Client > 
Horizon Client Global > Local Logon is disabled.
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Multimedia
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Multimedia

You can change the following multimedia setting:

Enable VMware multimedia redirection
Possible values:

Global setting: The setting under Sessions > Horizon Client > Horizon Client Global will be 
used.
off: The server renders the multimedia data and sends the individual images to the client.

Further options can be found in the Horizon Client Global setup area under Multimedia (see page 
173).
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Proxy
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Proxy

In this area, you can configure the use of a proxy for the connection between the client and server.

You can change the following settings:

Direct connection to the Internet:
☑ No proxy will be used.
Manual proxy configuration:
☑ A proxy will be used. The configuration must be specified in the following fields.

HTTP proxy: URL of the proxy for HTTP
Port: Port of the proxy for HTTP
SSL proxy: URL of the proxy for SSL
Port: Port of the proxy for SSL
SOCKS host: URL of the proxy for SOCKS
Port: Port of the proxy for SOCKS
SOCKS protocol version: Version of the SOCKS protocol used. Possible values:
SOCKS v4 
SOCKS v5
No proxy for: List of URLs for which no proxy is to be used (separated by commas).
System-wide proxy configuration:

☑ The proxy configured under Setup > Network > Proxy will be used.
You will find further settings options in the setup under Network > Proxy (see page 617).
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Desktop Integration
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Desktop 
Integration

Session name: Name for the session.

Session start options
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☑ The session will be launched automatically when the device boots.

Relaunch

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.
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Appliance Mode
Menu path: Setup > Sessions > Appliance Mode

In the appliance mode, only a specific session is shown. Access to other applications is not possible.

In the Appliance mode menu, you can activate the appliance mode for one of the following session types (if 
available on your system):

VMware Horizon (see page 193)
Citrix XenDesktop (see page 194)
Citrix Self-Service (see page 195)
RHEV/Spice (see page 196)
Imprivata (see page 197)
RDP MultiPoint Server (see page 199)
Caradigm (see page 200)
XDMCP for This Display (see page 203)

In the appliance mode, the screenlock does not work (although the screensaver does). In order to protect 
the session against unauthorized access, it is advisable to enable the screenlock of the remote system.



The system hotkey [Ctrl]+[Alt]+[s] for launching the setup application does not work in the Appliance 
Mode. Use [Ctrl]+[Alt]+[F2] instead.



You can set up a hotkey to start quick setup in Appliance Mode.
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VMware Horizon
Menu path: Sessions > Appliance Mode > VMware Horizon

Server URL: URL of the VMware Horizon server.

User name: User name when logging on to the VMware Horizon server.

User password: Password when logging on to the VMware Horizon server.

Domain: Domain when logging on to the VMware Horizon server.

Desktop name: Desktop that is to be launched automatically.

Autoconnect

☑ The desktop given in Desktop name is launched automatically.

Network level authentication

on: The user will authenticate themselves on the network level (network layer authentication) in 
order to establish an RDP connection.
off: Conventional authentication

Enable on-screen keyboard:

☑ If a touchscreen is available, an on-screen keyboard will be shown.

x coordinate of on-screen keyboard: Specifies the X position of the on-screen keyboard. (Default: 0)

y position of on-screen keyboard: Specifies the Y position of the on-screen keyboard. (Default: -1)

Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. (Default:
0)

Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. 
(Default: 300)

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 



If network level authentication is enabled, the local logon window is used. This also applies if the Use local 
login window option under Sessions > Horizon Client > Horizon Client Global > Local Logon is disabled.



If the on-screen keyboard is enabled, the local logon window is used. This also applies if the Use local 
login window option under Sessions > Horizon Client > Horizon Client Global > Local Logon is disabled.
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Citrix XenDesktop
Menu path: Setup > Sessions > Appliance Mode > Citrix XenDesktop

XenDesktop delivery server URL: URL of the XenDesktop Delivery server
Enable Smartcard Login
☑ The user can log in with a smartcard.

Enable on-screen keyboard: If the screen is a touchscreen, an on-screen keyboard will be shown.
X coordinate of the on-screen keyboard: Specifies the X position of the on-screen keyboard 
(default: 0).
Y coordinate of the on-screen keyboard: Specifies the Y position of the on-screen keyboard 
(default: 0).
Width of on-screen keyboard in pixels: It is recommended that you specify either the width or 
the height.
(default: 0)
Height of on-screen keyboard in pixels: It is recommended that you specify either the width or 
the height.
(default: 300)

When the option is enabled, the browser and Xen will be restarted.
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Citrix Self-Service
Menu path: Setup > Sessions > Appliance Mode > Citrix Self-Service

At least Citrix Receiver Version 13 is required!

Self-Service delivery server URL: Server address including the http://  prefix.

Multi User (StoreFront servers only)
☑ The user data on the client will be deleted after logging off or terminating Self-Service.
Reconnect after logon
☑ The Self-Service GUI reconnects automatically after being launched.
Reconnect to apps after starting an application
☑ The Self-Service GUI will attempt to reconnect to ongoing sessions if an application is launched 
or the store is reloaded.
Enable on-screen keyboard
☑ If the screen is a touchscreen, an on-screen keyboard will be shown.
X coordinate of the on-screen keyboard: Specifies the X position of the on-screen keyboard 
(default: 0).
Y coordinate of the on-screen keyboard: Specifies the Y position of the on-screen keyboard 
(default: 0).
Width of on-screen keyboard in pixels: It is recommended that you specify either the width or 
the height (default: 0).
Height of on-screen keyboard in pixels: It is recommended that you specify either the width or 
the height (default: 300).

In the Appliance Mode, only one server can be used for Self-Service.
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RHEV/Spice
Menu path: Setup > Sessions > Appliance Mode > RHEV/Spice

Connection Broker: URL of the Connection Broker

Enable on-screen keyboard

☑ If the screen is a touchscreen, an on-screen keyboard will be shown.

X coordinate of the on-screen keyboard: Specifies the X position of the on-screen keyboard (default: -1).

Y coordinate of the on-screen keyboard: Specifies the Y position of the on-screen keyboard (default: -1).

Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height (default:
0).

Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height (default:
300).
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Imprivata
Menu path: Setup > Sessions > Appliance Mode > Imprivata

Set the URL to the Server: URL of the single sign-on server.

Path to the Appliance: Path to the application on the single sign-on server. (Default: sso/servlet/

getembeddedloader?arch=amd64 )

Clear the Imprivata Data Partition

☑ The Imprivata client’s data partition will be deleted as soon as the parameter is saved (OK or Apply). When the 
Imprivata session is launched, the data will be downloaded again from the server. Following the deletion 
procedure, the parameter will be disabled.

☐ The Imprivata client’s data partition will be retained. (Default)

Enable Logging of the Bootstrap Component

☑ The bootstrap component generates a log. 

☐ No log is generated. (Default)

The following setting is active if Enable Logging of the Bootstrap Component is activated.

Bootstrap Component's Logging Verbosity: Specifies the level of detail for the bootstrap component log.
Possible options:

"debug": Detailed information on the flow through the system.
"info": Runtime events (startup/shutdown). 
"warning": Events that may lead to unexpected behavior.
"error": Other errors or unexpected conditions.
"critical": Events that may break the workflow. 

Generic session: Name of the Citrix session which was configured for Citrix Fast User Switching using generic 
access data.

Enable on-screen keyboard

☑ If a touchscreen is used, the on-screen keyboard is enabled.

☐ The on-screen keyboard is disabled. (Default)

The following settings are active if Enable on-screen keyboard is activated.

x coordinate of on-screen keyboard: Specifies the X position of the on-screen keyboard in pixels. (Default: 2)

y coordinate of on-screen keyboard: Specifies the Y position of the on-screen keyboard in pixels. (Default: 2)

Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. (Default: 
900)

The parameter is intended for use on a one-off basis. Do not enable the parameter via a UMS profile. If you 
enable the parameter via a UMS profile, the Imprivata data partition will be deleted each time that the 
device restarts and will need to be downloaded again.
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Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. 
(Default: 0)
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RDP MultiPoint Server
Menu path: Sessions > Appliance Mode > RDP MultiPoint Server

Connect to server as soon as it is found: If you always have to connect to the same server, you can preset the 
connection here by giving the DNS name of your RDP MultiPoint Server.
Otherwise, the device will find one or more RDP MultiPoint Servers automatically as soon as you launch the session. 
For this to be possible, the servers must be in the same network as the device and obtain their IP address from the 
same DHCP server as the device.
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Caradigm
Menu path: Setup > Sessions > Appliance Mode > Caradigm

The Caradigm appliance is integrated from IGEL Linux Version 5.09.100.

Caradigm Vault VIP: IP address or host name of the Caradigm authentication server, also referred 
to as the Vault
Caradigm Vault Port: Port number of the Caradigm authentication server (default port: 8443)

SSL Client Private Key: Path to the private key of the thin client. Example: /wfs/ca-certs/

tc_pk.pem

SSL Client Certificate: Path to the client certificate. Example: /wfs/ca-certs/tc_ca.crt

CA certs file: Path to the file which contains the CA certificates. Example: /etc/ssl/certs/

ca-certificates.crt
Disable SSL certification validation
☑ SSL validation will be disabled for testing purposes. Normally, the certificates should always be 
validated.
Timeout: Specifies the number of seconds after which the connection is automatically terminated 
(default: 30).
Way2Care (EGP): Name of a group within which the user can log in system-wide with a card 
without having to authenticate themselves again. Example: EGPGroup

Default domain: Name of the default domain. The following options are available for specifying 
the domain:

The authentication server returns a domain.
A default domain for the Caradigm Appliance is set.
A system-wide default domain is entered. You will find it under IGEL Setup > Network > 
LAN Interfaces > Default Domain field.
The user enters the domain manually when logging on.

Session type: Selects the session type. To do this, you must have entered the server in the 
relevant session beforehand. 
Possible values:

Citrix HDX/ICA
VMware Horizon

For the certificates that follow, you have to send the certificate files to the client via the file 
transfer - to the directory wfs/ca-certs/ . Three files are needed: the thin client 
certificate, the thin client private key and the Root-CA public key. Now enter the 
certificates here in the setup. The CA certificates must not be changed because the Root-
CA is automatically available after the first reboot via the file ca-certificates.crt .



This function only affects desktop sessions.
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Microsoft RDP

Depending on the session type, you have the following setting options:

Advanced settings for Citrix HDX/ICA

Logoff behavior: The logoff behavior can be specified for Citrix HDX/ICA. The following are 
possible:
User selection 
Session termination 
Session logoff

Advanced settings for VMware Horizon

Server URL: URL of the VMware Horizon server
Desktop name: Name of the desktop that is to be launched automatically.
Autoconnect
☑ Connect automatically to the desktop if enough information is given.
Network Level Authentication 
On: Enables network level authentication (NLA) for RDP connections. Requires local logon window. 
Off: Conventional authentication

Company Logo: (Optional) Full path of an image file for a logo which is to appear in the logon 
window.
Logging
☑ Local logging is enabled.

Logging verbosity: Specifies how exact logging is to be. The level of detail decreases as you 
move down through the selection.
Possible values: 
debug 
info 
warning 
error 
critical

On-screen keyboard: If this option is enabled, an on-screen keyboard will be shown.
X position of the on-screen keyboard: Specifies the X position of the on-screen keyboard 
(default: -1).
Y position of the on-screen keyboard: Specifies the Y position of the on-screen keyboard 
(default: -1).
Width of on-screen keyboard in pixels: It is recommended that you specify either the 
width or the height (default: 0).
Height of on-screen keyboard in pixels: It is recommended that you specify either the 
width or the height (default: 300).
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1.

2.

Smartcard Logon
To log in or off using the smartcard via Caradigm, proceed as follows:

 Tap the card on the card reader to log in.

 Tap the card on the card reader once more to log off again.

Forgotten your card?

Click on the arrow at the bottom right of the logon mask.
The Enter user data mask will open.
Enter your logon data.

If you leave the terminal without logging off, you will automatically be logged off as soon as another user 
logs on.
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XDMCP for This Display
Menu path: Sessions > Appliance Mode > XDMCP for this Display

If this session type is selected, the thin client acts as an XDMCP client.

Connection type: The type of the connection.
Possible values:

Indirect via localhost: At startup, the thin client generates a list of found XDMCP hosts. The user 
can select a host.
Indirect: At startup, a list of XDMCP hosts is displayed. This list is generated by the server specified 
under Name or IP of the server. The user can select a host.
Direct: The login mask of the host specified under Name or IP of the server is displayed.
Broadcast: The thin client starts a broadcast request. The login mask of that XDMCP host is 
displayed which is the first to respond to the broadcast request.

Name or IP of server: The name or IP of the XDMCP server.

Enable hotkeys for XDMCP Display: Defines whether hotkeys are managed by the thin client or the host.

☑ Hotkeys are managed by the thin client. When the user enters a shortcut key that is defined as a hotkey on the 
thin client, it starts the appropriate action. The input is not forwarded to the server. (Default)

☐ Hotkeys are not managed by the thin client. Almost all keyboard shortcuts are forwarded to the server. The 
hotkey [Ctrl + Alt + s] for opening the IGEL setup can still be used, provided that this hotkey is activated under
Accessories > Setup.
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Caradigm
Menu path: Setup > Sessions > Caradigm

The procedure for configuring your Caradigm session is described below.

Connection (see page 205)
Options (see page 206)
Desktop Integration (see page 208)
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Connection
Menu path: Setup > Sessions > Caradigm > Connection

In this area, you can define the connection settings for your Caradigm session:

Caradigm Vault VIP: IP address or host name of the Caradigm authentication server, also referred 
to as the Vault
Caradigm Vault Port: Port number of the Caradigm authentication server (default: 8443)

SSL Client Private Key: Path to the private key of the thin client (example: /wfs/client-

certs/tc_pk.pem )

SSL Client Certificate: Path to the client certificate (example: /wfs/client-certs /

tc_ca.crt )

CA certs file: Path to the file which contains the CA certificates (example: /etc/ssl/certs/

ca-certificates.crt )
Disable SSL certification validation:
☑ SSL validation will be disabled for testing purposes. Normally, the certificates should always be 
validated.
Timeout: Specifies the number of seconds after which the connection is automatically terminated. 
(default: 30)
Way2Care (EGP): Name of a group within which the user can log on system-wide with a card 
without having to authenticate themselves again. (Example: EGPGroup)

For the following certificates, you have to send the certificate files from the UMS to the 
client via the file transfer – to the directory / wfs/client-certs/ . Three files are 
needed: the thin client certificate, the thin client private key and the Root-CA public key. 
Now enter the certificates here in the setup. The CA certificates must not be changed 
because the Root-CA is automatically available after the first reboot via the file ca-

certificates.crt .



This function only affects desktop sessions.
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Options
Menu path: Setup > Sessions > Caradigm > Options

In this area, you can configure additional Caradigm settings such as the location domain and session-type-specific 
attributes:

Default domain: Name of the default domain. The following options are available for specifying 
the domain:

The authentication server returns a domain.
A default domain for the Caradigm Appliance is set.
A system-wide default domain is entered. You will find it under Setup > Network > LAN 
Interfaces > Default Domain field.
The user enters the domain manually when logging on.

Session type: Selects the session type. To do this, you must have entered the server in the 
relevant session beforehand. Possible values:

Citrix HDX/ICA
VMware Horizon
Microsoft RDP

Depending on the session type, you have the following setting options:

Advanced settings for Citrix HDX/ICA

Logout behavior: The logoff behavior can be specified for Citrix HDX/ICA. 
Possible values:

User choice
Force disconnect
Force logoff

Advanced settings for VMware Horizon

Server URL: URL of the VMware Horizon server
Desktop name: Name of the desktop that is to be launched automatically
Autoconnect
☑ Connect automatically to the desktop if enough information is given.
Network level authentication

On: Enables network level authentication (NLA) for RDP connections. Requires local logon 
window.
Off: Conventional authentication

Company logo: (Optional) Full path of an image file for a logo which is to appear in the logon 
window.
Logging:
☑ Local logging is enabled.
Logging verbosity: Specifies how exact logging is to be. The level of detail decreases as you move 
down through the selection.
Possible values:
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debug
info
warning
error
critical
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Desktop Integration
Menu path: Setup > Sessions > Caradigm > Desktop Integration

You can configure one or more Caradigm sessions.

The settings for launching the session are described below.

Session name: Name for the session

Session start options

Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Autostart requires network

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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☑ If no network is available at system startup, the session is not started. A message is shown. As 
soon as the network is available, the session is started automatically.
☐ The session is started automatically, even when no network is available.
Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Leostream
Menu path: Setup > Sessions > Leostream

In this area, you can configure settings for the Leostream Connection Broker. You have the following options:

Connection Details of the server and domain for logging on.

Desktop Integration Start option settings for this session.

Options Setting up the logon prompt and USB redirection.

More information on the Leostream Connection Broker is available from Leostream by visiting: http://
www.leostream.com/resources/downloads.php.

_____

Session (see page 211)
Connection (see page 213)
Desktop Integration (see page 214)
Options (see page 216)

By default, the RD Desktop client is used for the connection in UDLX – rdesktop must therefore be set as the 
Leostream API protocol with priority 1 on the server.



http://www.leostream.com/resources/downloads.php
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Session
Menu path: Setup > Sessions > Leostream > [session name]

Session name: Name for the session

Session start options

Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop
☑ The session can be started with a program starter on the desktop.
Autostart requires network
☑ If no network is available at system startup, the session is not started. A message is shown. As 
soon as the network is available, the session is started automatically.
☐ The session is started automatically, even when no network is available.
Hotkey
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 
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Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Restart: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Connection
Menu path: Setup > Sessions > Leostream > [session name] > Connection

Server: IP address or hostname of the connection broker.
User name: Login user name.
Domain: Login domain.
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Desktop Integration
Menu path: Setup > Sessions > Leostream > [session name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Relaunch

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Options
Menu path: Setup > Sessions > Leostream > [session name] > Options

Hide the 'Advanced Login' button
☑ The Advanced Login button is hidden. (Default)
Remove the domain field from the login screen
☑ The domain field is removed.
☐ The domain field is not removed. (Default)
When using a single desktop
Possible values:

Do not attach USB devices
Prompt to select devices to attach
Automatically attach all devices

When using multiple desktops
Possible values:

Do not attach USB devices
Prompt to select devices to attach
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AppliDis
Menu path: Setup > Sessions > AppliDis

AppliDis Fusion 4 is a virtualization solution which combines the virtualization of desktops and applications in a 
single console.

If you create an AppliDis session, you can configure the following settings:

Connection (see page 218): Details of the Server URL and Connect Type for logging on. If you use 
AppliDis SLB Linux in the Connector Mode, the name of the application that uses the connector 
can be specified here.
Options (see page 219): Allows you to define the language, credentials, access path, and further 
settings for the AppliDis client.
Desktop Integration (see page 221): Start option settings for this session.
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Connection
Menu path: Setup > Sessions > AppliDis > Connection

Server URL: Address of the AppliDis server or the administration server

HTTP/HTTPS service port: Protocol for communication with the AppliDis server
Possible options:

http
https

Connection type
Possible options:

Standard TS/RDS environment
VirtualDesktop environment
VirtualDesktop environment with AppliDis dashboard registration

AppliDis SLB connector mode: Name of the application which the connector uses if AppliDis SLB Linux is to be 
used in the connector mode.
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Options
Menu path: Setup > Sessions > AppliDis > Options

Language
Possible options:

English
French

RDP mode
Possible options:

classic RDP
console mode RDP

Working directory: Complete path of the work directory for the application on the server.

User name: User name when logging on to the server

Password: Password when logging on to the server

Full path to cert: Path to the certificate with file name.

Timeout: Maximum time that the system waits for a response from the server (default: 30)

AppliDisXML access path: Path for XML communication with the AppliDis administration server. (Example: /

applidisXML/ApplidisServer.asp )

Lock connection type

☑ The connection type is locked. (default)

☐ The connection type is not locked.

Hide “Close” tab

☑ The “Close” tab is not hidden. (default)

☐ The “Close” tab is not hidden.

Close AppliDis client at end of session

☑ The client is closed when the session ends. (default)

☐ The client is not closed.

Force insecure mode

☑ Insecure mode is forced.

☐ Insecure mode is not forced. (default)

Enable debug mode

☑ Debug mode is enabled.

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 
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☐ Debug mode is disabled. (default)

Activate SSL mode

☑ SSL mode is enabled.

☐ SSL mode is not enabled. (default)

Remember user

☑ AppliDis remembers the user name. (default)

☐ AppliDis does not remember the user name.

Discard credentials

☑ The credentials are not saved. (default)

☐ The credentials are saved.

Hide “Filter” tab

☑ The “Filter” tab is not shown.

☐ The “Filter” tab is shown. (default)

Hide “Service” tab

☑ The “Service” tab is not shown.

☐ The “Service” tab is shown. (default)

Hide “Server” tab

☑ The “Server” tab is not shown.

☐ The “Server” tab is shown. (default)
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Desktop Integration
Menu path: Setup > Sessions > AppliDis > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .
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Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Evidian AuthMgr
Menu path: Sessions > Evidian AuthMgr

The procedure for configuring your Evidian AuthMgr session is described below.

Evidian AuthMgr Global (see page 224)
Evidian AuthMgr Session (see page 227)
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Evidian AuthMgr Global
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Global

Here, you can configure the global settings for Evidian AuthMgr sessions.

Restarting (see page 225)
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Restarting
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Global > Restarting

Here, you can define the desktop integration for restarting Evidian AuthMgr.

Session name: Name for the session.

Session start options

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Relaunch

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Evidian AuthMgr Session
Menu path: Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions

Here, you can set up your own Evidian AuthMgr session.

Connection (see page 228)
Options (see page 229)
Desktop Integration (see page 230)
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Connection
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > [Session name] > Connection

In this area, you can specify the settings for the connection between Evidian AuthMgr and the server.

Protocol: Protocol that is used for user access.
Possible values:

"HTTP"
"HTTPS"

Server: IP address or DNS name that is used for user access.

Port: Port that is used for user access. 
Possible values:

"9764 (HTTP)"
"9765 (HTTPS)"
"Custom"

Custom port: If you selected "Custom" above, you can enter a port of your own here.

Path to service: Service path that is used for user access. (Default: /soap)

CA certificate: Path to the CA certificate with file name. The certificate is needed for HTTPS connections. (Example: 
/wfs/ca-certs/ca.crt )

Roaming session secret: Password for the roaming session.

Fallback User Access Services

Click on the logo to specify up to four alternative connections. These will be used if the primary authentication 
server is not available. The alternative servers will be queried in sequence.

•
•

•

Download the Certificate for Evidain from the EAM in base64 encoded x509 CER format,
Convert it to crt by the following command: openssl x509 -inform PEM -in 
YOUR_CERT.cer -out YOUR_CRT.crt
Eventually move YOUR_CRT.crt to the endpoint
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Options
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > [Session name] > Options

Specify further options for your Evidian AuthMgr session.

Session type
Possible values:

Citrix ICA
RDP
VMware Horizon
Custom

Custom commands

If you have selected the user-defined session type, you can enter your own start and stop commands here:

Custom start command: Command that is executed when the card is inserted. (Example: /wfs/

start.bash )

Custom stop command: Command that is executed when the card is removed. (Example:  /

wfs/stopp.bash )

Availability message
☑ A message is shown when the authentication tool is available.
Delay for dynamic tapping: Tapping delay in secondes (default: 3)
Tapping mode
☑ The operating mode can be changed by briefly tapping the card on the reader. Each tap 
triggers an action.
Debug mode:
☑ All outputs are switched to the default error output (false).
Level for trace: Specifies the trace level. The level of detail of the log messages decreases as you 
move down through the selection list.
Possible values:

none
low
medium
high
Details

Custom configuration file

Use configuration file
☑ Instead of the preconfigured session, a custom configuration file will be used. All other session 
settings will be ignored.
Path: Path to the configuration file with file name. (Example: /etc/rsUserAuth/

rsUserAuth.ini ).
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Desktop Integration
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > [Session name] > Desktop 
Integration

Session name: Name for the session.

Session start options

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Relaunch

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.



Sessions

IGEL OS Reference Manual   233 / 710

NoMachine NX Client
Menu path: Sessions > NoMachine NX Client > [Session Name]

You can configure one or more NoMachine NX sessions.

Further information regarding configuration can be found in the original documentation provided by NoMachine: 
http://www.nomachine.com/documents.

The settings for launching the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

http://www.nomachine.com/documents
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Connections (see page 236)
Unix Desktop (see page 237)
Unix Display (see page 239)
Windows Desktop (see page 241)
Windows Display (see page 242)
VNC Desktop (see page 244)
VNC Display (see page 245)
Shadow Display (see page 246)
Logon (see page 248)
Advanced (see page 249)
Services (see page 251)
Desktop Integration (see page 252)
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Connections
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Server

Here, you can specify the connection data for the NoMachine NX session.

Host: Host name or IP address of the NoMachine NX server.
Port: Port for connecting with the NoMachine NX server (default: 22).
Connection service: Protocol for connecting to the NoMachine NX server.
Possible values:

SSH
NX

Session: Session type
Possible values:

Unix: The session will run under Unix/Linux on the server side. X11 serves as the 
transmission protocol.
Windows: The session will run under Windows on the server side. RDP serves as the 
transmission protocol.
VNC: The session will be transmitted with VNC (Virtual Network Computing) via RFP (Remote 
Framebuffer Protocol). On the server side, the session can run on any operating system. A 
VNC server is required on the server.
Shadow: Protocol version for older VNC servers

Use following DSA key: DSA key which is to be used instead of the default key when logging on to 
the server. If no key is entered here, i.e. the field is empty, the thin client’s default key will be used. 
The default key is saved under /wfs/nxkeys/server.id_dsa.key .
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Unix Desktop
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Unix Desktop

Here, you can specify which window manager or display manager is to be launched on the server when the user logs 
on with the NoMachine NX client. The window manager must be available on the server.

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Unix".

Desktop
Possible values:

KDE: KDE will be launched.
Gnome: Gnome will be launched.
CDE: CDE will be launched.
XDM: The display manager XDM will be launched.
Custom: A custom window manager will be used.

Settings options if "Desktop" is set to "XDM":

Login: These options are available if Desktop is set to “XDM”.
Let the NX server decide: The configuration of the NoMachine NX server will be used for 
logon purposes.
Query an X desktop manager: The NoMachine NX client will connect to the X desktop 
manager of the computer defined under Host. The set Port will be used for this connection 
(default: 177).
Broadcast XDM request: The NoMachine NX client will send a request for available XDM 
servers in the subnet via the set Port (default: 177). The NoMachine NX client will use the 
first XDM server that responds to the request.
Get a list of available X desktop managers: The NoMachine NX client will send a request to 
the computer defined under Host via the set Port (default: 177). This computer will reply 
with a list of available XDM servers. This option is relevant to older versions of the 
NoMachine NX server.

Settings options if "Desktop" is set to "Custom":

Application

Run console: The terminal set by default will be launched. Example: Xfce terminal
Run default X client script on server: The script for the default desktop environment set by 
default will be launched. Example: /home/user/startxfce.sh
Run the following command: Start command for the desired application or the desired window 
manager. Example: startxfce
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Options

Floating window: The session will be shown in a separate window. This option makes particularly 
efficient use of bandwidth.
Use X agent encoding
☑ The data traffic will be decoded by the NX agent rather than in the X protocol. (default)
☐ The data traffic will remain in the X protocol and will be tunneled and compressed by the NX 
proxy.
Use taint of X replies
☑ Trivial sources of X roundtrips will be suppressed by generating the response on the side of the 
X client. This option is relevant to older versions of the NoMachine NX server. (default)
New virtual desktop: The session will take place on a new virtual desktop on the server side.
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Unix Display
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Unix Display

Here, you can define the properties for image transmission from the NoMachine NX server to the NoMachine NX
client.

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Unix".

Display: Size of the display area that is used for the session 
Possible values:

640x480
800x600
1024x768
Available area: The entire display area is used for the session. The taskbar is not visible.
Fullscreen: The session will be shown in full-screen mode, i. e. stretched across the entire 
screen.
Custom: The width and height can be freely defined.
Multimonitor fullscreen: The session will be shown in full-screen mode on all available 
monitors, i.e. stretched across the entire screen of each monitor.

Width: Width of the display area for the session (default: 800)
Height: Height of the display area for the session (default: 600)
Enable custom settings
☑ The image transmission properties can be changed on the client side.
☐ The image transmission properties are specified on the server side only. (default)

Use JPEG and RGB compression: JPEG compression (results in losses) as well as RGB 
compression (loss-free) will be used. The level of JPEG compression will be adjusted 
dynamically depending on the compressibility.
Use JPEG and RGB compression, and use custom JPEG quality: JPEG compression 
(results in losses) as well as RGB compression (loss-free) will be used. The level of JPEG 
compression is specified by the parameter JPEG quality.
Only use JPEG compression: Only JPEG compression (results in losses) will be used. The 
level of JPEG compression will be adjusted dynamically depending on the compressibility.
Use JPEG compression and custom JPEG quality: Only JPEG compression (results in 
losses) will be used. The level of JPEG compression is specified by the parameter JPEG 
quality.
Only use RGB compression: Only RGB compression (loss-free) will be used.
Use plain X bitmaps: The images will be transmitted as bitmaps without compression.
JPEG quality: If Use JPEG and RGB compression and define JPEG quality or Use JPEG 
compression and define JPEG quality is enabled, the quality of images in JPEG format can 
be defined (default: 6).

Use render extension

The image transmission properties can also be defined on the server side. If a server-side setting competes 
with a client-side setting, the server-side setting will be effective.





Sessions

IGEL OS Reference Manual   240 / 710

•

•

•

•

☑ The "Render" or "XRender" protocol extension is enabled. This allows a transparency effect 
where windows overlap on the screen. (default)
Disable the backing-store
☑ The cache is disabled. This reduces the amount of memory needed. However, the speed of the 
session may be reduced.
☐ The cache is enabled. (default)
Disable the composite extension
☑ The "Composite" protocol extension is disabled. Transparency effects where windows overlap 
on the screen are not possible.
☐ The "Composite" protocol extension is enabled. (default)
Disable the shared memory extension
☑ The shared memory extension is disabled.
☐ The shared memory extension is enabled. (default)
Disable emulation of shared pixmaps
☑ The emulation of shared images (shared pixmaps) is disabled.
☐ The emulation of shared images (shared pixmaps) is enabled. (default)
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Windows Desktop
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Windows Desktop

Here, you can specify which Windows terminal server (or remote desktop service) is used, how the user logs on and 
whether the entire desktop or an individual application is launched.

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Windows".

Windows terminal server: Host name or IP address of the Windows server on which the desktop 
or the application runs
Windows terminal server domain: Domain in which the Windows terminal server is located
Use the NX user's credentials: When the session starts, the logon information under Setup > 
NoMachine NX Client Sessions > [Session Name] > Logon will be used. (default)
Use following credentials: When the session starts, the logon information under Username and 
Password will be used.

Username: User name for starting the session
Password: Password for starting the session

Start Windows login screen: When starting the session, the user must enter their logon 
information.
Run desktop: When starting the session, the Windows desktop is shown (default)
Run application: When starting the session, the Windows application given in the text field is 
launched.
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Windows Display
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Windows Display

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Windows".

Display: Size of the display area that is used for the session 
Possible values:

640x480
800x600
1024x768
Available area:
Full screen: The session will be shown in full-screen mode, i. e. stretched across the entire 
screen.
Custom: The width and height can be freely defined.
Multi-monitor full screen:

Width: Width of the display area for the session (default: 800)
Height: Height of the display area for the session (default: 600)
Colors
Possible values:

256
32K
64K
16M

Use custom settings
☑ The image transmission properties can be changed on the client side.
☐ The image transmission properties are specified on the server side only. (default)

Use JPEG and RGB compression: JPEG compression (results in losses) as well as RGB 
compression (loss-free) will be used. The level of JPEG compression will be adjusted 
dynamically depending on the compressibility.
Use JPEG and RGB compression, and define JPEG quality: JPEG compression (results in 
losses) as well as RGB compression (loss-free) will be used. The level of JPEG compression is 
specified by the parameter JPEG quality.
Only use JPEG compression: Only JPEG compression (results in losses) will be used. The 
level of JPEG compression will be adjusted dynamically depending on the compressibility.
Use JPEG compression and custom JPEG quality: Only JPEG compression (results in 
losses) will be used. The level of JPEG compression is specified by the parameter JPEG 
quality.
Only use RGB compression: Only RGB compression (loss-free) will be used.
Use plain X bitmaps: The images will be transmitted as bitmaps without compression.
JPEG quality: If Use JPEG and RGB compression and define JPEG quality or Use JPEG 
compression and define JPEG quality is enabled, the quality of images in JPEG format can 
be defined (default: 6).

Enable RDP image cache
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☑ The cache is enabled. This increases the amount of memory needed. However, the speed of the 
session may be increased. (default)
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VNC Desktop
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > VNC Desktop

Here, you can specify the VNC server as well as the password for the VNC session.

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"VNC".

VNC server: Name or IP address of the server
: Number of the display.
Password: Password for the VNC session

These settings are only relevant up to NoMachine NX Server Version 3.5.
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VNC Display
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > VNC Display

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"VNC".

Display: Size of the display area that is used for the session 
Possible values:

640x480
800x600
1024x768
Available area
Fullscreen: The session will be shown in full-screen mode, i. e. stretched across the entire 
screen.
Custom: The width and height can be freely defined.
Multimonitor Fullscreen

Width: Width of the display area for the session (default: 800)
Height: Height of the display area for the session (default: 600)
Use custom settings
☑ The image transmission properties can be changed on the client side.
☐ The image transmission properties are specified on the server side only. (default)

Use both JPEG and RGB compression: JPEG compression (results in losses) as well as RGB 
compression (loss-free) will be used. The level of JPEG compression will be adjusted 
dynamically depending on the compressibility.
Use JPEG and RGB compression, and use custom JPEG quality: JPEG compression 
(results in losses) as well as RGB compression (loss-free) will be used. The level of JPEG 
compression is specified by the parameter JPEG quality.
Only use JPEG compression: Only JPEG compression (results in losses) will be used. The 
level of JPEG compression will be adjusted dynamically depending on the compressibility.
Use JPEG compression and custom JPEG quality: Only JPEG compression (results in 
losses) will be used. The level of JPEG compression is specified by the parameter JPEG 
quality.
Only use RGB compression: Only RGB compression (loss-free) will be used.
Use plain X bitmaps: The images will be transmitted as bitmaps without compression.
JPEG quality: If Use JPEG and RGB compression and define JPEG quality or Use JPEG 
compression and define JPEG quality is enabled, the quality of images in JPEG format can 
be defined (default: 6).

These settings are only relevant up to NoMachine NX Server Version 3.5.
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Shadow Display
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Shadow Display

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Shadow".

Display: Size of the display area that is used for the session
Possible values:

640x480
800x600
1024x768
Available area:
Fullscreen: The session will be shown in fullscreen mode, i. e. stretched across the entire 
screen.
Custom: The width and height can be freely defined.
Multi-monitor full screen:

Width: Width of the display area for the session (default: 800)
Height: Height of the display area for the session (default: 600)
Enable custom settings
☑ The image transmission properties can be changed on the client side.
☐ The image transmission properties are specified on the server side only. (default)

Use both JPEG and RGB compression: JPEG compression (lossy) as well as RGB 
compression (lossless) will be used. The level of JPEG compression will be adjusted 
dynamically depending on the compressibility.
Use JPEG and RGB compression, and use custom JPEG quality: JPEG compression (lossy) 
as well as RGB compression (lossless) will be used. The level of JPEG compression is 
specified by the parameter JPEG quality.
Only use JPEG compression: Only JPEG compression (lossy) will be used. The level of JPEG 
compression will be adjusted dynamically depending on the compressibility.
Use JPEG compression and custom JPEG quality: Only JPEG compression (lossy) will be 
used. The level of JPEG compression is specified by the parameter JPEG quality.
Only use RGB compression: Only RGB compression (lossless) will be used.
Use plain X images: The images will be transmitted as bitmaps without compression.
JPEG quality: If Use JPEG and RGB compression and use custom JPEG quality or Use 
JPEG compression and custom JPEG quality is enabled, the quality of images in JPEG 
format can be defined (default: 6).

Enable render extension
☑ The "Render" or "XRender" protocol extension is enabled. This allows a transparency effect 
where windows overlap on the screen. (default)
Disable the backing store
☑ The cache is disabled. This reduces the amount of memory needed. However, the speed of the 
session may be reduced.
☐ The cache is enabled. (default)

These settings are only relevant up to NoMachine NX Version 3.5.
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Disable the composite extension
☑ The "Composite" protocol extension is disabled. Transparency effects where windows overlap 
on the screen are not possible.
☐ The "Composite" protocol extension is enabled. (default)
Disable the shared memory extension
☑ The shared memory extension is disabled.
☐ The shared memory extension is enabled. (default)
Disable emulation of shared pixmaps
☑ The emulation of shared images (shared pixmaps) is disabled.
☐ The emulation of shared images (shared pixmaps) is enabled. (default)
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Logon
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Logon

Here, you can specify the logon information for starting the session.

Login method
Possible values:

Password: The user logs on with a logon and password.
Private key: The logon takes place with a private key.

Login: User name when logging on to the server
Password: Password when logging on to the server

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to 
store the session password on the endpoint device. 
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Advanced
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Advanced

Here, you can change advanced settings.

Link speed
Possible values:

Modem
ISDN
ADSL
WAN
LAN

Disable ZLIB stream compression
Possible values:
☑ The data traffic between the client and server will not be compressed.

☐ The data traffic between the client and server will be compressed. (default)
Enable SSL encryption on all traffic
☑ Connections with NX, SSH and UDP will be encrypted. (default)
☐ Connections with NX and SSH will be encrypted, connections with UDP will remain unencrypted.
Connect through a HTTP proxy
☑ The connection between the client and server will be routed via an HTTP proxy.
☐ The connection between the client and server will be direct. (default)
Host: Host name or IP address of the HTTP proxy
Port: Port of the HTTP proxy (default: 8080)
Username: User name when logging on to the HTTP proxy

Password: Password when logging on to the HTTP proxy

Remember my password

☑ The password will be saved.
☐ The password will not be saved and must therefore be entered again for each session. (default)
Disable deferred screen updates: Delayed screen refreshing ("lazy encoding") compensates for 
bottlenecks in data transmission. If a bottleneck occurs, refresh procedures requiring large 
amounts of bandwidth are delayed in favor of interactivity. There are two levels of delayed screen 

Switching off compression can be helpful if the data traffic is compressed on another 
level, e.g. by VPN software.



This setting is only relevant up to NoMachine NX Server Version 3.5.

This setting is only relevant up to NoMachine NX Server Version 3.5.

This setting is only relevant up to NoMachine NX Server Version 3.5.
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refreshing. With Level 1, refresh actions which are not displayed directly ("offscreen") are 
dismissed. With Level 2, refresh actions which are displayed directly ("onscreen") are dismissed.

☑ Bottlenecks in data transmission are not compensated for through delayed screen refreshing.
☐ If the connection speed is set to "WAN”, Level 1 delayed screen refreshing will be used. If the 
connection speed is set to "MODEM, “ISDN” or “ADSL”, Level 2 delayed screen refreshing will be 
used. (default)
Disk cache: Size of the persistent memory for caching images (default: 64 MB)

Memory cache: Size of the volatile memory for caching images (default: 16 MB)

This setting is only relevant up to NoMachine NX Server Version 3.5.

This setting is only relevant up to NoMachine NX Server Version 3.5.

This setting is only relevant up to NoMachine NX Server Version 3.5.
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Services
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Services

Here, you can enable or disable services for printers and audio playback on your thin client.

Enable multimedia support
You will find further information regarding audio playback on the Nomachine NX client in the 
NoMachine Knowledge Base10.
☑ Audio output is forwarded to the media player via esound.
☐ A dedicated channel is used for audio output. (default)
Enable CUPS printing
☑ Printing via the thin client is enabled. (default)
☐ Printing via the thin client is disabled.
Port: Port via which CUPS can be configured with a browser (default: 631)
Public printer
☑ The printer connected to the thin client is shared via the network. A server-side configuration is 
required for this purpose.
☐ The printer is not shared. (default)

https://www.nomachine.com/?q=AR03D00355
https://www.nomachine.com/?q=AR03D00355
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Desktop Integration
Menu path: Sessions > NoMachine NX Client > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the NoMachine NX session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )



Sessions

IGEL OS Reference Manual   253 / 710

•

•

•

•

•

•

•

Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Parallels Client Global
Menu path: Sessions > Parallels Client > Parallels Client Global

In this area, you can configure global settings for all Parallels Client sessions.

Keyboard (see page 256)
USB Redirection (see page 257)
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Keyboard
Menu path: Setup > Sessions > Parallels Client > Parallels Client Global > Keyboard

In this area, you can select the keyboard layout for Parallels Client sessions.

Keyboard layout
Possible values:

System presets as well as all available input schemes.
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USB Redirection
Menu path: Setup > Sessions > Parallels Client > Parallels Client Global > USB Redirection

In this area, you can configure USB Redirection for Parallels Client sessions.

USB Redirection

☑ USB redirection is enabled.

☐ USB redirection is disabled. (Default)

Automatically redirect all USB devices: Defines whether the Device Rules will be ignored and all USB devices 
redirected.

☑ All USB devices will be redirected.

☐ USB devices will be redirected according to the Device Rules. (Default)

Device Rules
In this area, you can define device rules for USB redirection.

Defining new rules:

Click  to get to the Add dialog.

In the Add dialog, you can define the following settings:

Rule
Possible values:

"Deny"
"Allow"

Vendor ID: Hexadecimal manufacturer number.

Product ID: Hexadecimal device number.

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
489).
System Information example:
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Name: Free text entry.

PTP/MTP redirection

☑ PTP/MTP redirection is enabled.

☐ PTP/MTP redirection is disabled. (Default)

Automatically redirect all PTP/MTP devices: Defines whether the Device Rules will be ignored and all PTP/MTP 
devices redirected.

☑ All PTP/MTP devices will be redirected.

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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☐ PTP/MTP devices will be redirected according to the Device Rules. (Default)

Device Rules
In this area, you can define device rules for PTP/MTP redirection.

Defining new rules:

Click  to get to the Add dialog.

In the Add dialog, you can define the following settings:

Rule
Possible values:

"Deny"
"Allow"

Vendor ID: Hexadecimal manufacturer number.

Product ID: Hexadecimal device number.

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
489).
System Information example:
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Name: Free text entry.

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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Parallels Client Session
Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > [Session Name]

You can configure one or more Parallels Client sessions.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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_________

Connection (see page 264)
Display (see page 266)
Local Resources (see page 267)
Experience (see page 268)
Network (see page 270)
Advanced (see page 271)
Desktop Integration (see page 272)



Sessions

IGEL OS Reference Manual   264 / 710

•
•

•

•

•

•

•

•

•

•
•

Connection
Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > [Session Name] > Connection

In this area, you can specify the settings for the connection between the Parallels Client and the server.

Application Server

Primary Server: Name or IP address of the primary application server
Secondary Server: Name or IP address of the secondary application server. The secondary 
application server is used if the primary application server cannot be contacted.
Connection Mode
Possible values:

Gateway Mode: This mode is suitable if the Parallels Client does not have access to a 
physical server and no special demands as regards security apply. The Parallels Client
establishes a connection to the Parallels SecureClientGateway via port 80. The RDP sessions 
runs in a tunnel within this connection.
Direct Mode: This mode is suitable if the Parallels Client has direct access to a physical 
server. The Parallels Client establishes a connection to the Parallels SecureClientGateway via 
port 80 in order to negotiate connection data for the RDP session with the application 
server. The Parallels Client then terminates the connection to the gateway and establishes 
the session with the application server. This mode is the most efficient because the 
connection to the gateway is temporary and the data traffic is correspondingly low.
Gateway SSL Mode: This mode is suitable if the Parallels Client does not have access to a 
physical server and there are high demands as regards security. The Parallels Client
establishes a connection to the Parallels SecureClientGateway via port 443. The RDP 
sessions runs in a tunnel within this connection.
Direct SSL Mode: This mode is suitable if the Parallels Client has direct access to a physical 
server and there are high demands as regards security. The Parallels Client establishes a 
connection to the Parallels SecureClientGateway via port 443 in order to negotiate 
connection data for the RDP session with the application server. The Parallels Client then 
terminates the connection to the gateway and establishes the session with the application 
server.

Port: Port for communication with the application server (default: 80)

Logon

Use system credentials
☑ The system-wide logon data will be used for logging on to the application server (single sign-
on). This option can be used if the local thin client logon takes place via Kerberos. The logon data 
saved temporarily when logging on to the thin client will be used for the user name and password.
☐ The logon data given under User name, Password and Domain will be used when logging on to 
the application server. (default)
User name: User name when logging on to the application server
Password: Password when logging on to the application server
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• Domain: Domain when logging on to the application server

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to 
store the session password on the endpoint device. 
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Display
Display color depth: Number of colors displayed

Possible values:

8 bit
15 bit
16 bit
24 bit
32 bit

Use all monitors for desktop session (if applicable)

☑ All monitors will be used for the desktop session.

☐ The primary monitor will be used for the desktop session. (Default)

Use only primary monitor for published applications
Published applications run on the server, the input and output data is exchanged between the client and the 
application server.

☑ Published applications will only be shown on the primary monitor.

☐ Published applications will only be shown on all available monitors. (Default)

Span desktop across all monitors

☑ The desktop will be shown across all available monitors.

☐ The desktop will only be shown on the primary monitor. (Default)

If the option RemoteFX is enabled under Setup > Parallels Client > Parallels Client Sessions > [session 
name] > Experience, the color depth will be set internally to 32 bit, regardless of the value selected.
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Local Resources
Menu path: Setup > Parallels Client > Parallels Client Sessions > [Session Name] > Local Resources

Remote computer sound
Possible values:

Bring to this computer: The device plays back the audio data supplied by the application server.
Do not play: The device does not play back the audio data supplied by the application server.
Leave at remote computer: The audio data will be played back on the application server.

Local devices
Connect local serial ports

☑ The device's serial interfaces can be used in the Parallels Client session.

☐ The serial interfaces cannot be used in the Parallels Client session. (Default)

Connect local smartcards

☑ The device's card reader can be used in the Parallels Client session.

☐ The card reader cannot be used in the Parallels Client session. (Default)

Connect local drives

☑ The drives connected to the device can be used in the Parallels Client session.

☐ The drives cannot be used in the Parallels Client session. (Default)

Connect local printers

☑ The printer connected to the device can be used in the Parallels Client session.

☐ The printer cannot be used in the Parallels Client session. (Default)

Connect clipboard

☑ The clipboard of the Parallels Client session can be used. (Default)

☐ The clipboard of the Parallels Client session cannot be used.
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Experience
Menu path: Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > Experience

You can enable or disable the features for the graphical display according to the bandwidth of the network 
connection.

Connection speed: Choice of graphical display modes
Possible options:

Modem 28 kbps: The RemoteFX and Adaptive RemoteFX (RDP 8.1) features are enabled.
Modem 56 kbps: The user interface design, RemoteFX and Adaptive RemoteFX (RDP 8.1) 
features are enabled.
Broadband: The menu and window animation, show window content when moving windows, 
user interface design, RemoteFX and Adaptive RemoteFX (RDP 8.1) features are enabled.
LAN: The desktop background, font smoothing, menu and window animation, show window 
content when moving windows, user interface design, RemoteFX and Adaptive RemoteFX 
(RDP 8.1) features are enabled.
Custom: The features can be enabled or disabled individually.

Desktop background

☑ The desktop background image for the session will be shown.

Font smoothing

☑ Edges will be smoothed when text is displayed.

Menu and window animation

☑ Transitions for menus and windows will be animated.

Show contents of window while dragging

☑ The window content will be shown when a window is moved.

Themes

☑ The design of the desktop can be modified.

RemoteFX

☑ Microsoft RemoteFX will be used.

Adaptive RemoteFX (RDP 8.1):

•

•

If this option is enabled, the following parameters will be set automatically:
The desktop background, font smoothing, menu and window animation, show 
window content when moving windows and user interface design features will be 
enabled internally, regardless of what is selected under Speed of the network 
connection.
The color depth will be set internally to 32 Bit, regardless of the value set under Setup > 
Parallels Client > Parallels Client Sessions > Parallels Client Session > Local Resources 
> Color Depth selection.
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☑ RemoteFX Progressive and H.264 (RDP 8.1) Parallel 2X Options are enabled.



Sessions

IGEL OS Reference Manual   270 / 710

•
•
•
•

Network
Menu path: Setup > Parallels Client > Parallels Client Sessions > [Session Name] > Network

Here, you can configure a proxy for communication between the Parallels Client and application server.

Use proxy server

☑ A proxy is used for communication between the Parallels Client and the application server.

☐ A direct network connection is used for communication between the Parallels Client and the application server. 
(default)

Proxy type: Type or protocol of the proxy used
Possible values:

SOCKS 4
SOCKS 4A
SOCKS 5
HTTP 1.1

Proxy host: URL of the proxy

Proxy port: Port of the proxy (default: 8080)

Use proxy credentials: If a proxy demands a logon, this option must be enabled and the logon data must be 
entered under Proxy user and Proxy password.

☑ The logon data in Proxy user and Proxy password will be sent to the proxy.

Proxy user: User name when logging on to the proxy

Proxy password: Password when logging on to the proxy. The password is relevant if either the “SOCKS 5” or 
“HTTP 1.1” protocol is selected as the proxy type.
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Advanced
Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > [Session Name] > Advanced

Redirect URLs to client

☑ URLs will be opened on the client.

☐ URLs will be opened on the application server. (Default)

Redirect MAIL to client

☑ E-mails will be opened on the client.

☐ E-mails will be opened on the application server. (Default)

Compression

☑ The data flow between the Parallels Client and the application server will be compressed. (Default)

☐ The data flow between the Parallels Client and the application server will not be compressed.

Use pre-windows 2000 login format

☑ Legacy login format (pre-Windows 2000) can be used. (Default)

☐ Legacy login format (pre-Windows 2000) cannot be used.

Network level authentication

☑ Network level authentication (NLA) is activated for the Parallels Client session. The client has to authenticate 
before connecting to the server. (Default)
For more information about NLA, see https://technet.microsoft.com/en-us/magazine/hh750380.aspx.

☐ Network level authentication is disabled.

Override computer name: The name entered here will override the name of the application server shown at the 
top of the session window.

Compression reduces network traffic but requires more CPU power.

https://technet.microsoft.com/en-us/magazine/hh750380.aspx
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Desktop Integration
Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > [Session Name] > Desktop 
Integration

In this area, you can configure desktop integration for the Parallels Client session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•

•

•

•

•

•

•

User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.
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•

PowerTerm Selection
Menu path: Sessions > PowerTerm Terminal Emulation > PowerTerm Selection

Here, you can choose between various versions of the PowerTerm terminal emulator in order to ensure the best 
possible compatibility with your terminal applications.

PowerTerm version

12.0.1.0.20170219.2-dev-34574

In IGEL Linux 10.x, only a single version can be selected.

Before you can use PowerTerm, you need a valid Ericom PowerTerm license, see IGEL Software License 
Overview.
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•

PowerTerm Session
Menu path: Setup > Sessions > PowerTerm Terminal Emulation > PowerTerm Session

You can configure one or more sessions for PowerTerm terminal emulation.

To edit the list, proceed as follows:

Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

You will find detailed information on configuring the PowerTerm software in the PowerTerm Interconnect Manual 
on the Ericom website11.

The configuration dialogs were designed to look as similar as possible to the setup pages described in the 
original documentation from ERICOM Software Ltd.



http://www.ericom.com/help.asp?cat=support
http://www.ericom.com/help.asp?cat=support
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Desktop Integration
Menu path: Sessions > PowerTerm Terminal Emulation > PowerTerm Sessions > [Session Name] > Desktop 
Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".
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•

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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IBM iAccess Client
Menu path: Setup > Sessions > IBM iAccess Client

IBM iAccess Client is an emulation of the IBM-5250 terminal in Java and supports numerous encodings.

 Add a session in order to be able to use the IBM iAccess Client.

 Under the Connection point under Destination address, give at least the DNS name or the IP address of a 
server. The client can also retrieve further logon information interactively.

 Under Help > Information Center in the IBM iAccess Client menu, you can read the help provided by the 
manufacturer in your browser.

_____

IBM iAccess Session (see page 280)

IBM iAccess certificates for server authentication and encryption can be distributed as files using the 
Universal Management Suite (UMS).
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IBM iAccess Session
Menu path: Sessions > IBM iAccess Client > iAccess Sessions > [Session Name]

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Connection (see page 283)
Screen (see page 286)
Preferences (see page 288)
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Connection
Menu path: Sessions > IBM iAccess Client > [session name] > Connection

Destination Address: Name or IP of the server

Destination Port: Server port (Default value: "default")

Use TLS/SSL

☑ TLS/SSL is used.

☐ TLS/SSL is not used. (Standard)

Server Authentication: Defines if the client validates the authenticity of the server when connecting.

☑ The client requires the server to authenticate itself. (Default)

☐ The client connects to the server without server authentication.

Workstation ID: Name of the client, visible to the server. This name must be unique. For more information, go to 
Help > Information Center in your iAccess client.

Screen Size

Possible values:

24x80
27x132

Host Code Page

Possible values:

1140 United States Euro
1141 Germany Euro
1141 Austria Euro
1142 Denmark Euro
...

Enable Unicode Data Stream

☑ Unicode Data Stream is enabled.

☐ Unicode Data Stream is disabled. (Default)

Enable DBCS in Unicode Fields

☑ DBCS is enabled in unicode fields.

If you leave Destination Address set to the string value "default" (default value) while Use TLS/SSL is 
enabled, port 229 is used. Without Use TLS/SSL enabled, port 23 is used. However, you are free to enter a 
custom port number.



To perform server authentication, the thin client must have the CA certificate that is associated with the 
server certificate. For instructions on how to deploy the certificate on the thin client, see Registering a File 
on the UMS Server (use IBM iAccess certificate) and Transferring a File to a Thin Client.
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☐ DBCS is disabled in unicode fields. (Default)

Auto-Connect

☑ Automatically connect to server on client startup. (Default)

Auto-Reconnect

☑ Automatically make reconnect attempt if server connection is lost. (Default)

_____

Advanced (see page 285)
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Advanced

Menu path: Setup > Sessions > IBM iAccess Client > [session name] > Connection > Advanced

Connection Timeout (seconds) (Default: 0)

Inactivity Timeout (minutes) (Default: 0)

Keepalive

☑ Keepalive is enabled.

☐ Keepalive is disabled. (Default)

Enable ENPTUI

☑ ENPTUI is enabled. (Default)

Password Prompting

Possible values:

Use default user name to prompt once for each system: The credentials preconfigured in the fields 
User ID and Password (optional) are used.
Prompt for user name and password every time
Use kerberos authentication: The credentials from the Active Directory login are used; only 
available if the user has logged in to the thin client via Active Directory. For more information, see 
Active Directory/Kerberos (see page 650).

User ID: The user ID to be used when Password Prompting is set to "Use default user name to prompt once for 
each system".

Password (optional): The password to be used when Password Prompting is set to "Use default user name to 
prompt once for each system".

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 
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Screen
Menu path: Setup > Sessions > IBM iAccess Client > [session name] > Screen

Block Cursor

☑ Show "Block" cursor. (Default)

☐ Show "Underline" cursor.

_____

Font (see page 287)
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•

Font

Menüpfad: Setup > Sessions > IBM iAccess Client > [session name] > Screen > Font

Fixed Font

☑ Use a fixed font.

☐ Use no fixed font. (Default)

Fixed Font Size

Possible values:

8
10
12
14
...
58

Font Scaling

☑ Font is scaled. (Standard)

Font Name

Possible values:

SIBM3270
Monospaced
Courier 10 Pitch
DejaVu Sans Mono
Liberation Mono
Lucida Sans Typewriter
Numbus Mono L
PComm Session
Ubuntu Mono

Font Style

Possible values:

Normal 
Bold
Italic
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Preferences
Menüpfad: Setup > Sessions > IBM iAccess Client > [session name] > Preferences

Automatic Resize

☑ Automatic window resizing is enabled. (Default)

☐ Automatic window resizing is disabled.

Show Border

☑ The session screen is framed by a border.

☐ No additional border is added. (Default)

Graphical OIA

☑ The Graphical OIA (Graphical Operator Information Area) is displayed. (Default)

☐ The Graphical OIA (Graphical Operator Information Area) is hidden.

Textual OIA

☑ The Textual OIA (Textual Operator Information Area) is displayed.

☐ The Textual OIA (Textual Operator Information Area) is hidden. (Default)

Keypad

☑ The Keypad is displayed.

☐ The Keypad is hidden. (Default)

Toolbar

☑ The toolbar is displayed. (Default)

☐ The toolbar is hidden.

Toolbar Text

☑ Textual items are added to the toolbar icons.

☐ No textual items are added to the toolbar icons. (Default)

Status Bar

☑ The status bar is displayed. (Default)

☐ The status bar is hidden.

Macro Manager

☑ The Macro Manager toolbar is displayed.

☐ The Macro Mananger toolbar is hidden. (Default)

Right Mouse Button Popup Keypad

☑ Right-clicking will bring up the the Popup Keypad.

☐ Right-clicking will bring up the default menu. (Default)

Scratch Pad
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☑ The Scratch Pad (integrated basic text editor) is displayed.

☐ The Scratch Pad (integrated basic text editor) is hidden. (Default)

'Save' in Scratch Pad

☑ The Save button in the Scratch Pad is active.

☐ The Save button in the Scratch Pad is inactive. (Default)

Quick Connect

☑ The Quick Connect toolbar is displayed.

☐ The Quick Connect toolbar is hidden. (Default)

Search Text

☑ The Search Text area is displayed.

☐ The Search Text area is hidden. (Default)

Screen History

☑ The Screen History area is displayed.

☐ The Screen History area is hidden. (Default)

History Screen Type Simple (Text)

☑ The History Screen will be displayed black and white.

☐ The History Screen will have the default terminal (green screen) look and feel. (Default)

Menu Bar

☑ The main menu bar is displayed. (Default)

☐ The main menu bar is hidden.

_____

Window (see page 290)
Start Options (see page 291)
Language (see page 292)
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Window

Menu path: Setup > Sessions > IBM iAccess Client > [session name] > Preferences > Window

Here you can define how the iAccess client application window is positioned and sized by default on start. If you 
leave the fields empty, the window will be positioned and sized automatically.

Width: Width of the window

Height: Height of the window

Horizontal offset: Horizontal offset of the window

Vertical offset: Vertical offset of the window
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Start Options

Menu path: Setup > Sessions > IBM iAccess Client > [session name] > Preferences > Start Options

Session ID

Possible values: 

Automatic
[Various alphabetic values]
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Language

Menüpfad: Setup > Sessions > IBM iAccess Client > [session name] > Preferences > Language

Emulation Language

Possible values:

Default
[Various languages]
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•

ThinLinc Global
Menu path: Sessions > ThinLinc > ThinLinc Global

In this area, you can change the global settings for ThinLinc sessions.

Server (see page 294)
Window (see page 295)
Options (see page 296)
Optimization (see page 298)
VNC Optimization (see page 299)
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Server
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Server

You can specify the port for communication between the client and server and allow remote monitoring of the 
client through shadowing.

SSH port
Possible values:

Default SSH (22): Port 22 is used.
HTTP (80): Port 80 is used.
Custom: Under Custom port number, you can enter an alternative port number.

Custom port number: Alternative port number
Allow shadowing
☑ The session can be remote monitored by shadowing via VNC.
☐ The session cannot be remote monitored by shadowing. (default)
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Window
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Window

In this area, you can define the window settings for ThinLinc sessions.

Screen size
Possible values:

"800x600"
"1024x768"
"1280x1024"
"1600x1200"
"Current monitor": The entire display area of the current monitor is used for the ThinLinc session.
"All monitors": The display area of all monitors is used for the ThinLinc session.
"Work area (maximized)": The display area of the current monitor minus the height of the taskbar 
is used for the ThinLinc session.
"Custom size": The display area specified with Custom screen width and Custom screen height is 
used for the ThinLinc session.

Custom screen width: Width of the display area for the session in pixels.

Custom screen height: Height of the display area for the session in pixels.

Full-screen mode

☑ The entire display area is used for the ThinLinc session. (Default)

Full-screen all monitor

☑ The entire display area of all monitors is used for the ThinLinc session. (Default)

Control bar for ThinLinc sessions

☑ If the ThinLinc session takes place in full-screen mode, an in-session control bar will be shown. You can 
minimize or close the session with the control bar. Further information can be found under In-Session Control 
Bar (see page 538).

☐ The in-session control bar will not be shown. (Default)
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1.
2.
3.

•
•

Options
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Options

You can change various settings and enable local directories.

Enable sound

☑ Audio output will be forwarded from the server to the device. The audio data can then be played back via the 
built-in loudspeaker or the headset.

☐ Audio output will not be forwarded to the device. (Default)

Redirect serial port

☑ The serial port data will be forwarded from the device to the server. The serial port can be used in the ThinLinc 
session.

☐ The serial port data will not be forwarded to the server. (Default)

Enable printer

☑ The local printer can be used in the ThinLinc session. (Default)

☐ The local printer cannot be used in the ThinLinc session.

Enable smartcard readers

☑ The server has access to the device’s local smartcard reader.

☐ The server does not have access to the local smartcard reader. (Default)

Enable drive access

☑ The server has access to local directories. These directories can be selected in the Exported Paths and 
Permissions area.

☐ The server does not have access to local directories. (Default)

Exported Paths and Permissions
To edit the list, proceed as follows:

Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

To select a local directory for server-side access, proceed as follows:

Click on .
In the Path field, enter the local directory path. Example: /userhome
Select the Permission that the server is to have for the directory.

Read only: The server has read rights for the directory but no write rights.
Read/write: The server has read and write rights for the directory.
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4.

Disabled: The server has no read rights and no write rights for the directory.

Click on Ok.

If you set a directory to “Disabled”, ensure that it is not a sub-directory of a directory for 
which the server has read or write rights.
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Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Optimization

You can select a suitable compression procedure in order to optimize the transmission speed between the client 
and server.

Enable custom compression level
☑ You can specify how much the data transmitted between the client and server are compressed.
☐ The default value will be used for the compression level. (default)
Compression level: Allows you to select the compression level; 9 is the highest compression 
(default: 8)
Enable JPEG compression: If this option is enabled, graphical data will be compressed using the 
JPEG procedure.

☑ Graphical data will be compressed in accordance with the JPEG procedure. (default)
JPEG quality: Allows you to select the image quality. 1 means the highest compression and the 
lowest image quality, 9 means the lowest compression and the highest image quality. (default: 7)
SSH compression
☑ The data will be compressed using SSH compression.
☐ The data will not be compressed using SSH compression. (default)

A higher JPEG compression level saves bandwidth but reduces the image quality.



Sessions

IGEL OS Reference Manual   299 / 710

•
•
•
•

•
•
•
•

VNC Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > VNC Optimization

You can change VNC protocol settings in order to optimize transmission.

VNC autoselect

☑ The preferred coding and color depth will be specified automatically. (Default)

☐ The Preferred coding and Color depth can be specified by the user.

Preferred encoding: Specifies how the data to be transmitted are to be coded. The coding is negotiated between 
the client and server.
Possible values:

"Tight": Suitable for slow networks too.
"ZRLE": Compatible with RealVNC.
"Hextile": Recommended for fast networks.
"Raw": No compression.

Color depth: Allows you to select the color resolution.
Possible values:

"Full (all colors)": The maximum value set on the server is used.
"Medium (256 colors)"
"Low (64 colors)"
"Very low (8 colors)"
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ThinLinc Session
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name]

In this area, you can configure desktop integration for the ThinLinc session.

Session name: Name for the session.

Session start options
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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________

Server (see page 303)
Window (see page 304)
Options (see page 305)
Optimization (see page 306)
VNC Optimization (see page 307)
User Interface (see page 308)
Desktop Integration (see page 309)
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Server
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Server

Server: Name or IP address of the ThinLinc server
User: User name for the connection to the ThinLinc server
Password: Password for the connection to the ThinLinc server

Use global SSH port settings
☑ The port set under Setup > Sessions > ThinLinc > ThinLinc Global > Server will be used. 
(default)
☐ The port set in SSH port or Custom port number will be used.
SSH port
Possible values:

Default SSH (22): Port 22 is used.
HTTP (80): Port 80 is used.
Custom: Under Custom port number, you can enter an alternative port number.

Custom port number: Alternative port number

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to 
store the session password on the endpoint device. 
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Window
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Window

In this area, you can define the window settings for the specific ThinLinc session.

Use global screen settings

☑ The settings under Setup > Sessions > ThinLinc > ThinLinc Global > Window will be used. (Default)

☐ The settings for this session are defined here.

Screen size
Possible values:

"800x600"
"1024x768"
"1280x1024"
"1600x1200"
"Current monitor": The entire display area of the current monitor is used for the ThinLinc session.
"All monitors": The display area of all monitors is used for the ThinLinc session.
"Work area (maximized)": The display area of the current monitor minus the height of the taskbar 
is used for the ThinLinc session.
"Custom size": The display area specified with Custom screen width and Custom screen height is 
used for the ThinLinc session.

Custom screen width: Width of the display area for the session in pixels.

Custom screen height: Height of the display area for the session in pixels.

Full-screen mode

☑ The entire display area is used for the ThinLinc session. (Default)

Full-screen all monitor

☑ The entire display area of all monitors is used for the ThinLinc session. (Default)

You can enable the in-session control bar for ThinLinc sessions only in the global settings, see Window (see 
page 295).
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Options
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Options

You can change various settings and enable local directories.

Use global shadowing settings

☑ The option Setup > Sessions > ThinLinc > ThinLinc Global > Server > Enable Shadowing will be used.

☐ The global setting Enable shadowing will not be used for this session.

Enable shadowing

☑ The session can be monitored remotely by shadowing via VNC.

☐ The session cannot be remotely monitored by shadowing. (Default)

Use global resourse settings

☑ The settings under Setup > Sessions > ThinLinc > ThinLinc Global > Options will be used. (Default)

☐ The settings for this session are defined here.

Enable sound

☑ Audio output will be forwarded from the server to the device. The audio data can then be played back via the 
built-in loudspeaker or the headset.

☐ Audio output will not be forwarded to the device. (Default)

Enable serial port

☑ The serial port data will be forwarded from the device to the server. The serial port can be used in the ThinLinc 
session.

☐ The serial port data will not be forwarded to the server. (Default)

Enable printer

☑ The local printer can be used in the ThinLinc session. (Default)

☐ The local printer cannot be used in the ThinLinc session.

Enable smartcard readers

☑ The server has access to the device’s local smartcard reader.

☐ The server does not have access to the local smartcard reader. (Default)

Enable drive access

☑ The server has access to local directories. These directories can be selected in the Exported Paths and 
Permissions area.

☐ The server does not have access to local directories. (Default)

Options popup key: Key to be used for opening the options menu during the session. (Default: F8)
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Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Optimization

You can select a suitable compression procedure in order to optimize the transmission speed between the client 
and server.

Use global compression level
☑ The global settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization > 
Use custom compression level option and Setup > Sessions > ThinLinc > ThinLinc Global > 
Optimization > Compression level selection will be used. (default)
☐ The specific settings for this session will be used.
Enable custom compression level
☑ You can specify how much the data transmitted between the client and server are compressed.
☐ The default value will be used for the compression level. (default)
Compression level: Allows you to select the compression level; 9 is the highest compression 
(default: 8)
Use global JPEG quality settings
☑ The global settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization > 
Use JPEG compression option and Setup > Sessions > ThinLinc > ThinLinc Global > 
Optimization > JPEG Quality selection will be used. (default)
☐ The specific settings for this session are defined here.
Enable JPEG compression

☑ Graphical data will be compressed in accordance with the JPEG procedure. (default)
JPEG quality: Allows you to select the image quality. 1 means the highest compression and the 
lowest image quality, 9 means the lowest compression and the highest image quality. (default: 7)
Use global SSH connection settings
☑ The global settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization > 
SSH Compression option will be used. (default)
☐ The specific setting for this session will be used.
SSH compression
☑ The data will be compressed using SSH compression.
☐ The data will not be compressed using SSH compression. (default)

A higher JPEG compression level saves bandwidth but reduces the image quality.
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VNC Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > VNC Optimization

You can change VNC protocol settings in order to optimize transmission.

Use global VNC settings

☑ The global settings under Setup > Sessions > ThinLinc > ThinLinc Global > VNC optimization will be used. 
(Default)

☐ The specific settings for this session are defined here.

VNC auto select

☑ The Preferred encoding and Color level will be specified automatically. (Default)

☐ The Preferred encoding and Color level can be specified by the user.

Preferred encoding: Specifies how the data to be transmitted are to be coded. The coding is negotiated between 
the client and server.
Possible values:

"Tight": Suitable for slow networks too.
"ZRLE": Compatible with RealVNC.
"Hextile": Recommended for fast networks.
"Raw": No compression.

Color level: Allows you to select the color resolution.
Possible values:

"Full (all colors)": The maximum value set on the server is used.
"Medium (256 colors)"
"Low (64 colors)"
"Very low (8 colors)"
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User Interface
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > User Interface

You can change the fields and settings options of the logon window as well as the ThinLinc Client Options dialog.

Lock server name
☑ The server name given under Setup > Sessions > ThinLinc Sessions > Server will be used and 
it will not be possible to change it in the logon window. (default)
Hide options button
☑ The Options button will not appear in the logon window. The ThinLinc Client Options dialog 
therefore cannot be opened. (default)
Advanced mode
☑ The fields that can be opened under Advanced will appear when starting the session.
☐ The fields that can be opened under Advanced will not appear when starting the session. 
(default)
Lock ThinLinc options tab
☑ The settings in the Options tab of the ThinLinc Client Options dialog cannot be changed. 
(default)
Lock Local Devices options tab
☑ The settings in the Local Devices tab of the ThinLinc Client Options dialog cannot be 
changed. (default)
Lock ThinLinc Screen tab
☑ The settings in the Screen tab of the ThinLinc Client Options dialog cannot be changed. 
(default)
Lock ThinLinc Optimization tab
☑ The settings in the Optimization tab of the ThinLinc Client Options dialog cannot be 
changed. (default)
Lock Security tab
☑ The settings in the Security tab of the ThinLinc Client Options dialog cannot be changed. 
(default)
Debug level: Specifies how detailed the debugging information is to be. 1 is the lowest level 
(default), 5 is the highest.
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Desktop Integration
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the ThinLinc session.

Session name: Name for the session.

Session start options
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.
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SSH Session
Menu path: Sessions > SSH > [Session Name]

You can launch applications on a remote computer via SSH (Secure Shell). The display is usually on the terminal; 
X11 connections too can be routed via SSH.

 Click on  Add to create an SSH session.

In the following area, you can configure desktop integration for the SSH session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Command (see page 315)
Options (see page 316)
Desktop Integration (see page 317)
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Command
Menu path: Sessions > SSH > [Session Name] > Command

Remote user name: User name under which the application runs on the remote computer If you do not give a 
name, you will be asked when the session starts.

Remote host: Host name or IP address of the remote computer.

Command line: Command which is to be executed on the remote computer immediately after logging in.
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Options
Menu path: Sessions > SSH > [Session Name] > Options

Here, you can change the setting for X11 forwarding, compression, and the protocol version used.

Enable X11 connection forwarding

☑ X11 applications on the remote computer that are launched via the SSH session will be shown on your device. 
(Default)

☐ No X11 programs can be launched on the remote computer via the SSH session.

Enable compression

☑ The data will be compressed for transmission.

Force protocol version 1

☑ The SSH client will force protocol version 1 for authentication. Protocol version 1 will be used when you connect 
to an old SSH server.

Force protocol version 2

☑ The SSH client will force protocol version 2 for authentication. 

Port: SSH port. (Default: 22)

Select one of the two protocol versions or none. If you select none, the system will decide which version it 
prefers.
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Desktop Integration
Menu path: Sessions > SSH > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the SSH session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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VNC Viewer Sessions
Menu path: Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name]

With the VNC viewer, you can access the graphical user interface of a remote computer.

 Click on  to create a VNC viewer session.

The settings for starting the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Connection (see page 323)
Compression (see page 324)
Input (see page 325)
Misc (see page 326)
Desktop Integration (see page 327)
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Connection
Menu path: Setup > Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Connection

Name or IP address of VNC server: Host name or IP address of the VNC server
Password: User password for logging on to the VNC server, if necessary

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to 
store the session password on the endpoint device. 
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Compression
Menu path: Setup > Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Compression

Compression level (default = 2): Allows you to select the compression level; 9 is the highest 
compression (default: 2)
JPEG quality level: Allows you to select the image quality. 1 means the highest compression and 
the lowest image quality, 9 means the lowest compression and the highest image quality. (default: 
8)
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Input
Menu path: Setup > Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Input

Here, you can change the settings for keyboard input for the VNC session.

View only
☑ Mouse and keyboard inputs are not forwarded to the remote computer. You can only observe 
the remote computer.
☐ Mouse and keyboard inputs are forwarded to the remote computer. You can remote control the 
remote computer. (default)
Pass system keys directly to the server (full-screen)
☑ You can use system key combinations in the VNC session, e.g. [Alt] + [Tab]. (default)
☐ System key combinations cannot be used in the VNC session.
Menu key: Key which brings up the menu.
Possible options (default: F8):

[F2] ... [F12]
[Pause]
[Print]
[Scroll lock]
[Esc]
[Ins]
[Del]
[Home]
[Page up] 
[Page down] 
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Misc
Menu path: Setup > Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Misc

Shared mode
☑ When starting a session, other users’ sessions with the same server are not terminated. The 
sessions run alongside each other with equal status.
☐ If another user has a VNC session with the same server, the other user’s session will be 
terminated when the session is started. (default)
Fullscreen mode
☑ The session will be shown in full-screen mode. The taskbar is not visible.
☐ The taskbar is visible. (default)
Color level: Number of possible colors
Possible values:

Default: The highest available color depth will be used.
Very low (8 colors)
Low (64 colors)
Medium (256 colors)
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Desktop Integration
Menu path: Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Browser Global
Menu path: Sessions > Browser > Browser Global

In this area, you can define the start page, display resolution and font size for the browser.

You can change the following settings:

When browser starts: Specifies what pages are shown when the browser is launched.

Start with a blank page
Show my home page (default)
Resume previous session: All tabs from the last session are reopened.

Home page: Specifies the URL of the start page. You can specify a number of start pages by separating the URLs of 
the start pages with a vertical dash "|".

Display resolution: Specifies the display resolution for the browser in DPI. Typical values are 72 for medium 
screens and 96 for large screens.
Possible values:

System setting
(Various discreet values)

Minimum font size: Specifies the minimum size of the fonts displayed on websites. The formats of the websites are 
overwritten in the process. 
Possible values:

None: The fonts can be as small as you like. (default)
(Various discreet values)

Show browser splash screen

☑ While the browser is starting, a Firefox logo will be shown in the middle of the screen. (default)

☐ No Firefox logo will be shown.

Tabs (see page 331)
Content (see page 332)
Print (see page 334)
Proxy (see page 335)
Privacy (see page 338)
Security (see page 340)
Advanced (see page 341)
Encryption (see page 344)
Smartcard Middleware (see page 346)
Commands (see page 347)
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Tabs
Menu path: Setup > Sessions > Browser > Browser Global > Tabs

In this area, you can define settings for the browser tabs.

New pages should be opened in: Specifies how links to new pages are to be opened.
Current window: The page will open in the current window, even if the link defines a new 
window as the target.
New window: If the link does not define a target, the page will open in the current window. If 
the link defines a new window as the target, the page will open in a new window. (default)
New tab: If the link does not define a target, the page will open in the current window. If the 
link defines a new window as the target, the page will open in a new tab.

Warn me when closing multiple tabs
☑ A warning will be shown as soon as you attempt to close a browser window with a number of 
tabs.
☐ No warning will be shown if you close a number of browser windows. (default)
Warn me when opening multiple tabs might slow down the browser
☑ A warning will be shown if a very large number of tabs are loaded simultaneously. (default)
☐ No warning will be shown if a very large number of tabs are loaded simultaneously.
When a link is opened in a new tab, switch to it immediately
☑ When a new tab is opened via a link, the focus will switch to the new tab.
☐ When a new tab is opened via a link, the focus will not change. (default)
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4.

5.

•
•

Content
Menu path: Sessions > Browser > Browser Global > Content

In this area, you can change settings regarding popups, JavaScript, downloads and the browser display.

Block pop-up windows

☑ The automatic opening of popup windows by websites will be blocked. With Exceptions..., you can allow 
popups to be opened automatically for specific websites.

☐ The automatic opening of popup windows will not be blocked. (default)

To add an exception for the automatic opening of popups, proceed as follows:

Click on Exceptions....
Click on .
In the Website field, give the URL of the website for which the exception is to apply.
Click on Ok.

Load images automatically

☑ Websites will be loaded fully including all images. (default)

☐ Images in websites will not be loaded; placeholders will be shown instead of the images. As a result of this, 
websites can be loaded more quickly, but the layout is impaired. With Exceptions... you can allow or prevent 
automatic loading for specific websites.

To add an exception for the automatic loading of images, proceed as follows:

Click on Exceptions....
Click on .
In the Website field, give the URL of the website for which the exception is to apply.
Using the Status drop-down menu, specify whether the automatic loading of images is to be 
allowed or prevented for the given website.
Click on Ok.

Type of download directory: Specifies the directory in which a downloaded file is saved.

User directory: The file is saved locally on the thin client desktop.
Custom path: You can specify whether the downloaded file is to be opened with an application or 
saved locally. (default)

Download path: Local directory in which the downloaded file is saved if Type of download directory is set to 
Custom path. (default: /tmp )

Enable JavaScript

☑ JavaScript code will be executed on websites. (default)

☐ JavaScript code will not be executed.

Raise or lower windows

☑ A website can place windows in the background or foreground via JavaScript. (default)

☐ Websites cannot place windows in the background or foreground via JavaScript.
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Move or resize existing windows

☑ A website can move windows or change the window size via JavaScript.

☐ Websites cannot move windows or change the window size via JavaScript. (default)

Disable or replace context menus

☑ A website can define a custom context menu via JavaScript; the browser's own context menu will be suppressed 
in the process.

☐ Websites cannot define a custom context menu.

Languages for web pages: One or more preferred languages for multilingual websites, given in the form of 
language abbreviations separated by commas. The languages should be given in the order of preference. Example: 
With de, en, fr, it , the website will be shown in German, if available, otherwise in English, etc.
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Print
Menu path: Sessions > Browser > Browser Global > Print

In this area, you can set the default paper size for the printer.

Use system settings for default paper size

☑ The globally set paper size will be used when printing websites. (Default)

☐ You can set the paper size via Default paper size.

Default paper size: Preset paper size when printing websites.
Possible values:

Letter
Legal
Executive
A5
A4
A3
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2.

Proxy
Menu path: Sessions > Browser > Browser Global > Proxy

In this area, you can change the proxy configuration.

To change the proxy configuration, proceed as follows:

In the Proxy Configuration pull-down menu, select the type of proxy configuration.
The following proxy configurations are available:

Direct connection to the Internet
Manual proxy configuration
Automatic proxy configuration
System-wide proxy configuration
Auto-detect proxy settings for this network

Enter the necessary configuration data for the selected proxy configuration.

Direct Connection to the Internet
With this proxy configuration, no proxy is used.

Manual Proxy Configuration
The configuration data must be specified in the following fields.

FTP proxy: URL of the proxy for FTP

Port: Port of the proxy for FTP

HTTP proxy: URL of the proxy for HTTP

Port: Port of the proxy for HTTP

SSL proxy: URL of the proxy for SSL

Port: Port of the proxy for SSL

SOCKS host: URL of the proxy for SOCKS

Port: Port of the proxy for SOCKS

SOCKS protocol version: Version of the SOCKS protocol used (default: SOCKS v5)

No proxy for: List of URLs for which no proxy is to be used (default: localhost, 127.0.0.1 )

Proxy realm: Area in which the browser authenticates itself for the proxy. Together with the user name and 
password, this information is necessary for authentication.

The Proxy realm field is internally pre-populated with the value moz-proxy://[HTTP Proxy]:

[Port] . If the field is empty, this value will be used when authenticating the browser. If the proxy 
expects another unknown value for the proxy realm, you can determine this as follows: Leave the User 
name and Password fields empty and launch the browser. The dialog window which appears will contain 
the correct value for the Proxy realm field:
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Use passthrough authentication: This option can be used if the local thin client logon takes place via Kerberos.

☑ The logon information saved temporarily when logging on to the thin client will be carried over when logging on 
to the proxy.

User name: User name with which the browser authenticates itself for the proxy.

Password: Password with which the browser authenticates itself for the proxy.

Do not prompt for proxy authentication if credentials are saved

☑ If logon data are already saved in the browser, the user will not be asked for a user name and password. 
(default)

Automatic Proxy Configuration
With this proxy configuration, the PAC file (Proxy Auto Config) available under URL will be used.

URL: URL of the proxy configuration file

Do not prompt for proxy authentication if credentials are saved

☑ If logon data are already saved in the browser, the user will not be asked for a user name and password. 
(default)

System-Wide Proxy Configuration
With this proxy configuration, the proxy configured under Setup > Network > Proxy will be used.

Do not prompt for proxy authentication if credentials are saved

In the example above, the value for the Proxy realm field is as follows: moz-proxy://

172.30.178.10:8080

This option should not be enabled in multiuser environments. If this option is enabled in a multiuser 
environment, a user can use the logon data of a previous user.



This option should not be enabled in multiuser environments. If this option is enabled in a multiuser 
environment, a user can use the logon data of a previous user.
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☑ If logon data are already saved in the browser, the user will not be asked for a user name and password. 
(default)

Auto-Detect Proxy Settings for This Network
With this proxy configuration, WPAD (Web Proxy Autodiscovery Protocol) will be used. The browser will determine 
the URL of the WPAD file wpad.dat  automatically with the help of DNS.

Do not prompt for proxy authentication if credentials are saved

☑ If logon data are already saved in the browser, the user will not be asked for a user name and password. 
(default)

This option should not be enabled in multiuser environments. If this option is enabled in a multiuser 
environment, a user can use the logon data of a previous user.



This option should not be enabled in multiuser environments. If this option is enabled in a multiuser 
environment, a user can use the logon data of a previous user.
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Privacy
Menu path: Sessions > Browser > Browser Global > Privacy

In this area, you can configure settings relevant to data protection.

Save browsing history (in days): Specifies how long your browsing history will be stored. If you select Do not store 
history, all browsing history data will be lost when the browser restarts. (default: 9)

Save information entered in forms and the search bar

☑ Entries in forms and search bars will be retained after the browser restarts.

☐ Entries in forms and search bars will be retained only for the duration of the session. (default)

Remember passwords

☑ Passwords entered will be retained after the browser restarts.

☐ Passwords entered will be retained only for the duration of the session. (default)

Clear private data when closing browser

☑ Data entered will be deleted when the browser is closed. What data are deleted is specified in the following 
options.

☐ Data entered will not be deleted when the browser is closed. (default)

Select the Items to Be Cleared
The options in this area are effective if Clear private data when closing browser is enabled.

Browsing & download history

☑ Addresses (URLs) of visited websites and the list of downloads will be deleted when the browser is closed. 
(default)

Form & search history

☑ Entries in the search window and in website forms will be deleted when the browser is closed. (default)

Saved passwords

☑ Passwords entered will be deleted when the browser is closed.

☐ Passwords entered will be retained after the browser restarts. (default)

Cookies

☑ Cookies will be deleted when the browser is closed. (default)

Cache

☑ The cache for temporarily saving websites will be emptied when the browser is closed. (default)

Active logins

All browsing history data stored before the period specified here will be lost.
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☑ Ongoing sessions on websites will be terminated when the browser is closed and will need to be restarted after 
the browser restarts. (default)

☐ Ongoing sessions on websites will be retained after the browser restarts.

Allow private browsing feature

☑ You can open one or more private windows in the browser. All data from private windows will be deleted after 
the browser is closed.

☐ Private windows cannot be opened. (default)

Always start in private browsing mode

☑ The browser will start in private mode. All data will be deleted after the browser is closed.

☐ The browser will start in default mode. (default)

Enable "Do Not Track" feature

☑ The browser will inform the website you are visiting that you do not wish to be tracked, i.e. you do not want your 
surfing history to be recorded. (default)

Enable built-in tracking protection

☑ The browser will block specific domains and websites that use tracking. The browser has an internal list for 
selecting the domains and websites to be blocked. (default)

Suggest visited sites in URL bar

☑ Suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on 
previously visited websites which are stored in the history. (default)

Suggest only typed visited sites

☑ The suggestions will be based only on the websites that were typed directly into the address bar. Websites that 
were visited via bookmarks or links in other websites will not be used for the suggestions.

☐ Websites that were visited via bookmarks or links in other websites will also be used for the suggestions. (default)

Suggest bookmarked sites in URL bar

☑ Suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on 
bookmarks. (default)

Suggest open tabs in URL bar

☑ Suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on 
previously opened tabs. (default)

The browser will use the DNT  ("Do Not Track") field in the HTTP header for this purpose. Observing this 
setting is voluntary; from a technical point of view, websites can still record the surfing history even when 
DNT  is set to 1.



If tracking protection is enabled, a shield symbol will be shown at the left-hand edge of the address bar.
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Security
Menu path: Sessions > Browser > Browser Global > Security

In this area, you can define settings for preventing phishing and malware.

Safe browsing

☑ The browser will check each address entered as to whether it can be found in the black list of fraudulent 
websites which use phishing. If this is the case, you will be given a warning.

☐ The browser will not check whether an address is on the black list of fraudulent websites. (default)

Malware protection

☑ The browser will check before a file is downloaded whether the relevant website can be found in the black list of 
fraudulent websites which provide malware for downloading. If this is the case, you will be given a warning.

☐ The browser will not check whether an address is on the black list of fraudulent websites which provide malware 
for downloading. (default)
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Advanced
Menu path: Sessions > Browser > Browser Global > Advanced

In this area, you can change various settings as well as add or change custom configuration parameters.

You can change the following settings:

Use old search bar

☑ The logo of the search engine currently set will be shown in the search window.

☐ The search engine currently set will not be shown in the search window, and search suggestions will be shown in 
the drop-down menu. (default)

Caret browsing on browser start

☑ Caret browsing is enabled when the browser starts. If caret browsing is enabled, you can navigate with the 
keyboard in websites without using the mouse. With the insertion mark, you can copy text to the clipboard.

☐ Caret browsing is not enabled when the browser starts. (default)

Find as you type

☑ Search suggestions that match the characters typed will be shown while you type.

☐ No search suggestions will be shown while you type. (default)

Warn me when websites try to redirect or reload the page

☑ A message window will be shown as soon as a website tries to get the browser to load another website or reload 
the current page.

☐ No message window will be shown if a website tries to load another website or reload the current page. (default)

Check my spelling as I type
Possible options:

"Off": Your spelling will not be checked while you type.
"On for text fields": Your spelling will be checked if you are typing in text fields with multiple lines. 
(default)
"On for text fields and lines": Your spelling will be checked if you are typing in text fields with one 
line or multiple lines.

Use autoscrolling

☑ You can launch automatic page scrolling by clicking on the middle mouse button to place a scroll symbol in the 
text and then positioning the mouse pointer above or below the anchor.

☐ Autoscrolling is disabled. (default)

Use smooth scrolling

☑ You can browse through a page using the [Page Up/Down] keys smoothly as with scrolling.

You can enable or disable caret browsing at any time by pressing [F7]. To prevent caret browsing being 
disabled, you will also need to enable the Setup > Sessions > Browser > Browser Sessions > [Session 
Name] > Settings > Hotkeys > Disable Hotkeys for Starting Caret Browsing option.
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☐ When you press the [Page Up/Down] keys, the display will jump immediately. (default)

Disable GStreamer in Browser

☑ GStreamer will not be used to play back videos. This may be a good idea if you experience problems when 
playing back videos.

☐ GStreamer will be used to play back videos.

Disable OpenGL acceleration

☑ Hardware acceleration with OpenGL will not be used. This may be a good idea if you experience problems with 
OpenGL applications.

To add a custom preference, proceed as follows:

Custom Preferences
In this area, you can add custom preferences.

 Click  to get to the Add dialogue.

In the Add dialogue, you can define the following settings:

Active: Defines whether the preference is active.

☑ The preference is active. (Default)

☐ The preference is not active.

Mode: The mode of the preference.
Possible values:

"pref": You can change the value in the browser via about:config . When the browser restarts, 
this change will be lost and the value set here will be used.
"defaultPref": You can change the value in the browser via about:config . When the browser 
restarts, this change will remain.
"lockPref": You cannot change the value in the browser via about:config .

We recommend that you disable this option if there is no multimedia codec pack installed on your thin 
client and you wish to view videos on HTML5 websites.



Changes to the advanced Firefox browser settings can impair its stability, security and speed. IGEL Support 
is not responsible for problems caused by changing the browser configuration, even if the browser 
configuration was changed in the IGEL setup.



Custom preferences can also be changed in the browser via about:config . To do this, the Browser 
Sessions > [Session Name] > Window Settings > Hide Browser Configuration Page option must be 
disabled.
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"clearPref": You cannot change the value in the browser via about:config  and the value will 

not be shown via about:config.

Custom preference: The name of the custom preference. Example: ui.textSelectBackground

Type: The type of the custom preference. 
Possible values:

"String": The value is a string of characters.
"Integer": The value is a whole number.
"Boolean": The value is a Boolean value, i.e. true  or false .

Value: The value of the custom preference. The possible entries depend on the Type selected.

 Click Ok to add the custom preference.
The custom preference will take effect the next time that the browser is launched.

You will find information regarding custom preferences in Firefox in the MozillaZine Knowledge Base under Firefox 
About:config entries12.

http://kb.mozillazine.org/About:config_entries
http://kb.mozillazine.org/About:config_entries
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Encryption
Menu path: Setup > Sessions > Browser > Browser Global > Encryption

In this area, you can define the settings for encryption methods and certificate validation.

Minimum required encryption protocol: This protocol will be used to establish a secure 
connection if no higher protocol is available. Higher protocols are preferred.
Possible options:

SSL3
TLS 1.0
TLS 1.1
TLS 1.2

Maximum supported encryption protocol: This protocol is requested when negotiating the 
connection. If this protocol is not available, the next lowest protocol will be requested.
Possible options:

SSL3
TLS 1.0
TLS 1.1
TLS 1.2

When a website requests a certificate: Specifies how the browser behaves if a website requests a 
security certificate.
Possible values:

Select one automatically: The browser selects a certificate automatically. (default)
Ask me every time: A dialog window requesting the certificate will be displayed.

View certificates: If you click on this button, the certificates saved in the browser's Certificate 
Manager will be displayed.
Certificate validation: Specifies the validation of certificates using OCSP (Online Certificate Status 
Protocol).

Do not use OCSP for certificate validation: The certificate will not be validated using OCSP.
Validate a certificate if it specifies an OCSP server: The certificate will be validated with the 
OCSP server specified in the certificate. If no OCSP server is specified, no certificate 
validation will take place. (default)
Validate all certificates with the following OCSP server: All certificates will be validated with 
the OCSP server specified under the Service URL, irrespective of which OCSP server is 
specified in the certificate.

Response signer: Signer of the response from the OCSP server
Service URL: URL of the OCSP server
When an OCSP server connection fails, treat the certificate as invalid:
☑ If, owing to a failed connection to the OCSP server, no validation can take place, the certificate 
will be treated as invalid. In this case, the browser will show the “This connection is not trusted” 
error message.
☐ The certificate will not be deemed invalid if no check can take place because there is no 
connection to the OSCP server. (default)
Gemalto/SafeNet eToken security device
☑ Gemalto/SafeNet eToken will be used for encryption.
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☐ Gemalto/SafeNet eToken will not be used for encryption. (default)
cryptovision sc/interface security device
☑ cryptovision sc/interface will be used for encryption.
☐ cryptovision sc/interface will not be used for encryption. (default)
Gemalto IDPrime security device
☑ Gemalto IDPrime will be used for encryption.
Athena IDProtect security device
☑ Athena IDProtect will be used for encryption.
☐ Athena IDProtect will not be used for encryption. (default)
A.E.T. SafeSign security device
☑ A.E.T. SafeSign will be used for encryption.
☐ A.E.T. SafeSign will not be used for encryption. (default)
SecMaker Net iD security device
☑ SecMaker Net iD will be used for encryption.
☐ SecMaker Net iD will not be used for encryption. (default)
Coolkey Security Devices
☑ Coolkey will be used for encryption.
☐ Coolkey will be not used for encryption. (Standard)
OpenSC Security Device
☑ OpenSC will be used for encryption.
☐ OpenSC will not be used for encryption. (Standard)
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Smartcard Middleware
Menu path: Sessions > Browser > Browser Global > Smartcard Middleware
In this area, you can activate or deactivate smartcard middleware that is to be used for encryption.
Gemalto SafeNet security device

☑ Gemalto/SafeNet eToken will be used for encryption.

☐ Gemalto/SafeNet eToken will not be used for encryption. (Default)

cryptovision sc/interface security device

☑ cryptovision sc/interface will be used for encryption.

☐ cryptovision sc/interface will not be used for encryption. (Default)

Gemalto IDPrime security device

☑ Gemalto IDPrime will be used for encryption. Enable this Gemalto middleware when you want to operate 
Gemalto Common Criteria devices in unlinked mode.

☐ Gemalto IDPrime will not be used for encryption. (Default)

Athena IDProtect security device

☑ Athena IDProtect will be used for encryption.

☐ Athena IDProtect will not be used for encryption. (Default)

A.E.T. SafeSign security device

☑ A.E.T. SafeSign will be used for encryption.

☐ A.E.T. SafeSign will not be used for encryption. (Default)

SecMaker Net iD security device

☑ SecMaker Net iD will be used for encryption.

☐ SecMaker Net iD will not be used for encryption. (Default)

Coolkey security device

☑ Coolkey will be used for encryption.

☐ Coolkey will be not used for encryption. (Default)

OpenSC security device

☑ OpenSC will be used for encryption.

☐ OpenSC will not be used for encryption. (Default)
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2.

Commands
Menu path: Sessions > Browser > Browser Global > Commands

In this area, you can define start options for browser commands.

The following commands are available:

Restart Browser

To open the dialogue for defining start options, proceed as follows:

Select the command. Example: Restart Browser
Click Modify...

The following start options are available:

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Browser Session
Menu path: Sessions > Browser > Browser Sessions > [Session Name]

In this area, you can configure desktop integration for the browser session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Settings (see page 352)
Window (see page 362)
Menus & Toolbars (see page 363)
Hotkeys (see page 366)
Context (see page 367)
Desktop Integration (see page 368)
Plugins (see page 371)
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Settings
Menu path: Browser > Browser Sessions > [Session Name] > Settings

In this area, you can define the start page, display resolution and font size for the browser.

You can change the following settings:

When browser starts: Specifies what pages are shown when the browser is launched.
Global setting
Start with a blank page
Show my home page
Resume previous session: All tabs from the last session are reopened.

Home page: Specifies the URL of the start page. You can specify a number of start pages by 
separating the URLs of the start pages with a vertical dash "|".
Display resolution: Specifies the display resolution for the browser in DPI. Typical values are 72 
for medium screens and 96 for large screens.
Possible values:

Global setting
System setting
(Various discreet values)

Minimum font size: Specifies the minimum size of the fonts displayed on websites. The formats of 
the websites are overwritten in the process.
Possible values:

Global setting
None: The fonts can be as small as you like. (default)
(Various discreet values)

Tabs (see page 353)
Content (see page 354)
Print (see page 355)
Proxy (see page 356)
Privacy (see page 357)
Security (see page 358)
Advanced (see page 359)
Encryption (see page 360)
Restart (see page 361)
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Tabs
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Tabs

In this area, you can define settings for the browser tabs.

You will find a description under the global settings, see Tabs (see page 331).
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Content
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Content

In this area, you can change settings regarding popups, JavaScript, downloads and the browser display.

You will find a description under the global settings, see Content (see page 332).

Exceptions for the blocking of popups and for the automatic loading of images can only be defined in the 
global settings.
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Print
Menu path: Setup > Browser > Browser Sessions > [Session Name] > Settings > Print

In this area, you can set the default paper size for the printer.

You will find a description under the global settings, see Printing (see page 334).
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Proxy
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Proxy

In this area, you can change the proxy configuration.

You will find a description under the global settings, see Proxy (see page 335).
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Privacy
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Privacy

In this area, you can configure settings relevant to data protection.

You will find a description under the global settings, see Data Protection (see page 338).
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Security
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Security

In this area, you can define settings for phishing and malware.

You will find a description under the global settings, see Security (see page 340).
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Advanced
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Advanced

In this area, you can change various settings.

You will find a description under the global settings, see Advanced (see page 341).

Custom configuration parameters can only be added and OpenGL acceleration disabled in the global 
settings.
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Encryption
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Encryption

In this area, you can define the settings for encryption methods and certificate validation.

You will find a description under the global settings, see Encryption (see page 344).
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Restart
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Restart

In this area, you can specify whether the browser automatically starts and whether it is automatically restarted 
after being closed and after what delay time.

Autostart
☑ The browser starts automatically when the thin client starts.
☐ The browser does not start automatically when the thin client starts. (default)
Restart
☑ The browser automatically restarts if it was closed.
☐ The browser does not automatically restart if it was closed. (default)
Restart after idle time: This function is available from IGEL Linux Version 10.02.
☑ If no action on the part of the user has occurred after the idle time has elapsed, the browser will 
automatically be restarted.
☐ There will be no automatic restart after a specific idle time has elapsed. (default)
Idle time after which a restart occurs: Time interval after which the browser is automatically 
restarted if in the meantime no action on the part of the user has occurred. (default: 5) 
The time unit can be selected under Unit.
Unit: Time interval for the idling time
Possible options:

Minutes
Seconds
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Window
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Window

In this area, you can define the window settings for a browser session.

Start in fullscreen mode
☑ The browser will start in fullscreen mode.
☐ The browser will start in a standard window. (default)
Start monitor: Specifies the monitor on which the browser window is shown when the browser 
starts.
Possible options:

No configuration: The browser window will be shown on the monitor that is currently in 
focus, i.e. the one with the mouse pointer.
1st monitor
2nd monitor

Firefox translation: Language of the user interface
Possible values:

System setting: The language set under Setup > User Interface > Language > Language 
will be used for the browser. (default)
English
German
French
Dutch
Spanish
Italian

Hide local filesystem
☑ The local file system will not be shown in the dialogs for saving data. The user cannot change 
the location for saving files.
☐ The local file system will be shown in the dialogs for saving data. (default)
Hide configuration page of the browser
☑ The browser configuration page ( about:config ) is locked. As a result, the user cannot 
change the configuration. (default)
☐ The browser configuration page ( about:config ) can be used.
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Menus & Toolbars
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Menus & Toolbars

In this area, you can change the browser’s menus and toolbars.

Hide app menu/menu bar
☑ The button for opening the browser menu will not be shown.
☐ The button for opening the browser menu will be shown. (default)
Use old menu bar
☑ The browser menu will be shown in the menu bar as in earlier browser versions.
☐ The browser menu can be opened via a button. (default)

Hide the following elements in app menu/menu bar

Hide bookmarks menu
☑ The bookmarks menu will not be shown in the menu bar.
☐ The bookmarks menu will be shown in the menu bar. (default)
Hide tools menu
☑ The “Tools” menu will not be shown.
☐ The “Tools” menu will be shown. (default)
Hide history entry
☑ The button for showing the browser history will not be shown.
☐ The button for showing the browser history will be shown. (default)
Hide tabs toolbar
☑ The tabs will not be shown in the menu bar. The user cannot switch between a number of tabs.
☐ The tabs will be shown in the menu bar. (default)
Hide bookmarks toolbar
☑ The bookmarks toolbar will not be shown. (default)
☐ The bookmarks toolbar will be shown.
Hide sidebar
☑ The sidebar will not be shown.
☐ The sidebar will be shown. The bookmarks can be shown in the sidebar. (default)
Hide navigation toolbar
☑ The navigation bar will not be shown.
☐ The navigation bar will be shown. (default)
Hide the toolbar for searching the page
☑ The search bar will not be shown.
☐ The search bar will be shown. (default)

Toolbar Items

Hide URL input
☑ Only search terms can be entered in the entry field; URLs cannot be entered manually.
☐ Both search terms and URLs can be entered in the entry field. (default)
Hide "Print" button
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☑ The button for printing websites will not be shown.
☐ The button for printing websites will be shown. (default)
Hide "Home" button
☑ The Home button will not be shown.
☐ The Home button will be shown. (default)
Hide "Search" input
☑ The search field will not be shown.
☐ The search field will be shown. (default)
Hide “Bookmarks” and “RSS Feed” button
☑ The button for displaying bookmarks and RSS feeds will not be shown.
☐ The button for displaying bookmarks and RSS feeds will be shown. (default)
User customization of toolbars
☑ The user can customize the toolbars. (default)
☐ The user cannot customize the toolbars.
Navigation toolbar: Specifies which symbols are shown in the navigation toolbar and the 
application menu. The symbols are given as follows; multiple symbols should be separated by 
commas “,”:

loop-button

zoom-controls

edit-controls

history-panelmenu

privatebrowsing-button

save-page-button

find-button

open-file-button

developer-button

sidebar-button

feed-button
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print-button

characterencoding-button

social-share-button

panic-button

web-apps-button

new-window-button

fullscreen-button

tabview-button

downloads-button
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Hotkeys
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Hotkeys

In this area, you can disable Firefox hotkeys.

Disable hotkey Quit/Close
☑ The hotkey for terminating/closing the browser is disabled.
☐ The hotkey for terminating/closing the browser is enabled. (default)
Disable hotkey for print dialog
☑ The hotkey for opening the print dialog is disabled.
☐ The hotkey for opening the print dialog is enabled. (default)
Disable hotkey for save page
☑ The hotkey for saving a website is disabled.
☐ The hotkey for saving a website is enabled. (default)
Disable hotkeys for opening new window/tab
☑ The hotkey for opening a new window or tab is disabled.
☐ The hotkey for opening a new window or tab is enabled. (default)
Disable hotkeys for opening a new webpage/location and download window
☑ The hotkey for opening a new website/location and the download window is disabled.
☐ The hotkey for opening a new website/location and the download window is enabled. (default)
Disable hotkeys to show history and page info
☑ The hotkey for showing the history and page information is disabled.
☐ The hotkey for showing the history and page information is enabled. (default)
Disable hotkeys for creating bookmarks
☑ The hotkey for creating a bookmark is disabled.
☐ The hotkey for creating a bookmark is enabled. (default)
Disable hotkeys for opening help pages
☑ The hotkey for displaying help is disabled.
☐ The hotkey for displaying help is enabled. (default)
Disable hotkeys for starting caret browsing
☑ The hotkey for starting caret browsing is disabled.
☐ The hotkey for starting caret browsing is enabled. (default)
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Context
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Hotkeys

In this area, you can disable various items in the browser context menu.

Disable navigation elements in context menu
☑ The navigation elements will not be shown in the context menu.
☐ The navigation elements will be shown in the context menu. (default)
Disable button for save page
☑ The button for saving a page will not be shown in the context menu.
☐ The button for saving a page will be shown in the context menu. (default)
Disable button for open new window/tab
☑ The button for opening a new window/tab will not be shown in the context menu.
☐ The button for opening a new window/tab will be shown in the context menu. (default)
Disable button for show info/source
☑ The button for showing page information/page source text will not be shown in the context 
menu.
☐ The button for showing page information/page source text will be shown in the context menu. 
(default)
Disable button for creating and editing bookmarks
☑ The button for creating and editing bookmarks will not be shown in the context menu.
☐ The button for creating and editing bookmarks will be shown in the context menu. (default)
Disable button for searching the web
☑ The button for searching the web will not be shown in the context menu.
☐ The button for searching the web will be shown in the context menu. (default)
Hide the browser's contextmenu
☑ The context menu will not be shown.
☐ The context menu will be shown. (default)
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Desktop Integration
Menu path: Sessions > Browser > Browser Sessions > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the Firefox browser session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Plugins
Menu path: Setup > Sessions > Browser > Plugins

The following plugins are available:

Adobe Flash Player 2
RHEV/Spice

The plugin may need to be licensed.

You can configure the browser plugin for the media player under Setup > Sessions > Media Player > Media Player 
Global > Browser Plugin.

To obtain an overview of the plugins available in the browser, proceed as follows:

 Click on the About:Plugins button.
The browser will start with the about:plugins  page. The plugins available in the browser will be shown.

_____

Flashplayer (see page 372)
RHEV/Spice (see page 374)
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Flashplayer
Menu path: Setup > Sessions > Browser > Plugins > Flashplayer

Before you can download and install Adobe Flash Player, you need to confirm the licensing of the software. IGEL 
Linux does not include a license for using the Flash Player.

 Enable the option I will license the Flash Player myself in order to enable Setup > Sessions > Browser > 
Browser Sessions > [Session Name] > Plugins > Flash Player > Download Flash Player.

_____

Download Flashplayer (see page 373)
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2.
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•
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3.

Download Flashplayer

Menu path: Setup > Sessions > Browser > Plugins > Flash Player > Download Flashplayer

To install Adobe Flash Player, proceed as follows:

Enable the option I want to update to the current Flash Player and care for the license by 
myself.
Configure the following settings:

Use firmware update settings for download
☑ The parameters User authentication, User name, Password and Download URL
receive the preset values and cannot be changed.
☐ The parameters User authentication, User name, Password and Download URL are set 
here. (default)
User authentication
☑ The thin client authenticates itself on the server with the access data given under User 
name and Password.
☐ No automatic user authentication. (default)
Download URL: URL of the directory in which the file for the Adobe Flash Player is located. 
(default: The official link from Adobe) Alternatively, you can specify the location in your 
company network.

Download file: Name of the file that contains the Adobe Flash Player.
Click on Apply or OK.
The Adobe Flash Player will be downloaded and installed.

You can also launch the installation with the UMS context menu. In the context menu, select Other Thin 
Client Commands > Download Flash Player.



At the time of firmware publication, the Adobe link is correct. However, it may change. If 
the download fails, change the URL accordingly.
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RHEV/Spice
Menüpfad: Setup > Sessions > Browser > Plugins > RHEV/Spice

Enable Browser plugin
☑ An RHEV/Spice session can be started via the browser. Here, the browser serves as a wrapper 
for the RHEV/Spice client.
☐ It is not possible to start an RHEV/Spice session via the browser. (default)
Enable USB Sharing
☑ Data from USB devices connected to the thin client are redirected to the server. (Standard)
☐ Data from USB devices connected to the thin client are not redirected.
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Media Player Global
Menu path: Setup > Sessions > Media Player > Media Player Global

Here, you can change the global settings for the thin client’s media player.

_____

Window (see page 376)
Playback (see page 377)
Video (see page 378)
Audio (see page 379)
Options (see page 380)
Browser Plugin (see page 381)
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Window
Menu path: Setup > Sessions > Media Player > Media Player Global > Window

Aspect ratio: Aspect ratio for video playback
Possible values:

Auto: The aspect ratio of the playback window will adapt to the video being played.
Square
4:3 (TV)
16:9 (widescreen)
2.11:1 (DVB)

Fullscreen
☑ The media player will be shown in full-screen mode.
☐ The media player will be shown in a standard window. (default)
Automatically resize the player window when a new video is loaded
☑ The window size will adapt to the video being played.
☐ The window size will not change. (default)
Main window should stay on top
☑ The media player window will always remain in the foreground. Other windows cannot be 
placed on top of the media player window.
☐ The media player window will behave like a standard window. Other windows can be placed on 
top of the media player window. (default)
Show controls
☑ The media player operating components will be shown. (default)
☐ The media player operating components will not be shown; only the playback window is visible.
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Playback
Menu path: Setup > Sessions > Media Player > Media Player Global > Playback

Repeat mode
☑ The playlist will be repeated until the user stops playback.
☐ The playlist will be played back once only. (default)
Shuffle mode
☑ The playlist will be played back in a random order.
☐ The playlist will be played back in the set order. (default)
Show visual effects when an audio file is played
☑ Visual effects will be shown when playing back audio data.
☐ No visual effects will be shown. (default)
Type of visualization: The type of visual effects when playing back audio data
Possible values:

Monoscope
Goom!

Visualization size: The size of the visual effects shown
Possible values:

Small
Normal
Large
Extra large
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Video
Menu path: Setup > Sessions > Media Player > Media Player Global > Video

Video output: Specifies the video output method.
Possible options:

Auto: The video output method will be set depending on availability. The following options 
will be queried in this order. Examples: If available, hardware acceleration will be used. If 
hardware acceleration is not available but the X video extension is, the X video extension 
will be used.
Hardware accelerated: Hardware acceleration will be used.
X video extension: The images will be written to the graphics card memory using shared 
memory. Hardware acceleration will be used.
X Window System: Video will be output via the X11 protocol. Hardware acceleration will not 
be used.
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Audio
Menu path: Setup > Sessions > Media Player > Media Player Global > Audio

Audio output type: Specifies via which output audio is to be delivered. The setting depends on the 
hardware used.
Possible values:

Stereo: Audio is delivered via the stereo output. This option is suitable if you work with an 
IGEL thin client.
4 channel output
4.1 channel output
5.0 channel output
5.1 channel output
AC3 passthrough: Audio is delivered digitally via an S/PDIF output if available.
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Options
Menu path: Setup > Sessions > Media Player > Media Player Global > Options

Disable screensaver when playing audio
☑ The screensaver will not be started during audio playback. (default)
☐ The screensaver will start after the set idling time, even is audio is being played back.
Network connection speed
Possible values:

56 kBps modem/ISDN
112 kBps dual ISDN/DSL
256 kBps DSL/cache
384 kBps DSL/cache
512 kBps DSL/cache
1.5 MBps T1/Intranet/LAN
Intranet/LAN

Buffer size: The buffer compensates for fluctuations in the network speed. (default: 3)
Autoload subtitle
☑ Subtitles contained in the video will be shown automatically. (default)
☐ Subtitles contained in the video will only be shown if the user has enabled them via View > 
Subtitles.
Subtitle encoding: Character coding for the subtitles. The value is set to UTF-8.
Font name: Font that is used for the subtitles
Possible values:

Sans
Sans Bold
Serif
Serif Bold

Font size: Size of the font that is used for the subtitles (default: 20)
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Browser Plugin
Menu path: Setup > Sessions > Media Player > Media Player Global > Browser Plugin

In this area, you can configure video output for the media player browser plugin.

Video output: Specifies the video output method.
Possible values:

Default: The setting under Setup > Sessions > Media Player > Media Player Global > Video
will be used.
Auto: The video output method will be set depending on availability. The following options 
will be queried in this order. Examples: If available, hardware acceleration will be used. If 
hardware acceleration is not available but the X video extension is, the X video extension 
will be used.
Hardware accelerated: Hardware acceleration will be used.
X video extension: The images will be written to the graphics card memory using shared 
memory. Hardware acceleration will be used.
X Window System: Video will be output via the X11 protocol. Hardware acceleration will not 
be used.

Aspect ratio: Aspect ratio for video playback
Possible values:

Default: The setting under Setup > Sessions > Media Player > Media Player Global > 
Window will be used.
Auto: The aspect ratio of the playback window will adapt to the video being played.
Square:
4:3 (TV)
16:9 (widescreen)
2.11:1 (DVB)
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Media Player Session
Menu path: Sessions > Media Player > Media Player Sessions > [session name]

In this area, you can configure desktop integration for the media player.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

                  

Playback (see page 385)
Options (see page 386)
Desktop Integration (see page 387)
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Playback
Menu path: Setup > Sessions > Media Player > Media Player Sessions > [Session Name] > Playback

In this area, you can specify which audio data or video data are played back with which window settings when the 
media player session starts.

Medium / filename: Path to the audio data or video data that are to be played back when the 
media player session starts. This can be a local path or a URL.
Use default fullscreen mode configuration
☑ The setting under Setup > Sessions > Media Player > Media Player Global > Window will be 
used. (default)
☐ The setting will be set on a session-specific basis with Play video in fullscreen.
Play video in fullscreen
☑ The media player will be shown in fullscreen mode.
☐ The media player will be shown in a standard window. (default)
Use image aspect ratio setting
☑ The setting under Setup > Sessions > Media Player > Media Player Global > Window will be 
used. (default)
☐ The setting will be set on a session-specific basis with Aspect ratio.
Aspect ratio: Aspect ratio for video playback
Possible values:

Auto: The aspect ratio of the playback window will adapt to the video being played.
Square
4:3 (TV)
16:9 (widescreen)
2.11:1 (DVB)



Sessions

IGEL OS Reference Manual   386 / 710

•

•

Options
Menu path: Setup > Sessions > Media Player > Media Player Sessions > [Session Name] > Options

Use default controls configuration
☑ The setting under Setup > Sessions > Media Player > Media Player Global > Window will be 
used. (default)
☐ The setting will be set on a session-specific basis with Show controls.
Show controls
☑ The media player operating components will be shown. (default)
☐ The media player operating components will not be shown; only the playback window is visible.
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Desktop Integration
Menu path: Sessions > Media Player > Media Player Sessions > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the media player.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)





Sessions

IGEL OS Reference Manual   389 / 710

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Java Session
Menu path: Setup > Sessions > JWS Sessions

You can set up one or more Java Web Start sessions. This can be for example an IGEL UMS console running as Java 
Web Start.

To set up a Java Web Start session, proceed as follows:

In the JWS Sessions area, click on .
A new Java Web Start session will be created.
Configure the Java Web Start session. You will find further information under Java Web Start (see 
page 391).

_____

Java Web Start (see page 391)
Desktop Integration (see page 392)
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Java Web Start
Menu path: Setup > JWS Sessions > [Session Name] > Java Web Start

In this area, give the address of the JNLP file which is needed for launching the Java Web Start session. The file is 
loaded to the cache before being executed.

JNLP file: Address of the JNLP file. Example: http://www.server.com/example.jnlp

The browser's global proxy settings are used when downloading the JNLP file. You will find a description of 
these proxy settings under Browser Proxy (see page 335). If a proxy is to be used only for the browser but not 
for the Java Web Start session, give the address of the JNLP file under Setup > Sessions > Browser > 
Browser Global > Proxy > No proxy for.
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Desktop Integration
Menu path: Setup > Sessions > JWS Sessions > [Session Name] > Desktop Integration

You can configure one or more Java Web Start sessions.

The settings for launching the session are described below.

Session name: Name for the session

Session start options

Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Autostart requires network

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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☑ If no network is available at system startup, the session is not started. A message is shown. As 
soon as the network is available, the session is started automatically.
☐ The session is started automatically, even when no network is available.
Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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VoIP Client
Menu path: Sessions > VoIP Client

Ekiga Voice over IP client allows you to use the SIP (Session Initiation Protocol) and H.323; see http://ekiga.org13.

You will find a detailed description of all Ekiga options under http://wiki.ekiga.org/index.php/Manual.

In this area, you can configure desktop integration for the VoIP session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



http://ekiga.org/
http://ekiga.org/
http://wiki.ekiga.org/index.php/Manual
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[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Account (see page 396)
Audio (see page 398)
SIP (see page 399)
H.323 (see page 400)
Call Options (see page 401)
Phone Book (see page 402)
Preferences (see page 403)
Desktop Integration (see page 404)

When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Account
Menu path: Setup > Sessions > VoIP Client > User Account

You can set up or change one or more user accounts as well as specify the name displayed.

Full Name: Name of the user; this name will be shown to the other person. Example: John Doe

To set up an SIP user account, proceed as follows:

Click .
If the user account is to be active once set up, enable the Enable Account option.
Enter the following data:

Protocol: Select SIP.
Name: Name for this user account.

Registrar: URI with which the VoIP client registers. This can be a DNS name or an IP address.
User name: Numerical or alphanumerical value. The user name is part of the SIP address. 
Example: john.doe  in john.doe@example.com
Login Name: Numerical or alphanumerical value. Name with which the VoIP client registers 
on the registrar. This name can differ from the name given under user name.
Password: Password with which the VoIP client registers on the registrar
Registration Update Timeout: Timeout after which the registration should be updated 
(default: 3600)

Click Ok.
The user account has been set up.

To set up an H.323 user account, proceed as follows:

Click .
If the user account is to be active once set up, enable the Enable Account option.
Enter the following data:

Protokoll: Wählen Sie H323.
Name: Name für dieses Benutzerkonto.

Ensure that the VoIP client was terminated before you start setting up or changing a user account. 
Changes will only be saved if the client is not running.



Choose a name which allows a distinction to be made easily between a number of user 
accounts.



Ensure that the VoIP client was terminated before you start setting up or changing a user account. 
Changes will only be saved if the client is not running.
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Gatekeeper: URI with which the VoIP client registers. This can be a DNS name or an IP 
address.
User name: Numerical or alphanumerical value. Example: john.doe  in 

john.doe@example.com
Passwort: Password with which the VoIP client logs on to the registrar
Registration Update Timeout: Timeout after which the registration should be updated 
(default: 3600)

Click Ok.
The user account has been set up.

Choose a name which allows a distinction to be made easily between a number of user 
accounts.
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Audio
Menu path: Setup > Sessions > VoIP Client > Audio

You can change the audio settings of the VoIP client.

To configure the audio devices in the VoIP client, proceed as follows:

In the IGEL setup, ensure that the option Save configuration changes made in the application is 
enabled under Sessions > VoIP Client > Preferences.
Start the VoIP client.
Configure your desired settings in the VoIP client under Edit > Preferences > Audio > Devices.

To save your settings, close the VoIP client window, right-click on  in the system tray and 
select Close.

The changes will be saved in the IGEL setup once the VoIP client is terminated.
Settings in the setup:

Sound event output device: Specifies which audio device is used for the ringtone.

Audio output device: Specifies which audio device is used for playback. Example: the audio 
device that is connected to the loudspeakers of the headset.
Audio input device: Specifies which audio device is used for recording. Example: the audio device 
that is connected to the microphone of the headset.
Enable silence detection: If this option is enabled, audio transmission will be suppressed in the 
absence of voice activity. This helps to save bandwidth.

Enable echo cancelation: If this option is enabled, the VoIP client will suppress echoes of your 
own voice.
Maximum jitter buffer (in milliseconds): The jitter buffer improves voice quality by 
compensating for delay variations when transmitting voice packets. The VoIP client continuously 
measures delay variations and automatically adjusts the buffer size. The bigger the delay 
variations are, the bigger the jitter buffer will be set. (Default: 500)

Recommendation: Configure the settings Device for ringtone, Device for audio playback and Device for 
audio recording in the VoIP client. All available audio devices of the thin client are shown in the VoIP 
client.



It is recommended that you select the audio device that is connected to the thin client's 
built-in loudspeaker.



Voice activity detection can reduce the voice quality.

A bigger jitter buffer results in greater latency.
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SIP
Menu path: Setup > Sessions > VoIP Client > SIP

You can change SIP-specific settings for the proxy, forwarding and the multi-frequency dialing process (DTMF).

Outbound Proxy: URI of the SIP proxy that handles outbound calls.
Forward URI: SIP URI to which inbound calls are forwarded if forwarding is enabled. You will find 
further information on forwarding under Call Options (see page 401).
Send DTMF as: Specifies how key sequences are transmitted while a connection is in place.
Possible values:

INFO: The key sequence is transmitted as SIP INFO.
RFC 2833: The key sequence is transmitted using RTP (Real-time Transport Protocol).
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H.323
Menu path: Setup > Sessions > VoIP Client > H.323

You can change H.323-specific settings for forwarding, H.245, quick start and for the multi-frequency dialing 
process (DTMF).

Forward URI: H.323 URI to which inbound calls are forwarded if forwarding is enabled. You will 
find further information on forwarding under Call Options (see page 401).
Enable H.245 tunneling
☑ H.245 messages will be packaged in H.225 messages. In this way, no additional TCP connection 
must be established. (Default)

☐ A separate TCP connection is established for H.245.
Enable early H.245
☑ H.245 will be launched at an earlier point in the connection process. The voice connection can 
be established more quickly as a result. (Standard)
Enable Fast Start procedure
☑ The voice connection will be established in quick start mode (fast connect, part of H.323 v2). 
(Standard)
DTMF senden als: Specifies how key sequences are transmitted while a connection is in place.
Mögliche Werte:

String: The key sequence is transmitted using H.245 User Input Indication.
Tone: The key sequence is transmitted as a tone sequence in the audio data flow.
RFC 2833: The key sequence is transmitted using RTP (Real-time Transport Protocol).
Q.931: The key sequence is transmitted via the signaling channel.

For H.245 tunneling, port 1720 is required.



Sessions

IGEL OS Reference Manual   401 / 710

•

•

•

•

Call Options
Menu path: Setup > Sessions > VoIP Client > Call Options

You can change settings for inbound calls.

Always forward calls to the given address: If this option is enabled, inbound calls will 
immediately be forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > 
Foward URI (see SIP (see page 399)) or Setup > Sessions > VoIP Client > H.323> Forward URI (see 
H.323 (see page 400)).
Forward calls to the given address if no answer: If this option is enabled, inbound calls will be 
forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > URI for Forwarding
(see SIP (see page 399)) or Setup > Sessions > VoIP Client > H.323> URI for Forwarding (see 
H.323 (see page 400)) after the time specified under Time limit for calls not taken. If this option is 
disabled, inbound calls will be rejected after the time specified under Time limit for calls not 
taken.
Forward calls to the given address if busy: If this option is enabled, inbound calls during a call 
will be forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > URI for 
Forwarding (see SIP (see page 399)) or Setup > Sessions > VoIP Client > H.323> URI for Forwarding 
(see H.323 (see page 400)).
No Answer Timeout: Time in seconds after which calls not taken are rejected or forwarded.
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Phone Book
Menu path: Setup > Sessions > VoIP Client > Telephone Book

You can add one or more LDAP address books or local contacts.

To add an LDAP address book, proceed as follows:
In the List of LDAP address books area, click on .
Enter the following data:

Name: Name with which the LDAP address book will be displayed in the VoIP client
Server Name: Host name of the LDAP server
Port: Port for the connection to the LDAP server (Default: 389)
Base DN: Basis for the search in the LDAP tree
Scope: Area for the LDAP search
Possible options: 
- Single level 
- Subtree
Display name attribute: LDAP attribute that is displayed as the name of the contact in the 
VoIP client. (Default: cn)
Call Attribute: LDAP attribute that contains the telephone number (Standard: 
telephoneNumber)
Filter Template: Filter for the LDAP search (Default: (cn=$))
Bind ID: Identifier for the LDAP search. This identifier is sent to the LDAP server in a BIND 
request.
Password: Password for the user account for the LDAP search

Click Ok.

To add a contact to the local contact list, proceed as follows:
In the List of Contacts area, click on .
Enter the following data:

Name: Name of the SIP or H.323 address displayed
Address: SIP or H.323 address. Example: sip:500@example.com
Group: Optional group name in order to group contacts

Click Ok.
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Preferences
Menu path: Setup > Sessions > VoIP Client > Settings

You can change VoIP client settings.

Save configuration changes made in the application
☑ changes made in the VoIP client will be saved in the IGEL setup when the VoIP client is 
terminated. This applies to all settings available in the IGEL setup, with the exception of settings 
for the LDAP address book. (Default)
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Desktop Integration
Menu path: Sessions > VoIP Client > Desktop Integration

In this area, you can configure desktop integration for the VoIP client session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".
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[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Accessories
ICA Connection Center (see page 407)
Terminals (see page 410)
Change Smartcard Password (see page 413)
Change Password (see page 416)
Setup (see page 420)
Quick Settings (see page 424)
Display Switch (see page 427)
Application Launcher (see page 437)
Sound Preferences (see page 440)
System Log Viewer (see page 446)
UMS Registering (see page 450)
Touchscreen Calibration (see page 453)
Task Manager (see page 456)
Screenshot Tool (see page 462)
On-Screen Keyboard (see page 465)
Java Manager (see page 469)
Monitor Calibration (see page 473)
Commands (see page 475)
Network Tools (see page 477)
Bluetooth Tool (see page 481)
System Information (see page 486)
Disk Utility (see page 490)
Disk Removal (see page 494)
Mobile Device Access (see page 497)
Firmware Update (see page 500)
Personalize Smartcard (see page 503)
Identify Monitors (see page 506)
Webcam Information (see page 509)
ICG Agent Setup (see page 512)
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ICA Connection Center
Menu path: Setup > Accessories > ICA Connection Center

With the Citrix ICA Connection Center, you are given an overview of the existing connections to Citrix servers as well 
as information regarding connection properties. You can also terminate server connections and log off from Citrix
servers. For details of how to use the ICA Connection Center, see Using ICA Connection Center (see page 409).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )





Accessories

IGEL OS Reference Manual   408 / 710

•
•
•

•

•

•

•

•

•

•

•
•

•

•
•

•

Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using ICA Connection Center (see page 409)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using ICA Connection Center
To obtain an overview of the existing connections to Citrix servers, proceed as follows:

 Start the ICA Connection Center. The start options are described under ICA Connection Center (see page 407).
All applications are shown in a tree structure with the associated Citrix servers.

To view the properties of a connection to a Citrix server, proceed as follows:
Start the ICA Connection Center. The start options are described under ICA Connection Center (see 
page 407).
Click on the server whose connection properties you want to view.
Click on the Properties button.
The connection properties as well as constantly updated information regarding the number of 
incoming and outgoing bytes and frames will be shown.
If you would like to reset the counter for incoming and outgoing bytes to 0, click on Reset.

To terminate a server connection, proceed as follows:
Start the ICA Connection Center. The start options are described under ICA Connection Center (see 
page 407).
Click on the server whose connection you want to terminate.
Click on Terminate.
The connection to the server is terminated. The Citrix session will be interrupted. The applications 
will not be terminated on the server. As a result, the application status will be retained until the 
session is resumed.

To log off from the Citrix server, proceed as follows:
Start the ICA Connection Center. The start options are described under ICA Connection Center (see 
page 407).
Click on the server from which you want to log off.
Click on Log off.
The connection to the server is terminated. The Citrix session will end. The applications on the 
server will be terminated.

With the help of the tree structure, you can see which applications run on which servers. If a number of 
applications run on the same server, this will make the exchanging of data between these applications 
easier.
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Terminals
Menu path: Setup > Accessories > Terminals > Local Terminal

With the local terminal, you can execute local commands on your thin client. For details of how to use the local 
terminal, see Using local terminal (see page 412).

The settings for starting the function are described below.

Session name: Name for the session

Start menu: If this option is enabled, the session can be launched from the start menu.
Application Launcher: If this option is enabled, the session can be launched with the Application 
Launcher.
Desktop: If this option is enabled, the session can be launched with a program launcher on the 
desktop.
Quick start panel: If this option is enabled, the session can be launched with the quick start panel.
Start menu's system tab: If this option is enabled, the session can be launched with the start 
menu's system tab.
Application Launcher's system tab: If this option is enabled, the session can be launched with 
the Application Launcher's system tab.
Desktop context menu: If this option is enabled, the session can be launched with the desktop 
context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

It is also possible to access a local shell without a terminal session: Alternatively, you can switch to the 
virtual terminals tty11  and tty12  by pressing [Ctrl]+[Alt]+[F11 ]or [Ctrl]+[Alt]+[F12]. Pressing [Ctrl]+
[Alt]+[F1] takes you back to the user interface.



The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Local Terminal (see page 412)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Local Terminal
To use the local terminal, proceed as follows:

Start the local terminal. The start options are described under Terminals (see page 410).
Log in as user  or root .

You can enter the shell commands supported by IGEL Linux.

If the parameter Use password is enabled under Security > Password in the User area, 
you will need to enter the user password to log in as user . If the parameter Use 
password is enabled under Security > Password in the Administrator area, you will need 
to enter the administrator password to log in as root .
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Change Smartcard Password
Menu path: Setup > Accessories > Change Smartcard Password

With this function, you can change the password for your IGEL smartcard. For details of how to use the function, see 
Using "Change Smartcard Password" (see page 415).

Further information regarding the IGEL smartcard can be found in the Authentication with IGEL Smartcard how-to.

The settings for starting the function are described below.

Session name: Name for the session

Start menu:
☑ The session can be started with the start menu. (Default)
☐ The session cannot be found in the start menu.
Application Launcher:
☑ The session can be started with the Application Launcher. (Default)
☐ The session cannot be found in the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop. (Default)
☐ The session does not have a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
☐ The session cannot be found in the quick start panel. (Default)
Start menu's system tab:
☑ The session can be started with the start menu’s system tab.
☐ The session cannot be found in the start menu’s system tab. (Default)
Application Launcher's system tab:
☑ The session can be started with the Application Launcher’s system tab.
☐ The session cannot be found in the Application Launcher’s system tab. (Default)
Desktop context menu:
☑ The session can be started with the desktop context menu.
☐ The session cannot be found in the desktop context menu. (Default)
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey: A hotkey with which the session can be started is defined. It consists of modifiers and a 
key.
Modifiers: One or two modifiers for the hotkey:

None

 = Shift
[Ctrl ] = Ctrl

 = Super_L

[Alt] = Alt

Modifiers can be combined by using the pipe character |:

[Ctrl ]+  = Ctrl|Super_L
Key: Key for the hotkey

_____
Using Change Smartcard Password Function (see page 415)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the character string for 

the Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Change Smartcard Password Function
With this function, you can change the password for your IGEL smartcard. In order to do this, the Logon with IGEL 
smartcard option must be enabled under Security > Logon > IGEL Smartcard.

To change the password for your IGEL smartcard, proceed as follows:

Start the Change Smartcard Password function. The start options are described under Change 
smartcard password (see page 413).
Enter the following data in the dialog:

Old smartcard password: Previous password
New smartcard password: Chosen password
Reenter new smartcard password: Chosen password (entered again)

The password for your IGEL smartcard will be changed.
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Change Password
Menu path: Accessories > Change Password

With this function, you can change the password for the user logged on via Active Directory. The user’s Active 
Directory account will be changed accordingly.

For details of how to use the Change Password function, see Using "Change password" function (see page 419).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

The Change Password function can only be used if Security > Logon > Active Directory/Kerberos > 
Login to Active Directory Domain is enabled. Further information can be found under Active Directory/
Kerberos (see page 650).



The Change Password function starts when the user receives a message informing them that a change of 
password is due and clicks on the button to change the password.



The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .
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• Using Change password Function (see page 419)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Using Change password Function
To change the password for logging on via Active Directory, proceed as follows:

Start the Change password function. The start options are described under Change password (see 
page 416).
Enter the following data in the dialog:

Old password: Previous password
New password: Chosen password
Repeat password: Chosen password (entered again)

The password for your Active Directory account will now be changed.
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Setup
Menu path: Accessories > Setup

With the IGEL setup, you can configure your thin client. For details of how to allow the user access to the individual 
areas of the setup, see User Page Permissions (see page 422). For details of how to change the setup options, see 
Options (see page 423).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

User Page Permissions (see page 422)
Options (see page 423)

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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User Page Permissions
If a password was set up for the administrator, the IGEL Setup can only be opened with administrator rights, i.e., 
after entering the password (see Password). However, individual areas of the setup can be enabled for the user, e.g. 
to allow them to change the system language or configure a left-handed mouse.

To enable setup pages for the user, proceed as follows:

Under Security > Password, enable the password for the administrator and the setup user.

Under Accessories > Setup > Page Authorizations , enable those areas to which the user is to 
have access.

A check in the checkbox indicates that the node is visible in the setup.

A red symbol  indicates that the parameter is password protected by the 
administrator.

A green symbol  indicates that the user can edit the parameters on this setup page.

If users are to be allowed to edit parts of the setup even without a password, create a 
quick setup (see page 45) session, the password for the setup user will not be enabled in this 
case.



If you enable a setup page on the lower levels, the node points required for access will 
automatically be marked as visible (but blocked for editing purposes).
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Options
Menu path: Accessories > Setup > Options

You can configure the display of tooltips in the setup.

Enable Tooltips

☑ When the mouse pointer is placed over a parameter, the associated tooltip will be shown after the set delay.

☐ No tooltip will be shown.

Tooltip Delay: Time interval in tenths of a second during which the mouse pointer must be placed over a parameter 
for the tooltip to be shown.
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Quick Settings
Menu path: Setup > Accessories > Quick Settings

With the IGEL setup, you can allow the user access to individual areas of the setup. Instructions can be found under 
User Page Permissions (see page 422).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Setup User Permissions (see page 426)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Setup User Permissions
Menu path: Accessories > Quick Settings > Setup User Permissions

Define which setup pages are visible to users.

You will find instructions for this function under User Page Permissions (see page 422).
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Display Switch
Menu path: Setup > Accessories > Display Switch

With this function, you can configure the display on several screens. For details of how to set the function, see 
Options (see page 429). For details of how to use the function, see Using "Display Switch" Function (see page 434).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Options (see page 429)
Minimal Dialog (see page 431)
Advanced Dialog (see page 433)
Using Display Switch (see page 434)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Options
Menu path: Setup > Accessories > Display Switch > Options

You can change the way the Display Switch function behaves.

Dialog type
Possible values:

Minimal dialog: The Display Switch function starts with the Basic dialog. With Advanced, 
you can switch to the Advanced dialog.
Advanced dialog: The Display Switch function starts with the Advanced dialog. With Basic, 
you can switch to the Advanced dialog.

Preserve settings over reboot
☑ The settings for the Display Switch function will be preserved over a reboot.
☐ The settings for the Display Switch function will be reset to the default settings in the event of a 
reboot. (default)
Configure new displays when connected
☑ The Display Switch function starts as soon as new screens are connected. You can then 
configure the new screens.
☐ The Display Switch function does not start automatically when new screens are connected. 
(default)

Buttons in Minimal dialog

Mirror displays
☑ The Shadow screens option  is shown in the minimal dialog. (default)
☐ The option is not shown in the minimal dialog.
Expand to the left
☑ The Expand to the left option  is shown in the minimal dialog. (default)
☐ The option is not shown in the minimal dialog.
Expand to the right
☑ The Expand to the right option  is shown in the minimal dialog. (default)
☐ The option is not shown in the minimal dialog.
Rotate displays (Page orientation)
☑ The Rotate displays (Page orientation) option  is shown in the minimal dialog.
☐ The option is not shown in the minimal dialog. (default)
Mouse options
☑ The Left-handed mouse, Pointer speed and Double click interval settings are shown in the 
minimal dialog.
☐ The mouse settings are not shown. (default)
Advanced
☑ The Advanced button is shown. With Advanced, you can switch to the advanced dialog. 
(default)
☐ The Advanced button is not shown.
Reset
☑ The Reset button is shown. With Reset, you can restore the default settings. (default)
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☐ The Reset button is not shown.
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Minimal Dialog
Selection Function

Uses only display 1.

Shows the same content on all screens, i.e. clone mode or 
mirroring.

Extends the display area to the screen on the right.

Extends the display area to the screen on the left

Uses only display 2.

Rotates the selected display to the left or to the right.

Identify Displays: Starts the monitor detection.

Advanced: Switches to Advanced mode of display configuration.

Reset: Restores the default settings.

Close: Closes the IGEL Display Switch window.

Mouse options

Lefthand Mode
☑Lefthand mode is active.

☐ Righthand mode is active. (Default)
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Pointer speed: Value for the mouse speed in percentage between 1 (slow) and 100 (fast). (Default: 
50)
Double click: Maximum interval in milliseconds between two mouse clicks to still be recognized as 
a double-click. (Default: 300)

For more information, see Using Display Switch (see page 434) and Display Switch.
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Advanced Dialog
You can access the advanced settings by clicking Advanced in the minimal dialog.

Advanced settings (pan/scale/resolution) can be configured in a collapsible area on the right. To enlarge 
the Advanced modes window, click the arrow on the right side of the window.

The following parameters must be activated for the Display Switch function to be able to save the settings:

Display Switch > Options > Preserve settings over reboot
Display Switch > Options > Smart display configuration

In the collapsible area:

Use this display
☑ Enables the selected display.
☐ Disables the selected display.
Index: Give the selected display an order number.
Rotation: Rotation of selected display
Possible values:

None
Left
Inverted
Right

Resolution: Select the resolution of the selected display. (Default: Automatic)
Refresh rate: Depends on the resolution (Default: Automatic)
Panning: Set up a virtual screen that is larger than your physical screen. It will look like an 
enlarged screen. By moving the mouse to the edge of the screen, hidden parts become visible. 
(Default: None)
Reflection: Transforms the display as if being reflected by a mirror.
Possible values:

None
Horizontal
Vertical
Horizontal and Vertical

Scale from: A software variant of the resolution. This can be useful if you need a resolution that is 
not available on the hardware. (Default: None)

For more information, see the articles Using Display Switch (see page 434) and Display Switch.
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Using Display Switch
 Start the Display Switch function. The start options are described under Display Switch (see page 427).

Depending on the setting under Setup > Accessories > Display Switch > Options > Dialog Type selection, the basic 
or the advanced dialog will be shown.

Identify Displays

 To start screen detection, click on Identify Displays
The names and properties of the screens will be detected. The connection, the assigned number (1 = main screen) 
and the name will be shown on each screen. Example: 1: DVI-D(II): Samsung 24"

Specify main screen

If necessary, switch to the advanced dialog with Advanced.
Select the screen that you wish to specify as the main screen.
Enable Main screen.

Split display over several screens
You have various options for using several screens. In the dialog, the connection, the assigned number (1 = main 
screen) and the name is shown for each screen. Example: 1: DVI-D(II): Samsung 24"

The procedure with the minimal dialog is described below. To switch from the advanced to the minimal dialog, click 
on Simple.

 To show the same content on all screens (Shadow screens), click on .

 If you would like to expand the display to all screens and the other screens are to the left of the main screen, 
click on .

 If you would like to expand the display to all screens and the other screens are to the right of the main screen, 
click on .

Rotate displays (Page orientation)
The procedure with the minimal dialog is described below; Setup > Accessories > Display Switch > Options > 
Rotate displays (Page orientation) must be enabled. To switch from the advanced to the minimal dialog, click on 
Basic.

 To rotate the display anti-clockwise, click on .

 To rotate the display clockwise, click on .
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Change mouse settings
The procedure with the minimal dialog is described below; Setup > Accessories > Display Switch > Options > 
Mouse Options must be enabled. To switch from the advanced to the minimal dialog, click on Simple.

 To adjust the mouse for left-handed users, enable the Lefthanded Mode.

 To adjust the speed of the mouse pointer, change the value under Pointer speed. The higher the value, the 
further the mouse pointer will travel when the mouse is moved.

 To change the time interval within which two consecutive mouse clicks are recognized as a double-click, 
change the number of milliseconds under Double click interval.

Zoom display (screen magnifying glass)
You can magnify the screen content. The effect is the same as with the screen magnifying glass in Microsoft 
Windows: All text and graphics are magnified by the same factor; this results in a virtual display area which is bigger 
than the monitor’s available display area. The user therefore sees a magnified section of the entire screen content; 
the section can be moved by moving the mouse to the edge of the screen.

If necessary, switch to the advanced dialog with Advanced.
Enable Zoom.
Under Virtual resolution, set the highest possible value. Example: 1920x1200
Under Resolution, set a low value. This value simulates the actual resolution of the screen. 
Example: 1280x800
Click on Apply.
The screen content will be magnified. The magnification factor results from the ratio of the virtual 
resolution and the simulated actual resolution.

Change refresh rate

If necessary, switch to the advanced dialog with Advanced.
Under Refresh rate, set the desired value.

Restore default settings

 Click on Reset to restore the default settings.

If the same content is displayed on a number of screens (Shadow screens), all screens will 
show the same section. However, you can set a different magnification level for each of 
the screens.



A refresh rate of 60 Hz is usually suitable for standard screens.
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Auto Switch Monitor Configuration for Laptops
This display switch can use multiple different profiles, automatically chosen at runtime depending on the currently 
connected monitors. A profile is created, whne the current monitor layout/resolution is configured via the Display 
Switch utility. The profile will be associated with the current connected displays automatically (manufacturer, 
model an dused connector are used for allocation) and if applicable, th state of the laptop lid.

The Setup will be restored by hot-(un)plugging known displays, meanst the system will automatically switch to the 
already configured profile. The display switch utility itself got a new interface. All base functionality can be 
configured via Drag and Drop.

For the display switch functionality the following parameters should be enabled for proper usage:

Go in IGEL Setup under Accessories > Display Switch > Options.
Enable Preserve settings over reboot and Smart display configuration. (Default: disabled)

Example configuration of auto switch monitor for Laptops, see Example Auto Switch Monitor Configuration for 
Laptops . 



Accessories

IGEL OS Reference Manual   437 / 710

•

•

•

•

•

•

•

•

•

•

•

•

•

Application Launcher
Menu path: Setup > Accessories > Application Launcher

With the Application Launcher, you can launch predefined sessions and thin client functions/tools. You are also 
given information regarding the thin client and the licenses used.

Further information can be found under Application Launcher (see page 34).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Application Launcher Configuration (see page 439)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Application Launcher Configuration
Menu path: Setup > Accessories > Application Launcher > Application Launcher Configuration

You can hide individual areas and elements of the Application Launcher.

Hide system page

☑ The  button for displaying the system tools (accessories) will not be shown.

☐ The  button for displaying the system tools (accessories) will be shown. (default)
Hide reboot button

☑ The  button for restarting the thin client will not be shown.

☐ The  button for restarting the thin client will be shown. (default)
Hide shut down button

☑ The  button for shutting down the thin client will not be shown.

☐ The  button for shutting down the thin client will be shown. (default)
Show current user name in about, application launcher and startmenu
☑ The current user will be shown at the top edge of the relevant window.
☐ The current user will not be shown.

Single click mode:
☑ Sessions are started with a single-click. This option was set up specially for users of 
touchscreen monitors.
☐ Sessions are started with a double-click. (default)

•
•

In order for user names to be recognized and passed on, you must configure two settings 
beforehand:

Enable Active Directory/Kerberos: Security > Active Directory/Kerberos
Enable local logon: Security > Logon > Active Directory/Kerberos
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Sound Preferences
Menu path: Setup > Accessories > Sound Preferences

With this function, you can configure your thin client’s audio system. For details of how to change the presets for 
the audio system, see Options (see page 443). For details of how to use the function, see Using Audio Settings 
Function (see page 445).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

_____

Options (see page 443)
Using Audio Settings Function (see page 445)
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Options
Menu path: Accessories > Sound Preferences > Options

With this function, you can change presets for the audio system. The settings can be changed at any time via the 
"Sound Preferences" function; see Using “Sound Preferences” function (see page 445).

Show volume control in taskbar
☑ The  button is shown in the taskbar. When the user clicks on this button, the volume control 
will be shown. (Default)
☐ The  button will not be shown. The user must start the Audio Settings function to change the 
volume. Further information can be found under Using “Sound preferences” function (see page 440).
Remote volume settings
☑ The settings for the parameters Mute, PCM volume, Input mute, and Input volume are 
restored after each system restart.
☐ The last settings set by the user will remain after the next system start. (Default)
Mute
☑ Audio playback is off.
☐ Audio playback is on. (Default)
PCM volume: Preset volume in percent (default: 50)
Input mute
☑ The audio input is muted. Sounds from a microphone that are recorded are not transferred via 
the thin client.
☐ The audio input is switched on. Sounds from a microphone that are recorded can be transferred 
via the thin client. (Default)
Input volume: Volume in percent at which sounds at the audio input are recorded, for example 
from a microphone. (Default: 100)

Default Sound Output

Port name
Possible options:

Automatic: The audio output is automatically assigned to a device. The following order 
applies here:
1. USB devices 
2. PCI devices; this also includes the HDMI interface. 
3. Internal speaker 
Not connected ports will be ignored.
HDMI / DisplayPort
Speaker
Headset

Device name: Name of the device, as it is shown on the Output tab of the Sound Preferences
dialog. The name must be entered exactly as it is written. Examples: "Built-in Audio", "Microsoft 
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LifeChat LX-3000".

Default Sound Input

Port name
Possible options:

Automatic: The audio input is automatically assigned to a device. The following order 
applies here:
1. USB devices 
2. PCI devices 
Not connected ports will be ignored.
Microphone
Headset microphone

Device name: Name of the device, as it is shown on the Input tab of the Sound Preferences
dialog. The name must be entered exactly as it is written, analogous to Default Sound Output. 
Examples: "Built-in Audio", "Microsoft LifeChat LX-3000".
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Using Audio Settings Function
 Start the Audio Settings function. The start options are described under Audio Settings (see page 440).

To change the playback volume, proceed as follows:

 Move the playback volume slider to the right to increase the volume or to the left to reduce the volume.

To select and configure the device for playback, proceed as follows:

Click on the Output tab.
Under Sound output via, select the device which is to be used for playback.
If necessary, adjust the Balance, Crossover and Subwoofer settings.

To select and configure the device for recording, proceed as follows:

Click on the Input tab.
Under Sound input via, select the device which is to be used for recording.
Adjust the Input volume if necessary.

To change the playback volume for specific applications, proceed as follows:

Click on the Applications tab.
Adjust the volume control for the relevant application.
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System Log Viewer
Menu path: Setup > Accessories > System Log Viewer

With this function, you can view your thin client’s system logs. For details of how to add additional logs to the logs 
shown by default, see Options (see page 448). For details of how to use the function, see Using “System Log Viewer” 
function (see page 449).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Options (see page 448)
Using System Log Viewer Function (see page 449)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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3.

Options
Menu path: Setup > Accessories > System Log Viewer > Options

Here, you can add additional files to the files shown by default. The System Log Viewer function shows the 
following files by default:

/config/Xserver/card0

/config/Xserver/xorg.conf-0

/config/sound/card0

/config/sound/card1

/config/sound/default_card_name

/var/log/Xorg.0.log

To add a further file to the display, proceed as follows:

Click on .
In the Add dialog, enter the path and the file name of the desired file. Example: /var/log/

igfmount.log

Click OK.
When the System Log Viewer function is started, the file that you have added will be shown.

If you want to add several files, you can also use the asterisk *. Example: /var/log/ *.log or  

/var/log/ *.txt
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Using System Log Viewer Function
Start the System Log Viewer function. The start options are described under System Log 
Viewer (see page 446).
In the left-hand column, select the file that you want to view.
The selected file will be shown in the right-hand column.
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UMS Registering
Menu path: Setup > Accessories > UMS Registering

With this function, you can register your thin client in the UMS (IGEL Universal Management Suite) locally. For details 
of how to use the function, see Using “UMS Registering” function (see page 452).

The settings for starting the function are described below.

Session name: Name for the session

Start menu:
☑ The session can be started with the start menu. (Default)
☐ The session cannot be found in the start menu.
Application Launcher:
☑ The session can be started with the Application Launcher. (Default)
☐ The session cannot be found in the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop. (Default)
☐ The session does not have a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
☐ The session cannot be found in the quick start panel. (Default)
Start menu's system tab:
☑ The session can be started with the start menu’s system tab.
☐ The session cannot be found in the start menu’s system tab. (Default)
Application Launcher's system tab:
☑ The session can be started with the Application Launcher’s system tab.
☐ The session cannot be found in the Application Launcher’s system tab. (Default)
Desktop context menu:
☑ The session can be started with the desktop context menu.
☐ The session cannot be found in the desktop context menu. (Default)
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey: A hotkey with which the session can be started is defined. It consists of modifiers and a 
key.
Modifiers: One or two modifiers for the hotkey:

None

 = Shift
[Ctrl ] = Ctrl

 = Super_L

[Alt] = Alt

Modifiers can be combined by using the pipe character |:

[Ctrl ]+  = Ctrl|Super_L
Key: Key for the hotkey

_____
Using UMS Registration Function (see page 452)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the character string for 

the Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using UMS Registration Function
Menu path: Accessories > UMS Registration

Start the UMS Registration function. The start options are described under UMS Registering (see 
page 450).
Enter the following data:

Server Address: IP address or host name of the UMS Server.
Port Number: Port of the UMS Server.
Structure Tag: Character string for assigning the device to a specific UMS directory.
New Hostname: Name under which the device is registered in the UMS.
Login: User name for logging in to the UMS Console.
Password: Password for logging in to the UMS Console.

If you want to assign a specific UMS directory to the device, click on Click to select directory and 
then select the desired directory from the list.
Click on Register.

Any UMS user with sufficient rights can be specified under Login and Password.
Example: If a device has to be registered in a particular folder, the user must have "move" 
permission for this folder.
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Touchscreen Calibration
Menu path: Setup > Accessories > Touchscreen Calibration

With this function, you can calibrate the touchscreen connected to your thin client. For details of how to use the 
function, see Using “Touchscreen Calibration” function (see page 455).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Touchscreen Calibration (see page 455)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Touchscreen Calibration
 Ensure that Enable touchscreen is enabled under User Interface > Input > Touchscreen.

You will find a description of the touchscreen calibration procedure in the Touchscreen Calibration how-to.
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Task Manager
Menu path: Setup > Accessories > Task Manager

This function provides an overview of the applications and other processes running on the thin client. You can also 
pause or end processes and change the priority of processes. For details of how to use the Task Manager, see Using 
Task Manager (see page 458).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Task Manager (see page 458)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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2.

Using Task Manager
With the Task Manager, you can observe and influence applications and processes in the following ways:

Determining thin client processor usage
Determining thin client memory usage
Determining processor usage by a specific application
Determining memory usage by a specific application
Pausing and continuing an application
Closing an application
Force closing an application
Changing the priority of an application

 Launch the Task Manager function. The launch options are described under Task Manager (see page 456).

To determine the thin client's total processor usage, proceed as follows:

 Read the percentage value under CPU:.

To determine the thin client's total memory usage, proceed as follows:

 Read the percentage value under RAM:.

 To calculate the value in bytes, click on  and enable the option Show memory usage in bytes.

To determine the extent to which a specific application contributes to processor usage, proceed as follows:

In the search window, enter the name of the application or part of the name.
The Task Manager will now show only the relevant applications and processes.
Read the percentage value for the relevant application in the CPU column.
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To determine the extent to which a specific application contributes to memory usage, proceed as follows:

Click next to  on  and ensure that Virtual Bytes and Private Bytes are enabled.
In the search window, enter the name of the application or part of the name.
The Task Manager will now show only the relevant applications and processes.
Read the values in the VSZ and RSS columns. 
The VSZ column shows how much memory is available for the application. The RSS column shows 
how much memory the application is currently using.
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To pause an application, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Pause.
The application will be paused (Signal SIGSTOP). You can then continue the application.

To continue an application, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Continue.
The application will continue (Signal SIGCONT).

To close an application, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Close.
The application will close (Signal SIGTERM).
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To force an application to close, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Kill.
The application will be forced to close (Signal SIGKILL).

To change the priority of an application, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Priority.
Select one of the following values for the priority:

Very low (nice value: 15)
Low (nice value: 5)
Normal (nice value: 0)
High (nice value: -5). This value can only be set by the administrator.
Very high (nice value: -15) This value can only be set by the administrator.

In this case, the application is instructed to close by the operating system. If the 
application does not react to this instruction, you can force it to close with the Kill
command.



As a normal user, you can only change the priority from a higher value to a lower value. 
Example: If you have changed the priority from "Normal" to "Low", you can only then 
change it to “Very low” – you can no longer change it back to “Normal”. The administrator 
can increase the priority.



The priority corresponds to the nice value. High values result in a low priority, while low 
values result in a high priority.
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Screenshot Tool
Menu path: Setup > Accessories > Screenshot Tool

With this function, you can take a screenshot. For details of how to use the function, see Using “Screenshot 
Tool” (see page 464).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

Special hotkeys
With the hotkeys defined under User Interface > Hotkeys > Commands, you can use the function as follows:

Screenshot of the active window: This hotkey takes a screenshot of the window currently active.
Screenshot of the entire screen: This hotkey takes a screenshot of the entire screen.

_____

Using Screenshot Tool (see page 464)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Screenshot Tool
Launch the Screenshot Tool function. The launch options are described under Screenshot 
Tool (see page 462).
Select the area you would like to photograph. You have the following options:

Entire screen
☑ The entire screen content will be photographed.
Active window
☑ The window that is currently active will be photographed.
Select a region
☑ You can select a section of the screen using the mouse.
Capture mouse pointer
☑ The mouse pointer is visible on the screenshot.

Specify the Delay before capturing in seconds. The minimum value is 1.
Click on OK.
If you have enabled Entire screen or Active window, the screenshot will be taken after the Delay 
before capturing has elapsed. 
If you have enabled Select a region, you can select the desired part of the screen using the mouse. 
To do this, press and hold the left mouse button while dragging the mouse across the screen.
Specify how the screenshot is to be used. You have the following options:

Save: If this option is enabled, the screenshot will be saved in PNG format via your thin 
client. You can save the screenshot locally, on a network drive or on a USB mass storage 
device.
Copy to the clipboard: If this option is enabled, the screenshot will be available in the thin 
client's local cache. You can access the local cache from an RDP session and open the image 
in an RDP session application.
Open with: If this option is enabled, the screenshot will be opened in your thin client's 
image viewer as soon as it is taken.

If you start the function via User Interface > Hotkeys > Commands > Screenshot of 
active window or User Interface > Hotkeys > Commands > Screenshot of entire 
screen, no options will be shown.
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On-Screen Keyboard
Menu path: Setup > Accessories > On-Screen Keyboard

This function shows an on-screen keyboard on the desktop.

The settings for starting the function are described below.

Session name: Name for the session

Start menu: If this option is enabled, the session can be launched from the start menu.

Application Launcher: If this option is enabled, the session can be launched with the Application Launcher.

Desktop: If this option is enabled, the session can be launched with a program launcher on the desktop.

Quick start panel: If this option is enabled, the session can be launched with the quick start panel.

Start menu's system tab: If this option is enabled, the session can be launched with the start menu's system tab.

Application Launcher's system tab: If this option is enabled, the session can be launched with the Application 
Launcher's system tab.

Desktop context menu: If this option is enabled, the session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Autostart: If this option is enabled, the session will be launched automatically when the device boots.

Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the device booting and the session being launched 
automatically.

Appearance (see page 467)

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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• Application Integration (see page 468)
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Appearance
Menu path: Accessories > On-Screen Keyboard > Appearance

Show Function Keys
☑ The on-screen keyboard features the function keys [F1] ... [F12]. (default)
Show Navigation Keys
☑ The on-screen keyboard features the arrow keys for navigating on the screen. (default)
Show Numpad
☑ The on-screen keyboard features the number block.
☐ The on-screen keyboard does not feature the number block. (default)
Enable switching to alternative layout

☑ The on-screen keyboard has an additional key by which the user can toggle between the 
normal layout and a reduced layout. The reduced layout resembles the numpad, with the 
following differences:
- Additional backspace key [←] 
- Additional tab key [↹] 
- Additional space key [ ] 
- Additional escape key [Esc] 
- Return key [⏎] instead of [Enter] key
☐ Switching to the reduced layout is not possible. (default)

This option is available from IGEL Linux version 10.04.100 onwards.
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Application Integration
Menu path: Accessories > On-screen keyboard > Application Integration

Taskbar settings for the login dialog
These settings are relevant if a login is necessary in order to use the device. This applies to all logon methods that 
are possible with the device.

Show on-screen keyboard button

☑ A button for launching the on-screen keyboard will be shown during the login dialog.

☐ The on-screen keyboard cannot be launched during the login dialog. (Default)

Start on-screen keyboard automatically

☑ The on-screen keyboard is shown during the login dialog. The on-screen keyboard can be used for input in the 
logon dialog.

☐ The on-screen keyboard is not shown during the login dialog. However, it can be launched via a button if Show 
on-screen keyboard button is enabled. (Default)

Taskbar settings when the screenlock is active
Show on-screen keyboard button

☑ If the screen is locked, a button for launching the on-screen keyboard will be shown.

☐ If the screen is locked, the on-screen keyboard cannot be launched. (Default)

Start on-screen keyboard automatically

☑ If the screen is locked, the on-screen keyboard will be shown.

☐ If the screen is locked, the on-screen keyboard will not be shown. However, it can be launched via a button if 
Show on-screen keyboard button is enabled. (Default)

On-Screen Keyboard Toggle Button
Show button

☑ A button for switching the on-screen keyboard on and off will be shown on the desktop.

☐ The button will not be shown. (Default)

Touch and hold delay: Time in milliseconds, after which the button reacts to movement. (Default: 1000 ms)

Button size: A size between 40 and 80 pixels can be chosen. (Default: 60px)

For further information, see Configuring the Automatic Appearance of on-screen software keyboard.
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Java Manager
Menu path: Setup > Accessories > Java Manager

With this function, you can configure the execution of Java on your thin client. For details of how to use this 
function, see Using Java Control Panel (see page 471).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Java Manager (see page 471)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Java Manager
With the Java Control Panel, you can check and change the properties of Java sessions. Changes will remain in force 
until the next thin client restart. The procedure for changing the security settings and importing certificates with the 
Java Control Panel is described below.

The procedure for rectifying an error when connecting to the UMS via Java Web Start is described in the FAQ Error 
when connecting to UMS via Java Web Start: "received fatal alert: handshake_failure".

Further information regarding the Java Control Panel can be found at http://java.sun.com/j2se/1.5.0/docs/guide/
deployment/deployment-guide/jcp.html.

To change the security settings for Java sessions, proceed as follows:

Launch the Java Manager. The start options are described under Java Manager (see page 469).
Click on the Security tab.
If you want to use Java applications (applets) in the browser, enable Enable Java content in the 
browser.
Select a security level for applications that are not on the Exception Site list:

Very high: The Java application will only be executed if it has a valid certificate which has 
not been withdrawn.
High: The Java application will only be executed if it has a valid certificate. No check will be 
made as to whether the certificate was withdrawn.

If you would like to add an exception, click on Edit Site List... > Add and enter the URL of the 
website for which the security rule is not to apply. When you have added all your exceptions, click 
on OK.
Click on OK or Apply.
The changed settings will remain valid until the next thin client restart.

To import a certificate from a file, proceed as follows:

Launch the Java Control Panel. The start options are described under Java Control Panel (see page 
469).
Click on the Security tab.
Click on Manage Certificates....
Select the certificate type.
Select the certificate file on your thin client and click on Open.

•
•

Alternatively, you can configure the settings in the registry; the changes are then 
permanent:

System > Registry > java > deployment > security_level
System > Registry > java > deployment > exception_site%



Certificates should always be imported using the UMS. You should therefore use the Java Control Panel 
only if you want to import a certificate whose type is not supported by the UMS. The UMS only supports 
"Signer CA” certificates, i.e. certificates from a certification authority (CA) for protected certificates.



http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-guide/jcp.html
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6. Click on Import.



Accessories

IGEL OS Reference Manual   473 / 710

•

•

•

•

•

•

•

•

•

•

•

•

•
•

Monitor Calibration
Menu path: Setup > Accessories > Monitor Calibration

With this function, you can calibrate the monitor connected to your thin client.

A test image which you can modify using the arrow keys will appear. Using this test image, you can automatically or 
manually recalibrate your screen. This applies to old, analog monitors in particular. New monitors calibrate 
themselves.

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Commands
Menu path: Setup > Accessories > Commands

The following system commands can be made accessible to the user:

Logoff: Logs the user off from the thin client.
Reboot Terminal: Restarts the thin client.
Restart windowmanager: Restarts the thin client user interface.
Shutdown terminal: Shuts down the thin client.
Sort icons: Sorts the symbols on the desktop so that they form a block.

 Highlight one of these commands and click on Edit....
A window via which you can specify the settings for starting system commands will open:

Session name: Name for the session

Start menu:

☑ The session can be started with the start menu. (Default)

☐ The session cannot be found in the start menu.

Application Launcher:

☑ The session can be started with the Application Launcher. (Default)

☐ The session cannot be found in the Application Launcher.

Desktop:

☑ The session can be started with a program starter on the desktop. (Default)

☐ The session does not have a program starter on the desktop.

Quick start panel:

☑ The session can be started with the quick start panel.

☐ The session cannot be found in the quick start panel. (Default)

Start menu's system tab:

☑ The session can be started with the start menu’s system tab.

☐ The session cannot be found in the start menu’s system tab. (Default)

Application Launcher's system tab:

☑ The session can be started with the Application Launcher’s system tab.

☐ The session cannot be found in the Application Launcher’s system tab. (Default)

Desktop context menu:

☑ The session can be started with the desktop context menu.

☐ The session cannot be found in the desktop context menu. (Default)

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey: A hotkey with which the session can be started is defined. It consists of modifiers and a key.

Modifiers: One or two modifiers for the hotkey:

None

 = Shift

[Ctrl ] = Ctrl

 = Super_L

[Alt] = Alt

Modifiers can be combined by using the pipe character |:

[Ctrl ]+  = Ctrl|Super_L

Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the character string for the Key field. Example: Tab  in (keysym 

0xff09, Tab)
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Network Tools
Menu path: Setup > Accessories > Network Tools

This function provides the following tools for network analysis:

Devices - Information regarding use can be found under Using "Network Tools" function - 
Devices (see page 479).
Ping - Information regarding use can be found under Using "Network Tools" function - Ping.
Netstat - Information regarding use can be found under Using "Network Tools" function - Network 
Status.
Traceroute - Information regarding use can be found under Using "Network Tools" function - 
Trace Route.
Lookup - Information regarding use can be found under Using "Network Tools" function - Look 
Up.

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Network Tools Function (see page 479)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Network Tools Function
 Start the Network Tools function. The start options are described under Network Tools (see page 477).

To obtain information regarding a network device available on your thin client, proceed as follows:

Click on the Devices tab.
Under Network device, select the network device for which you would like to obtain information. 
The information regarding the selected network device will be shown.

To send a ping query to a device in your network, proceed as follows:

Click on the Ping tab.
Under Network address, enter the IP address or the host name of the device to which you would 
like to send a ping query.
If necessary, add the number of ping queries under Send.
Click on the Ping button.
The set number of ping queries will be sent. The results will then be shown.

To obtain information regarding the network status of your thin client, proceed as follows:

Click on the Netstat tab.
Select the desired information under Display:

Routing Table Information
Active Network Services
Multicast Information

Click on the Netstat button.
The desired information will be shown.

To identify the router via which an IP data packet from your thin client reaches a specific target computer, proceed 
as follows:

Click on the Traceroute tab.
Under Network address, give the IP address of the target computer.
Click on the Trace button.
The thin client will send IP packets to the target computer at short intervals, each with a TTL (Time 
To Live, i.e. maximum number of hops) increased by 1. 
When the packet reaches the target computer, "reached” will be shown in the last line and no 
further packet will be sent. 
If no computer replies, "no reply" will be shown.

With the Lookup function, you can request DNS information regarding any address on the Internet from your thin 
client.
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Further information regarding the DNS (Domain Name System) can be found on Wikipedia under Domain Name 
System14.

Detailed descriptions of the Domain Name concept can be found in RFC 103415 and in related RFCs.

To obtain DNS information regarding an address on the Internet, proceed as follows:

Click on the Lookup tab.
Under Network address, give the IP address or the host name.
Under Information type, select which information is to be shown. The following information types 
are available:

Default information
Internet address
Canonical name
Processor type/operating system
Mailbox exchange
Mailbox information
Name server
Computer name for address
Text information
Generally known services
Any / all information

Click on Lookup.
The desired information will be shown.

https://en.wikipedia.org/wiki/Domain_Name_System
https://tools.ietf.org/html/rfc1034
https://en.wikipedia.org/wiki/Domain_Name_System
https://tools.ietf.org/html/rfc1034
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Bluetooth Tool
Menu path: Accessories > Bluetooth Tool

With the Bluetooth Tool, you can connect Bluetooth devices, e.g. a keyboard, a mouse or a headset, to your thin 
client. For details of how to use the function, see Using Bluetooth Tool (see page 484).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

In order to be able to use Bluetooth, it must be enabled under Devices > Bluetooth.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Relaunch

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Using Bluetooth Tool (see page 484)
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Using Bluetooth Tool
With the Bluetooth Tool, you can connect Bluetooth devices, e.g. a keyboard, a mouse or a headset, to your thin 
client.

The Bluetooth Tool supports the following coupling methods, i.e. the mutual authentication of the Bluetooth 
device and thin client:

Coupling with PIN entry (for most keyboards)
Coupling with fixed PIN (for most headsets, mice or GPS devices)
Coupling with automatic PIN allocation

In order to use Bluetooth devices, a Bluetooth USB adapter must be connected to the thin client.

To connect a Bluetooth device with PIN entry, proceed as follows:

Ensure that the coupling mode is enabled on the Bluetooth device.
Start the Bluetooth Tool. The start options are described under Bluetooth Tool (see page 481).
The Device Search dialog page will be shown. After a few seconds, the Bluetooth devices found by 
the thin client will be displayed.
Highlight the desired Bluetooth device and click on Forward.
A PIN will be shown on the Device setup dialog page.
Enter the PIN shown into your Bluetooth device.
On the Setup summary dialog page, the status of the connection will be shown.
Click on Close.

To connect a Bluetooth device with a fixed PIN, proceed as follows:

Start the Bluetooth Tool. The start options are described under Bluetooth Tool (see page 481).
The Device Search dialog page will be shown. After a few seconds, the Bluetooth devices found by 
the thin client will be displayed.
Highlight the desired Bluetooth device.
Click on PIN options.
Select one of the specified PINs or enable Custom PIN and enter the PIN for the Bluetooth device. 
You will find this PIN in the documentation for your Bluetooth device. 
On the Setup summary dialog page, the status of the connection will be shown.
Click on Close.

To connect a Bluetooth device with automatic PIN allocation, proceed as follows:

Ensure that the coupling mode is enabled on the Bluetooth device.
Start the Bluetooth Tool. The start options are described under Bluetooth Tool (see page 481).
The Search for devices dialog page will be shown. After a few seconds, the Bluetooth devices 
found by the thin client will be displayed.
Highlight the desired Bluetooth device and click on Forward.
A PIN will be shown on the Device configuration dialog page and on your Bluetooth device.
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If the PINs on the Device configuration dialog page and on your Bluetooth device are identical, 
click on Yes.
On the Set-up summary dialog page, the status of the connection will be shown.
Click on Close.

To cancel coupling to a Bluetooth device, proceed as follows:

Start the Bluetooth Tool. The start options are described under Bluetooth Tool (see page 481).
The connected Bluetooth device will be shown on the Device Search dialog page.
Highlight the connected Bluetooth device and click on Forward.
On the Setup summary dialog page, the status of the connection will be shown.
Click on Close.
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System Information
Menu path: Setup > Accessories > System Information

With this function, you can obtain information regarding the operating system of your thin client and the installed 
system components, internal and connected hardware and the network. You can also measure the performance of 
your thin client using various benchmarks.

The information shown can be copied to the clipboard in order to send it to the IGEL Support department for 
example.

For details of how to use the function, see Using “System Information” function (see page 489).

The settings for starting the function are described below.

Session name: Name for the session.

Session start options
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

_________

Using System Information Function (see page 489)
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Using System Information Function
Menu path: Accessories > System Information

To obtain system information regarding a specific component of your device, proceed as follows:

Start the System Information function. The start options are described under System 
Information (see page 486).
Click on the desired area, e.g. Computer > Operating System.
The information regarding the desired area will be shown.
To send the information shown, e.g. to the IGEL Support department, click on the Copy to 
Clipboard button.
The information is on your clipboard. With Paste or [Ctrl] + [V], you can paste the information into 
an e-mail or a web form.

You can use the System Information function to find out the Vendor ID and Product ID of your connected 
hardware. They are required, for example, if you want to configure Device Rules, see e.g. USB Access 
Control (see page 640) or Native USB Redirection (see page 128).

See also Issues with USB IDs in USB Devices Rules.
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Disk Utility
Menu path: Setup > Accessories > Disk Utility

With this function, you can obtain information regarding the hotplug storage devices connected to your thin client. 
You can also remove hotplug storage devices safely, i.e. without the risk of losing data.

For details of how to use the function, see Using “Disk Utility” (see page 493).

The settings for starting the function are described below.

Session name: Name for the session.

Session start options
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

The Disk Utility function can only be started if the automatic mounting of hotplug storage devices is 
enabled. The automatic mounting of hotplug storage devices is enabled if the option Setup > Devices > 
Storage Devices > Hotplug Storage Devices > Enable dynamic client drive mapping is enabled or the 
number in Setup > Devices > Storage Devices > Hotplug Storage Devices > Number of Storage hotplug 
devices is greater than 0.



The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 





Accessories

IGEL OS Reference Manual   492 / 710

•

Autostart

☑ The session will be launched automatically when the device boots.

Relaunch

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

________

Using Disk Utility (see page 493)

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Using Disk Utility
To obtain information regarding a hotplug storage device connected to your thin client, proceed as follows:

Start the Disk Utility function. The start options are described under Disk Utility (see page 490).
Click on the desired hotplug storage device in the left-hand column.
The information regarding the hotplug storage device is shown in the right-hand column.

To remove a hotplug storage device safely, proceed as follows:

Start the Disk Utility function. The start options are described under Disk Utility (see page 490).
Click on the Safely Remove Hardware button in the right-hand column.
The hotplug storage device is disconnected from the thin client. Once it has been disconnected, 
the storage device can be removed from the thin client.

If Setup > Devices > Storage Devices > Storage Hotplug > Use storage hotplug beep is 
enabled, a signal tone will signal that the device has been disconnected successfully. If 
Setup > Devices > Storage Devices > Storage Hotplug > Show storage hotplug 
message is enabled, a message window will signal that the device has been disconnected 
successfully. Further information can be found under Storage Hotplug (see page 636).
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Disk Removal
Menu path: Accessories > Disk Removal

With this function, you can remove a hotplug storage device connected to your thin client safely without the risk of 
losing data. For details of how to use the function, see Using “Safely Remove Hardware” function (see page 496).

The settings for starting the function are described below:

Session name: Name for the session (default: Safely Remove Hardware)

Start menu: If this option is enabled, the session can be launched from the start menu.
Application Launcher: If this option is enabled, the session can be launched with the Application 
Launcher.
Desktop: If this option is enabled, the session can be launched with a program launcher on the 
desktop.
Quick start panel: If this option is enabled, the session can be launched with the quick start panel.
Start menu's system tab: If this option is enabled, the session can be launched with the start 
menu's system tab.
Application Launcher's system tab: If this option is enabled, the session can be launched with 
the Application Launcher's system tab.
Desktop context menu: If this option is enabled, the session can be launched with the desktop 
context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Show disk utility in device eject menu
☑ You can start the Disk Utility function from the context menu. (default)

_____

Using Safely Remove Hardware Function (see page 496)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Safely Remove Hardware Function
To remove a hotplug storage device safely, proceed as follows:

Start the Safely Remove Hardware function. The start options are described under Safely 
Remove Hardware (see page 494).
In the context menu, click on the hotplug storage device that you want to remove.
The hotplug storage device is disconnected from the thin client. Once it has been disconnected, 
the storage device can be removed from the thin client.

If Setup > Devices > Storage Devices > Storage Hotplug > Use storage hotplug beep is 
enabled, a signal tone will signal that the device has been disconnected successfully. If 
Setup > Devices > Storage Devices > Storage Hotplug > Show storage hotplug 
messages is enabled, a message window will signal that the device has been 
disconnected successfully.
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Mobile Device Access
Menu path: Setup > Accessories > Mobile Device Access

With this function, you can access the directories and files of a mobile device. Mobile device access is available from 
IGEL OS 10.04.100 onwards.

The following device types can be used:

Smartphones with Android (via MTP / PTP) or iOS
Tablets with Android via MTP / PTP) or iOS
Digital cameras

To use the mobile device access feature, you must first activate the function. For information about the activation 
and use, see Using Mobile Device Access.

The settings for starting the function are described below.

Session name: Name for the session.

Session start options
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Feature Not Available on IZ Devices

This feature is not available on IGEL IZ devices (IGEL Zero HDX, IGEL Zero RFX, or IGEL Zero Horizon).


Feature with limited support! The mobile device access feature comes with limited support and without 
any warranty. Any support for this feature is provided on a non-binding, “best effort” basis.



The functionality may differ according to the specific device and operating system version.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".
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[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Firmware Update
Menu path: Setup > Accessories > Firmware Update

With this function, you can update your thin client’s firmware. For details of how to use the function, see Using 
“Firmware Update” function (see page 502).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Firmware Update Function (see page 502)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Firmware Update Function
To launch the firmware update for your thin client, proceed as follows:

Ensure that the settings under System > Update > Firmware Update are correct. Further 
information can be found under Firmware Update (see page 664).
Start the Firmware Update function. The start options are described under Firmware Update (see 
page 500).
Confirm this by clicking Yes.
The latest firmware will be loaded onto your thin client. The thin client will restart in the process.
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Personalize Smartcard
Menu path: Setup > Accessories > Personalize Smartcard

With this function, you can change the password for your IGEL smartcard. For details of how to use the function, see 
Using “Personalize smartcard” function (see page 505).

Further information regarding the IGEL smartcard can be found in the Authentication with IGEL Smartcard how-to.

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Smartcard Personalization Function (see page 505)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Smartcard Personalization Function
With this function, you can change your user name, the associated password and sessions on your IGEL smartcard.

To personalize an IGEL smartcard, proceed as follows:

Start the Smartcard Personalization function. The start options are described under Personalize 
smartcard (see page 503).
Specify the access data on your IGEL smartcard:

First name: First name of the user
Last name: Surname of the user
Require password
☑ A password must be entered when logging on with this IGEL smartcard.
☐ No password must be entered when logging on.
Password: Password for logging on with this IGEL smartcard.

Select the sessions and functions that are to be available on this IGEL smartcard.
Specify the start behavior for the sessions and functions on this IGEL smartcard:

Autostart
☑ The session/function will automatically start after you log on. The application launchers 
configured in the desktop integration are available.
☐ The session will not automatically start. The application launchers configured in the 
desktop integration are available.
Restart
☑ The session/function will automatically restart after being closed.
☐ The session/function will not automatically restart.

Click on Write smartcard.

A confirmation dialog will appear when the writing operation is complete. 
You can now remove the IGEL smartcard.

Do not remove the IGEL smartcard before the writing operation is complete.
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Identify Monitors
Menu path: Setup > Accessories > Identify Monitors

With this function, you can identify the monitors connected to your thin client. For details of how to use the 
function, see Using “Identify Monitors” function (see page 508).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Identify Monitors Function (see page 508)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Identify Monitors Function
To identify the monitors connected to your thin client, proceed as follows:

 Start the Identify Monitors function. The start options are described under Identify Monitors (see page 506).
The following data are shown for each monitor:

Socket to which the monitor is connected
Type of monitor
Resolution currently used
Maximum resolution of the monitor if the resolution currently used is a different one
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Webcam Information
Menu path: Setup > Accessories > Webcam Information

With this function, you can change and check the settings for a connected webcam. For details of how to use the 
Webcam Information function, see Using Webcam Information (see page 511).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

_____

Using Webcam Information (see page 511)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Using Webcam Information
You can determine and change the width, height and frame rate for the webcam connected.

To determine and change the values for width, height and frame rate, proceed as follows:

Start the Webcam Information function.
The following values will be shown:

Width: Width of the image in pixels
Height: Height of the image in pixels
Rate: Frame rate in fps (frames per second: individual images per second). Example: 1/30
means 30 individual images per second.

Click on one of the fields to change the value. The supported values will be shown in the process.
Click on Test.
The video image generated by the webcam with the current settings will be shown.
In order to check whether the webcam is functioning in a session (e.g. redirected via Citrix HDX 
Webcam Redirection), open the website Cameroid in your browser within the session (Adobe Flash 
must be installed).

Alternatively, you can determine the values supported by the webcam in the local terminal with the 
command webcam-info -l .
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ICG Agent Setup
Menu path: Accessories > ICG Agent Setup

This tool helps you configure the connection to IGEL Cloud Gateway (ICG). To learn how to use it, please refer 
to Using ICG Agent Setup (see page 515).

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Relaunch

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Using ICG Agent Setup (see page 515)
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Using ICG Agent Setup
This assistant helps you configure the connection to IGEL Cloud Gateway (ICG):

 Start ICG Agent Setup. Start options are described in ICG Agent Setup.

Address: IP address or DNS name of the server running ICG. You can specify a TCP port by 
appending a colon and the port number.

 After entering the server address, click Connect.

If you are using an ICG certificate signed by an unknown CA:
Root certificate fingerprint: Fingerprint identifying the root certificate - three of four fields are 
prefilled. 
Supply the missing fingerprint field from the credentials you received from your system 
administrator.
ICG One-Time Password: The one-time-password you received from your system administrator.

 Click this icon in order to make the one-time password readable.

 Click this icon in order to change the keyboard layout for entering the 
password.

Login: Click this button to connect the thin client to ICG.
Finish: Click this button for instant connection to ICG. Otherwise it will be started automatically on 
next boot.

This cloud icon in the system tray indicates that the thin client is connected to ICG.
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User Interface
Display (see page 517)
Desktop (see page 523)
Language Settings for IGEL OS 11 (see page 539)
Screenlock / Screensaver (see page 540)
Input (see page 547)
Hotkeys (see page 557)
Font Services (see page 559)
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Display
Menu path: Setup > User Interface > Screen

Every screen connected to the IGEL UD device can be configured independently. The position of the individual 
screens can be determined in relation to Screen 1.

 Click on  to show the screen identifier on each device.

If you work in an environment with a number of monitors, see the How-To Multimonitor.

If you use the Shared Workplace (SWP) feature with user-specific display resolutions, see the How-To Display 
Configuration for Shared Workplace (SWP).

Screen configuration
Number of screens: Select how many monitors you would like to use.

Identifies each screen connected and specifies the connection and display resolution 
for each screen.

Arranges the screens in a single row.

Arranges the screens in two rows.

Rotates the selected screen anti-clockwise.

Rotates the selected screen clockwise.

Removes the screen which was last added.

Adds a screen.

The selected screen is highlighted with a blue frame. The black bar at the bottom edge of the screen represents the 
physical orientation of the monitor.

Selected screen: Selects a screen using this selection box to configure the following settings.

For details of the display resolution supported by your IGEL thin client, please see the relevant data sheet.
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Screen resolution: Move the slider to the resolution which the selected screen is to have. The 
resolution is shown in the right-hand box.

Advanced
Refresh rate: Number of individual images per second
Possible values:

56 ... 100 (default: 60)
Graphic card: Graphics card assigned to the selected screen. A graphics card can have more 
outputs than are actually used. In order to ensure transparency, you may need to assign the 
graphics cards manually.

Monitor: Assigns the screen selected under Selected screen to a monitor connection. Example: 
HDMI(II) (default: Automatic)

_____

Power Options (see page 519)
Access Control (see page 520)
Gamma Correction (see page 521)
Options (see page 522)

•

•

From IGEL Linux Version 10.03.100, you have the option of defining your own resolutions 
via the registry ( x.xserver0.custom_resolution ). In order for the values set 
there to take effect, the resolution must be set to "Automatic" (slider at the far left). The 
following parameters apply to the entry in the registry:

WxH  : W = width, H = height (example: 1920x1080)

WxH@R : W = width, H = height, R = refresh rate (example: 1920x1080@60 or 
1920x1200@59.8)



If Automatic is set for the Monitor and no configurable monitor is found for the selected 
graphics card, the next available monitor will be used by another graphics card.
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Power Options
Menu path: Setup > User Interface > Screen > Power Options

In this area, you can handle display power management.

Please note: Your screen must support Display power management signaling (DPMS).

Handle Display Power Management
☑ The DPMS energy saving functions are enabled.

 Specify separately for battery and mains operation the number of minutes before the screen switches to a 
specific energy-saving mode:
Three different modes are offered:

Standby Time (standby mode)
Suspend Time (sleep mode)
Off Time (Off)

If a device is switched on but not used for some time, energy can also be saved by Brightness Reduction.

 Specify by how many percent the brightness of the screen is to be reduced and how long the period of inactivity 
before brightness reduction should be. Values between 10 seconds and two minutes are available to choose from.

Naturally, all stages are gone through only if the X-Server does not receive any new entries during this 
period.
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Access Control
Menu path: Setup > User Interface > Screen > Access Control

In this area, you can control access to the screen. Thin client access control is enabled by default.

Disable console switching

☑ Access to your terminal screen is possible from any UNIX host. You can no longer access the console using [Ctrl] 
+ [Alt] + [F11] or [Ctrl] + [Alt] + [F12].

☐ You can access the console using [Ctrl] + [Alt] + [F11] or [Ctrl] + [Alt] + [F12]. (default)

Access Control

☑ Access to this display from other computers will be controlled. This access control is enabled by default. 
(default)

Disable TCP connections

☐ All TCP connections to the display are prohibited. Only local applications are displayed. The xhost mechanism no 
longer functions.
This parameter is ignored if XDMCP is configured.

Fixed X-Key

☑ You can grant specific users permanent remote access to the thin client:

Click on Calculate.
A 32-digit key will appear in the X-Key field.
Enter this key in the Xauthority file on the user’s computer.

List of trusted X hosts

Here, you can approve specific computers for console access:

Click on the Add button to open the entry mask.
Give the name of the remote host (not the IP address) you would like to add.
Confirm this by clicking OK.
The computer will be entered in the list.
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Gamma Correction
Menu path: Setup > User Interface > Screen > Gamma Correction

In this area, you can increase or decrease the various brightness ranges in order to adjust the display on your screen 
to your preferences.

Selected screen: Select the screen whose brightness you would like to adjust (default: First 
Screen).

You can then change the gamma values for red, green and blue. The scale ranges from 0.10 (dark) to 10 (light) and is 
set to 1.00 by default.

Gamma value Red: Changes the brightness curve for the red color portion.
Gamma value Green: Changes the brightness curve for the green color portion.
Gamma value Blue: Changes the brightness curve for the blue color portion.
Link Sliders
☑ All sliders are moved equally in order to change the brightness harmoniously. (default)
☐ Each slider can be moved individually. This way, you can also change the color ratio.
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Options
Menu path: Setup > User Interface > Screen > Options

Configure the options for the display here:

Monitor probing (DDC)
☑ You can share information between the system and the screen via the Display Data Channel. 
DDC is enabled by default and the native resolution supported by the screen is determined 
automatically. (default)
☐ Screen properties are not automatically detected.
Monitor DPI: Enter the DPI resolution (dots per inch) for your monitor (default: 96).
Color depth: Selects the desktop color depth
The following options are available:

True Color (24)
True Color (32)

Make sure that all screens connected to the thin client support the color setting.
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Desktop
Menu path: Setup > User Interface > Desktop

On this page, you can configure general settings for the appearance of the desktop:

Local window manager for this display: Here, you can disable the window manager if you only 
work in full-screen sessions and do not require this service.
User interface theme: The colors of windows such as the Application Launcher, the start menu, 
the local terminal, the taskbar and messages can be varied. You can either select one of our 
predefined color schemes or define a color scheme of your own.

IGEL Dark: The frame color is dark gray, IGEL logos are yellow.
IGEL Light: The frame color is light gray, IGEL logos are dark gray.
Custom Colors: Define your own color combinations below.

Desktop icon size: Specify the size in which you would like the icons to be displayed on the 
desktop (default 64).
Monitor for desktop icons: If you use several monitors, select the one which is to display desktop 
icons.

All monitors
As taskbar
1st monitor
2nd monitor
(other monitors if connected)

Single click mode:
☑ Open programs with a single click. This option was set up specially for users of touchscreen 
monitors.

Desktop fonts
Default font: Choose between serif and sans-serif text and between standard and bold. The 
following are available to choose from:

Sans
Sans bold
Serif
Serif Bold

Default font size: Specify your desired font size in pt (points) here (default: 10).
Desktop icon font size: Specify your desired font size for desktop icons in pt (points) here (default: 
11).
Titlebarfont: Choose between serif and sans-serif text and between standard and bold. The 
following are available to choose from:

Sans
Sans bold
Serif
Serif Bold

Titlebar font size: Specify your desired font size in pt (points) here (default: 11).
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Background (see page 525)
Taskbar (see page 528)
Taskbar Background (see page 530)
Taskbar Items (see page 531)
Pager - Virtual Workspaces for Organizing the IGEL OS Desktop (see page 532)
Start Menu (see page 537)
In-Session Control Bar (see page 538)
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Background
Menu path: Setup > User Interface > Desktop > Background

In this area, you can configure the desktop background with pre-defined IGEL backgrounds, a fill color or a color 
gradient.

You can also use a background image of your own.

Wallpaper: Provides a selection of pre-defined IGEL backgrounds:
neutral
disabled
black (4x3)
blue (4x3)
gray (4x3)
orange (4x3)
green
black (16x9)
blue (16x9)
gray (16x9)
orange (16x9)

Wallpaper Style: Provides various design versions:
Automatic
Centered
Tiled
Spread
Scaled
Zoomed

Color Style: Sets a fill color or a color gradient.
Solid color
Horizontal gradient
Vertical gradient

Desktop Color: Select a background color if you have not selected an image.
2nd Desktop Color: Select a second background color if you have not selected an image.
Custom Wallpaper Download:
☑ You can provide a user-specific background image on a download server.
Custom Wallpaper File: Give a name for the background image file.
Specify the download server under Desktop > Background > Custom Wallpaper Server.

You can set up a separate background image for each monitor that is connected to the thin client.

If you have already defined a server for the system update files, you can use the same 
server setting for downloading the background image.
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The user-specific background image will be downloaded from the specified server if the function was enabled and if 
requested manually (Update Background Image). The download can also be launched from the IGEL Universal 
Management Suite via Update desktop changes.

A user-specific boot image can be provided on a download server. The file types BMP, JPG, GIF, TIF, PNG 
and SVG are supported for an own background image and bootsplash. A total storage area of 25 MB is 
available for all user-specific images.
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Custom Wallpaper Server
Menu path: Setup > User Interface > Desktop > Background > Custom Wallpaper Server

In this area, you can configure the download server for your own background images.

Use firmware update server location
☑ The same server and path configuration is used as for the firmware update.
☐ An own server location is used. (default)
Protocol: Determines the protocol that is to be used. The following are available to choose from:

HTTP
HTTPS
FTP
SecureFTP
FTPS
File

Server Name: Name or IP address of the server used.
Server Path: Directory in which you saved the background image.
Port: Port used (default: 80)
User name: Name of the user account on the server
Password: Password for this account
Wallpaper update: Refreshes the background image.
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Taskbar
Menu path: Setup > User Interface > Desktop > Taskbar

In this area, you can enable and configure the taskbar.

You can change the following settings:

Use Taskbar:
☑ The taskbar is displayed and the following taskbar settings options are available.
Taskbar Position: Specifies the position in which the taskbar is displayed.
Possible values:

Bottom
Top
Left
Right

Vertical Taskbar Mode: Specifies how items are shown in the taskbar. This parameter is available 
if Taskbar Position is set to Left or Right.
Possible values:

Vertical: The session texts are rotated by 90°.
Deskbar: The session texts are not shown.

Taskbar Height/Width: Specifies the height of the taskbar in pixels (default 40).

Number of rows/columns in taskbar: Specifies the number of rows for the Quick Start Panel. The 
following taskbar items can be broken down into a number of rows and columns: Icons in the 
Quick Start Panel, window buttons. Possible values:

Automatic: The number of rows for the Quick Start Panel depends on the height and width 
of the taskbar.
Numeric value: The chosen value specifies the number of rows for the Quick Start Panel.

Multi Monitor Taskbar Size: Specifies whether the taskbar is expanded across a number of 
monitors or restricted to one monitor. Possible values:

Restrict taskbar to one monitor
Extend taskbar to all monitors

Monitor: Specifies the screen on which the taskbar is shown. This parameter is available if 
Taskbar size in Multi Monitor is set to Restrict taskbar to one monitor (default: 1st monitor).

•
•
•
•
•
•

If Maximum number of rows/columns in window button list is set to Automatic, the 
window buttons as well as the icons in the Quick Start Panel will be shown in a number of 
rows depending on the height of the taskbar. The number of rows increases in increments 
of 55 pixels:

1 - 55 pixels: One row
56 - 110 pixels: Two rows
111 - 165 pixels: Three rows
166 - 220 pixels: Four rows
221 - 275 pixels: Five rows
276 or more pixels: Six rows
The Maximum number of rows/columns in window button list parameter is 
described under Taskbar Items (see page 531).
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Taskbar on top of all windows:
☑ The taskbar is accessible on all screens, even in sessions with a full-screen window.
Taskbar Auto Hide:
☑ The taskbar is hidden and will only be shown if the mouse pointer is moved to the position of 
the taskbar at the edge of the screen.
Auto Hide Behavior: Specifies when the taskbar is automatically hidden.
Possible values:

Intelligent: The taskbar is shown as standard. The taskbar will be hidden if the space is 
needed by a window, e. g. a window in full-screen mode.
Continuous: The taskbar is hidden as standard. The taskbar will be shown if the mouse 
pointer is moved to the edge of the screen.

Taskbar Show Delay: Time interval in milliseconds before the taskbar is shown. The mouse 
pointer must be at the edge of the screen constantly during this time interval. This setting is only 
effective if Taskbar Auto Hide is enabled (default: 600).

Taskbar Hide Delay: Time interval in milliseconds before the taskbar is hidden. This setting is only 
effective if Automatically hide taskbar is enabled (default: 400).
Further settings options can be found under Screensaver and Screenlock (see page 540).

With the show delay, you can prevent the taskbar for a full-screen session being covered 
by the thin client's taskbar. A show delay is necessary if the taskbar for the full-screen 
session is set to be shown automatically and both taskbars are positioned at the same 
screen edge. If no show delay is set and the user brings up the taskbar for the full-screen 
session, this will immediately be covered by the thin client's taskbar. During the show 
delay time interval, the user has time to move the mouse pointer away from the edge of 
the screen.
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Taskbar Background
Menu path: Setup > User Interface > Desktop > Taskbar Background

You can specify the background style for the taskbar here.

Background Style:
Possible values:

System preset
Solid color
Color gradient
Background image

Depending of the above selection you can define following features:

Taskbar Color: Choose the color for the taskbar.
2nd Taskbar Color: Choose the 2nd color for the taskbar if you want to create gradient colors.
Reverse Gradient
☑ The color gradient is reverse.
☐ The color gradient is normal. (default)
Background Image Path: Path of your background image
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Taskbar Items
Menu path: Setup > User Interface > Desktop > Taskbar Items

Taskbar clock:
☑ A clock is shown in the taskbar.
Sorting order in window button bar: Specifies the criteria according to which the window 
buttons are sorted.
Possible values:

Time stamp: The window buttons are sorted in the chronological order in which the 
windows were opened.
Group and time stamp: The window buttons are grouped according to the type of 
application. If for example a number of setup applications are open, all associated window 
buttons will be arranged next to each other. Within the group, the window buttons are 
sorted chronologically.
Window title: The window buttons are sorted alphabetically.
Group and window title: The window buttons are grouped according to type. If for example 
a number of setup applications are open, all associated window buttons will be arranged 
next to each other. Within the group, the window buttons are sorted alphabetically.
Drag and drop: You can order the buttons as you wish using drag and drop. You must drag a 
button over at least half of the button to be skipped.

Maximum number of rows/columns in window button bar: Specifies the maximum number of 
rows available for window buttons.
Possible values:

Automatic: The number of rows depends on the Taskbar height/width and Number of 
rows/columns in taskbar parameters, see Taskbar.
Numeric values: This value specifies the maximum number of rows.

Show labels in window button bar:
☑ The names of the ongoing sessions are displayed in the associated window buttons. (default)
☐ Only the icons are displayed.
Taskbar system tray:
☑ The system tray is shown in the taskbar. (default)
Size of icons in system tray: Specifies the size of system tray icons (volume, network connection 
etc.).
You can choose a pre-defined value or enter a numeric value between 1 and 64. 
Predefined values:

Automatic: The size is adjusted to the height and width of the taskbar.
Small: 20 pixels
Medium: 40 pixels
Large: 60 pixels

Further settings options can be found under On-screen Keyboard (see page 465), Keyboard (see page 
548) and Additional Keyboard Layouts (see page 549) and Screensaver and Screenlock.
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Pager - Virtual Workspaces for Organizing the IGEL OS Desktop
In IGEL OS, you can use the Pager tool to enable the use of multiple virtual desktops. The Pager allows you to divide 
one desktop into several virtual workspaces and, thus, to better organize your desktop: for example, you can open a 
certain type of applications in one workspace and another type of applications in the second workspace. 

The Pager makes switching between multiple open applications easier – you can switch between full-screen 
applications at the click of a mouse. Instead of minimizing / maximizing sessions or switching between them using 
key combinations, you simply click on the desired workspace using the mouse. When you switch back, the virtual 
desktop is displayed exactly as before (unless you restarted the system or changed the language in the IGEL Setup). 

Menu path: User Interface > Desktop > Pager

Use Pager
☑ The Pager is enabled. You can configure up to 25 virtual desktops. The Pager will be displayed on the right of the 
taskbar:

Make sure you have enabled User Interface > Desktop > Taskbar (see page 528) > Taskbar on top of all 
windows.



The Pager can be used only in non-appliance mode.
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1.

For details on how to use the pager, see the below section "Example for how to Use the Pager (see page 533)".

☐ The Pager is disabled.*

Number of Screens - Horizontal
Specifies how many workspaces will be shown next to each other. (Default: 2)

Number of Screens - Vertical
Specifies how many workspaces will be shown above each other. (Default: 1)

Names of the workspaces
Specify names for the individual desktops.

Paging Resistance
Specifies how many pixels the cursor needs to be moved over the edge of the screen before it triggers a switch of 
the desktop. (Default: 10)

You only need to make this setting if you enable at least one of the following options – Wrap workspaces while 
dragging a window or Wrap workspaces with pointer.

Wrap workspaces while dragging a window
☑ The desktop is switched as soon as a window is dragged out of view.

☐ The desktop is not switched when a window is dragged out of view.*

Wrap workspaces with pointer
☑ The desktop is switched as soon as the mouse reaches the edge of the screen.

☐ The desktop is not switched when the mouse reaches the edge of the screen.*

Example for how to Use the Pager

Start your endpoint device and launch the desired sessions / applications, e.g. Firefox and 
Chromium browsers. 
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2. In the Pager panel in the taskbar, navigate to another workspace, e.g. Workspace 2, and click it.

You will see the "empty" desktop, i.e. without opened sessions / applications.
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3. Start the required sessions / applications, e.g. an RDP session. 
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4. When you need to switch back to the Firefox and Chromium browsers, simply select the 
corresponding workspace (in this example, Workspace 1) in the Pager panel in the taskbar.
Your desktop will be displayed exactly as before the switch to Workspace 2. Thus, you switch 
between your browser sessions and an RDP session without minimizing the latter.

*IGEL OS system default

Tip
You can use drag & drop to rearrange the sessions / applications between the workspaces: in the 
respective virtual desktop, click on the required application / session symbol on the left of the taskbar and 
drag it to the desired workspace.
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Start Menu
Menu path: Setup > User Interface > Desktop > Start Menu

In this area, you can configure the desktop start menu:

Start menu types
Classic - Default setting which is similar to that from Windows 95 - a list of available sessions 
and options
Advanced - An expanded start menu featuring a search function and a more attractive 
design. It requires more resources, which is particularly noticeable on slow devices.
Automatic - Automatically selects the classic or advanced start menu depending on the 
processor.

Select which options are to be shown in the start menu:

Lock screen
Log off
System restart
Shut down
System tab
Information

Show active user name in About, Application Launcher and Start Menu
☑ The current user will be shown at the top edge of the relevant window.
☐ The current user will not be shown.

•
•

In order for user names to be recognized and passed on, you must configure two settings 
beforehand:

Enable Active Directory/Kerberos: Security > Active Directory/Kerberos
Enable local logon: Security > Logon > Active Directory/Kerberos
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In-Session Control Bar
Menu path: Setup > User Interface > Desktop > In-Session Control Bar

In a full-screen session, the in-session control bar allows you

to eject a USB drive,
to start the wireless manager,
to minimize the session view,
to end the session.

Use in-session control bar in all supported sessions
☑ The in-session control bar is shown. Depending on the configuration, the in-session control bar 
will be permanently visible or will be shown as soon as you move the cursor to the top edge of the 
screen.
☐ In-session control bar is not used. (default)

The in-session control bar is available for the following session types:

RDP - see RDP Global (see page 108)
Citrix - see HDX / ICA Global (see page 52), Legacy ICA Sessions (see page 78) and Citrix StoreFront / Web 
Interface (see page 88)
ThinLinc - see ThinLinc (see page 293)
NX - see NX (see page 233)
Parallel 2X Client - see Parallel 2X Client (see page 255)

To use the in-session control bar, proceed as follows:

 To eject a USB device, click .

 To minimize the session view, click .

 To end the session, click .

 To make the in-session control bar permanently visible, click .
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Language Settings for IGEL OS 11
In this area, you can configure the country-specific language settings.

Menu path: Setup > User Interface > Language

Language
The language of the user interface.

Keyboard layout
When the language is changed for the first time, the keyboard layout is automatically set to the same language.

Show indicator in taskbar
☑ Shows a country abbreviation for the keyboard layout in the taskbar.

☐ No indicator is shown. (System default)

Input language
The keyboard layout is used by default.

Standards and formats
Specifies how country-specific formats for the time and currency are displayed, for example. The default setting is 
geared to the input language selected.
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Screenlock / Screensaver
Menu path: Setup > User Interface > Desktop > Screen Lock/Saver

You can set up the screen saver so that it is activated automatically after a time limit expires, via a button or in 
response to a key combination (hotkey). You can also select a password option. The look of the taskbar can be 
configured separately for the logon dialog and the locked screen.

The screen can be locked via icons in the Quick Start Panel and on the desktop or via the hotkey [Ctrl-Shift-L].

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Options (see page 543)
Taskbar (see page 544)
Screensaver (see page 545)
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Options
Menu path: Setup > User Interface > Screenlock / Screensaver > Options

Start automatically
☑ The screenlock or screensaver starts automatically if there is no activity on the thin client 
within this time limit. The screenlock can be overridden by the user or administrator with the 
relevant password (see: Password). (Default)
Timeout: Period of time in minutes before the screenlock or the screensaver starts. (Default: 5)
Screenlock Password
☑ None: No password is set. A screenlock cannot be set up.

Different screenlock timeout
☑ You can specify a time limit of your own for the screenlock. (Default)
☐ The same time limit will be used for the screenlock as for the screensaver. This means that after 
the set time the screen will be locked and then the screensaver will appear.
Screenlock timeout: Period of time in minutes before the screenlock starts. (Default: 5)
Allow administrator password:
☑ Access is allowed for the user and the administrator. (Default)
☐ Access is allowed for the user only.
Countdown duration in seconds: Countdown time with which the screenlock is initiated. If the 
value is 0, the screen is locked without a countdown. (Default: 0)

Countdown visual effect: While the countdown is running, a current screenshot is displayed in 
the background. This parameter determines the visual effect that the screenshot will be displayed 
with.
Possible options:

Dark screenshot
Gray screenshot

Countdown background image: Path and file name of an image file, which is displayed in the 
background while the countdown is running. This background image is displayed instead of the 
screenshot, if the path and file name are valid; if the field is empty, the screenshot is displayed. 
Supported file formats: JPEG, PNG, GIF. Example: /images/image.jpg

•
•
•
•
•
•

The appearance of the digits for the countdown is specified together with the settings for 
the clock display under Setup > User Interface > Screenlock / Screensaver > 
Screensaver; see Screensaver (see page 545). The following parameters are relevant for the 
countdown:

Clock display monitor
Show seconds
Horizontal clock position
Vertical clock position
Clock background color
Clock foreground color
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Taskbar
Menu path: Setup > User Interface > Desktop > Screen Lock/Saver > Taskbar

Taskbar settings when the logon dialog is visible
☑ Show taskbar during the logon dialog. (Default)

☑ Show clock. (Default)

☑ Show switch for the keyboard layout. (Default)

☑ Show “On-screen keyboard” button.

☑ Start on-screen keyboard automatically.

☑ Show “Restart” button.

☑ Show “Shut down” button. (Default)

Taskbar settings when the screen is locked
☑ Show taskbar when the screen is locked. (Default)

☑ Show clock. (Default)

☑ Show switch for the keyboard layout. (Default)

☑ Show “On-screen keyboard” button.

☑ Start on-screen keyboard automatically.

☑ Show “Restart” button.

☑ Show “Shut down” button.
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Screensaver
Menu path: Setup > User Interface > Desktop > Screen Lock/Saver > Screensaver

Screen background color: Color palette for determining the background color of the screen.
Enable image display
☑ An image will be shown as the screensaver. (default)
File for screen saver logo: Complete path for an individual image file or directory that contains an 
unlimited number of images. If no path is given, the IGEL logo will be used.

One image per monitor
☑ If a number of monitors are used, a different image will be shown on each one. (default)
☐ Images will be distributed over the monitors.
Image duration: Time in seconds until the image is changed. (default: 10)
Image display mode: Type of display. The following are available to choose from:

Small-sized hopping - Small images are shown in changing positions.
Medium-sized hopping - Larger images are shown in changing positions.
Full-screen center cut-out - The images are shown in full-screen size. However, they may be 
clipped.
Full-screen letterbox - The images are shown as large as possible in relation to the screen 
size.

Clock display monitor: Selects the monitor on which the clock is to be shown. The following are 
available to choose from:

None
All
A specific monitor

Show seconds: Shows the seconds too in digital format.
Clock display size: The following sizes are available to choose from:

Tiny
Small
Medium
Large
Huge

Horizontal clock position
Left
Center
Right

Vertical clock position
Top
Center
Bottom

Clock background color: Color palette for determining the background color of the clock.
Clock background opacity percentage: 75% is preset.

If you enter a folder instead of a single image file as the source, all images in the folder will 
be displayed as a slide show, the display time for the images can be configured.
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• Clock foreground color: Color palette for determining the foreground color of the clock.
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Input
Menu path: Setup > User Interface > Input

These setup pages allow you to set the keyboard layout and other input options.

The following input devices can be set up:

Keyboard (see page 548)
Mouse (see page 550)
Touchpad (see page 551)
Touchscreen (see page 554)
Signature pad (see page 556)
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Keyboard
Menu path: Setup > User Interface > Input > Keyboard

In this area, you can configure the keyboard.

Keyboard layout: Specify the keyboard layout. The selected layout applies to all parts of the system including 
emulations, window sessions and X applications.

Enable dead keys

☑ Dead keys can be used to enter special characters.

Keyboard type: Specifies the keyboard type.
Possible values:

Default: Automatically selects the keyboard type according to the computer type (Macbook, 
Chromebook or PC105 for all others).
Standard PC keyboard (105 keys)
IBM keyboard (122 keys)
Trimodal keyboard
Sun Type 6 keyboard
Chromebook
Macbook
Macbook international

Show indicator in taskbar

☑ Shows the language code for the keyboard in the taskbar.

Character Repeat
Repeat delay: Determines the delay (in milliseconds) before automatic repetition begins.

Key repeat rate: Determines the number of times a character repeats per second.

Start with NumLock on:

☑ NumLock will be enabled automatically during the boot process.
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Additional Keyboard Layouts
Menu path: Setup > User Interface > Input > Additional Keyboard Layouts

In this area, you can define additional keyboard layouts which can be selected by the user.

Enable this layout
☑ Keyboard layout is enabled and can be defined.
Keyboard layout: Selects the language for the keyboard layout.
Enable dead keys: Enable this function if the keyboard used supports dead keys for special 
characters.
Hotkey
☑ A hotkey allowing you to switch to this keyboard can be defined.
Key: Select a key for the key combination.
Modifier: If necessary, select an additional modifier.

Hotkey for default keyboard layout

Enable hotkey to switch to the default keyboard layout
☑ A hotkey which takes you back to the default keyboard layout can be defined. This is useful 
when a number of keyboard layouts are configured.

Hotkey for next keyboard layout

Enable hotkey to switch between a number of keyboard layouts
☑ A hotkey which switches to the next keyboard layout can be defined. This is useful when a 
number of keyboard layouts are configured.
Further settings can be configured under On-screen Keyboard (see page 465).
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Mouse
Menu path: Setup > User Interface > Input > Mouse

In this area, you can configure the mouse.

Lefthand mode
☑ The mouse is switched to left-handed mode.
Emulation 3 Button Mouse: Enables/disables emulation of the third (middle) mouse button for 
mice with only two physical buttons. This third button is emulated by pressing both buttons at the 
same time. If 3-button emulation was enabled, the emulation time limit determines how long (in 
milliseconds) the driver waits before deciding whether two buttons were pressed at the same 
time.
Hide Cursor: The mouse pointer will be hidden after the defined time limit.
Pointer Speed: Determines the mouse resolution in counts per inch.
Double Click Interval: Changes the maximum interval in milliseconds between two consecutive 
mouse clicks which are to be recognized as a double-click.
Double Click Distance: Changes the maximum distance in pixels between two clicks which are to 
be recognized as a double-click. The object under the second click is double-clicked.
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Touchpad
Menu path: Setup > User Interface > Input > Touchpad

Here, you can configure touchpad settings.

Custom configuration
☑ Using the following options, adapt the touchpad to your needs.
☐ No custom configuration. (default)
Operating mode: Allows various touchpad modes. Possible values:

Enable touchpad
Switch off touchpad
Turn off tapping and scrolling only

Min speed: Minimum speed of the pointer in seconds (default: 1.00)
Max speed: Maximum speed of the pointer in seconds (default: 1.75)
Acceleration: Acceleration from the minimum to the maximum speed in seconds (default: 0.01)

With a number of touchpads, you can assign functions to the four corners. Specify which mouse button is clicked by 
tapping in the relevant corner:

No action
Left mouse button
Middle mouse button
Right mouse button

The following settings apply by default:

Action top left: No action
Action bottom left: No action
Action top right: Middle mouse button
Action bottom right: Right mouse button

The actual settings options depend on the hardware supported by the particular touchpad.
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Touchpad Scrolling
Define the properties for vertical and horizontal scrolling here.

Vertical

Vertical scrolling
☑ The right edge of the touchpad will be used as a vertical scrollbar. The vertical scroll speed can 
be set.
☐ The right edge is not enabled as a scrollbar. (default)
Vertical scroll speed: Specifies from what distance scrolling is recognized when moving in a 
vertical direction. (default: 25.00)
Scroll vertically with two fingers:
☑ Two-finger scrolling is enabled for vertical scrolling.
☐ Two-finger scrolling is disabled.

Horizontal

Horizontal scrolling:
☑ The bottom edge of the touchpad will be used as a horizontal scrollbar. The horizontal scroll 
speed can be set.
☐ The bottom edge is not enabled as a scrollbar. (default)
Horizontal scroll speed: Specifies from what distance scrolling is recognized when moving in a 
horizontal direction. (default: 25.00)
Scroll horizontally with two fingers:
☑ Two-finger scrolling is enabled for horizontal scrolling.
☐ Two-finger scrolling is disabled.
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Touchpad Advanced
Further settings are possible here:

Corner coasting
☑ You can continue scrolling if your finger reaches the corner when scrolling vertically or 
horizontally along the touchpad edges.
Circular scrolling
☑ You can scroll in a circle. In the selection menu, specify where circular scrolling is to begin.

Circular scrolling enabled at 
All Edges 
Top Edge 
Top Right Corner 
Right Edge 
Bottom Right Corner 
Bottom Edge 
Bottom Left Corner 
Left Edge 
Top Left Corner

Tap and drag gesture
☑ You can move items by tapping and dragging them.
Locked drags
☑ The tap and drag gesture ends only after an additional tap; it will otherwise end when you let 
go.
Palm detect
☑ Avoids triggering a function accidentally with the palm of your hand. The function must be 
supported by the device.
ClickPad
☑ ClickPads are permitted. These are touchpads with so-called integrated soft buttons on which 
physical clicks are possible.
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Touchscreen
Menu path: Setup > User Interface > Input > Touchscreen

Here, you can configure a touchscreen. To ensure that you can open the setup and navigate within it, the initial 
configuration should take place with a mouse and keyboard connected.

You will find an up-to-date list of the touchscreens supported by IGEL in the IGEL Third Party Hardware Database16.

Enable touchscreen
☑ The touchscreen is enabled.
☐ The touchscreen is disabled. (default)
Touchscreen type: Selects the touchscreen driver which is to be used.
Possible options:

EvTouch (USB)
eGalax
Elo Multitouch (USB)
Elo Singletouch (USB)
TSharc

You will find the complete list of supported devices in the IGEL Hardware Database17.
Touchscreen already calibrated
If you enable the touchscreen function, the touchscreen must be calibrated first.
☑ Calibration starts automatically after each system boot. (default)
☐ Calibration does not start automatically after each system boot.
Swap X and Y values
☑ X values are interpreted as Y values and Y values as X values. Enable this option if the mouse 
pointer moves vertically when you move your finger in a horizontal direction.
☐ X and Y values are not swapped. (default)
Minimal/maximal X value/Y value: These values are determined by the calibration tool. However, 
you can also change them manually. (default: 0 / 4000)
Untouch delay: The maximum permitted time (in milliseconds) between two instances of contact 
which are still registered as a single touch. When moving windows by drag-and-drop, for example, 
your contact with the screen may inadvertently be interrupted. Increasing this value prevents the 
thin client from recognizing two individual contacts if you let go in this way. (default: 3)
Report delay: Determines how long (in milliseconds) the screen needs to be touched in order for 
the contact to be recognized. (default: 2)
Emulate right button
☑ A right-click is generated by touching the screen for a long time.
☐ Touching the screen for a long time does not generate a right-click. (default)
Right button timeout: Time (in milliseconds) after which a right-click is generated. (default: 1000)
Set driver-specific defaults: Loads the preset for the driver currently selected under 
Touchscreen type. Click on this button once after changing the touchscreen type or to restore the 
default settings.

https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
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Multimonitor

Graphic card: Graphics card assigned to the selected touchscreen. A graphics card can have more 
outputs than are actually used. In order to ensure transparency, you may need to assign the 
graphics cards manually.

Touchscreen monitor: Assigns a monitor connection to the touchscreen. Example: HDMI(II) 
(default: Automatic)

To set up a touchscreen and on-screen keyboard, proceed as follows:

 Enable the on-screen keyboard for the touchscreen use under Setup > Accessories > On-Screen Keyboard; see 
On-Screen Keyboard (see page 465).

 Calibrate the touchscreen for optimum contact recognition. The touchscreen calibration application can be 
found under Application Launcher > System.
In the calibration program, you will see a pattern with calibration points which must be touched one after another.

If “Automatic” is set for the touchscreen monitor and no configurable monitor is found 
for the selected graphics card, the next available monitor will be used by another graphics 
card.



The layout for the normal keyboard will also be used for the on-screen keyboard.
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Signature Pad
Menu path: Setup > User Interface > Input > Signature Pad

You can connect signature pads from the following manufacturers here:

StepOver;
signotec.

StepOver

Enable StepOver TCP Client
☑ The StepOver TCP Client is enabled and you can use USB signature pads from this 
manufacturer in sessions.
☐ The StepOver TCP Client is not enabled. (Default)
Listening TCP port: If necessary, you can change the TCP port. (Default: 8888)

signotec

Enable signotec VCOM daemon
☑ The signotec VCOM daemon is enabled and you can use USB signature pads from this 
manufacturer in sessions.
☐ The signotec VCOM daemon is not enabled. (Default)

See also the tip & trick Connecting Signature Pads.
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•

Hotkeys
Menu path: Setup > User Interface > Hotkeys > Commands

In order to make it easier to use your thin client, hotkeys are available for frequent operating routines. A hotkey is a 
combination of one or more modifiers and an alphanumeric key.

You can enable or disable hotkeys and change the keys used.

To enable or disable a hotkey, proceed as follows:

Highlight the hotkey in the list.
Click on Modify....
Enable or disable the Hotkey option in the dialog window.
Click on Ok in the dialog window.
Click on Apply or Ok.

To change the keys used for a hotkey, proceed as follows:

Highlight the hotkey in the list.
Click on Modify....
In the Modifiers selection list, select a modifier, no modifier or a combination of modifiers.
Enter the Key.
Click on Ok in the dialog window.
Click on Apply or Ok.

_____

Commands (see page 558)
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Commands
Menu path: Setup > User Interface > Hotkeys > Commands

The following hotkeys are available and can be changed:

Hide all windows and show desktop
Screenshot of the active window
Screenshot of the entire screen
Volume up (multimedia key)
Volume down (multimedia key)
Volume mute (multimedia key)
Switch between active windows using Task Switcher
Switch between active windows using Task Switcher (backwards)
Open start window
Open start window (alternative)
Switch focus to next window (sorted backwards)
Switch focus to next window
Switch focus to next window (alternative)
Mapping Ctrl+Alt+End to Ctrl+Alt+Del for Citrix sessions
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Font Services
Menu path: Setup > User Interface > Font Services

You can import further fonts in addition to the ones provided by IGEL:

XC Font Service (see page 560)
NFS Font Service (see page 561)
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XC Font Service
Menüpfad: Setup > User Interface > Font Services > XC Font Service

In this area, you can configure the XC Font Service.

Enable XC Font Service
☑ The XC Font Service is enabled.
☐ Der XC Font Service is not enabled. (Default)

Once you have enabled the XC Font Service, you can define the following settings:

XC Font Server: The server on which the XC Font Service is running.
Port Number: The port number on which the XC Font Service is available. (Default: 7100)
Prefer Local Fonts
☑ Local fonts are used before a request is sent to the font server.
☐ Local fonts are not preferred. (Default)
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NFS Font Service
Menu path: Setup > User Interface > Font Services > NFS Font Service

Using the NFS font service is another way to import additional fonts. The NFS font service also offers the advantage 
that the mount point for the fonts can be configured. This is necessary for a number of remote applications that 
search for your fonts in a specific directory.

To define and enable an NFS font path entry in order to use the NFS font service, proceed as follows.
Click on Add  to open the dialog window:

Local Path: Defines the local directory for the mount point
NFS Server: Name or IP address of the server that makes available the font directories via 
NFS.
Remote Path: Path on the server under which the fonts are available.
Prefer Local Fonts
☑ Local fonts are used before a request is sent to the font server.

Click on OK to enable the entry.
Export the font directory on the server via NFS read-only for the thin client.
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Network
In this area, you can configure network connections of the endpoint device.

LAN Interfaces (see page 563)
Mobile Broadband (see page 579)
DHCP Client (see page 581)
VPN (see page 584)
SCEP Client (NDES) (see page 606)
Routing (see page 610)
Hosts (see page 611)
Network Drives (see page 612)
Proxy (see page 617)
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LAN Interfaces
Menu path: Setup > Network > LAN Interfaces

Here, you can configure the LAN interfaces.

Activate default interface (Ethernet)

☑ The default interface is enabled. (Default)

☐ The Ethernet interface is not enabled.

Get IP from the DHCP server: The IP address of the client will be obtained automatically using DHCP. (Default)

DHCP options can be specified under DHCP Client (see page 581).

Specify an IP address: The IP address and the network mask are entered manually.

IP address: IP address of the device.

Network mask: Network mask of the device.

Default gateway: IP address of the default gateway.

Enable

☑ Routing via the default gateway is enabled.

☐ Routing via the default gateway is not enabled. (Default)

Terminal name: Local name of the device. If the field is empty, the default name combined of ' ITC ' with a MAC 
address will be generated.

Enable DNS

☑ The manual DNS configuration will be used.

☐ The DNS configuration will be carried out by DHCP or BOOTP. (Default)

Default domain: Usually the name of the local network.

Name server: IP address of the name server to be used.

Name server: IP address of an alternative name server.

Manually overwrite DHCP settings

☑ The default route, the domain name, and the DNS server will be overwritten by manual entries.

☐ Manual entries will not overwrite DHCP settings. (Default)

Dynamic DNS registration:

☑ The terminal name will be registered dynamically via the DNS or DHCP server.

☐ The terminal name will not be registered dynamically. (Default)

Dynamic DNS registration method

If a number of Ethernet interfaces are available, the device designated as /dev/eth0  by Linux will be 
used as the default interface.
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DHCP: Updates the terminal name through DHCP option 81.
DNS: Sends updates to the DNS server in accordance with RFC 2136.

TSIG key file for additional DNS authentication: Path to the private key if TSIG-based DDNS registration is used.

Individual Interface (see page 565)
Wireless (see page 570)
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Individual Interface
Menu path: Setup > Network > LAN Interfaces > [Interface]

Activate default interface (Ethernet)

☑ The default interface will be enabled. (Default)

☐ The Ethernet interface will not be enabled.

Get IP from DHCP server

☑ The IP address of the client will be obtained automatically using DHCP. (Default)

DHCP options can be specified under DHCP Client (see page 581).

Specify an IP address: The IP address and the network mask are entered manually.

IP address: IP address of the device.

Network mask: Network mask of the device.

IPv6 Configuration

Compatibility mode: Behavior of earlier firmware versions.
Disabled: IPv6 completely disabled.
Automatic: IPv6 auto configuration based on router advertisements (can include DHCPv6).
For further information, see RFC 4861.18

DHCPv6: IPv6 configuration using DHCPv6 if router advertisements are not available.
This is mentioned in RFC 4862 Section 5.5.2.19

Network link type

Auto sense
1000 Mb/s full duplex
100 Mb/s full duplex
100 Mb/s half duplex
10 Mb/s full duplex
10 Mb/s half duplex

Force auto-negotiation

☑ With this option, problems with half/full duplex for specific switches that expect the auto-negotiation flag for 
fixed bandwidths can be addressed.

☐ Automatic negotiation will not be forced. (Default)

Enable tray icon

☑ A tray icon for the network interface will be shown. (Default)

If a number of Ethernet interfaces are available, the device designated as /dev/eth0  by Linux will be 
used as the default interface.



https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
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Enable context menu

☑ A context menu will be shown when you click on the tray icon. (Default)

Enable network info dialog

☑ A dialog window with information regarding the network connection will be shown when you click on the 
context menu. (Default)

Authentication (see page 567)
Wake-on-LAN (see page 569)
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Authentication
Menu path: Setup > Network > LAN Interfaces > [Interface] > Authentication

Here, you can enable and configure network port authentication.

Enable IEEE-802.1x authentication

☑ Network port authentication is enabled.

☐ Network port authentication is not enabled. (Default)

If you enable authentication, further options are available:

EAP type: Here, you can select the authentication procedure:

PEAP
TLS
TTLS

Auth method: The following authentication methods are available:

MSCHAPV2
TLS
GTC
MD5
PAP

Validate server certificate

☑ The server’s certificate is checked cryptographically. (Default)

CA Root certificate: The path to the CA root certificate file. This can be in PEM or DER format.

Identity: User name for RADIUS

Password: Password for network access

The following settings are relevant if you have selected "TLS" as EAP type:

Manage certificates with SCEP (NDES)

☑ Client certificates will automatically be managed with SCEP (see page 606).

☐ Client certificates will not be managed with SCEP (see page 606). (Default)

Client certificate: Path to the file with the certificate for client authentication in the PEM (base64) or DER format.

If you leave the Identity and Password fields empty, an entry mask for authentication purposes will be 
shown. However, this does not apply to the methods with a client certificate (TLS and PEAP-TLS) where 
these details are mandatory.



If a private key in the PKCS#12 format is used, leave this field empty.
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Private key: Path to the file with the private key for the client certificate. The file can be in the PEM (base64), DER, 
or PFX format. The Private key password may be required for access.

Identity: User name for network access

Private key password: Password for the Private key for the client certificate



Network

IGEL OS Reference Manual   569 / 710

Wake-on-LAN
Menu path: Setup > Network > LAN Interfaces > [Interface] > Wake-On-LAN

Select the packets or messages with which the endpoint device can be started via the network.

For further information on the Wake-on-LAN functionality of the UMS, see Wake-on-LAN.

Wake on magic packet

☑ The device can be started with a Wake-on-LAN magic packet. (Default)

Wake on ARP packet

☑ The device can be started with a Wake on ARP packet.

☐ The device cannot be started with a Wake on ARP packet. (Default)

Wake on broadcast message

☑ The device can be started with a Wake on broadcast message.

☐ The device cannot be started with a Wake on broadcast message. (Default)

Wake on multicast message

☑ The device can be started with a Wake on multicast message.

☐ The device cannot be started with a Wake on multicast message. (Default)

Wake on physical activity

☑ The device can be started with a physical activity.

☐ The device cannot be started with a physical activity. (Default)

Wake on unicast message

☑ The device can be started with a Wake on unicast message.

☐ The device cannot be started with a Wake on unicast message. (Default)
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Wireless
Menu path: Setup > Network > LAN Interfaces > Wireless

In this area, you can configure everything relating to your wireless connections.

You will find details of compatible wireless hardware in the IGEL Linux 3rd Party Hardware Database20.

Activate wireless interface
☑ The default interface is enabled.
☐ The wireless interface is not enabled. (Default)

Get IP from DHCP server: The IP address of the client will be obtained automatically using DHCP. 
(Default)
DHCP options can be specified under DHCP Client (see page 581).
Specify IP address: The IP address and the network mask are entered manually

IP address: IP address of the thin client
Network mask: Network mask of the thin client

IPv6 configuration:
Compatibility mode: Behavior of earlier firmware versions
Disabled: IPv6 is completely disabled.
Automatic: IPv6 auto configuration is based on router advertisements (can include 
DHCPv6).

You will find further information in RFC 486121.
DHCPv6: IPv6 configuration using DHCPv6 if router advertisements are not available.

You will find further information in RFC 4862 Section 5.5.222.
Enable tray icon
☑ A tray icon for the wireless interface will be shown. (Default)
Enable context menu
☑ A context menu will be shown when you click on the tray icon. (Default)
Enable network info dialog
☑ A dialog window with information regarding the network connection will be shown when you 
click on the context menu. (Default)
Enable Wireless Manager:
☑ The Wireless Manager (see page 572) is enabled. This tool allows the user to establish a 
connection to a wireless network quickly. (Default)
☐ The Wireless Manager is disabled.

Configure the wireless frequency range (see page 578) to ensure that your device meets the local regulations 
for wireless equipment.



Note that only the first wireless interface ( wlan0 ) is supported. All other wireless interfaces will 
be ignored.



https://www.igel.com/linux-3rd-party-hardware-database/
https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
https://www.igel.com/linux-3rd-party-hardware-database/
https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
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__________
Wireless Manager (see page 572)
Default Wi-Fi Network (see page 574)
Additional Wi-Fi Networks (see page 577)
Wireless Regulatory Domain (see page 578)

If you use wireless regularly, it is recommended that you enable the following options: 
Tray icon, Enable context menu, Enable Wireless Manager. Via the Wireless Manager, 
you can use IGEL Café Wireless.
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Wireless Manager
The Wireless Manager tool allows the user to connect quickly to available wireless networks.

You can bring up the Wireless Manager from the tray icon for wireless:

Click on the tray icon for wireless and select Manage wireless networks from the context menu.

Search for available networks.
The list of active networks is sorted according to the quality of their signal strength.
Previously configured connections are flagged with a tick in the Configured column.
The connection currently active is likewise flagged with a symbol under Connected.

The Wireless Manager can be enabled under Network > LAN Interfaces > Wireless.
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3.

4.

5.

Double-click on a network in the list in order to open the entry mask.
You can either permanently save the logon information or enter it each time you establish a 
connection to this network.

Click on the Connect network button in order to establish the previously configured connection:
The tray icon will change to show the connection quality. 
Hidden networks appear in the Wireless Manager with the network name empty or can be defined 
using the Search for network button. 
In order to connect to a previously unknown hidden network, you must first enter the SSID before 
the access data are retrieved:

In the context menu for the tray icon, all available networks are listed and can be brought up from 
here.
The IGEL Setup shows all connections configured by the local user under Network > LAN 
Interfaces > Wireless > Additonal Wi-Fi Networks.

See also Café Wireless (Wi-Fi).

Click on the key symbol in order to display the key phrase while you are typing.

If you have configured the available connections, you will no longer need the Wireless 
Manager in order to establish a connection.
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Default Wi-Fi Network
Menu path: Setup > Network > LAN Interfaces > Wireless > Default Wi-Fi network

Here, you can configure wireless network connections.

Disable Encryption: No encryption will be used. (Default)

Enable WEP Encryption: WEP encryption will be used.

Enable WPA Encryption: WPA encryption will be used.

Wireless Network Name (SSID): Name of the wireless network (SSID)

For WEP Encryption

Transmit key ID: Choose from a maximum of four configurable keys. (Default: 1)

Key Format:

ASCII
Hexadecimal

Key [1-4]: Enter the key here.

For WPA/WPA2 Personal Encryption

Network authentication

WPA Personal: Wi-Fi Protected Access Pre-Shared Key (WPA / IEEE 802.11i/D3.0)
WPA Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA / IEEE 802.11i/D3.0)
WPA2 Personal: Wi-Fi Protected Access Pre-Shared Key (WPA2 / IEEE 802.11i/RSN)
WPA2 Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA2/IEEE 802.11i/RSN)

Network key: WPA network key/passphrase as set at the dial-in point. This is either an ASCII character string with a 
length of 8...63 or exactly 64 hexadecimal digits.

Data encryption:

Default: The default value depends on which network authentication method is selected - TKIP for 
WPA, AES (CCMP) for WPA2.
TKIP: Temporal Key Integrity Protocol (IEEE 802.11i/D7.0)
AES (CCMP): AES in Counter mode with CBC-MAC (RFC 3610, IEEE 802.11i/D7.0)
AES (CCMP) + TKIP: One of two encryption methods is selected by the access point.
Automatic: The access point can choose the encryption method freely – nothing is stipulated.

You will need to give further information depending on the encryption method chosen.

•
•

Characters to be entered for WEP keys:
For 64-bit encryption, 5 characters (ASCII) or 10 hex digits (hexadecimal)
For 128-bit encryption, 13 characters (ASCII) or 26 hex digits (hexadecimal)
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AP Scan mode: Scan mode for access points

Default
Broadcast: Alternative for access points which allow the SSID broadcast
No broadcast: Alternative for access points which refuse the SSID broadcast (hidden access points)

For WPA/WPA2 Enterprise Encryption

Network authentication:

WPA Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA / IEEE 802.11i/D3.0)
WPA2 Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA2/IEEE 802.11i/RSN)

Data encryption:

Default: The default value depends on which network authentication method is selected - TKIP for 
WPA, AES (CCMP) for WPA2.
TKIP: Temporal Key Integrity Protocol (IEEE 802.11i/D7.0)
AES (CCMP): AES in Counter mode with CBC-MAC (RFC 3610, IEEE 802.11i/D7.0)
AES (CCMP) + TKIP: One of two encryption methods is selected by the access point.
Automatic: The access point can choose the encryption method freely – nothing is stipulated.

AP Scan mode: Scan mode for access points

Default
Broadcast: Alternative for access points which allow the SSID broadcast
No broadcast: Alternative for access points which refuse the SSID broadcast (hidden access points)

EAP Type

PEAP
TLS: Transport Layer Security with client certificate
TTLS: Tunneled Transport Layer Security (from IGEL Linux 10.04.100 onwards)

Auth Method: Method for authentification that is available for the selected EAP type
Possible options for PEAP:

MSCHAPv2: Microsoft Challenge Handshake Authentication Protocol
TLS: Transport Layer Security with client certificate
GTC: Generic Token Card
MD5: MD5-Challenge

Possible options for TTLS:

MSCHAPv2: Microsoft Challenge Handshake Authentication Protocol
PAP: Password Authentication Protocol

Validate Server Certificate

☑ The thin client validates the authenticity of the authentification server against the certificate file. This certificate 
file is stored under the path defined by CA Root Certificate.

☐ The authenticity of the authentification server is not validated.
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CA Root Certificate: Path and file name of the file that contains the certificates with which the authentification 
server authenticates itself.

Identity: User name that is stored at the authentification server

Password: Password relevant to the user name

Learn more from the how-to Using WPA Enterprise / WPA2 Enterprise with TLS Client Certificates.
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Additional Wi-Fi Networks
Menu path: Setup > Network > LAN Interfaces > Wireless > Additional Wi-Fi Networks

You can add other wireless networks here. The settings options per wireless network correspond to those for the 
Default Wi-Fi Network (see page 574).

To edit the wireless network list, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.
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Wireless Regulatory Domain
Menu path: Setup > Network > LAN Interfaces > Wireless > Wireless Regulatory Domain

This page allows you to set the wireless device in accordance with local regulations.

Wireless regulatory domains: Select the area in which the device is located.

Not configured
Africa
Arctic
Asia
Australia
Europe
North America
South America
World

Location: Select the country in which the device is located.

Not configured
Albania
Armenia
[...]
Cyprus
Austria

The list below sets out the technical requirements for the selected location for your information.
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Mobile Broadband
Menu path: Setup > Network > Mobile Broadband Network

Here, you can change the settings for a modem or a surf stick. This function is available from IGEL Linux Version 
10.03.100.

If the device is already inserted and has been configured, the network connection will be established after the thin 
client boots. It can take between a few seconds and around 1 minute to establish a connection. The network 
connection will remain in place until the surf stick is removed or the thin client is put on standby or shut down.

The status of the network connection is shown in the system tray:

 The network connection is established; the thin client is online This symbol is only shown if 
“Modem” is selected as the device type. If "Router” is selected as the device type, the symbol for a 

LAN connection  will be shown.
 The network connection was interrupted; the thin client is offline This symbol is only shown if 

“Modem” is selected as the device type. If "Router” is selected as the device type, the 
corresponding symbol for a LAN connection will be shown.

You can change the following settings:

Enable mobile broadband
☑ The mobile broadband network can be used if a supported modem is connected.
☐ The mobile broadband network cannot be used. (default)
Device type
Possible options:

Modem: The device will be operated as a modem. The access data can be changed with the 
parameters number, user name, password, APN, network ID and PIN.
Router: The device will be operated as a router. The device must be configured in advance in 
such a way that it is ready for use when it is inserted.

Number: Access number for your network connection. If you do not know the access number, ask 
your mobile communications operator for it.
User name: User name for your network connection. If you do not know the user name, ask your 
mobile communications operator for it.
Password: Password for your network connection. If you do not know the password, ask your 
mobile communications operator for it.
APN: APN (Access Point Name) for your network connection. If you do not know the APN, ask your 
mobile communications operator for it.

•
•

Ensure that data traffic is adequately secured. You can do this in the following ways:
Use a private APN.
Use OpenVPN and block traffic that would circumvent VPN with firewall rules.



Select the "Router” device type if you use a device from Huawei in the HiLink mode; 
example: Huawei E3372.
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Network ID: Network ID for your network connection. If you do not know the network ID, ask your 
mobile communications operator for it.
PIN: PIN for the SIM card used.
Enable tray icon
☑ The current status of the network connection is shown with the symbol  or .
☐ The current status of the network connection is not shown with a symbol.
Enable context menu
☑ If you click on  or , a context menu can be opened.
☐ No context menu can be opened.
Enable network info dialog
☑ Via the context menu, you can bring up detailed information regarding the network 
connection.
☐ No detailed information regarding the network connection can be brought up.
Enable mobile broadband configuration dialog
☑ Via the context menu, you can open a configuration dialog in order to change the access data.
☐ The configuration dialog cannot be opened.
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DHCP Client
Menu path: Setup > Network > DHCP Client

Here, you can change the advanced settings for the firmware’s built-in DCHP client.

_____

Default Options (see page 582)
User-Defined Options (see page 583)
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Default Options
Menu path: Setup > Network > DHCP Client > Default Options

User Class: A freely definable character string which can serve as a criterion for allocating specific 
settings for the DHCP server.
List of standard options: Options with which the client can request information from the DHCP 
server.
You will find information regarding the various DHCP options in RFC 2132 DHCP Options and 
BOOTP Vendor Extensions23.

To edit the list, proceed as follows:
Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

https://tools.ietf.org/html/rfc2132
https://tools.ietf.org/html/rfc2132
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User-Defined Options
Menu path: Setup > Network > DHCP Client > User-Defined Options

 To create a new entry, click on  in the List of custom options area.

Enabled
☑ The option is enabled. (default)
☐ The action is not enabled.
Option Name: Add a prefix of your own in order to prevent a conflict with the default DHCP 
options. Example of the syntax: [ YourPrefix]-[OptionName] . English letters, numbers and 
the special character “-” are allowed.
Code: A number that is used by the DHCP server and DHCP client to reference an option. A number 
between 80 and 254 can be chosen. (default: 80)
Data Type: Type of option. Possible values:
boolean 
integer 8 
integer 16 
integer 32 
signed integer 8 
signed integer 16 
signed integer 32 
unsigned integer 8 
unsigned integer 16 
unsigned integer 32 
ip address 
text 
string

For more information regarding these options, see the manual for your DHCP server or your network 
components.
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VPN
Menu path: Setup > Network > VPN

Remote users securely access company networks via virtual private network protocols (VPN).

Enable tray icon
☑ A tray icon for the network interface will be shown. (default)
Enable context menu
☑ A context menu will be shown when you click on the tray icon. (default)
Enable network info dialog
☑ A dialog window with information regarding the network connection will be shown when you 
click on the context menu. (default)

_____

OpenVPN (see page 585)
OpenConnect VPN (see page 594)
genucard (see page 599)
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OpenVPN
Menu path: Setup > Network > VPN > OpenVPN

The OpenVPN client puts in place a virtual private network using TLS encryption and requires OpenVPN 2.x as a VPN 
server.

Enable Autostart During Boot
☑ Shows the Auto column in the list of OpenVPN sessions. Highlight the desired session and click 
on Set Auto to enable this connection to be established during the boot procedure.
☐ Autostart is disabled. (default)
Restart connection when disconnected:

To manage the list of OpenVPN session, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

_____

Session (see page 586)
Options (see page 588)
TLS Options (see page 589)
Proxy (see page 590)
IPv4 (see page 591)
Route (see page 592)
Desktop Integration (see page 593)

IGEL Linux 10.01.100 does not support the use of OpenVPN with smartcards and eTokens.

If problems with OpenVPN occur, read the /tmp/journal.log  log file with the System Log Viewer (see 

page 449) accessory.
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Session
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Session

OpenVPN Server(s): Name or public IP address of the OpenVPN server
Authentication type

TLS certificates: Authentication with user certificate and private key
Name/password: Authentication with user name and password
Name/password with TLS-certificates: Combines name/password with user certificate.
Static key: Authentication with a private key. No PKI infrastructure is needed for this.

TLS Certificates Authentication Type

Client certificate file: File with the client certificate. Enter a path relative to /wfs/OpenVPN  or 
select using the file selection.
CA certificate file: File with the CA certificate. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Private key file: File with the private key. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Private key password: Password in case one is set for the private key

For details of how to distribute certificates and keys securely to thin clients, see the Securely 
Distributing Keys and Certificates for OpenVPN How-To.

Name/Password Authentication Type

Username: User name - if you leave this field empty, the user will be asked for it when establishing 
a connection.
Password required
☑ The user must enter a password. (default)
Password: Password - if you leave this field empty, the user will be asked for it when establishing a 
connection.
CA certificate file: File with the CA certificate. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.

Persistent storage of files is possible in the folder /wfs  resp. subfolders of /wfs  only. 
Files stored under other paths will be lost when the thin client is rebooted.



If you have a PKCS#12 file which contains the client certificate, CA certificate and private 
key, always enter its name in the three file fields. The advantage lies in the fact that only a 
single file needs to be distributed.
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Name/Password with TLS-Certificates Authentication Type

Username: User name - if you leave this field empty, the user will be asked for it when establishing 
a connection.
Password required
☑ The user must enter a password. (default)
Password: Password - if you leave this field empty, the user will be asked for it when establishing a 
connection.
CA certificate file: File with the CA certificate. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Clientcertificate file: File with the user certificate. Enter a path relative to /wfs/OpenVPN  or 
select using the file selection.
CA certificate file: File with the CA certificate. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Private key file: File with the private key. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Private key password: Password in case one is set for the private key

For details of how to distribute certificates and keys securely to thin clients, see the Securely 
Distributing Keys and Certificates for OpenVPN how-to.

Static Key Authentication Type

Private key file: File with the static key. Enter a path relative to /wfs/OpenVPN  or select using 
the file selection.
Key direction:

None: No key direction
0: If the default option is not used, one side of the connection should use Direction 0 and the 
other Direction 1.
1: If the default option is not used, one side of the connection should use Direction 0 and the 
other Direction 1.

Remote IP address: The VPN IP address of the server
Local IP address: The VPN IP address of the client

If you have a PKCS#12 file which contains the user certificate, CA certificate and private 
key, always enter its name in the three file fields. The advantage lies in the fact that only a 
single file needs to be distributed.
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Options
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Options

Here, you can configure the options for the OpenVPN client in order to ensure interaction with the server.

Further information regarding the options can be found in the OpenVPN documentation24 which is maintained by 
the OpenVPN project.

Gateway port: Local gateway port (default: 1194)
Custom renegotiation interval: Renegotiate data channel key after given number of seconds 
(default: 0)
Use LZO data compression
☑ The client will use LZO compression. Necessary if the server uses compression.
☐ The client will not use LZO compression. (default)
Protocol used for communication to the host

udp: UDP will be used.
tcp-client: TCP will be used.

Virtual network type
tun: Routing will be used
tap: Bridging will be used.

Use custom tunnel maximum transmission unit (MTU): The MTU of the TUN device will be used 
as a given value. The MTU of the interface will be derived from it.
UDP fragment size: Allow internal data fragmenting up to this size in bytes. Leave this field empty 
to keep the default value.
Restrict tunnel TCP maximum segment size (MSS)
☑ The TCP segment size (MSS) of the tunnel will be restricted.
☐ The TCP segment size (MSS) will not be restricted. (default)
Randomize remote hosts
☑ The remote gateways will be ordered randomly as a simple type of load balancing.
☐ The remote computers will not be ordered randomly. (default)
Cipher: Encryption algorithm for data packets. (default: BF-CBC - Blowfish in the Cipher Block 
Chaining mode)
HMAC authentication: Hashing algorithm for packet authentication (default: SHA1)

If you use a proxy, select tcp-client.

https://openvpn.net/index.php/open-source/documentation.html
https://openvpn.net/index.php/open-source/documentation.html
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TLS Options
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > TLS Options

Subject match: The computer will only accept connections from a computer whose X.509 name or name matches 
the one entered. If you leave this field empty, no check will take place.

Remote peer certificate TLS type

Do not verify
Check for server certificate
Check for client certificate

Key file for additional TLS authentication: As the path, enter relative to /wfs/OpenVPN  or select using the file 
selection. This adds an additional HMAC legitimization level above the TLS control channel in order to prevent 
DDOS attacks.

Key direction

None: No key direction
0: If the default option is not used, one side of the connection should use Direction 0 and the other 
Direction 1.
1: If the default option is not used, one side of the connection should use Direction 0 and the other 
Direction 1.
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Proxy
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Proxy

Here, you can set up an optional proxy server for the VPN connection.

Proxy type
None: Direct connection to the Internet.
HTTP: HTTP proxy will be used.
SOCKS: SOCKS proxy will be used.

Details for HTTP proxy

Proxy address: Name or IP address of the proxy server
Proxy port: Port on which the proxy service is available
Retry indefinitely when errors occur
☑ In the event of errors, repeated attempts to establish a connection via proxy will be made.
☐ No further attempts to establish a connection will be made (default).

Ceredentials for HTTP

Proxy username: User name for the proxy server
Proxy password: Password for the proxy server

If you use a proxy, select the value tcp-client under Options > Communication protocol to the host.
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IPv4
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > IPv4

By default, OpenVPN uses the server’s DNS and routing settings. Here, you can change these settings.

Automatic DNS:
☑ The name server(s) will be carried over by the OpenVPN server. (default)
☐ Extra name servers (see below) will be used.
Extra name server(s): One or more name servers, IP addresses separated by commas.
Extra search domain(s): One or more search domains, separated by commas.
Automatic routes
☑ The routing table will be carried over by the OpenVPN server. (default)
☐ Extra routes will be configured.
VPN is the default route
☑ The default route leads to the VPN. (default)
☐ Extra routes will be configured.
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Route
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Route [0,1,2]

Here, you can configure extra routes.

Enable
☑ This route is enabled.
☐ This route is not enabled. (default)
Network route / host route: Type of route

Network route: The routing relates to a (sub) network
Host route: The routing relates to the address of a computer

Network / host IP: The address of the network (for a network route) or the IP address or the name 
of the host (for a host route)
Network mask: Mask for the desired IP range, e.g. 255.255.255.0
Gateway: Gateway that routes the packets to the target network
Metric: Here, you can enter a numerical quality assessment for routing decisions, 0 is the best 
value.
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Desktop Integration
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Desktop Integration

Session name: Name for the session

Session start options

Start menu
☑ The session can be started with the start menu. (default: enabled)
Application Launcher
☑ The session can be started with the Application Launcher. (default: enabled)
Desktop:
☑ The session can be started with a program starter on the desktop. (default: enabled)
Desktop context menu
☑ The session can be started with the desktop context menu. (default: disabled)
Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key. (default: disabled)
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log in as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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OpenConnect VPN
Menu Path: Setup > Network > VPN > OpenConnect VPN

The OpenConnect VPN Client puts in place a virtual private network using TLS encryption. This feature is available 
from IGEL Linux 10.04.100 onwards.

Enable autostart during boot
☑ Autostart is enabled.
☐ Autostart is disabled. (Default)
Restart connection when disconnected
☑ Reconnect automatically when a disconnect occurs.
☐ Do not reconnect automatically when a disconnect occurs. (Default)

To manage the list of OpenConnect VPN sessions, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

_____

Session (see page 595)
Desktop Integration (see page 596)
Enabling the OpenConnect VPN Client (see page 598)

Feature Not Available on IZ Devices

This feature is not available on IGEL IZ devices (IGEL Zero HDX, IGEL Zero RFX, or IGEL Zero Horizon).


Feature with limited support The OpenConnect VPN Client feature comes with limited support and 
without any warranty. Any support for this feature is provided on a non-binding, “best effort” basis.



The OpenConnect VPN Client feature needs to be enabled manually before you can use it, see Enabling the 
OpenConnect VPN Client (see page 598).
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Session
Menu path: Setup > Network > VPN > OpenConnect VPN > [session name] > Session

Gateway: IP address, hostname or Fully Qualified Domain Name (FQDN) of the VPN gateway
Connect to Juniper Networks VPN
☑ The protocol of Juniper Networks VPN is used.
☐ The protocol of Juniper Networks VPN is not used. (Default)
Name/Password Authentication
☑ User name and password are used for authentication.
☐ User name and password are not used for authentication. (Default)
User name: User name used for authentication
Password: Password used for authentication
CA Certificate: Path to the CA certificate
User Certificate: Path to the user certificate 

Private Key: Path to the private key
Private Key password: Password of the private key

The certificates should be stored in the directory /wfs/OpenVPN/  if possible, then they will 
certainly be found after a reboot.





Network

IGEL OS Reference Manual   596 / 710

•

•

•

•

•

•

•
•

•
•
•
•

•

•

•

•

•

•

•

Desktop Integration
Menüpfad: Setup > Network > VPN > OpenConnect VPN > [session name] > Desktop Integration

Session Name: Name for the session

Starting Methods for Session

Start Menu
☑ The session can be started from the start menu. (Default)
Application Launcher
☑ The session can be started with the application launcher. (Default)
Desktop:
☑ The session icon will appear on the desktop. (Default)
Quick Start Panel
☑ The session can be started from the quick start panel.
☐ The session cannot be started from the quick start panel. (Default)
Desktop Context Menu
☑ The session can be started form the desktop context menu.
☐ The session cannot be started from the desktop context menu. (Default)
Application Launcher folder: Path to the application launcher folder
Password Protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup User: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Enabling the OpenConnect VPN Client
To enable the OpenConnect VPN Client, proceed as follows:

Ensure that the settings under System > Update > Firmware Update are correct. The Server Path
must point to the firmware version that is currently installed. This is required because the software 
package for the OpenConnect VPN client must be downloaded in order to deploy the feature.
Go to System > Firmware Customization > Features and activate VPN OpenConnect (Limited 
support - functionality "as is", see product documentation for details).
Confirm the warning dialog with Ok.
Click Ok in the main window.
Reboot the thin client.
On reboot, the client downloads and installs the software package for the OpenConnect VPN Client 
feature.
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genucard
Menu path: Setup > Network > VPN > genucard

The genucard VPN hardware offers a choice of preconfigured Internet and VPN connections.

The settings for launching the session are described below.

Session name: Name for the session

Start menu:
☑ The session can be started with the start menu. (Default)
☐ The session cannot be found in the start menu.
Application Launcher:
☑ The session can be started with the Application Launcher. (Default)
☐ The session cannot be found in the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop. (Default)
☐ The session does not have a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
☐ The session cannot be found in the quick start panel. (Default)
Start menu's system tab:
☑ The session can be started with the start menu’s system tab.
☐ The session cannot be found in the start menu’s system tab. (Default)
Application Launcher's system tab:
☑ The session can be started with the Application Launcher’s system tab.
☐ The session cannot be found in the Application Launcher’s system tab. (Default)
Desktop context menu:
☑ The session can be started with the desktop context menu.
☐ The session cannot be found in the desktop context menu. (Default)
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey: A hotkey with which the session can be started is defined. It consists of modifiers and a 
key.
Modifiers: One or two modifiers for the hotkey:

None

 = Shift
[Ctrl ] = Ctrl

 = Super_L

[Alt] = Alt

Modifiers can be combined by using the pipe character |:

[Ctrl ]+  = Ctrl|Super_L
Key: Key for the hotkey

_____
“Connections” Window (see page 601)
Options (see page 602)
Desktop Integration (see page 603)
Administrator Session (see page 605)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the character string for 

the Key field. Example: Tab  in (keysym 0xff09, Tab)
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“Connections” Window
The Connections window opens as soon as the genucard session is launched. You will find the following menu 
points there:

File
Change PIN: Enter your previous PIN as well as your chosen new PIN twice.
Rekeying: Enter your PIN to generate a new key.

Wifi: Opens the Wifi dialog which allows you to configure wireless access for the genucard.
Select a wireless network from the list. Scan updates the list (this can take up to a minute).
Password: The password for the selected wireless network. Show shows the entry in plain 
text.
Save: Saves the connection data entered along with the password on the genucard.
Saved connections: Select one of the previously saved connections.
Delete: Deletes the selected connection.
Edit: Changes the password for the selected connection.

Log: Allows you to view the log
Network connection: Select one of the network connections preconfigured on the genucard, for 
example LAN or WiFi.

 To start the selected network connection, click Connect.

VPN connection: Select one of the VPN connections preconfigured on the genucard.

 To start the selected VPN connection, click Connect.

The network connections listed here have been configured using a genucard
administration session or the genucenter. Connections configured with the genucenter are 
marked with "(GCE)".



The VPN connections listed here have been configured using a genucard administration 
session or the genucenter. Connections configured with the genucenter are marked with 
"(GCE)".
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Options
Menu path: Setup > Network > VPN > genucard > Options

Here, you can prepopulate connection and user data for the genucard.

Autostart during boot
☑ The genucard application is launched during booting. This option increases the waiting time 
until the network is available.

☐ The genucard application is not launched during booting. (default)
Autostart after USB directory (requires restart)
☑ The genucard application is automatically launched as soon as the genucard is connected to 
the thin client. (default)

Default Internet connection: Name of an Internet connection configured on the genucard.
Default VPN connection: Name of an Internet connection configured on the genucard.
User name: User name for the genucard application
Password: Password for the genucard application
Internet connection timeout: Permitted waiting time in seconds (default: 120)
VPN connection timeout: Permitted waiting time in seconds (default: 120)
File path for private keys for machine connection: File path for the key file.

If the user name, password, default Internet connection and the default VPN connection 
are set in the setup, automatic launching allows firmware updates via VPN too.



Launching the genucard can take up to 60 seconds.
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Desktop Integration
Menu path: Setup > VPN > genucard > Desktop Integration

Session name: Name for the session

Start menu:
☑ The session can be started with the start menu. (Default)
☐ The session cannot be found in the start menu.
Application Launcher:
☑ The session can be started with the Application Launcher. (Default)
☐ The session cannot be found in the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop. (Default)
☐ The session does not have a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
☐ The session cannot be found in the quick start panel. (Default)
Start menu's system tab:
☑ The session can be started with the start menu’s system tab.
☐ The session cannot be found in the start menu’s system tab. (Default)
Application Launcher's system tab:
☑ The session can be started with the Application Launcher’s system tab.
☐ The session cannot be found in the Application Launcher’s system tab. (Default)
Desktop context menu:
☑ The session can be started with the desktop context menu.
☐ The session cannot be found in the desktop context menu. (Default)
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey: A hotkey with which the session can be started is defined. It consists of modifiers and a 
key.
Modifiers: One or two modifiers for the hotkey:

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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None

 = Shift
[Ctrl ] = Ctrl

 = Super_L

[Alt] = Alt

Modifiers can be combined by using the pipe character |:

[Ctrl ]+  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the character string for 

the Key field. Example: Tab  in (keysym 0xff09, Tab)
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1.

2.

3.
4.

5.

Administrator Session
The genucard is configured and administered centrally via the genucenter management interface. While VPN 
profiles can only be configured via genucenter or other remote interfaces, Internet connection profiles can also be 
configured via a local administration session.

Further information is available from www.genua.de25.

Optionally, an administrator session allowing the genucard Internet connection to be configured can be set up:

To configure an Internet connection profile via a local administration session, proceed as follows:
Click on Add instance under System > Registry > Sessions > genucard%.
The genucard icon will appear on the desktop.
Click on the genucard icon.
The genucard logon window will open.
Enter a user name and password.
Click on Logon.
The Internet/VPN page will open.
In the Internet area, configure the connection with the help of the  (Create),  (Edit) and 
(Delete) buttons.

https://www.genua.de/en.html
https://www.genua.de/en.html
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SCEP Client (NDES)
Menu path: Setup > Network > SCEP Client (NDES)

SCEP allows the automatic provision of client certificates via an SCEP server and a certification authority. This type 
of certificate is automatically renewed before it expires and can be used for purposes such as network 
authentication (e.g. IEEE 802.1x).

A Microsoft Windows Server (MSCEP, NDES) for example can serve as a queried counterpart (SCEP server and 
certification body). More information can be found at Microsoft, e.g. in the following Technet article: Network 
Device Enrollment Service (NDES) in Active Directory Certificate Services (AD CS)26

Manage certificates with SCEP

☑ Certificate management via SCEP Client (NDES) is enabled. Now carry out the necessary configuration.

☐ Certificate management via SCEP Client (NDES) is not enabled. (Default)

__________

Certificate (see page 607)
Certification Authority (see page 608)
SCEP (see page 609)

http://social.technet.microsoft.com/wiki/contents/articles/9063.network-device-enrollment-service-ndes-in-active-directory-certificate-services-ad-cs.aspx
http://social.technet.microsoft.com/wiki/contents/articles/9063.network-device-enrollment-service-ndes-in-active-directory-certificate-services-ad-cs.aspx
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Certificate
Menu path: Setup > Network > SCEP Client (NDES) > Certificate

Here, you can specify the basic data for the certificate to be issued by the certification body.

Type of CommonName/SubjectAltName: The characteristic for linking the certificate to the thin client.

IP address: The IP address of the thin client.
DNS name: The DNS name of the thin client.
IP address (auto): The IP address of the thin client (inserted automatically).
DNS name (auto): The DNS name of the thin client (inserted automatically).
Email address: An email address.

CommonName/SubjectAltName: Give a designation which matches the Type of CommonName/SubjectAltName. 
For certain types, this occurs automatically. No entry is then required.

Organizational unit: Stipulated by the certification authority.

Organization: A freely definable designation for the organization to which the client belongs.

Locality: Details regarding the thin client’s locality. Example: "Augsburg".

State: Details regarding the thin client’s locality. Example: "Bayern".

Country: Two-digit ISO 3166-1 country code. Example: "DE".

RSA key length (bits): Select a key length (one suited to the certification authority) for the certificate that is to be 
issued. 
Possible values:

"1024"
"2048"
"4096"

If the client automatically obtains its network name, DNS Name (auto) is a good type for the thin client 
certificate.
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Certification Authority
Menu path: Setup > Network > SCEP Client (NDES) > Certification Authority

The details for the following fields can be obtained from the certification authority:

CA identifier

CA certificate fingerprint (MD5)
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SCEP
Menu path: Setup > Network > SCEP Client (NDES) > SCEP

Here, you can give information regarding the SCEP server used.

SCEP server URL: Address of the SCEP server. Examples: http://myserver.mydomain.com/certsrv/mscep/
mscep.dll (Windows Server 2019); http://myserver.mydomain.com/certsrv/mscep (before Windows Server 2019)

Proxy server for SCEP requests: Proxy server in the format host:port . If this field is empty, no proxy will be 
used.

Challenge password: Password for queries.

Certificate renewal period (days): Time interval before certificate expiry after which the certificate renewal 
procedure is started. (Default: 30)

Certificate expiry check interval (days): Specifies how often the certificate is checked against its expiry date. 
(Default: 1)

For more information, see the how-to Providing the SCEP Server Data. See also Configuration of the SCEP Client.

Because of the need to enter a fingerprint (CA root certificate) and the Challenge password (SCEP server), 
the configuration process is somewhat complicated. Ideally, it should be set up in the UMS as a profile and 
distributed to the devices. At the same time, the certificate cannot yet be used for communication 
purposes.



As an example, a certificate is valid until 31.12. of a year. If the period for renewal is set to 10 days, a new 
certificate will be requested for the first time on 21.12. of the same year.
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Routing
Menu path: Setup > Network > Routing

Here, you can enter additional routes if necessary.

Enable: (default: disabled)

☑ Routing is enabled.

Default gateway: Gateway that routes the packets to the target network

Interface: The network interface via which the route is to run, e.g. eth0

Routing [1-5]
Enable: (default: disabled)

☑ This route is enabled.

Network route / host route: Type of route

Network route: The routing relates to a (sub) network
Host route: The routing relates to the address of a computer

Network / host IP or name: The address of the network (for a network route) or the IP address or the name of the 
host (for a host route)

Network mask: Mask for the desired IP range, e.g. 255.255.255.0

Gateway: Gateway that routes the packets to the target network

Interface: The network interface via which the route is to run, e.g. eth0
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Hosts
Menu path: Setup > Network > Hosts

If no DNS (Domain Name Service) is used, you can specify a list with computers in order to allow translation 
between the fully qualified host name, the short host name and the IP address.

To manage the list of computers, proceed as follows:
Click  to create a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.
Click  to copy the selected entry.

Add
IP address: IP address of the host you would like to add
Fully qualified host name: Host name along with the domain, e.g. mail.example.com

Short host name: E.g. mail
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Network Drives
Menu path: Setup > Network > Network Drives

Here, you can configure both the drives that are to be connected during booting and the associated login data.

_____

NFS (see page 613)
Windows Drive (see page 615)
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NFS
Menu path: Setup > Network > Network Drives > NFS

In this area, you can integrate network drives using the Network File System (NFS).

You can find a sample configuration at the end of this page.

To manage the network drives, proceed as follows:
Click  to create a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.

Click  to copy the selected entry.

Add

Enabled: Here, you can enable and disable configured entries.
☑ The network drive will be integrated. (default)
Local Mount Point: The local directory under which the server directory is to be visible (default: /

nfsmount )
Server: NFS server that exports the directory

Directory name: Path under which the NFS server exports the directory

Sample configuration entry
The picture belows shows a sample configuration entry.

For Server, you can provide an IP address, a hostname or a Fully-Qualified Domain Name 
(FQDN).



In both the Local Mount Point and Directory Name only /  (Linux/Unix-style forward slash) is permitted 
as a path separator.
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Windows Drive
Menu path: Setup > Network > Network Drives > Windows Drive

In this area, you can integrate network drives shared by Windows as well as those from Linux/Unix servers via the 
SMB protocol (Samba).

You can find a sample configuration at the end of this page.

To manage the drive list, proceed as follows:
Click  to create a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.

Click  to copy the selected entry.

Clicking  will bring up the Add dialogue, where you can define the following settings:

Enabled: Defines whether the configuration entry will be applied.
☑ The network drive will be integrated.
Local Mount Point: The local directory under which the server directory is to be visible 
(default:  /smbmount )
Server: The IP address, Fully-Qualified Domain Name (FQDN) or NetBIOS name of the server.
Share Name: Path name as exported by the Windows or Unix Samba host.
User name: User name for your user account on the Windows or Unix Samba host.
Password: Password for your user account on the Windows or Unix Samba host.
User writable
☑ The user can not only read but also write directory contents. Otherwise, only the local root user 
is able to do this.
☐ The user can only read directory contents. (default)

Sample configuration entry
The following picture shows a sample configuration entry.

If a NetBios name is provided for Server, make sure it is not preceded by slashes, e.g. \\myComputer

(wrong) vs. myComputer  (correct).



For Local Mount Point, only /  (Linux/Unix-style forward slash) can be used as a path separator. Note 

that if you enter, for example, \smbmount  as a moint point, a directory called \smbmount  will be 

created, because \  is a legal character in Linux directory names. For Share Name, however, /  (Linux/

Unix-style forward slash) or \  (Windows-style backward slash) can be used as a path separator.
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Proxy
Menu path: Setup > Network > Proxy

Here, you can select the communication protocols for which a system-wide proxy server is to be used.

Direct connection to the Internet: The endpoint device is directly connected to the Internet. No proxy is used.

Manual proxy configuration: One or more proxies are used.

FTP proxy / port: FTP proxy server and port

HTTP proxy / port: HTTP proxy server and port

SSL proxy / port: SSL proxy server and port

SOCKS host / port: Socks proxy server and port

SOCKS protocol version: Selects the SOCKS protocol version. (Default: SOCKS v5)

No proxy for: List of computers to which the endpoint device is to connect directly, separated by commas (Default: 
localhost, 127.0.0.1)

Proxy realm for browser: Area in which the browser authenticates itself for the proxy. Together with the user name 
and password, this information is necessary for authentication. See also Browser Global Proxy (see page 335)

Use passthrough authentication

☑ The temporarily saved login information (user name and password) will be used to log in to the proxy server.

☐ The login information entered under User name and Password will be used to log in to the proxy server. 
(Default)

User name: User name for the proxy login

Password: Password for the proxy login
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Devices
Menu path: Setup > Devices > Hardware Info

 Click on Hardware Info to view the system information for your IGEL thin client.

In this area, you can set up printers (see page 621), storage devices (see page 635), and Bluetooth devices (see page 639) and 
regulate the use of USB devices (see page 640).

Printer (see page 619)
Storage Devices (see page 635)
Bluetooth (see page 639)
USB Access Control (see page 640)
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Printer
Menu path: Devices > Printers

You can set up a printer for the thin client here.

The printers must be set up under Devices > Printer > CUPS > Printers and must be enabled there for mapping in 
sessions.

CUPS (see page 620)
LPD (see page 624)
TCP/IP (see page 625)
ThinPrint (see page 631)

Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the 
server. Please note that you will need to be logged in as administrator to the terminal to which the printer 
is connected.
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CUPS
Menu path: Setup > Devices > Printers > CUPS

The Common UNIX Printing SystemTM (or CUPS) is the software that allows you to print from within applications, 
e.g. from this web browser.

CUPS converts the page descriptions produced by the application, e.g. "Insert Paragraph", "Draw Line" etc., into 
data that can be read by the printer, and then sends this information to the printer.

With the appropriate configuration, CUPS can use printing devices via the following connections:

Parallel (LPT 1, LPT 2)
Serial (COM1, COM2, USB COM1, USB COM2 – with a USB-to-serial adapter)
USB (1st and 2nd USB printer)
Network (TCP/IP, LPD, IPP)

Default Paper Size: Specify a default paper size for print jobs.

Possible values:

Letter
Legal
Executive
A5
A4
A3
Autodetect

Additional information on CUPS printers can be found under CUPS: Mapping Local Printer to Citrix or RDP Sessions
and Installing a Custom CUPS Driver. 

Printers (see page 621)
IPP Printer Sharing (see page 623)



Devices

IGEL OS Reference Manual   621 / 710

•
•
•
•
•
•

•
•

•
•
•
•
•
•
•

Printers
Menu path: Setup > Devices > Printer > CUPS > Printers

Printers can be created and edited here.

 Click on  to open the Add dialog.

 In the edit dialog, specify a Printer Name which begins with a letter.

General

Printer Port: Interface type for locally connected printers or the network protocol for network printers. 
Possible values:

Parallel interface
Serial interface
USB interface
LPD network printer
TCP network printer
IPP network printer

Parallel Device

LPT1
LPT2

Detect Devices...: Opens a mask for selecting the available devices.

Manufacturer: List of possible printer manufacturers. When you select a manufacturer here, the relevant selection 
of models will be provided under Printer Names. (Example: Generic)

Printer Names: List of possible printer models. (Example: PostScript Printer)

Default Paper Size: Set the printer-specific paper size that you would like to use as a default. 
Possible values:

Letter
Legal
Executive
A5
A4
A3
System setting

Share Printer

☑ You can access the printer via the network if you have enabled the print server under IPP Printer Sharing. 
(Default)

Mapping in sessions

Map Printer in NX Sessions

☑ The printer is available in NX sessions.
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☐ The printer is not available in NX sessions. (Default)

Map Printer in Parallels Client Sessions

☑ The printer is available in Parallels Client sessions.

☐ The printer is not available in Parallels Client sessions. (Default)

Map Printer in ICA Sessions

☑ The printer is available in ICA sessions. (Default)

Map Printer in RDP Sessions

☑ The printer is available in RDP sessions. (Default)

Use Windows Driver Name from List

☑ A driver name from the following list will be used. (Default)

Manufacturer: List of possible printer manufacturers. (Example: Generic)

Model: List of possible models. (Example: Generic PostScript)

Use Custom Windows Driver Name

☑ Give the name of your driver here if it is not mentioned in the list above.

Printer Driver: Windows driver name for the printer.

When printing in ICA and RDP sessions, the print data are normally prepared for the printer model by the Windows 
printer driver and are passed unchanged from the thin client to the printer. An exception is encountered when using 
the Windows driver in ICA sessions: Manufacturer: Generic, model: Generic PostScript. In this case, the print data are 
prepared on the thin client with the help of the printer driver defined above under Printer for the printer model. 
This requires thin client resources depending on the size of the print job.

The name must not contain “;” or “:”.
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IPP Printer Sharing
Menu path: Devices > Printer > CUPS > IPP Printer Sharing

The IPP (Internet Printing Protocol) offers the following configuration options:

Network or host for sharing local printers: Access to the printer is possible from this network or host. 

Possible options:

"None"
"Local network": Allows printing on the local device from the local network.

"Global": Allows printing on the local device from the global network.

This can also be given in the form 192.0.2.*  or 192.0.2.0/24  or 

*.domain.com  or 192.0.2.1  or host.domain.com .
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LPD
Menu path: Setup > Devices > Printers > LPD

LPD printers are used by the BSD printing system and are also supported by Windows servers.

Enable LPD Print Server
☑ Local printers are provided in the network as LPD printers. The thin client is made the LPD print 
server. The CUPS printers defined under Printers (see page 621) can be addressed under their printer 
name as a queue name via the LPD protocol. (default)
Print Filter:

Automatic: Attempts to automatically recognize whether or not the print data need to be 
prepared by the local printer driver.
None: The print data are always forwarded unchanged to the printer.

Max. Consurrent Connections: Limits the number of print jobs that can be accepted at the same 
time.

Unlimited
1
2
3

Restrict LPD Access - Specifies the sub-networks or hosts from which print jobs can be accepted.

 Click on  to add an LPD network or a host to the list.
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TCP/IP
Menu path: Setup > Devices > Printers > TCP/IP

You can assign printers connected to your device to a TCP/IP port.

_____

COM 1 / 2 (see page 626)
Additional Serial Ports (see page 627)
LPT 1 (see page 629)
USBLP 1 (see page 630)
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COM 1 / 2
Menu path: Setup > Devices > Printers > TCP/IP > COM 1

Activate TCP/IP printers on this port
☑ Maps the interface defined below in a TCP/IP port.
☐ Disabled (default)
TCP/IP port number: Port on which the interface is to be mapped (default: 3004).
Poll criterion: Criterion according to which the interfaces are mapped.

Always: Maps constantly without polling.
Online: Maps only if the printer is switched on.

Poll frequency: Amount of time between polls (default: 1 sec)
Speed: Input and output speed (default: 9600)
Parity: Parity bits that are to be used. Possible values:

None
Even
Odd

Stop bits: Use up to two stop bits. (default: 1)
Word width: Sets the number of bits used per byte.

5
6
7
8

Use RTS/CTS flow control
☑ Hardware flow control will be used.
☐ Not used (default)
Use XON/XOFF flow control
☑ Software flow control by sending start/stop signs will be used.
☐ Not used (default)
Use DSR flow control
☑ Hardware flow control with DSR for output will be used.
☐ Not used (default)
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Additional Serial Ports
Menu path: Setup > Devices > Printers > TCP/IP > Additional Serial Ports

TCP/IP printers on additional serial ports

 Click on to add TCP/IP printers to the list.
A mask with the following settings options will open:

Activate TCP/IP printer on this interface
☑ Maps the interface defined below in a TCP/IP port.
☐ Disabled (default)
Device name: The printer can be connected to one of the following connections, provided that 
they are available on the device:

USB COM1
USB COM2
Perle COM1
Perle COM2

Search for devices...: Opens a dialog allowing you to select the device file. 3 device files are 
available for each device; the Designation column shows the type of device file:

(GENERIC) [device designation]: Generic type. The name of the device file ends in a 
consecutive number which depends on the boot procedure or the order of insertion. 
Example: /dev/ttyUSB0

(BY PORT) [device designation]: According to USB port. The device file is in the /dev/

usbserial/  directory. The name of the device file ends in the number of the USB port 

that the device is plugged into. Example: /dev/usbserial/ttyUSB_P12

(BY USBID) [device designation]: According to USB ID. The device file is in the /dev/

usbserial/  directory. The name of the device file ends as follows: _V[Vendor 

ID]_P[Product ID] . Example: /dev/usbserial/ttyUSB_V067b_P2303
TCP/IP port number: Port on which the interface is to be mapped (default: 9100).
Poll criterion: Criterion according to which the interfaces are mapped.

Always: Maps constantly without polling.
DSR (M1): Maps only if the relevant line is set by the serial device.
DCD (M5): Maps only if the relevant line is set by the serial device.

Poll frequency: Amount of time between polls (default: 1 sec)
Speed: Input and output speed (default 9600 baud).
Parity: Parity bits that are to be used. Possible values:

None
Even
Odd

Stop bits: Use up to two stop bits. (default: 1)

Data are forwarded bidirectionally at serial interfaces. This means that other serial devices 
such as barcode scanners or scales can be operated too.
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Word width: Sets the number of bits used per byte.
5
6
7
8

Use RTS/CTS flow control
☑ Hardware flow control will be used.
☐ Not used (default)
Use XON/XOFF flow control
☑ Software flow control by sending start/stop signs will be used.
☐ Not used (default)
Use DSR flow control
☑ Hardware flow control with DSR for output will be used.
☐ Not used (default)
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LPT 1
Menu path: Setup > Devices > Printers > TCP/IP > COM 1

Activate TCP/IP printers on this interface
☑ Maps the interface defined below in a TCP/IP port.
☐ Disabled (default)

TCP/IP port number: Port on which the interface is to be mapped (default: 3004).
Poll criterion: Criterion according to which the interfaces are mapped.
Always: Maps constantly without polling. 
Online: Maps only if the printer is switched on.
Poll frequency: Amount of time between polls (default: 1 sec)
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USBLP 1
Menu path: Setup > Devices > Printers > TCP/IP > USBLP 1

Activate TCP/IP Printers on this Port:
☑ Maps the interface defined below in a TCP/IP port.
☐ Disabled (default)

TCP/IP Port Number: Port on which the interface is to be mapped (default: 3004).
Poll Criterion: Criterion according to which the interfaces are mapped.
Always: Maps constantly without querying. 
Online: Maps only if the printer is switched on.
Poll Frequency: Amount of time between status queries (default: 1 sec)
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ThinPrint
Menu path: Devices > Printer > ThinPrint

ThinPrint allows the bandwidth provided for the transfer of print jobs to be reduced depending on the resources 
available. The ThinPrint client prints either on printers connected to a local interface (serial, parallel or USB), on an 
LPD network printer or on a CUPS printer defined on the thin client.

In this area, you will find the following parameters:

Port Number: Port number via which the ThinPrint daemon will communicate (default: 4000).

Bandwidth: A bandwidth value (in bits per second) which is lower than or equal to the value specified on the 
ThinPrint server. A higher value, the disabling of client control or no entry at all means that the ThinPrint server 
values will be used (default: 0).

Open Printer Interval: Maximum waiting time in seconds if a printer is unavailable (default: 165).

Open Printer Tries: Number of attempts to contact a printer in order to start a print job (default: 100).

Printer (see page 632)
Connection Service (see page 633)
Encryption (see page 634)

Make sure that the port number on the ThinPrint client and the ThinPrint server is the same 
(communication will otherwise not be possible).
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Printer
Menu path: Devices > Printer > ThinPrint > Printer

In this area, the List of ThinPrint Printers is shown.

The page provides an overview of pre-configured ThinPrint printers.

 Click on  to add a printer to the list.
A mask with the following settings options will open:

Active: Indicates whether or not the printer is visible.

Printer Name: Name under which the printer can be addressed.

Printer Class Name: Name of the printer class - optional, max. 7 characters without spaces

Device: A device file or the printer name, e.g. /dev/ttyS1 (COM2).

Detect Devices...: Opens a mask for selecting the available devices.

Print Retries: Number of attempts to contact a printer in order to start a print job (default: 10).

Default: Defines the selected device as the default printer.
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Connection Service
Menu path: Setup > Devices > Printers > ThinPrint > Connection Service

By default, the .print client waits for incoming connections from the print server. If the thin client is unavailable via 
the network from the print server, the connection can also be established from the thin client .

Connection Service ModeMode:
Listen Mode: Receive print jobs without Connection Service. The .print client heeds 
incoming connections.
Static Mode: Use connection to receive print jobs. The .print client establishes a connection 
to the .print Connected Gateway.
Both: Use both modes.

Connection Server Address: IP address of the computer on which the connection service runs.
Connection Service Port number: The client port of the .print Connected Gateway (default: 4001)
Client D: The ID of the client must be unique.
Connection Service Authentication key: A value that is defined on the connection server.
Connection Service Retry Interval: Waiting time in seconds until another connection attempt is 
made if the .print Connection Service is unavailable (default: 300)
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Encryption
Menu path: Setup > Devices > Printers > ThinPrint > Encryption

In this area, you can enable encryption for print jobs.

Enable SSL Encryption:
☑ The client can receive print jobs via an encrypted connection.
☐ Disabled (default)
SSL Root Certificate: Path name of the file that receives the root certificate in the .pem format.
SSL Client Certificate: Path name of the file that receives the client certificate in the .pem format.
SSL Client Certificate Password
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Storage Devices
Menu path: Setup > Devices > Storage Devices

Configure your hotplug storage devices here.

Show registered storage devices: Shows a list with registered storage devices.

_____

Storage Hotplug (see page 636)
Automount (see page 638)

Make sure that a number greater than 0 has been entered under Setup > Devices > Storage Devices 
> Storage Hotplug > Number of drives.
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Storage Hotplug
Menu path: Setup > Devices > Storage Hotplug

In this area you can set up the connection of hotplug storage devices. These can be USB mass storage devices or 
MMC card readers for example.

Following file systems are officially supported: 

ext2, ext3, ext4 Standard Linux file systems

squashfs a packed read-only file system

vfat supports all FAT variants (except extFAT)

udf CDROM/DVD file systems

ntfs about ntfs-3g (Fuse)

You can change the following settings:

Default permission: Default access rights for hotplug storage devices.
Possible values:

Read/Write
Read only

Enable dynamic client drive mapping
☑ Hotplug storage devices will automatically be added and removed during ICA sessions and RDP 
sessions.

Number of storage hotplug devices: The number of hotplug storage devices that can be used 
simultaneously in the session (default: 0).
Private drive letter for each storage drive
☑ A drive letter is assigned to each hotplug storage device.

•
•

•

Before you unplug a hotplug storage device from the thin client, you must safely remove it. Otherwise, 
data on the hotplug storage device can be damaged. Depending on the configuration, there is one or 
several possibilities to safely remove a hotplug storage device:

Click on  in the task bar. The taskbar is not available in a fullscreen session.
Click on   in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a fullscreen session. For further information, see In-
Session Control Bar (see page 538).
Function Accessories > Safely Remove Hardware with further starting possibilities; 
amongst other things, a hotkey can be defined here.
If the following warning is displayed: Volume(s) still in use. Dont' remove the device., 
then the hotplug storage device must not be removed. First, exit the program concerned 
or close all files or directories that reside on the hotplug storage device.
☐ Dynamic client drive mapping is disabled (default)
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☐ A single drive letter will be generated for all hotplug storage devices and each hotplug storage 
device will be assigned a sub-directory. (default)
Start storage drives with this drive letter: Letter that is assigned to the first hotplug storage 
device if automatic drive mapping is enabled (default: A). Further hotplug storage devices are 
assigned the next letter alphabetically.
ICA Read Access for storage hotplug devices: Specifies whether read access to hotplug storage 
devices is allowed in an ICA session.

Possible values:
Yes: Read access is allowed.
No: Read access is not allowed.
On request: Read access can be allowed on request.

ICA Write Access for storage hotplug devices: Specifies whether write access to hotplug storage 
devices is allowed in an ICA session.

Possible values:
Yes: Write access is allowed.
No: Write access is not allowed.
On request: Write access can be allowed on request.

Use storage hotplug beep
☑ A signal tone will be heard when connecting and disconnecting hotplug storage devices. 
(Default)
Show storage hotplug message
☑ Hotplug messages will be shown when connecting and disconnecting hotplug storage devices. 
(Default)
Message timeout: Period of time after which the window with the hotplug messages is hidden. If 
the time period is set to 0, the window will be shown until it is closed manually (default: 15).
You will find further settings options in the HDX / ICA Global setup area under Drive mapping (see 
page 58), in the RDP Global setup area under Drive mapping (see page 116), in the Devices area under 
USB access control (see page 640) and in the Accessories area under Disk Removal (see page 494).

This setting is only effective if Enable dynamic drive mapping is disabled.

This setting is only effective if Enable dynamic drive mapping is disabled.
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Automount
Menu path: Setup > Devices > Storage Devices > Automount

In this area, you can specify a directory in which external storage devices are automatically mounted.

Enable Automount Browse
☑ A link to /autofs_manual/... is specified to make it easier for users to find the devices. 
(default)
Automount Browse Directory:/: Local directory in which the devices can be found. (Default: 
userhome/media)
Enable built-in floppy drives
☑ Built-in disk drives are active.
☐ Built-in disk drives are disabled (default)

This option is only valid for drives which are not connected via USB.
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Bluetooth
Menu path: Setup > Devices > Bluetooth

In this area, you can set up a Bluetooth service.

Activate Bluetooth
☑ The Bluetooth service is active. The Bluetooth Tool can be used.
☐ The Bluetooth service is inactive. The Bluetooth Tool cannot be used. (default)
Tray Icon
☑ A Bluetooth icon will be shown in the system tray. You can launch the Bluetooth Tool by 
double-clicking on the Bluetooth icon. Right-clicking on the Bluetooth icon will bring up an 
overview as to which Bluetooth devices are connected to the thin client and you can enable or 
disable Bluetooth.
☐ Disabled (default)
Details of the settings options for Bluetooth can be found under Accessories > Bluetooth Tool (see 
page 481).
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USB Access Control
Menu path: Devices > USB Access Control

You can allow or prohibit the use of USB devices on your endpoint. Specific rules for individual devices or device 
classes are possible. For an example, see How to Configure USB Access Control.

Enable

☑ USB access control is enabled and the following settings can be configured.

☐ USB access control is inactive. (Default)

Default rule: Specifies whether the use of USB devices is allowed or prohibited.

Allow
Deny

Default permission: Default access rights for USB devices.

Read Only
Read/Write

Class Rules
Class rules apply to USB device classes.

 Click on  to create a new rule.
An input mask with the following options will open:

Rule: Specifies whether the use of the device class defined here is allowed or prohibited.

Class ID: Device class for which the rule should apply. (Examples: Audio, Printers, Mass Storage).

Name: Name of the rule

Device Rules
Device rules apply to specific USB devices.

 Click on  to create a new rule.
An input mask with the following options will open:

Rule: Specifies whether the use of the device defined here is allowed or prohibited.

The activation of USB Access Control and setting the Default rule to Deny will block the use of USB 
devices locally and in the session and, thus, might disable devices needed for the users. Therefore, activate 
the USB access control only if your security policy requires that. In this case, set Default rule to Deny and 
configure Allow rules for the required USB devices and USB device classes. 
It is recommended to make settings for USB Access Control as the last step in the device configuration. 
Before activating the USB access control, check that all your other settings for printers, Unified 
Communication, USB redirections, mapping settings for USB devices are working as expected.
Note that the feature does not disable a USB port physically, i.e. power delivery will still work.
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Vendor ID: Hexadecimal ID of the device manufacturer

Product ID: Hexadecimal ID of the device

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
489).
System Information example:

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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Device uuid: Universal Unique Identifier of the device

Permission: Authorizations for access to the device
Possible values: 

Global setting: The default setting for hotplug storage devices is used; see the Default permission
parameter under Devices > Storage Devices > Storage Hotplug.
Read only
Read/Write

Name: Name of the rule

Further setting options can be found under Storage Hotplug (see page 636).
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Security
Menu path: Setup > Security

In order to prevent unauthorized access to the thin client setup, it is important to set up an administrator password 
after the initial configuration. With an additional user password, you can allow the user to make limited changes to 
the configuration.

Further information can be found under Password (see page 644).

_____

Password (see page 644)
Logon (see page 646)
Active Directory/Kerberos (see page 655)
Smartcard (see page 658)
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Password
Menu path: Setup > Security > Password

Administrator
Use password
☑ A password is needed to log in as an administrator ( root ). A password is also needed for the 

user ( user ) and the setup user. The administrator password is also needed to reset the client to 
the factory defaults in the boot menu. The password is set by clicking Change password.
☐ No password is needed to log in as an administrator. A password is not needed for the user 
( user ) and the setup user either. (default)

Change password: Sets the password for the administrator ( root ).

Setup user
Enable user access: This option is relevant if an administrator password is set.
☑ The user can access the areas of the IGEL setup for which they have authorization. Further 
information can be found under Page authorizations (see page 422). A password is needed to log in as 
a setup user. The password is set by clicking Change password.
☐ The user cannot access the IGEL setup. (default)
Change password: Sets the password for the setup user.

User
Use password: This option is relevant if an administrator password is set.
☑ The user ( user ) needs a password in order to log in to the thin client via the local terminal. 
The password is set by clicking Change password.
☐ If an administrator password is set, the user ( user ) cannot log in to the thin client via the local 

terminal. If no administrator password is set, the user ( user ) can log in to the thin client via the 
local terminal without a password. (default)
Change password: Sets the password for the user ( user ).

User account for remote access
Enable login

When entering a password, ensure that the correct keyboard layout is enabled.
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☑ The remote user ( ruser ) can log in to the thin client via SSH. Further information can be 
found under Remote access (see page 669). (default)
☐ Logging in via SSH is not possible.
Use password
☑ A password is needed to log in via SSH.
☐ No password is needed to log in via SSH. (default)

 By clicking Change password, set up a user password.
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Logon
Menu path: Setup > Security > Logon

_____

IGEL Smartcard (see page 647)
Taskbar (see page 648)
Active Directory/Kerberos (see page 650)
Shared Workplace (see page 653)
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IGEL Smartcard
Menu path: Setup > Security > Logon > IGEL Smartcard

Login with IGEL smartcard
☑ You can log in to the device using a smartcard. Depending on the configuration, a password 
may also be needed. Sessions stored on the smartcard become available.
☐ The desktop can be used without an IGEL smartcard. (Default)
Company key:  A shared code for a smartcard and a device. The code entered must match the 
code stored on the IGEL smartcard. If two codes do not match, the IGEL smartcard cannot be used 
on this terminal.

Start application to write IGEL smartcards:

Smartcard personalization: Opens a window where you can set a login password and add 
sessions to the card.

For further information about the smartcard personalization function, see Using “Smartcard Personalization” 
function (see page 505).

For information how to create IGEL smartcards via the UMS, see Authentication with IGEL Smartcard.

See also Smartcard Readers Supported by IGEL Smartcards.

Save the settings before starting to personalize the card.

Session configurations are stored on the card's integrated circuit, and the session can be used on any IGEL 
device that reads the card.



Smartcard personalization is possible via the local Setup only. The option is not available via the UMS.
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Taskbar
Menu path: Setup > Security > Logon > Taskbar

Taskbar settings for the login dialog

Show taskbar in login screen
☑ The taskbar will be shown during the login dialog. (default)
☐ The taskbar will not be shown during the login dialog.
Show clock
☑ The clock will be shown during the login dialog. (default)
☐ The clock will not be shown during the login dialog.
Show keyboard layout switcher
☑ The switch for the keyboard layout will be shown during the login dialog. (default)
☐ The switch for the keyboard layout will not be shown during the login dialog.
Show on-screen keyboard button
☑ The button for opening the on-screen keyboard is shown during the login dialog.
☐ The button for opening the on-screen keyboard is not shown during the login dialog. (default)
Start on-screen keyboard automatically
☑ The on-screen keyboard is open during the login dialog.
☐ The on-screen keyboard is not open during the login dialog. (default)
Show reboot button
☑ The button for rebooting the thin client is shown during the login dialog.
☐ The button for rebooting the thin client is not shown during the login dialog. (default)
Show shutdown button
☑ The button for shutting down the thin client is shown during the login dialog. (default)
☐ The button for shutting down the thin client is not shown during the login dialog.

Taskbar settings when the screenlock is active

Show taskbar in screenlock
☑ The taskbar is shown while the screen is locked. (default)
☐ The taskbar is not shown while the screen is locked.
Show clock
☑ The clock is shown while the screen is locked. (default)
☐ The clock is not shown while the screen is locked.
Show keyboard layout switcher
☑ The switch for the keyboard layout is shown while the screen is locked. (default)
☐ The switch for the keyboard layout is not shown while the screen is locked.
Show on-screen keyboard button
☑ The button for opening the on-screen keyboard will be shown while the screen is locked.
☐ The button for opening the on-screen keyboard will not be shown while the screen is locked. 
(default)
Start on-screen keyboard automatically
☑ The on-screen keyboard will remain open while the screen is locked.
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☐ The on-screen keyboard is not open while the screen is locked. (default)
Show reboot button
☑ The button for rebooting the thin client is shown while the screen is locked.
☐ The button for rebooting the thin client is not shown while the screen is locked. (default)
Show shutdown button
☑ The button for shutting down the thin client is shown while the screen is locked.
☐ The button for shutting down the thin client is not shown while the screen is locked. (default)
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Active Directory/Kerberos
Menu path: Setup > Security > Logon > Active Directory / Kerberos

In this area, you can enable local login to the thin client via the Kerberos protocol. Active Directory/Kerberos must 
be configured, see Active Directory/Kerberos (see page 655).

Login to Active Directory domain
☑ You can log in to the thin client via Active Directory.
☐ You cannot log in to the thin client via Active Directory. (Default)

Login Methods

Explicit:
☑ You can log in with a user name and password. (Default)
☐ You cannot log in with a user name and password. If logging in with a smartcard is set up, you 
can log in with a smartcard.
Remember last user name
☑ The login dialog will be prepopulated with the last user name that logged on. Explicit must be 
enabled for this.
☐ The login dialog will not be prepopulated. (Default)
Smartcard
☑ You can log in using a smartcard.
☐ You cannot log in using a smartcard. (Default)

Smartcard removal action: Specifies what action is performed when the smartcard via which the 
user is logged in is removed.
Possible actions:

Log off: The user is logged off from the thin client.
Lock thin client: The screen is locked.

Logout Shortcut Locations
The start options for the logoff function are specified here.

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

The login can be used for single sign-on in a number of session types (ICA, RDP).

Select the smartcard type under Security > Smartcard > Middleware.



Security

IGEL OS Reference Manual   651 / 710

•
•
•
•

•

•

•

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".
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 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Shared Workplace
Menu path: Setup > Security > Logon > Shared Workplace

Activate IGEL Shared Workplace
☑ You can log in to the thin client via IGEL Shared Workplace.
☐ You cannot log in to the thin client via IGEL Shared Workplace. (Default)
Skip lGEL Shared Workplace login if UMS server is unavailable
☑ If the UMS server is not available, the user can log in via Active Directory/Kerberos. In order to 
do this, logging in via Active Directory/Kerberos must be configured; further information can be 
found under Active Directory/Kerberos (see page 650).
☐ Logging in is only possible if the UMS server is available. (Default)
Remember last user name
☑ The login dialog will be prepopulated with the last user name that logged on.
☐ The login dialog will not be prepopulated. (Default)

Logout Shortcut Locations
The start options for the logoff function are specified here.

Start menu: If this option is enabled, the session can be launched from the start menu.
Application Launcher: If this option is enabled, the session can be launched with the Application 
Launcher.
Desktop: If this option is enabled, the session can be launched with a program launcher on the 
desktop.
Quick start panel: If this option is enabled, the session can be launched with the quick start panel.
Start menu's system tab: If this option is enabled, the session can be launched with the start 
menu's system tab.
Application Launcher's system tab: If this option is enabled, the session can be launched with 
the Application Launcher's system tab.
Desktop context menu: If this option is enabled, the session can be launched with the desktop 
context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
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Setup user: The setup user's password is requested when launching the session.
Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Active Directory/Kerberos
Menu path: Setup > Security > Active Directory / Kerberos

Enable
☑ The Kerberos basic configuration will be carried out.
☐ The Kerberos basic configuration will not be carried out. (default)
Default domain (Fully Qualified Domain Name): This value must match the Windows domain on 
which the logon is to take place, e.g. EXAMPLE.COM .

DNS lookup for domain controller
☑ In order to find the key distribution centers (KDCs, domain controllers) and other servers for a 
realm, DNS SRV records are used if they are not explicitly indicated. (default)
☐ The key distribution centers entered under Setup > Security > Active Directory/Kerberos > 
Domain 1 ... Domain 4 will be used.
DNS lookup for domain
☑ In order to determine the Kerberos realm of a host, DNS TXT records are used. (default)
☐ The details under Setup > Security > Active Directory / Kerberos > Domain Realm Mapping 
are used.
Obtain addressless tickets
☑ The first Kerberos ticket is addressless. This may be necessary if the client is located behind an 
NAT device (Network Address Translation). (default)

_____

Domain 1 ... Domain 4 (see page 656)
Domain Realm Mapping (see page 657)

The value must be entered in upper case letters.
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Domain 1 ... Domain 4
Menu path: Setup > Security > Active Directory/Kerberos > Domain 1 ... Domain 4

Up to 4 domains where a login is possible can be configured here.

To configure a domain, proceed as follows:
Under Domain name, give the name of the domain (Kerberos realm).
Click  to create a new entry.
Under Domain controller, give the name or IP address of the domain controller (Kerberos key 
distribution center). A port number can be added to the host name; the port name must be 
preceded by a colon.
Click on Continue.
The domain controller will be added to the Domain controller list.



Security

IGEL OS Reference Manual   657 / 710

•

1.
2.

3.

4.

Domain Realm Mapping
Menu path: Setup > Security > Active Directory / Kerberos > Domain Realm Mapping

With domain realm assignment, a host name is translated into the corresponding Kerberos realm name.

Use default DNS domain - Active Directory domain mapping
☑ The DNS name and Active Directory domain name match. (default)
☐ DNS name and Active Directory domain name assignments must be set up.

To set up a DNS name to Active Directory domain name assignment proceed as follows:
Click  to create a new entry.
Under DNS host or domain name, enter the host name that is to be assigned to an Active 
Directory domain name.
Under Active Directory domain name, enter the Active Directory domain name that is to be 
assigned to the host name.
Click on Continue.
The data entered will be added to the Domain realm mapping list.
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Smartcard
Menu path: Setup > Security > Smartcard

Here, you can define settings for logging on using a smartcard.

_____

Services (see page 659)
Middleware (see page 660)
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Services
Menu path: Setup > Security > Smartcard > Services

The PC/SC service makes the smartcard reader connected to the device and thus the smartcard inserted available 
to an application. This can be a server-side application where the data are forwarded via an RDP or ICA connection 
or a local application, e.g. the browser.

Enable PC/SC daemon
☑ The PC/SC service is enabled. The card reader is available for applications. (Default)
☐ The PC/SC service is disabled. The card reader is not available.
Currently active PC/SC devices: List of smartcard readers currently connected to the device. 
Internal smartcard readers and a variety of USB smartcard readers are supported.
You will find a list of supported smartcard readers in the IGEL Hardware Database27.
See also Smartcard Readers Supported by IGEL Smartcards.
Cherry USB2LAN proxy
☑ The Cherry USB2LAN proxy is active and makes Cherry electronic health card devices available 
in the network via SICCT and HTTPS.
☐ The Cherry USB2LAN proxy is disabled. (Default)
Network interface (if the Cherry USB2LAN proxy is enabled)

auto: The first network interface with IPv4 address will be used for the proxy. (Default)
eth0: The Ethernet interface will be used.
wlan0: The WLAN interface will be used.

https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
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Middleware
Menu path: Security > Smartcard > Middleware

Here, select the middleware (PKCS#11 module) which matches your card or your token. The middleware selected 
here will be used for the following logins:

Login to Citrix HDX / ICA sessions; see HDX / ICA Global (see page 52)
Login to Citrix StoreFront/Web Interface sessions; see Citrix StoreFront/Web Interface (see page 88)
Login to thin client via Active Directory; see Active DirectoryKerberos (see page 655)

The following options are available:

Gemalto SafeNet: The middleware for Gemalto/SafeNet eToken, IDPrime smartcards and Token is used.

cryptovision sc/interface: The middleware for cryptovision smartcards is used.

Gemalto IDPrime: The middleware for Gemalto IDPrime smartcards is used.

Athena IDProtect: The middleware for Athena IDProtect smartcards is used.

A.E.T. SafeSign: The middleware for SafeSign smartcards is used.

Secmaker Net iD: The middleware for Net iD smartcards is used.

Coolkey: The middleware Coolkey is used.

OpenSC: The middleware OpenSC is used.

Custom PKCS#11 module: The PKCS#11 module stored under the Path to the library is used. See also Using a 
Custom PKCS#11 Library.

Path to the library: Path to the custom PKCS#11 module

Enable this Gemalto middleware when you want to operate Gemalto Common Criteria devices in unlinked 
mode.
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System
Menu path: Setup > System

You can configure basic system settings here.

_____

Time and Date (see page 662)
Update (see page 663)
Remote Management (see page 666)
Remote Access (see page 669)
Power Options (see page 675)
Firmware Customization (see page 680)
Registry (see page 709)
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Time and Date
Menu path: Setup > System > Time and Date

Timezone Continent/Area: Continent/Area for your location
Possible values:

General: Under Location, you can select a time zone.
Africa... Pacific: Under Location, you can select a city for the selected continent/area.

Location: Select your location or time zone.

Use NTP Time Server
☑ The system clock is set via NTP.
☐ The system clock is not set via NTP. (default)
Use NTP Time Server: IP or name of an NTP time server. If you would like to enter a list of NTP 
time servers for redundancy purposes, separate the servers with spaces.
Set time and date: Carries over the time and date and sets the hardware clock.
You will find further information regarding the updating of time zone information (e.g. summer 
time adjustments) in the Updating Timezone Information (Daylight Saving Time, DST) FAQ.

Please note that the GMT time zones under Linux are usually in POSIX format. This means 
that you need to invert the actual time difference (e.g. for New York you select the zone 
"GMT+5" for "5 hours west of Greenwich” although the time in New York is actually 5 hours 
behind GMT). Defining the time zone by selecting a Continent and Location is therefore 
preferable.
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Update
Menu path: Setup > System > Update

Here, you can configure settings for the system update.

_____

Firmware Update (see page 664)
Buddy Update (see page 665)
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Firmware Update
Menu path: Setup > System > Update > Firmware Update

Here, you can specify how the device obtains updates for its own firmware.

Protocol: Select the method for accessing the updates.
HTTP: Download from a web server.
HTTPS: Download from a TLS/SSL-secured web server.
FTP: Download from an FTP server. (FTP passive mode is used)
Secure FTP: Download via SSH-secured FTP.
FTPS: Download from a TLS/SSL-secured FTP server.
FILE: The update lies in the device file system, possibly as a shared NFS or Windows update. 
You can choose the location by selecting a file below.

Server name: Name or IP address of the server.
Port: Port of the server on which the service is provided.
Server path: The path to the directory with the update files on the server.
User name: User name on the server.
Password: Password for the user account on the server.
Automatic update check on boot
☑ The device will automatically search for and install an updated firmware version each time that 
it boots.
☐ The device will not automatically search for an updated firmware version. (Default)
Automatic update check on shutdown
☑ The device will automatically search for and install an updated firmware version each time that 
it shuts down.
☐ The device will not automatically search for an updated firmware version when it shuts down. 
(Default)
Automatic buddy detection
☑ The device will automatically search for further devices in the local network that offer firmware 
updates as Buddy Servers.
☐ The device will not automatically search for Buddy Servers. (Default)
Update firmware: Launches the update process. If you have made changes on this setup page 
earlier on, click on Apply first.
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Buddy Update
Menu path: Setup > System > Update > Buddy Update

Under Buddy Update, you can specify your thin client as an update server for other IGEL thin clients. If you use a 
thin client as an update server, only the FTP protocol can be used to update the firmware. A number of thin clients 
can be set up as buddy update servers within the network.

Thin clients without a specified update server search for available servers during the update. The first update server 
contacted then provides the update.

Enable Update Server
☑ This thin client serves as an FTP firmware update server for other thin clients.
☐ This thin client does not serve as an FTP firmware update server for other thin clients. (default)
User Name: User name for FTP access (default: anonymous)
Password: Password for FTP access. The asterisk * allows any password.
Max. Concurrent Logins: Maximum number of simultaneous logons on the FTP server. (default: 
10)
For further information, read the Buddy Update how-to.
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Remote Management
Menu path: Setup > System > Remote Management

Here, you can configure settings relating to the remote administration of the client using the Universal Management 
Suite (UMS).

Enable remote management
☑ The thin client can be managed via the UMS. (default)
☐ Remote management is not allowed.
Universal Management Suite: If the client is registered on a UMS server, its IP address or host 
name will be shown in the list.

To add another UMS instance, click on :
UMS Server: Name or IP of the UMS server
Port Number: Port number of the UMS server (default: 30001)

Display “Apply changes” dialog on boot: If new settings were made in the UMS, the thin client 
may receive them during the boot procedure. Here you can decide whether the user can influence 
the application of the new settings.
☑ During the boot procedure, the Apply changes dialog will be shown if new settings are 
available. The user can decide whether the new settings are applied immediately. If the user does 
not allow them to be applied immediately, they will automatically be applied when the system is 
next restarted.
☐ The dialog will not be shown. The new settings will be automatically applied or ignored 
depending on the setting under Default action on boot.
Timeout: Number of seconds for which the Apply changes dialog is shown.
Possible values:

No time limit: The dialog is shown until the user clicks on a button.
1 ... 120 seconds

Default action on boot: Configure the action that is to be performed if the dialog exceeds the time 
limit or if it is disabled.
Possible values:

Apply changed configuration immediately: New settings will become active immediately 
and programs that are running may be restarted.
Ignore changed configuration: New settings will not be applied. The new configuration will 
be saved on the thin client.

Promt user on UMS actions
☑ The user will be informed via a message window if the client receives new settings from the 
UMS or is shut down. (default)
☐ The user will not be informed if the client receives new settings from the UMS or is shut down.

The list can contain more than one UMS instance. If the client cannot contact a UMS server 
under the host name igelrmserver , and the DHCP option 244 is not set, the client will 
go through the entries in the list until it can contact a UMS server successfully.
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Timeout: Number of seconds for which the notification window is shown (default: 20)
Possible values:

No time limit: The dialog is shown until the user clicks on a button.
1 ... 120 seconds

Structure tag: You can define a structure tag in order to sort the thin client into a directory in 
accordance with the UMS directory rules.
UMS Registration: This button opens the UMS Registration (see page 450) program from the 
accessories.
Further information regarding the use of structure tags can be found in the Using Structure Tags
How-To.

_____

Options (see page 668)
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Options
Menu path: Setup > System > Remote Management > Options

Log login and logoff events

☑ If a user logs on or off via Citrix or Kerberos, details of this event will be sent to the UMS and can 
be used there, e.g. to process support queries.
Logoffs from the Shared Workplace will also be logged (logons take place via the UMS anyway). 
(default)
☐ Logon and logoff events will not be relayed. (default)

Delay session start at boot time in order to apply new UMS settings: If new settings were made 
in the UMS, the thin client may receive them during the boot procedure.
☑ The session start will be delayed until the settings have been transferred or the time limit has 
been exceeded.
Timeout: Delay in seconds (default: 10)
Possible values:

No time limit: The dialog is shown until the user clicks on a button.
1 ... 120 seconds

Please note: For this option to work, in the UMS Console under UMS Administration > 
Globale Configuration > Logging the option Log Events must be enabled.



The event logs can be found under the system information for the thin clients in the UMS.
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Remote Access
Menu path: Setup > System > Remote Access

In order to allow central administration, the thin client can be configured in such a way that it can be accessed via 
the WAN.

_____

SSH Access (see page 670)
Shadow (see page 672)
Secure Terminal (see page 674)
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SSH Access
Menu path: Setup > System > Remote Access > SSH Access

Remote access to the local system via SSH is permitted by default. However, you can restrict remote access to a 
specific user from a specific host.

Enable
☑ The SSH service is enabled. (default)
Permit empty passwords
☑ Logging on without a password is allowed.
☐ Logging on without a password is not allowed. (default)
Permit administrator logon:
☑ Logging on as an administrator is allowed.
☐ Logging on as an administrator is not allowed (default)
Port number: Port number for SSH (default: 22)

User access

User name: Permitted user
Possible values:

root
user
ruser

Hostname: Name of the host from which SSH access takes place (example: xterm.igel.de )
Deny
☑ Access is denied.
☐ Access is allowed. (default)

Enable applications access for remote user “ruser”

Command line: Command that is allowed or prohibited for the remote user
Enable application
☑ The application given under command line may be executed by the remote user. (default)
☐ The application given under command line may not be executed by the remote user.

For the remote user "ruser" a password has to be assigned under Security > Password. 
The names "root" and "user" work without passwords, tough.



Unlike root and user, the ruser is not intended for real SSH sessions, but only for starting X 
applications.
And only those that are listed as allowed here on this setup page. By default in OS 10 these are 
localshell  and /config/sessions/setup0 .
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But if you intuitively try to log on to the device as ruser via SSH, then you will never be able to 
connect. The connection will be closed immediately without anything happening.
In this case you must add the parameter "-X" and the program to be started in the session call, like 
in this example: 
ssh -X ruser@192.168.10.203 localshell
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Shadow
Menu path: System > Remote Access > Shadow

For helpdesk purposes, you can observe the endpoint device via shadowing. This is possible via IGEL VNC Viewer in 
the Universal Management Suite (UMS) or another VNC client (e.g. TightVNC). For detailed information on 
shadowing, see Shadowing (VNC).

Allow remote shadowing

☑ Desktop content can be viewed from remote computers with VNC software.

☐ VNC shadowing is not allowed. (Default)

If Allow remote shadowing is activated, you can change the following settings:

Secure mode

☑ Communication will be secured via SSL/TLS and shadowing will only be possible for UMS administrators.

☐ Communication will not be secured via SSL/TLS. (Default)

Further information regarding secure shadowing can be found under Secure Shadowing (VNC with TLS/SSL).

Use password

☑ The remote user must enter a password before shadowing can begin.

☐ The remote user does not require a password for shadowing. (Default)

Password: Password for the VNC connection

Prompt user to allow remote session

☑ The local user will be asked for permission before shadowing. (Default)

Allow user to disconnect remote shadowing

☑ A button with which the user can terminate the connection is shown. (Default)

Allow input from remote

☑ The remote user can make entries using the keyboard and mouse as if they were the local user. (Default)

For Remote Working, Use Secure Shadowing

If the endpoint device is in a mobile or work-from-home environment, it is highly recommended to use 
secure shadowing only. Regular shadowing without encryption poses a security risk.



The user can terminate the VNC connection at any time by clicking on the Disconnect button.

In a number of countries, for example, Germany, unannounced shadowing is prohibited by law. Do not 
disable this option if you are in one of these countries!
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Scale frame buffer

☑ The screen content of the shadowed device is reduced or enlarged by the scaling factor before being 
transferred.

☐ The screen content is transferred in the original size. (Default)

Scale factor: Factor by which the screen content of the shadowed device is enlarged or reduced. (Default: 1.0)

Further parameters for the VNC server on the device are accessible under Setup > System > Registry > 
network.vncserver.
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Secure Terminal
Menu path: Setup > System > Remote Access > Secure Terminal

You can establish a secure terminal connection to a thin client.

The thin client must meet the following requirements:

The firmware of the thin clients is IGEL Linux Version 5.11.100 or higher or IGEL Linux Version 
10.01.100 or higher.

For IGEL Linux Version 5.11.100 and 10.03.100:

In the thin client setup, go to System > Remote Access > Secure Terminal
Enable Secure Terminal

For IGEL Linux Version 10.01.100 or newer:

Enable the following options in the thin client registry:
network > telnetd > enabled > allow telnet access
network > telnetd > secure_mode > secure telnet

You can allow access via the secure terminal for all registered thin clients. To do this, 
enable the UMS Administration > Global Configuration > Remote Access > Enable 
Global Secure Terminal option.
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Power Options
Menu path: Setup > System > Power Options

In this area, you will find the settings for energy management.

_____

System (see page 676)
Rechargeable Battery (see page 677)
Screen (see page 678)
Shutdown (see page 679)
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System
Menu path: Setup > System > Power Options > System

Here you can configure the settings for standby and for the CPU power plan.

System suspend on inactivity: Specify how long the user can be inactive before the system 
switches to standby mode.
Possible values:

Never
After 1 minute
...
After 24 hours

Without dialog
☑ The user is not asked if the system is to be set to the standby mode.
☐ The dialog will be shown. (Default).
Dialog timeout: Time in seconds, for which the dialog is to be displayed. (Default: 10 seconds)
CPU Power Plan: Specify here which CPU power plan (CPU Governor) the device is to use in 
battery mode and in AC mode.

On Battery:
High Performance: full performance with maximum processor speed 
Balanced (Smooth): slower regulation of performance in a balanced manner according to 
the demands of programs. Suitable for users who are bothered by the fan frequently 
running at high speed. 
Balanced (Recommended) : rapid regulation of performance according to the demands of 
programs. 
Power Saver: lowest processor speed
Plugged in:
High Performance 
Balanced (Smooth) 
Balanced (Recommended) 
Power Saver

Tray Icon
☑ A CPU icon will be shown in the system tray. This makes it easy to switch between power plans.
☐ No CPU icon will be shown. (Default)
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Rechargeable Battery
Menu path: Setup > System > Power Options > Battery

In this area, you can define the rechargeable battery messages.

Battery Notification

Critical battery level (percentage): Percentage of remaining battery charge deemed critical 
(default: 5)
Critical battery action: Action to be taken in the event of a critical battery level
Possible options:

Do nothing
Show warning
Run command
Run command in terminal

Critical command: Command that is executed when a critical charge level is reached (example: 
Shutdown)
Low battery level (percentage): Percentage of remaining battery charge deemed low (default: 
10)
Low battery action: Here you can specify what action is to be taken in the event of a low battery 
level.
Possible options:

Do nothing
Show warning
Run command
Run command in terminal

Low command: Command that is executed when a low charge level is reached (example: 
Shutdown)

Battery Tray Icon

Display percentage:
☑ The percentage of remaining energy is shown in the taskbar. (default)
Display time
☑ The estimated remaining battery life is shown in the taskbar.
☐ The estimated remaining battery life is not shown. (default)
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Screen
Menu path: Setup > System > Power Options > Display

In this area, you can configure screen settings which can help to reduce energy consumption.

Display Power Management Settings

Handle Display Power Management:
☑ You can configure energy saving settings separately for battery or AC operation. (default)
☐ You cannot configure energy saving settings.
Standby Time: Number of minutes after which the screen switches to standby mode if the user is 
inactive. (default: 6 minutes)
Suspend time: Number of minutes after which the screen switches to suspend mode if the user is 
inactive. (default: 8 minutes)
Off Time: Number of minutes after which the screen switches off if the user is inactive. (default: 10 
minutes)

Brightness Reduction

On inactivity reduce to: Specify to how many percent the screen brightness should be reduced if 
you are not using the device for battery and AC operation. (default for battery: 20%, default for AC 
operation: 80%)
Reduce after: Specify a time between 10 and 120 seconds after which the screen brightness will be 
reduced for battery and AC operation. (default: Never)



System

IGEL OS Reference Manual   679 / 710

•

•

•

•

•
•
•

•
•

•

Shutdown
Menu path: Setup > System > Power Options > Shutdown

Here, you can change the behavior when the thin client shuts down manually or automatically.

Allow system shutdown
☑ The thin client can be shut down. (Default)
☐ The thin client cannot be shut down.
Allow system suspend
☑ The thin client can be placed in standby mode. (Default)
☐ The thin client cannot be placed in standby mode.
Allow canceling of shutdown process
☑ The user cannot cancel the procedure via a button. (Default)
☐ The user cannot cancel the procedure.
Default action: Action that is carried out when the time is set under Dialog timeout.
Possible options:

Shutdown
Standby mode
Cancel: No action will be carried out after the time set under Dialog timeout expires, see 
Allow canceling of shutdown process parameter.
No action: No action will be carried out after the time set under Dialog timeout expires.

Without dialog
☑ The dialog will not be shown. The action selected under Default action will be carried out.
☐ The dialog will be shown. (Default)
Dialog timeout: After the time (in seconds) set here expires, the dialog will close and the action 
specified under Default action will be carried out. If the value is set to 0, the dialog will be shown 
until the user selects one of the possible actions. (Default: 10)
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Firmware Customization
Menu path: Setup > System > Firmware Customization

You can configure the firmware according to your needs.

_____

Custom Partition (see page 681)
Custom Application (see page 685)
Custom Commands (see page 691)
Corporate Design (see page 697)
Environment Variables (see page 705)
Features (see page 708)
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Custom Partition
Menu path: Setup > System > Firmware Configuration > Custom Partition

In IGEL Linux, a custom data partition is available for use as required. A download/update function which loads data 
from a server and, where appropriate, updates them can be set up for this custom storage area.

_____

Partition (see page 682)
Download (see page 683)

The IGEL Support Team offers support for the deployment of Custom Partitions. However, it is not possible 
to offer support for any third-party software that is installed on a Custom Partition.



If the thin client is reset to the default settings (factory reset), the custom partition and all data stored on it 
will be deleted.
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Partition
Menu path: Setup > System > Firmware Configuration > Custom Partition > Partition

Here, you can create a partition of your own.

Enable partition
☑ The customer partition is enabled in the IGEL Setup of the thin client or with the IGEL Universal 
Management Suite via the setup path.
☐ The customer partition is not enabled. (default)
Size: Size of the partition. A number must be followed by a multiplicative ending, without a space 
in between. Example: "100K" stands for 100 Kibibytes, that is, 100 * 1024 bytes.
The following multiplicative endings are possible (capital letters required):
K for kibibytes (number * 1024)
M for mebibytes (number * 1024 * 1024)
G for gibibytes (number * 1024 * 1024 * 1024)

Mount point: Path on which the partition is to be mounted. (default: /custom )
Partitions parameters: From IGEL OS Version 10.03.100, you can enter name value pairs which are 
passed on to the custom partition for further processing.
To manage the list, proceed as follows:

Click  to create a new parameter.
Click  to remove the selected parameter.
Click  to edit the selected parameter.
Click  to copy the selected parameter.

Add

Name: Name of the parameter
Value: Value of the parameter

Sensible values are for example "100K" (for 100 KiB = 100 * 1024 bytes) or "100M" (for 100 
MiB = 100 * 1024 * 1024 bytes). The size of the partition should be set to at least 100 KiB. 
However, no more than 300 MiB should be reserved for the customer-specific partition 
(based on the 1 GB standard CF used in IGEL Linux thin clients). This is because 
subsequent firmware updates may require more storage space than the current version.
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Download
Menu path: Setup > System > Firmware Configuration > Custom Partition > Download

Sources for partition data

In order to load data onto the custom partition, at least one source for partition data must be set up here.

To manage the list, proceed as follows:

Click  to create a new source.
Click  to remove the selected source.
Click  to edit the selected source.
Click  to copy the selected source.

Add

Automatic update
☑ The contents from this source will be updated automatically.
☐ The contents from this source will not be updated automatically. (default)
URL: URL of the web server
User name: User name for access to the web server
Password: Password for access to the web server
Initialization action: Action which is performed after mounting the partition (program or script 
with absolute path). For example, a program downloaded to the partition can be launched.
Finalizing action: Action which is performed before mounting the partition (program or script 
with absolute path). For example, a program downloaded to the partition can be ended.

The transfer protocols are the same as the ones for updating the firmware, e.g. HTTP and HTTPS. An INF  file 
which in turn references a tar archive zipped using bzip2 must be referenced as the target.

The structure of the INF file is as follows:

[INFO], [PART] Header information

file="test.tar.bz2" File name of the compressed tar archive

version="1" Version number - a higher version results in 
an update if Update automatically is 
enabled.

The files to be transferred must therefore be zipped in a tar archive which is then compressed using bzip2. This file 
is referenced in the INF file which is the target of the URL.

The tar archive can be created under Windows, e.g. with the open source program 7-Zip (www.7-zip.de28). This 
program also allows bzip2  compression. Under Linux, tar and bz2 files can be created using onboard resources.

http://www.7-zip.de
http://www.7-zip.de


System

IGEL OS Reference Manual   684 / 710

The procedure makes it possible to replace the file(s) on the server with a new version which the thin client loads 
the next time it is booted. The Version  parameter in the INF  file must be increased for this purpose.



System

IGEL OS Reference Manual   685 / 710

•

•

•

•

•

•

•

•

•

•

•

Custom Application
Menu path: Setup > System > Firmware Customization > Custom Application > Custom Application

Applications which were loaded onto a customer partition for example can be launched via the Application 
Launcher or an icon on the desktop once they have been defined as custom applications. In order for this to be 
possible, a command to call up the application must be entered under Settings (see page 687).

 Click on  to define a custom application.

 Specify the launch options:

Session name: Name for the session

Session start options

Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
Start menu's system tab
☑ The session can be started with the start menu’s system tab.
Application Launcher's system tab
☑ The session can be started with the Application Launcher’s system tab.
Desktop context menu
☑ The session can be started with the desktop context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

_____

Settings (see page 687)
Desktop Integration (see page 688)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Settings
Menu path: System > Firmware Customization> Custom Application > [Session Name] > Settings

Enter the command for calling up an application here:

Icon name: Select an icon provided. (default: applications-other).

Command: Give the name and path of the application. (Example: /usr/bin/gpicview ).

Only the desktop icon of a session is customizable. The taskbar icon of a session cannot be customized 
and will remain the default icon. Complete customization is not possible.
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Desktop Integration
Menu path: System > Firmware Customization > Custom Application > [Session Name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Relaunch

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Custom Commands
Menu path: Setup > System > Firmware Customization > Custom Commands

You can define custom commands for specific points in time when the system is starting. You can use configured 
environment variables (see page 705) in the commands.

_____

Post Session (see page 692)
Base (see page 693)
Network (see page 694)
Desktop (see page 695)
Reconfiguration (see page 696)
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Post Session
Menu path: Setup > System > Firmware Customization> Custom Commands > After End of Session

For a specific session type, you can define an action that is performed when the last session of this type is ended.

Session type: Session type for which the action is performed
Possible values:

No post session command
Citrix
Citrix StoreFront/XenApp web portal
RDP
VMware Horizon
Browser
Java-based (Webstart/Leostream Connect)
vWorkspace
NoMachine NX
Parallels Client
PowerTerm terminal emulation
ThinLinc
X session
IBM iSeriesAccess
Media player
VNC viewer

Post session command: Action that is carried out after the end of the session selected above 
Possible options:

Logoff: The user is automatically logged off; a login method must be defined for this 
purpose. Further information can be found under IGEL Smartcard (see page 647), Active 
Directory / Kerberos (see page 650) and Smartcard (see page 658).

Shutdown/suspend (system default action): The thin client will be shut down or placed in 
standby mode depending on the setting under System > Power Options > Shutdown > 
Default action selection. A dialog allowing the user to cancel the procedure will be shown 
in the process. Further information can be found under Shutdown (see page 679).
Shutdown/standby mode (system default action without dialog): The thin client will be shut 
down or placed in standby mode depending on the setting under System > Power Options 
> Shutdown > Default action selection. The user cannot cancel the procedure.
Reboot (with dialog timeout): The thin client will reboot. A dialog allowing the user to cancel 
the procedure will be shown in the process.
Reboot (without dialog): The thin client will reboot. The user cannot cancel the procedure.
Enter custom command here: Command to be executed

The “Logoff” option cannot be used if the Appliance Mode is in use. Further information 
can be found under Appliance Mode (see page 192).
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Base
Menu path: Setup > System > Firmware Customization > Custom Commands > Base

The commands defined here are executed on a one-off basis during the boot procedure. You can define commands 
for the execution times described below:

Initialization
Not all drivers loaded, not all devices available
Network scripts not launched, network not available
Partitions available except firefox profile, scim data, ncp data, custom partition

Before session configuration
Not all drivers loaded, not all devices available
Network scripts launched, network not available
Partitions available except firefox profile, scim data, ncp data, custom partition
Sessions not configured

After session configuration
All drivers loaded, all devices available
Network available
Partitions available except custom partition
System daemons not launched (CUPS, ThinPrint etc.)
Sessions configured
UMS settings retrieved but not yet effective

Final initialization command
All partitions available
All system daemons launched
UMS settings effective
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Network
Menu path: Setup > System > Firmware Customization > Custom Commands > Network

The commands defined here are executed each time that the relevant network interface (default:  eth0 ) starts. 

The network interface can be selected with the  $INTERFACE  environment variables ( eth0 ,  eth1 ,  wlan0 ). 
You can define commands for the execution times described below:

Network initialization

The commands defined here are executed at the beginning of the network configuration.
No further network settings used

After network DNS

Runs after each change in the IP address or host name
IP address / name server settings used (e.g. via DHCP)

Before network services

IP address / name server settings used
VPN connected (if VPN autostart was enabled in the setup)
No network / host routing settings used

Final network command

Network / host routing settings used
NFS and SMB drives available
System time synchronized with time server
UMS settings retrieved but not effective yet
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Desktop
Menu path: Setup > System > Firmware Customization > Custom Commands > Desktop

The commands defined here are executed when the X server is launched. You can define commands for the 
execution times described below:

Desktop initialization
Runs once during the boot procedure
Desktop environment configured but not launched
User not logged on (Kerberos, smartcard etc.)

Before desktop start
Runs once during the boot procedure
Desktop environment launched
Message service launched
Session D-Bus launched
User not logged on (Kerberos, smartcard etc.)

Final desktop command
Runs after each user logon and desktop restart
User logged on (Kerberos, smartcard etc.)
User desktop launched



System

IGEL OS Reference Manual   696 / 710

•

Reconfiguration
Menu path: Setup > System > Firmware Customization > Custom Commands > Reconfiguration

The commands defined here are executed after settings relating to the local setup or the UMS have been changed. 
You can define commands for the execution time described below.

After reconfiguration: Runs after an effective change in the thin client settings (local setup, UMS)
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Corporate Design
Menu path: Setup > System > Firmware Customization > Corporate Design

In this area, settings allowing you to adapt the user interface to your company layout are grouped together.

You can place your own logo in the following places:

Custom Bootsplash (see page 698)
Background (1st Monitor) (see page 700)
Company Logos (see page 703)

See also the how-to Customizing IGEL Linux Desktop.
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Custom Bootsplash
Menu path: Setup > System > Firmware Configuration > Corporate Design > Custom Bootsplash

With a bootsplash, you can show your company logo or a specific image during the booting procedure. The 
bootsplash will be shown instead of the console messages.

Please note: You need to provide an image file for your custom bootsplash on a download server.

Custom bootsplash

Enable custom bootsplash
☑ You can make the following settings in order to configure a custom bootsplash.
☐ No custom bootsplash is configured. (default)

Custom bootsplash - Server Location

Use firmware update server location
☑ The server configuration will be carried over from the firmware update (see page 664).
☐ You can carry out a custom configuration below. (default)
Protocol: Access method for the image

HTTP: Download from a web server.
HTTPS: Download from a TLS/SSL-secured web server.
FTP: Download from an FTP server.
Secure FTP: Download via SSH-secured FTP.
FTPS: Download from a TLS/SSL-secured FTP server.
FILE: The image file lies in the thin client file system, possibly as a shared NFS or Windows 
update. You can choose the location simply by selecting a file below.

Server name: Name or IP address of the server
Port: Port of the server on which the service is provided
Server path: Path to the directory with the image file on the server
User name: User name on the server
Password: Password for the user account on the server

Custom Bootsplash - Settings

Custom bootsplash file: File name of the custom image
As regards positioning, the following applies: 0 = left-justified, 50 = centered, 100 = right-justified
Custom Bootsplash Style:

Original
Stretched
Scaled

The file types BMP, JPG, GIF, TIF, PNG and SVG are supported for a bootsplash. A total storage area of 25 
MB is available for all user-specific images. The image is 800 x 600 pixels in size (aspect ratio remains 
unchanged). It can be positioned vertically and horizontally.
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Zoomed
Background color: Use the color picker to choose.
Horizontal position of the bootsplash image (default: 50)
Vertical position of the bootsplash image (default: 50)
Size of progress indicator (default 72)
Horizontal position of the progress indicator (default: 90)
Vertical position of the progress indictaor (default: 90)
Bootsplash update: The user-specific bootsplash will be downloaded from the given server.

If you change the image file or even just one of the settings for an existing bootsplash, be 
sure to click on Bootsplash update in order to regenerate the system files used and then 
on Apply or OK.
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Background (1st Monitor)
Menu path: Setup > System > Firmware Customization > Corporate Design > Background (1st Monitor)

Decorate the desktop background with predefined IGEL backgrounds, a fill color or a color gradient or define a 
custom background image. You can set up a separate background image for each monitor that is connected to the 
thin client.

Prerequisite: You have provided a custom background image on a server; see Background Image Server (see page 702).

Wallpaper: Select one of the predefined background images from the following list:
neutral
disabled
black (4x3)
blue (4x3)
gray (4x3)
orange (4x3)
green
black (16x9)
blue (16x9)
gray (16x9)
orange (16x9)

Wallpaper Style: If you have set a custom background image, you can display it in a number of 
ways.
Possible options:

Automatic
Centered
Tiled
Spread
Scaled

The file types BMP, JPG, GIF, TIF, PNG and SVG are supported for a background image. A total storage area 
of 25 MB is available for firmware customization images.



•

•
•
•

From IGEL Linux Version 10.03.500 both background images and background image server can be defined 
user-customized via Shared Workplace. Please note the following for this:

All user-customized background images will be saved on the thin client and therefore 
require a part of the available 25 MB storage space. Ensure that this storage limit is not 
exceeded. (When the storage limit is reached, all images except the one currently used will 
be deleted; with a new logon via Shared Workplace, the previously deleted images will be 
downloaded again until the storage limit is reached.)
You will find further information on Shared Workplace and background images here:
IGEL Linux user manual: Shared Workplace (see page 653)
IGEL UMS user manual: Shared Workplace
How-To: Creating your own Wallpaper in the How-To Customizing the IGEL Linux Desktop
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Zoomed
Color Style: If you have chosen two different colors as the desktop background color, you can 
define color gradients here. Possible values:
Possible options:

Solid color
Horizontal gradient
Vertical gradient

Desktop Color: Click on Choose color to specify a custom background color for your desktop if 
you have not chosen a background image.
2nd Desktop Color: Click on Choose color to specify a second background color for your desktop.
Custom wallpaper downlad
☑ You can set up a custom background image.
☐ No custom background image will be used. (Default)
Custom Wallpaper file: Name of the background image file

If you would like to use a custom background image, you need to specify the download 
server under System > Firmware Customization > Corporate Design > Background (1st 
Monitor) > Custom Wallpaper Server (see page 702). If you have already defined a server for 
the system update files, you can use the same server settings for downloading the 
background image.
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Background Image Server

Menu path: Setup > System > Firmware Customization > Corporate Design > Background (1st Monitor) > 
Custom Wallpaper Server

Custom Wallpaper - Server Configuration

Use firmware update server location
☑ The server configuration will be carried over from the firmware update (see page 664).
☐ You can carry out a custom configuration below. (default)
Protocol: Select the method for accessing the image.

HTTP: Download from a web server.
HTTPS: Download from a TLS/SSL-secured web server.
FTP: Download from an FTP server.
Secure FTP: Download via SSH-secured FTP.
FTPS: Download from a TLS/SSL-secured FTP server.
FILE: The image lies in the thin client file system, possibly as a shared NFS or Windows file. 
You can choose the location simply by selecting a file below.

Server name: Name or IP address of the server.
Port: Port of the server on which the service is provided.
Server path: The path to the directory with the image file on the server
User name: User name on the server
Password: Password for the user account on the server
Wallpaper update: The user-specific background image will be downloaded from the given server.
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Company Logos
Menu path: Setup > System > Firmware Customization > Corporate Design > Company Logos

You can show your company logo in the screensaver and in the start menu.

Screensaver

Enable image display
☑ The image defined below will be shown as the screensaver. (default)
File for screen saver logo: Complete path for an image file or a directory that contains a number 
of image files.

One image per monitor
☑ The image will be shown on each individual monitor rather than one image across all monitors. 
(default)
Image duration: Time in seconds until the image changes (default: 10)
Image display mode

Small-sized hopping: small image that jumps across the screen
Medium-sized hopping: larger image that jumps across the screen
Full screen center cut out: Image is displayed across whole screen, edges can be cut off.
Full screen letterbox: Complete image is shown. A black edge may be visible depending on 
the format.

Start menu

Start button icon: File name with full path to select your logo as the icon for the start menu in the 
taskbar. Size: 32x32 pixels
Company logo in start menu: File name with full path to show your company logo in the start 
menu window. Size: 64x64 pixels

If you enter a folder instead of a single image file as the source, all images in the folder will 
be displayed as a slide show. The image display time for the images can be configured. If 
you do not specify a file of your own, the IGEL logo will be used.



In order to see the company logo in the start menu window, you must set the start menu 
type to Advanced. To do this, click on User Interface > Desktop > Start Menu.
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Environment Variables
Menu path: System > Firmware Customization > Environment Variables

Environment variables allow you to use dynamic parameter values for a number of session types, e.g. so as not to 
have to enter ICA or RDP servers for every session.

Predefined variables can also be allocated and distributed via the IGEL UMS. Additionally, defined variables can 
only be used locally on the thin client and may be overwritten by a UMS configuration.

Enable variable substitution in session: (default: disabled)

☑ The use of variables in sessions such as ICA and RDP is enabled. If specific parameters contain a $ , shell 
substitution will be carried out.

☐ The use of variables in sessions is not enabled. (default)

The environment variables are available in the setup under Custom Commands (see page 691).

In addition, the following session parameters can be updated through variables:

Legacy ICA sessions: Citrix Server or published application
Legacy ICA sessions: User
RDP session: Server
RDP session: User

_____

Predefined (see page 706)
Additional (see page 707)



System

IGEL OS Reference Manual   706 / 710

•
•

1.

2.
•

•
3.

Predefined
Menu path: System > Firmware Customization > Environment Variables > Predefined

Variable name: Name for the variable
Value: Value for the variable

To use environment variables in sessions, proceed as follows:
Enable environment variables under System > Firmware Customization > Environment 
Variables > Enable variable substitution in session.
Define the variable name and content, e.g.

Variable name: SERVERNAME

Value: testServer
Enter the variable name in the parameter field of the session with the $ symbol before it. Example: 
$SERVERNAME

In the case of RDP and ICA sessions, the value is entered in the session file after saving. 
With XenApp, the setting is not implemented until a session starts and is running.
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Additional
Menu path: System > Firmware Customization > Environment Variables > Additional

You can define other variables in addition to the 10 predefined ones.

Variable name: Name for the variable
Value: Value for the variable
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Features
Menu path: System > Firmware Configuration > Features

Using this list of available services, you can quickly enable or disable firmware components such as Powerterm, 
Media Player, Extra Font Services, etc. in order to reduce the amount of storage space required.

If a service was disabled, the associated session type will no longer be available when the system is restarted. 
Existing sessions will no longer be shown but will not be deleted either.

You will find further information in Disabling Features to Reduce Firmware Size.

A disabled session type will not be updated during a firmware update. You should, therefore, disable 
unused services in order to speed up update processes.



Features with Limited Support

A number of products feature functions with “limited support”. These functions are offered 'as is' without 
any warranty. Any support for these functions is provided on a non-binding, “best effort” basis.
These features are not available on IGEL IZ devices (IGEL Zero HDX, IGEL Zero RFX, or IGEL Zero Horizon).
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Registry
Menu path: System > Registry

In the registry, you can change virtually any firmware parameter. You will find information on the individual items in 
the tooltips.

Search parameter...: Search for setup parameters in the registry.

Search criterion: Criterion for searching. 
The following can be selected:

Parameter name
Parameter name: Any search term.
Logical search restriction:

Contains
Exact match
Use regular expressions

Ignore case
Find previous: Go back if there are a number of hits.
Find next: Go forwards if there are a number of hits.
Example: If you would like to find the FTP settings for updating the Linux firmware, you can search 
for the parameter name ftp . The parameter found in the registry structure is highlighted. Click 
on Find next until you find your desired parameter:

Changes to the registry should only be made by experienced administrators. Incorrect parameter settings 
can easily destroy the configuration and cause the system to crash. In cases like these, the only way to 
restore the functionality is to reset the device to the factory defaults!
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Add instance: Adds instances. This is possible with parameters which have a percent sign as their last character, 
e.g. nfymount% . The new instances are numbered consecutively: nfymount1 , nfymount2  etc.

Delete instance: Deletes a previously added instance.
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